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Préface

Ce guide de l’utilisateur explique les procédures d’installation et d’utilisation du
programme Sun StorEdge Configuration Service qui permet de configurer, surveiller
et gérer les baies de disques Sun StorEdge FC.

Sauf indication contraire, la baie Sun StorEdge FC est dénommée par la suite baie.
Ce manuel fait référence aussi à Sun StorEdge 3000 Family Diagnostic Reporter, un
utilitaire complémentaire du programme Sun StorEdge 3000 Family Configuration
Service qui envoie et reçoit les messages système des hôtes et des baies. Pour tout
renseignement supplémentaire sur l’installation et l’utilisation de Diagnostic Reporter,
voir le Guide de l’utilisateur de Sun StorEdge 3000 Family Diagnostic Reporter 1.2.

Ce manuel est destiné aux administrateurs système expérimentés qui sont déjà
familiers avec le matériel et les logiciels Sun.

Organisation de ce guide
Ce guide contient les rubriques suivantes:

Le Chapitre 1 est une introduction aux principales fonctions de Sun StorEdge 3000
Family Configuration Service.

Le Chapitre 2 décrit les étapes à suivre pour assurer que la baie de disques est
correctement configurée avant d'installer et d'utiliser Configuration Service.

Le Chapitre 3 détaille la configuration système requise et les procédures
d'installation pour les consoles et les agents Configuration Service sur des systèmes
sous l'environnement d'exploitation Solaris™.

Le Chapitre 4 détaille la configuration système requise et les procédures
d'installation pour les consoles et les agents Configuration Service sous les systèmes
Windows NT/2000.
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Le Chapitre 5 détaille la configuration système requise et les procédures
d'installation pour les consoles et les agents Configuration Service sous
l'environnement d'exploitation Linux.

Le Chapitre 6 décrit les procédures de configuration de Configuration Service.

Le Chapitre 7 donne toutes les instructions nécessaires pour la configuration de la
baie.

Le Chapitre 8 décrit comment créer un filtre d’unité logique (LUN Filter) pour la
gestion de grands réseaux Fibre Channel qui partagent un stockage commun.

Le Chapitre 9 explique comment surveiller la baie.

Le Chapitre 10 décrit comment préserver l'intégrité de la baie.

Le Chapitre 11 explique comment modifier et étendre la configuration actuelle de la
baie.

L’Annexe A fournit une explication générale de la technologie RAID.

L’Annexe B explique comment surveiller une unité autonome JBOD et télécharger
une mise à jour de son firmware (SCSI uniquement).

L’Annexe C décrit comment configurer un cluster de périphériques.

L’Annexe D explique comment définir le World Wide Name (WWN) d’hôte dans
les systèmes fonctionnant sous l'environnement d'exploitation Solaris et sous
Microsoft Windows NT.

L’Annexe E explique comment configurer les capacités de surveillance intégrale
d'événements et de notification par message électronique.

L’Annexe F propose des suggestions pour résoudre certains problèmes.

L’Annexe G contient la liste des codes et des messages d'erreurs de Configuration
Service.

Le Glossaire contient la liste des acronymes et des termes liés à Configuration
Service qui sont employés dans ce guide.
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Utilisation des commandes UNIX
Ce document ne contient peut-être pas d'informations sur les commandes et
procédures UNIX® de base telles que l'arrêt du système, le démarrage du système et
la configuration des périphériques.

Pour plus d'informations sur ces sujets, veuillez consulter les ressources suivantes:

■ Guide des périphériques Sun Solaris ;
■ la documentation en ligne AnswerBook2™ pour le système d'exploitation Solaris™;
■ la documentation des logiciels fournis avec votre système.

Conventions typographiques

Type de
caractère*

* Les paramètres de votre navigateur peuvent différer de ceux-ci.

Signification Exemples

AaBbCc123 Noms de commandes, de
fichiers et de répertoires;
affichage sur -l'écran de
l'ordinateur.

Modifiez le fichier .login.
Utilisez ls -a pour dresser la liste de tous
les fichiers.
% You have mail.

AaBbCc123 Ce que vous tapez, par
opposition à l'affichage sur
l'écran de l'ordinateur.

su

Password:

AaBbCc123 Titres d'ouvrages, nouveaux
mots ou termes, mots
importants. Remplace les
variables de ligne de
commandes par des noms ou
des valeurs réels.

Lisez le chapitre 6 du Guide de l'utilisateur.
Il s'agit d'options de classe.
Vous devez être un superutilisateur pour
pouvoir effectuer ceci.
Pour supprimer un fichier, tapez rm nom de
fichier.
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Invites d'interpréteur de commande

Documentation connexe

interpréteur de commande Invite

Interpréteur de commande C nom-machine%

Superutilisateur interpréteur C nom-machine#

Interpréteurs Bourne et Korn $

Superutilisateur interpréteurs Bourne et Korn #

Titre Numéro de pièce

Sun StorEdge 3000 Family Release Notes 816-7301

Manuel d'installation, d'utilisation et d'entretien de Sun StorEdge 3000 Family 816-7300

Guides des méthodes recommandées pour la gamme Sun StorEdge 3000 816-7325

Guide de l’utilisateur Sun StorEdge 3000 Family RAID Firmware 816-7934

Sun StorEdge 3000 Family Configuration Service 1.2 - Guide de l’utilisateur 816-7931

Sun StorEdge 3000 Family - Guide d’installation en bâti 816-7320

Guide d’installation Sun StorEdge 3000 Family FRU 816-7326

Sun StorEdge 3000 Family Safety, Regulatory, and Compliance Manual 816-7930
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Support technique
Pour les toutes dernières nouveautés et les conseils de dépannage, examinez les
Release Notes concernant votre baie dans le répertoire approprié :

www.sun.com/products-n-solutions/
hardware/docs/Network_Storage_Solutions/Workgroup/3510

Pour accéder 24 heures sur 24 aux solutions du support technique sur le Web, visitez
le centre de support en ligne à l'adresse suivante :

www.sun.com/service/online

Pour les numéros de téléphone de l’asistance internationale et les renseignements sur
comment soumettre les questions en ligne, appelez le 1-800-USA-4SUN ou visitez :

www.sun.com/service/contacting

Accès à la documentation Sun en ligne
Toute la documentation sur la baie Sun StorEdge 3510 FC est disponible en ligne
sous les formats PDF et HTML aux deux adresses suivantes :

http://www.sun.com/products-n-solutions/
hardware/docs/Network_Storage_Solutions/Workgroup/3510

Remarque – Les deux adresses indiquées ci-dessus vous permettent de télécharger
tout un document HTML en une fois.

http://www.sun.com/documentation

Vous pouvez commander des copies sur papier des manuels de la baie
Sun StorEdge 3510 FC à l'adresse suivante :

http://corppub.iuniverse.com/marketplace/sun
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508 Fonctions d’accessibilité
La documentation Sun StorEdge est disponible en fichiers au format HTML
conforme 508 qui peut être utilisé avec des programmes d’aide pour le personnel
ayant des problèmes de cécité. Ces fichiers sont fournis sur le CD de Documentation
CD de votre produit ainsi que sur les sites Web indiqués dans « Accès à la
documentation Sun en ligne », page xxi. De plus, les applications logicielles et
firmware fournissent les raccourcis clavier de navigation qui sont aussi documentés
dans les guides de l’utilisateur.

Sun vous invite à envoyer vos
commentaires
Dans le souci d'améliorer notre documentation, nous vous invitons à nous faire
parvenir vos commentaires et vos suggestions. Pour cela, adressez un courrier
électronique à l'adresse suivante :

docfeedback@sun.com

Veuillez préciser le numéro de pièce (817-2772-10) du document en question dans
l'objet de votre courrier.
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CHAPITRE 1

Introduction

Cette section présente une vue sommaire des fonctions du programme Sun StorEdge
3000 Configuration Service.

Remarque – Sun StorEdge 3000 Family Configuration Service est dénommé par la
suite Configuration Service ou le programme.

Configuration Service est un programme puissant reposant sur le langage de
programmation JavaTM et intégrant dans une seule application des fonctions telles que
la configuration du stockage, l’allocation des ressources, la maintenance et les outils de
surveillance requis pour une administration centralisée des baies de disques.

Depuis une seule console sur un réseau, les administrateurs système peuvent
initialiser les périphériques de stockage du réseau, modifier les configurations,
surveiller l'état et planifier les cycles de maintenance avec une interface utilisateur
graphique intuitive.

Les administrateurs peuvent aussi allouer, réallouer ou étendre dynamiquement la
capacité au fur et à mesure que les exigences de stockage évoluent en fonction des
demandes de stockage de tout le réseau.

Lorsqu'une modification de l'état se produit, Configuration Service envoie des
alertes par affichage sur la console, par courrier électronique ou sur un récepteur de
radiomessagerie alphanumérique. Configuration Service peut aussi envoyer des
alertes à une console de gestion d'entreprise SNMP, notamment HP OpenView.
1



Configuration Service comprend deux composants :

■ L'agent Configuration Service – les environnements d’exploitation Solaris 8 et
Solaris 9, Microsoft Windows NT et Windows 2000, et Sun™ Linux 5.0 et
Red Hat Linux 7.2 et 7.3.

L'agent surveille les périphériques de stockage sur disque connectés et rapporte
leurs états à la console. Le logiciel de l'agent doit être installé sur chaque serveur
individuel du réseau faisant partie de Configuration Service. L'installation peut
être réalisée à distance depuis une station de travail du réseau.

■ La console Configuration Service – Environnements d'exploitation Solaris 8 et
Solaris 9, ainsi que Microsoft Windows NT et Windows 2000.

La console intègre l'interface utilisateur graphique de Configuration Service et
affiche les informations rapportées par les agents. Elle permet aussi la gestion
et la configuration à distance des périphériques depuis une station de travail.
La console Configuration Service doit être installée sur un ordinateur gérant les
serveurs sur le réseau.
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CHAPITRE 2

Préliminaires

Ce chapitre contient des renseignements importants que vous devez connaître avant
d'installer et d'utiliser le programme Configuration Service et le guide d’utilisation.
Les rubriques suivantes sont couvertes dans ce chapitre :

■ « Quelle version de Configuration Service convient-elle pour votre baie ? », page 3
■ « À propos des fenêtres d’exemple », page 4
■ « Environnement d'exploitation Solaris », page 4
■ « Système d'exploitation Microsoft Windows NT/2000 », page 5
■ « Privilèges de superutilisateur/administrateur », page 5

Quelle version de Configuration Service
convient-elle pour votre baie ?
Le tableau ci-dessous indique la version de Configuration Service adaptée à chaque
baie Sun StorEdge.

TABLEAU 2-1 Versions adaptées de Configuration Service

Configuration
Service Version Baie Sun StorEdge Comments

1.0 Baie de disques Sun
StorEdge 3310 SCSI

Édition initiale de Configuration Service pour
SCSI uniquement.

1.2 Baie de disques Sun
StorEdge 3510 FC

Le programme Configuration Service et le
guide de l’utilisateur ont été mis à jour avec les
fonctions Fibre Channel, y compris le filtrage
des unités logiques (LUN).
3



À propos des fenêtres d’exemple
De nombreuses fenêtres d’exemple sont présentées dans ce guide pour illustrer le
fonctionnement du programme Configuration Service. Ces fenêtres identifient soit la
baie Sun StorEdge 3310, soit la baie Sun StorEdge 3510 à la sortie. Sauf s’il est
spécifiquement indiqué qu’une fonction, et donc sa fenêtre d’exemple, est applicable
à la baie Sun StorEdge 3510 FC uniquement, les deux baies sont applicables.

Environnement d'exploitation Solaris
Avant d'installer Configuration Service sur des systèmes fonctionnant sous
l'environnement d'exploitation Solaris, procédez comme suit :

■ Veillez à ce que le serveur hôte sur lequel l'agent Configuration Service est installé
soit connecté à un canal affecté d'un identificateur primaire. Reportez-vous au
Manuel d'installation, d'utilisation et d'entretien Sun StorEdge 3000 Family relatif à
votre baie de disques pour tout renseignement concernant les paramètres par
défaut et la configuration initiale du contrôleur.

■ Pour la baie Sun StorEdge 3310 SCSI, veillez à ce que l'environnement d'exploitation
puisse reconnaître plusieurs unités logiques sous un même identificateur. Il peut
s'avérer nécessaire de modifier le fichier /kernel/drv/sd.conf afin d'affecter des
unités logiques d'hôte supplémentaires. Pour toute information concernant la
modification de ce fichier, se reporter au Manuel d'installation, d'utilisation et
d'entretien Sun StorEdge 3000 Family pour votre baie SCSI. Si vous modifiez le fichier
sd.conf, vous devez redémarrer votre poste de travail pour que les modifications
deviennent effectives.
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Système d'exploitation Microsoft
Windows NT/2000
Avant d'installer Configuration Service sous le système d'exploitation Microsoft
Windows, procédez comme suit :

■ Veillez à ce que le serveur hôte sur lequel l'agent Configuration Service est installé
soit connecté à un canal affecté d'un identificateur primaire. Reportez-vous au
Manuel d'installation, d'utilisation et d'entretien Sun StorEdge 3000 Family relatif à
votre baie de disques pour tout renseignement concernant les paramètres par
défaut et la configuration initiale du contrôleur.

■ Veillez à ce que le serveur soit connecté au système d'exploitation et qu'il
reconnaisse les périphériques de stockage.

Privilèges de
superutilisateur/administrateur
Vous devez disposer des privilèges de superutilisateur/administrateur pour installer
Configuration Service et exécuter la console Configuration Service.
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CHAPITRE 3

Installation de Configuration Service
sur des systèmes utilisant
l'environnement d'exploitation Solaris

Ce chapitre présente les procédures d'installation des consoles et agents
Configuration Service sur des systèmes utilisant l'environnement d'exploitation
Solaris. Les rubriques suivantes sont couvertes dans ce chapitre :

■ « Configuration système requise », page 7
■ « Avant l'installation de Configuration Service », page 8
■ « Installation du logiciel », page 9
■ « Utilisateurs et mots de passe », page 15
■ « Désinstallation de Configuration Service », page 17
■ « Restaurer une configuration », page 18

Configuration système requise
■ Netscape™ 4.0 ou supérieur – Pour afficher l'aide en ligne.

■ Interface réseau conforme au protocole TCP/IP pour la console – Chaque console
Configuration Service doit être dotée d'une interface réseau conforme au
protocole TCP/IP (par exemple, une carte réseau Ethernet ou Token Ring, ou une
ligne série avec un modem).

■ Il est conseillé pour l'affichage d'une console Configuration Service de régler le
moniteur à une résolution de 800 x 600 pixels avec 256 couleurs. Pour les autres
exigences relatives à la console, voir le tableau ci-dessous.
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■ Interface réseau conforme au protocole TCP/IP pour l'agent – Chaque agent
Configuration Service doit être doté d'une interface réseau conforme au protocole
TCP/IP et de l'ensemble des pilotes (inclus dans l'environnement d'exploitation).
Pour les autres exigences relatives à l'agent, voir le tableau ci-dessous.

Avant l'installation de Configuration
Service
Veuillez noter les procédures et options supplémentaires suivantes requises avant
l'installation de Configuration Service et de ses composants logiciels connexes.

■ Lisez attentivement les Sun StorEdge 3000 Family Release Notes relatives à votre baie.

■ Installez les mises à jour de l'environnement d'exploitation. Pour exécuter
Configuration Service sous l'environnement d'exploitation Solaris, vous devez
installer les correctifs les plus récents de l'environnement d'exploitation et de Java
recommandés par Sun pour les systèmes Solaris 8 et 9. Pour obtenir une liste des
correctifs Sun conseillés, reportez-vous à Sun StorEdge 3000 Family Release Notes
pour votre baie.

TABLEAU 3-1 Configuration système requise pour la console

Version de l'environnement
d'exploitation Solaris Mémoire Espace disque

Solaris 8 et 9 avec les
correctifs Sun conseillés.
Pour obtenir une liste des
correctifs Sun conseillés,
reportez-vous à Sun
StorEdge 3000 Family Release
Notes pour votre baie.)

64 Mo conseillés 16 Mo minimum

TABLEAU 3-2 Configuration système requise pour l'agent

Version de l'environnement
d'exploitation Solaris Mémoire Espace disque

Solaris 8 et 9 128 Mo minimum 1 Mo minimum
minimum
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■ Si l'environnement d'exploitation contient une console de gestion d'entreprise,
vous pouvez facultativement configurer les agents Configuration Service de
manière à ce qu'ils envoient des événements d'alarme à cette console en utilisant
le service SNMP. Le service SNMP fait partie de l'environnement d'exploitation.
Il est installé après la pile du protocole TCP/IP.

■ Si vous voulez que les serveurs Configuration Service sur le réseau envoient des
alarmes SNMP à la console de gestion d'entreprise, voir « Messagerie électronique
et protocole SNMP », page 221.

■ Facultatif. Pour installer et utiliser Sun StorEdge Diagnostic Reporter, un utilitaire
de Configuration Service qui envoie les événements du système de stockage à des
adresses de messagerie électronique spécifiées, voir Guide de l’utilisateur de Sun
StorEdge 3000 Family Diagnostic Reporter 1.2.

Remarque – Vous devez être un superutilisateur pour installer Configuration
Service et exécuter la console Configuration Service.

Installation du logiciel
Le logiciel Configuration Service comprend les composants suivants :

■ Agent Configuration Service

■ Console de Configuration Service

■ Diagnostic Reporter (utilitaire facultatif – pour tout renseignement sur l’installation et
l’utilisation, voir le Guide de l’utilisateur de Sun StorEdge 3000 Family Diagnostic
Reporter 1.2)

Packages d'installation de Configuration Service
Les packages d'installation Configuration Service sont contenus sur le CD Sun
StorEdge 300 Professional Storage Manager, et comprennent les fichiers suivants :

■ SUNWscsd – Agent Configuration Service
■ SUNWscsu – Console Configuration Service
■ SUNWscsa – Agent Diagnostic Reporter
■ SUNWscui – Diagnostic Reporter Config Tool (UI)
■ SUNWsccli – Command Line Interface (CLI)
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▼ Installation de l'agent et de la console
Configuration Service
Installez l'agent sur chaque serveur faisant partie de Configuration Service. Installez
la console sur l'ordinateur ou la station de travail à utiliser pour la gestion et la
maintenance du système de stockage.

Le package de la console de gestion Configuration Service, SUNWscsu, peut être
installé sur le serveur ou sur n'importe quel système client. Le package de l’agent
Configuration Service, SUNWscsd, doit être installé sur le serveur auquel est
connecté le périphérique de stockage.

Procédez comme suit pour installer l'agent, la console ou les deux. Vous devez
installer au moins un agent et une console pour que Configuration Service puisse
fonctionner.

Remarque – Assurez-vous que l'environnement d'exécution Java 1.2 (ou version
ultérieure) est installé sur la station de travail ou l'ordinateur sur lequel vous
installez Configuration Service.

Remarque – Pour la mise à jour de la console ou de l'agent Configuration Service,
vous devez désinstaller Configuration Service. Pour plus d'informations relatives à
la désinstallation de Configuration Service, voir « Désinstallation de Configuration
Service », page 17.

1. Insérez le CD Sun StorEdge 3000 Family Professional Storage Manager et tapez

2. Installez les packages de l'une des manières suivantes :

a. Pour installer uniquement l'agent, tapez

b. Pour installer uniquement la console, tapez

# cd /cdrom/cdrom0/product/solaris

# pkgadd -d SUNWscsd

# pkgadd -d SUNWscsu
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c. Pour installer tous les packages, tapez

d. Pour sélectionner les packages à installer depuis un menu, tapez

e. Pour installer uniquement les deux agents (Configuration Service et Diagnostic
Reporter), tapez

3. Répondez correctement à chaque invite de l'installation standard.

La plupart des invites d'installation sont des invites classiques pkgadd -d relatives
au choix des packages à installer et à la manière de traiter les scripts (avec des
privilèges de superutilisateur).

a. À l'invite Select, répondez correctement en fonction de la méthode d'installation.

Par exemple, si vous choisissez 2a ou 2b, saisissez 1 puis appuyez sur Entrée.

b. Si vous avez déjà installé l’agent, un message vous demandant si vous voulez
restaurer la configuration apparaît pendant la procédure d’installation.

Saisissez y pour restaurer la configuration. Si vous saisissez n, vous devez ré-
activer les serveurs de gestion.

Remarque – Les mots de passe de l’utilisateur sont supprimés quand
Configuration Service est désinstallé. Si vous avez déjà défini une configuration,
vous devez resaisir les mots de passe de ssmon, ssadmin et ssconfig comme
indiqué dans « Utilisateurs et mots de passe », page 15.

# pkgadd -d .all

# pkgadd -d .

# pkgadd -d . SUNWscsd SUNWscsa

Select package(s) you wish to process (or ‘all’ to process all
packages). (default:all) [?,??,q]: 1

The previous configuration was saved. User passwords must be
reentered. Do you want to restore the configuration [y,n,?,q]: y
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c. Si vous avez installé préalablement la console, un message vous demandant si
vous voulez restaurer la configuration apparaît pendant la procédure d’installation.

Appuyez sur y pour restaurer la configuration. Si vous saisissez n, vous devez
rajouter les informations sur le serveur.

d. Pour continuer l'installation, saisissez y puis appuyez sur Entrée.

Après avoir installé l’agent, le message suivant est affiché pour indiquer que
l’installation a été faite avec succès et que l’agent a été lancé.

Le programme d’installation contrôle que Java runtime 1.2 ou une version supérieure
est installé. S’il ne le trouve pas, une invite vous demande d’indiquer le chemin.
Si vous savez que l’environnement Java runtime 1.2.2, 1.3, ou 1.4 a été installé mais
que le programme d’installation ne le trouve pas, examinez le répertoire /usr pour
vérifier la présence d’un lien de Java vers une version plus récente que Java 1.1.
Pour des renseignements sur la création du lien, voir « Dépannage », page 235.

L'agent et la console Configuration Service sont installés dans le répertoire suivant :
/opt/SUNWsscs/sscsconsole

The previous configuration was saved. Do you want to restore the
configuration [y,n,?,q]: y

Do you want to continue with the installation [y,n,?] y

Configuring and starting Sun StorEdge(tm) Configuration Service
agent daemons :
       The configuration is complete.

Sun StorEdge(tm) Configuration Service agent server daemon
has started.

Sun StorEdge(tm) Configuration Service agent monitor daemon
has started.
Sun StorEdge(tm) Configuration Service agent startup is complete.

Installation of <SUNWscsd> was successful.
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4. Pour accéder à l’aide en ligne de Configuration Service, vous devez indiquer le
chemin au navigateur Internet (Netscape 4.0 ou version ultérieure).

a. Passez à /opt/SUNWsscs/sscsconsole et tapez

b. Tapez le chemin au navigateur internet.

Remarque – Vous pouvez configurer le nom du chemin du navigateur n’importe
quand ; toutesfois, si vous ne le faites pas, l’accès à l’aide en ligne n’est pas disponible.

5. Pour les baies de disques Sun StorEdge 3310 SCSI, modifiez
/kernel/drv/sd.conf si :

■ des adaptateurs de bus hôte d'un autre fabricant avec plusieurs lecteurs et
plusieurs unités logiques sont utilisés

■ des périphériques Fibre sont utilisés
■ toutes les unités logiques ont le même identificateur.

Ajouter les lignes nécessaires aux unités logiques (LUNs) en fonction de votre
configuration. Les unités logiques peuvent être numérotées de 0 à 31. En principe,
vous n'ajoutez pas plus de définitions d'unités logiques que celles que vous envisagez
d'avoir sous risque d'augmenter la durée de balayage nécessaire pour chaque bus
SCSI, qu'un périphérique de stockage soit connecté ou non. Pour tout renseignement
sur la modification de sd.conf file, reportez-vous au Manuel d'installation, d'utilisation
et d'entretien Sun StorEdge 3000 Family relatif à votre baie SCSI.

6. Exécutez une réinitialisation de la reconfiguration uniquement si le fichier
sd.conf a été modifié.

./config_sscon
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▼ Démarrage et arrêt de l'agent Configuration
Service
L’agent de Configuration Service peut être arrêté et démarré manuellement grâce au
script de commandes d’exécution dans /etc/init.d/ssagent.

1. Pour démarrer l’agent, tapez

Remarque – Pour démarrer l’agent, vous devez disposer des privilèges de
superutilisateur et utiliser l'interpréteur de commande Bourne.

Si vous utilisez la commande start sans avoir auparavant utilisé la commande
stop, le script redémarre tous les agents qui sont arrêtés. Si tous les agents sont
arrêtés (comme à la suite de l'utilisation de l'option stop), le script reconfigure
l'environnement d'exécution avant le redémarrage des agents.

2. Pour arrêter les agents, tapez

3. Pour déterminer si l’agent est activé, tapez

Les noms ssmon et ssserver sont alors affichés. Si vous avez activé la génération
de déroutements SNMP, le nom sstrapd apparaîtra également.

4. Si le système de stockage n'est pas affiché après le démarrage initial, arrêtez
l’agent et à l'invite de commandes, exécutez

5. Libellez les disques voulus puis redémarrez l’agent de Configuration Service.

# /etc/init.d/ssagent start

# /etc/init.d/ssagent stop

# ps -e | grep ss

# format
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Utilisateurs et mots de passe

Directives et niveaux de sécurité administrative
(Utilisateur)
Si vous exécutez l'application Configuration Service sur un système utilisant
l'environnement d'exploitation Solaris, les niveaux de sécurité d'administrateur sont
automatiquement créés pendant la procédure d'installation. Vous n'avez qu'à définir les
mots de passe et affecter les utilisateurs au niveau de permission voulu.

Les fonctions administratives de Configuration Service exigent une ouverture de
session et la saisie de mots de passe d'accès pour éviter l'éventualité qu'un
administrateur ne réattribue ou n'élimine des ressources de stockage appartenant à
d'autres clients et hôtes sans autorisation.

Vous attribuez des mots de passe individuels pour les trois niveaux de sécurité du
programme Configuration Service. Pour ce faire, vous devez configurer trois
utilisateurs sur les agents ayant des périphériques de stockage gérés par
Configuration Service. Ces trois utilisateurs sont automatiquement ajoutés pendant
l'installation de l'agent Configuration Service.

Les niveaux de sécurité Configuration Service doivent avoir exactement les noms
suivants :

■ ssmon

Représente le niveau de surveillance du logiciel.

■ ssadmin

Représente le niveau d'administration du logiciel et fournit l'accès aux fonctions
de reconstruction, de vérification de la parité et de planification de la vérification
de parité, ainsi que de surveillance.

■ ssconfig

Représente le niveau de configuration du logiciel qui donne à l'installateur un
accès direct aux fonctions de configuration et à tous les autres aspects connexes
du programme.

Ces noms de connexion sont obligatoires pour les trois niveaux de sécurité. Après
l'installation, vous devez attribuer un mot de passe à chaque nom de sécurité.
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ssmon, ssadmin et ssconfig sont les ouvertures de session qui correspondent
uniquement aux niveaux de sécurité dans Configuration Service. Pour les
environnements d’exploitation UNIX (Solaris/Linux OEs), l’interpréteur de
commande par défaut pour ces comptes est affecté à /bin/false de manière à
éviter que les identitités de l’utilisateur ne soient utilisées lors d’ouvertures de
session interactives.

Configuration Service peut être configuré pour que les activités de surveillance
n'obligent pas les utilisateurs à taper le mot de passe ssmon. Pour ce faire,
sélectionnez l'option Auto Discovery lorsque les serveurs sont ajoutés sur la liste
Managed Servers à la console Configuration Service. Vous pouvez configurer ces trois
ouvertures de session et mots de passe localement sur chaque serveur. (Les comptes
peuvent avoir des mots de passe différents sur chaque serveur, le cas échéant).

Une fois que ces trois ouvertures de session ont été configurées sur les agents à
gérer, l'administrateur du système fournit habituellement l'accès aux utilisateurs de
Configuration Service en attribuant aux employés des mots de passe appropriés,
suivant le niveau de sécurité requis pour accomplir leurs tâches. Par exemple, toute
personne ayant les privilèges d'administration sur un serveur particulier se verrait
affecter le mot de passe établi pour l'utilisateur ssadmin.

Remarque – Pour ajouter des serveurs à la liste Managed Servers, voir « Ajout de
serveurs », page 43.

▼ Création des mots de passe et des permissions
Créez un mot de passe pour un nouvel utilisateur en tapant

# passwd user-name
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Les administrateurs peuvent aussi vouloir changer les permissions de groupe qui
sont définies dans le fichier svrlist.dat placé dans le répertoire
/opt/SUNWsscs/sscsconsole pendant l'installation.

La console Configuration Service est un utilitaire basé sur Java, qui, par conséquent,
ne peut pas fournir les outils de gestion des permissions ou des appartenances des
fichiers que Configuration Service crée. Le fichier svrlist.dat peut se lire dans un
programme de traitement de texte en format ASCII. Il contient le mot de passe codé
pour l'utilisateur ssmon et peut être décodé.

Remarque – Ne changez ni les permissions ni l'appartenance des groupes dans le
fichier svrlist.dat après avoir ajouté tous les agents à surveiller.

Désinstallation de Configuration Service
Pour la mise à jour de la console ou de l'agent Configuration Service, vous devez
désinstaller Configuration Service. Remarquez que certains fichiers ne sont pas
supprimés car ils ont été créés après l'installation et sont toujours valides pour le
nouvel environnement.

▼ Désinstallation de Configuration Service
Utilisez le nom de la commande pkgrm suivi du package Configuration Service que
vous désirez désinstaller, SUNWscsu (console) ou SUNWscsd (agent).

# pkgrm SUNWscsu

# pkgrm SUNWscsd
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Restaurer une configuration
Si vous réinstallez l’agent ou la console, un message vous demandant si vous voulez
restaurer la configuration apparaît pendant laprocédure d’installation. Si vous
choisissez de restaurer les configurations, les informations sont extraites des fichiers
suivants :

■ /var/opt/SUNWsscs/sscsagt.cfg.tar – Configuration Service Agent

■ /var/opt/SUNWsscs/sscscon.cfg.tar – Configuration Service Console

Remarque – Si vous supprimez définitivement Configuration Service, il est
recommandé d’éliminer manuellement ces fichiers. Si vous décidez toutefois de
réinstaller Configuration Service, vous ne pourrez pas restaurer les configurations de
l’agent et de la console.
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CHAPITRE 4

Installation de Configuration
Service sur un système Microsoft
Windows NT ou 2000

Ce chapitre détaille la configuration système requise et les procédures d'installation
pour les consoles et les agents Configuration Service sur des systèmes Microsoft
Windows NT ou 2000. Les rubriques suivantes sont couvertes dans ce chapitre :

■ « Configuration système requise », page 19
■ « Préliminaires d'installation de Configuration Service », page 20
■ « Installation du logiciel », page 21
■ « Utilisateurs et mots de passe », page 23
■ « Désinstallation de Configuration Service », page 26

Configuration système requise
■ Netscape 4.0 (ou version ultérieure) ou Microsoft Internet Explorer 4.0 (ou version

ultérieure) – Pour afficher l'aide en ligne.

■ Interface réseau conforme au protocole TCP/IP pour la console – Chaque console
Configuration Service doit être dotée d'une interface réseau conforme au
protocole TCP/IP (par exemple, une carte réseau Ethernet ou Token Ring, ou une
ligne série avec un modem). Pour les autres exigences relatives à la console, voir
le tableau ci-dessous.
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■ Interface réseau conforme au protocole TCP/IP pour l'agent – Chaque agent
Configuration Service doit être doté d'une interface réseau conforme au protocole
TCP/IP et de l'ensemble des pilotes (inclus dans le système d'exploitation).
Pour les autres exigences relatives à l'agent, voir le tableau ci-dessous.

Préliminaires d'installation de
Configuration Service
Veuillez noter les procédures et options supplémentaires suivantes requises avant
l'installation de Configuration Service et de ses composants logiciels connexes.

■ Lisez attentivement les Sun StorEdge 3000 Family Release Notes relatives à votre baie.

■ Si votre environnement d'exploitation contient une console de gestion
d'entreprise, vous pouvez facultativement configurer les agents Configuration
Service de manière à ce qu'ils envoient les événements d'alarme à cette console
via le service SNMP. Le service SNMP fait partie de l'environnement
d'exploitation. Il est installé après la pile du protocole TCP/IP.

■ Si vous voulez que les serveurs Configuration Service sur le réseau envoient des
alarmes SNMP à la console de gestion d'entreprise, voir « Messagerie électronique
et protocole SNMP », page 221.

TABLEAU 4-1 Configuration système requise pour la console

Version du système
d'exploitation Mémoire Espace disque

Microsoft Windows NT 4.0
(Service Pack 3 ou ultérieur)
Microsoft Windows 2000

32 Mo minimum
64 Mo conseillés

20 Mo minimum
40 Mo conseillés

TABLEAU 4-2 Configuration système requise pour l'agent

Version du système
d'exploitation Mémoire

Espace
disque

Microsoft Windows NT 4.0
(Service Pack 3, 4, 5 ou 6)
Microsoft Windows 2000

32 Mo minimum, 64 Mo ou plus recommandés.
La configuration requise est déterminée par
d'autres programmes aussi importants, tels que
ceux faisant intervenir des bases de données.

2 Mo
minimum
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■ Facultatif. Pour installer et utiliser Sun StorEdge Diagnostic Reporter, un utilitaire
de Configuration Service qui envoie les événements du système de stockage à des
adresses de messagerie électronique spécifiées, voir le Guide de l’utilisateur Sun
StorEdge 3000 Family Diagnostic Reporter.

Remarque – Vous devez être un administrateur pour installer Configuration
Service et exécuter la console Configuration Service.

Installation du logiciel
Le logiciel Configuration Service comprend les composants suivants.

■ Agent Configuration Service

■ Console de Configuration Service

■ Diagnostic Reporter (utilitaire facultatif – pour de plus amples informations sur
l’installation et l’utilisation, consultez le Guide de l’utilisateur de Sun StorEdge 3000
Family Diagnostic Reporter 1.2)

Installez l'agent sur chaque serveur dont le stockage sera géré par Configuration
Service. Installez la console sur l'ordinateur ou la station de travail à utiliser pour la
gestion et la maintenance du système de stockage.

Packages d'installation de Configuration Service
Le package d'installation Configuration Service, setup.exe, est contenu sur le CD Sun
StorEdge 3000 Family Professional Storage Manager, et comprend les fichiers suivants :

■ Sun StorEdge Configuration Service Agent

■ Sun StorEdge Configuration Service Console

■ Sun StorEdge Diagnostic Reporter

■ Sun StorEdge Command Line Interface
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▼ Installation de l'agent et de la console
Configuration Service
Vous devez installer l'agent Configuration Service sur chaque serveur Microsoft
Windows 2000 ou NT dont le stockage doit être géré par Configuration Service.

Remarque – Assurez-vous que la version Java Runtime Environment (JRE) 1.2 ou
la version supérieure est installée sur l'ordinateur ou la station de travail où vous
installez la console Configuration Service.

1. Pour un fonctionnement optimal de l'utilitaire d'installation, fermez toutes les
applications Microsoft Windows ouvertes.

2. Insérez le CD de Sun StorEdge 3000 Family Professional Storage Manager et
passez au répertoire \product\windows.

3. Double-cliquez sur setup.exe et sélectionnez le composant logiciel à installer,
SUNWsscs Agent ou SUNWsscs Console.

4. Dans la fenêtre Choose Destination Location, installez dans le dossier par défaut
et cliquez sur Next. L’agent est installé dans C:\Program Files\Sun\ssagent ;
la console est installée dans C:\Program Files\Sun\sscs.

Pour procéder à l'installation dans un autre dossier, cliquez sur Browse, sélectionnez
un autre dossier, puis cliquez sur Next.

Une fois l’installation terminée, les agents démarrent automatiquement.

▼ Démarrage et arrêt de l'agent Configuration
Service

Serveurs Microsoft Windows NT

Pour démarrer l'agent Configuration Service sur le serveur, vous devez redémarrer le
serveur ou démarrer les trois services Configuration Service suivants : SUNWscsd Startup,
SUNWscsd Server, et SUNWscsd Monitor sous Settings → Control Panel → Services.

Pour arrêter les agents Configuration Service, passez à Settings → Control Panel →
Services, sélectionnez l'agent à arrêter, puis cliquez sur Stop.
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Serveurs Microsoft Windows 2000

1. Sélectionnez Start → Administrative Services → Computer Management.

2. Cliquez sur Services & Applications.

3. Cliquez avec le bouton droit de la souris sur le service (SUNWscsd Monitor,
SUNWscsd Server, SUNWscsd Startup) à arrêter ou démarrer.

Vous pouvez également sélectionner Start → Settings → Control Panel → Admin
Tools → Computer Management.

Utilisateurs et mots de passe

Directives et niveaux de sécurité administrative
(Utilisateur)
Les fonctions administratives de Configuration Service exigent une ouverture de
session et la saisie de mots de passe d'accès pour éviter l'éventualité qu'un
administrateur ne réattribue ou n'élimine des ressources de stockage appartenant à
d'autres clients et hôtes sans autorisation. Vous attribuez des mots de passe
individuels pour les trois niveaux de sécurité du programme Configuration Service.
Pour ce faire, vous devez configurer trois utilisateurs sur les agents ayant des
périphériques de stockage gérés par Configuration Service.

Les niveaux de sécurité Configuration Service doivent avoir exactement les noms
suivants :

■ ssmon

Représente le niveau de surveillance du logiciel.

■ ssadmin

Représente le niveau d'administration du logiciel et fournit l'accès aux fonctions
de reconstruction, de vérification de la parité et de planification de la vérification
de parité, ainsi que de surveillance.

■ ssconfig

Représente le niveau de configuration du logiciel qui donne à l'installateur un
accès direct aux fonctions de configuration et à tous les autres aspects connexes
du programme.
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Ces noms sont obligatoires pour les trois niveaux de sécurité. Après l'installation,
vous devez attribuer un mot de passe à chaque nom de sécurité.

ssmon, ssadmin et ssconfig sont les ouvertures de session qui correspondent
uniquement aux niveaux de sécurité dans Configuration Service.

Configuration Service peut être configuré pour que les activités de surveillance
n'obligent pas les utilisateurs à saisir le mot de passe ssmon. Pour ce faire,
sélectionnez l’option Auto Discovery lorsque les serveurs sont ajoutés sur la liste
Managed Servers à la console Configuration Service. Vous pouvez configurer ces
trois ouvertures de session et mots de passe localement sur chaque serveur.
(Les comptes peuvent avoir des mots de passe différents sur chaque serveur).

Une fois que ces trois ouvertures de session ont été configurées sur les agents à
gérer, l’administrateur du système fournit habituellement l’accès aux utilisateurs à
Configuration Service en attribuant aux employés des mots de passe appropriés,
suivant le niveau de sécurité exigé pour accomplir des tâches. Par exemple, toute
personne ayant les privilèges d'administration sur un serveur particulier se verrait
affecter le mot de passe établi pour l'utilisateur ssadmin.

Remarque – Pour ajouter des serveurs à la liste Managed Servers, voir « Ajout de
serveurs », page 43.

Mots de passe globaux sur plusieurs serveurs
Si vous disposez d'un réseau important et ne voulez pas définir des ouvertures de
session individuelles, et s'il est admissible d'utiliser les mêmes mots de passe sur
plusieurs serveurs, vous pouvez définir les trois ouvertures de session sur un
serveur de domaine sous Microsoft Windows. Tous les autres serveurs du domaine
sous Microsoft Windows auront alors accès aux trois ouvertures de sessions avec les
mots de passe définis.
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▼ Création d'utilisateurs sous Microsoft
Windows NT

1. Ajoutez les utilisateurs à l'aide du programme NT User Manager.

2. Sélectionnez Policies, puis User Rights.

3. Sélectionnez Show Advanced User Rights.

4. Conférez à l'administrateur des utilisateurs NT l'autorisation d'agir (Rights to Act)
en tant qu'élément du système d'exploitation.

5. Sous User Properties, désélectionnez User Must Change Password at Next Login.

6. Sous User Properties, sélectionnez User Cannot Change Password et Password
Never Expires.

7. Si vous envisagez de définir les noms d'utilisateurs sur un serveur de domaine, de
telle sorte qu'il ne soit pas nécessaire d'effectuer les définitions sur plusieurs serveurs,
veillez à ce que les serveurs que vous désirez gérer appartiennent au domaine dans
lequel vous avez établi le compte utilisateur de Configuration Service.

Pour des renseignements supplémentaires, veuillez vous reporter à la
documentation Microsoft Windows NT.

▼ Création d’utilisateurs sous Microsoft
Windows 2000

1. Sous Settings → Control Panel → Administrative Tools →Computer Management
→ System Tools → Local Users and Groups, sélectionnez Users.

2. Avec le bouton droit de la souris, cliquez sur le dossier Users et sélectionnez
New User pour ajouter les trois utilisateurs (ssmon, ssconfig et ssadmin).

3. Ajoutez un des utilisateurs sous User name. Vous pouvez également saisir une
description sous Description.

4. Saisissez un mot de passe et, le cas échéant, sélectionnez les options User Cannot
Change Password et Password Never Expires.
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Désinstallation de Configuration Service
Utilisez l'utilitaire Windows Add/Remove Programs pour supprimer Configuration
Service d'une console Microsoft Windows.

▼ Désinstallation de Configuration Service
1. Cliquez sur Start → Settings → Control Panel → Add/Remove Programs.

2. Sélectionnez Configuration Service Agent, puis Add/Remove. Répondez aux
invites du système.

3. Sélectionnez Configuration Service Console, puis Add/Remove. Répondez aux
invites du système.
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CHAPITRE 5

Installation de Configuration Service
sur des systèmes utilisant
l'environnement d'exploitation Linux

Ce chapitre présente les procédures d'installation des consoles et agents
Configuration Service sur des systèmes utilisant l'environnement d'exploitation Sun
Linux ou Red Hat Linux. Les rubriques suivantes sont couvertes dans ce chapitre :

■ « Configuration système requise », page 27
■ « Préliminaires d'installation de Configuration Service », page 28
■ « Installation du logiciel », page 29
■ « Utilisateurs et mots de passe », page 32
■ « Désinstallation de Configuration Service », page 35

Configuration système requise
■ Netscape™ 4.0 ou version ultérieure – Pour visualiser l’aide en ligne.

■ Interface réseau conforme au protocole TCP/IP pour la console – Chaque console
Configuration Service doit être dotée d'une interface réseau conforme au
protocole TCP/IP (par exemple, une carte réseau Ethernet ou Token Ring, ou une
ligne série avec un modem).

■ Il est conseillé pour l'affichage d'une console Configuration Service de régler le
moniteur à une résolution de 800 x 600 pixels avec 256 couleurs. Pour les autres
exigences relatives à la console, voir le tableau ci-dessous.
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■ Interface réseau conforme au protocole TCP/IP pour l'agent – Chaque agent
Configuration Service doit être doté d'une interface réseau conforme au protocole
TCP/IP et de l'ensemble des pilotes (compris avec l'environnement d'exploitation).
Pour les autres exigences relatives à l'agent, voir le tableau ci-dessous.

Préliminaires d'installation de
Configuration Service
Veuillez noter les procédures et options supplémentaires suivantes requises avant
l'installation de Configuration Service et de ses composants logiciels connexes.

■ Lisez attentivement les Sun StorEdge 3000 Family Release Notes relatives à votre baie.

■ Si l'environnement d'exploitation contient une console de gestion d'entreprise, vous
pouvez facultativement configurer les agents Configuration Service de manière à ce
qu'ils envoient des événements d'alarme à cette console en utilisant le service SNMP.

■ Si vous voulez que les serveurs Configuration Service sur le réseau envoient des
alarmes SNMP à la console de gestion d'entreprise, voir « Messagerie électronique
et protocole SNMP », page 221.

■ Facultatif. Pour installer et utiliser Sun StorEdge Diagnostic Reporter, un utilitaire
de Configuration Service qui envoie les événements du système de stockage à des
adresses de messagerie électronique spécifiées, voir le Guide de l’utilisateur de Sun
StorEdge 3000 Family Diagnostic Reporter 1.2.

Remarque – Vous devez être un superutilisateur pour installer Configuration
Service et exécuter la console Configuration Service.

TABLEAU 5-1 Configuration système requise pour la console

Version de Linux Mémoire Espace disque

Sun Linux 5.0
Red Hat® Linux 7.2 et 7.3

256 Mo minimum 10 Mo

TABLEAU 5-2 Configuration système requise pour l'agent

Version de Linux Mémoire Espace disque

Solaris 8 et 9 128 Mo minimum 1 Mo
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Installation du logiciel
Le logiciel Configuration Service comprend les composants suivants :

■ Agent Configuration Service

■ Console de Configuration Service

■ Diagnostic Reporter (utilitaire facultatif – pour tout renseignement
supplémentaires sur l’installation et l’utilisation, consultez le Guide de l’utilisateur
de Sun StorEdge 3000 Family Diagnostic Reporter 1.2)

Packages d'installation de Configuration Service
Les packages d'installation Configuration Service sont contenus sur le CD Sun StorEdge
300 Family Professional Storage Manager, et comprennent les fichiers suivants :

■ SUNWscsu.exe – Console Configuration Service
■ SUNWscsd.exe – Agent Configuration Service
■ SUNWscsa.rpm Agent Diagnostic Reporter
■ SUNWscui – Diagnostic Reporter Config Tool (UI)
■ SUNWsccli.rpm – Interface de ligne de commande (CLI)

▼ Installation de l'agent et de la console
Configuration Service
Installez l'agent sur chaque serveur faisant partie de Configuration Service. Installez
la console sur l'ordinateur ou la station de travail à utiliser pour la gestion et la
maintenance du système de stockage.

Le package de la console de gestion Configuration Service, SUNWscsu.rpm, peut
être installé sur le serveur ou sur n'importe quel système client. Le package de
l’agent Configuration Service, SUNWscsd.rpm, doit être installé sur le serveur
auquel est connecté le périphérique de stockage.

Procédez comme suit pour installer l'agent, la console ou les deux. Vous devez installer
au moins un agent et une console pour que Configuration Service puisse fonctionner.

Remarque – Assurez-vous que l'environnement d'exécution Java 1.2 (ou version
ultérieure) est installé sur la station de travail ou l'ordinateur sur lequel vous
installez Configuration Service.
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1. Assurez-vous que l'environnement d'exécution Java 1.2 (ou version ultérieure) est
installé sur la station de travail ou l'ordinateur sur lequel vous installez
Configuration Service. Si ce n’est pas le cas, installez-le.

2. Si le CD ROM n’est pas encore installé dans votre système de fichiers, installez-le.

3. Insérez le CD Sun StorEdge 3000 Family Professional Storage Manager et tapez

4. Installez les packages de l'une des manières suivantes :

a. Pour installer uniquement l'agent, tapez

b. Pour installer uniquement la console, tapez

5. Pour accéder à l’aide en ligne de Configuration Service, il faut qu’un navigateur
Internet soit installé dans le système sur lequel vous installez la console. Si aucun
navigateur Internet n’est trouvé, un message apparaît vous demandant d’indiquer
le chemin du navigateur Internet (Netscape 4.0 ou version ultérieure).

a. Passez à /opt/SUNWsscs/sscsconsole et tapez

b. Type the absolute path to the web browser.

# cd mount /dev/cdrom /mnt/cdrom

# cd /mnt/cdrom/product/linux

# rpm -ivh SUNWscsd.rpm

# rpm -ivh SUNWscsu.rpm

./config_sscon
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Remarque – Vous pouvez configurer le chemin du navigateur n’importe quand ;
toutefois, si vous ne le faites pas, l’accès à l’aide en ligne n’est pas disponible.

Une fois l’agent installé, le message suivant apparaît vous indiquant que
l’installation des composants a été effectuée avec succès et que l’agent est lancé.

Une fois l’agent installé, le message suivant apparaît vous indiquant que
l’installation des composants a été faite avec succès et que l’agent est lancé.

L'agent et la console Configuration Service sont installés dans le répertoire suivant :
/opt/SUNWsscs/sscsconsole.

▼ Démarrage et arrêt de l'agent Configuration
Service
L’agent Configuration Service peut être arrêté et démarré manuellement grâce au
script de commandes d’exécution dans /etc/init.d/ssagent.

1. Pour démarrer l’agent, tapez

ou

# rpm -ivh SUNWscsd.rpm Preparing...
########################################### [100%] 1:SUNWscsd
########################################### [100%] add user ssmon
add user ssadmin add user ssconfig Configuring and starting Sun
StorEdge(tm) Configuration Service daemons[ OK ]
Starting Sun StorEdge(tm) Configuration Service agent daemon[ OK ]
Starting Sun StorEdge(tm) Configuration Service agent monitor
daemon[ OK ]

# rpm -ivh SUNWscsu.rpm Preparing...
########################################### [100%] 1:SUNWscsu
########################################### [100%]
Installation completed successfully !

# /etc/init.d/ssagent start

# service ssagent start
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Remarque – Pour démarrer l’agent, vous devez disposer des privilèges de
superutilisateur.

Si vous utilisez la commande start sans avoir auparavant utilisé la commande
stop le script redémarre tous les agents qui sont arrêtés. Si tous les agents sont
arrêtés (comme à la suite de l'utilisation de l'option stop), le script reconfigure
l'environnement d'exécution avant le redémarrage des agents.

2. Pour arrêter l’agent, tapez

3. Pour déterminer si l’agent est activé, tapez

ou

Les noms ssmon et ssserver sont alors affichés. Si vous avez activé la génération
de déroutements SNMP, le nom sstrapd apparaîtra également.

Utilisateurs et mots de passe

Directives et niveaux de sécurité administrative
(Utilisateur)
Si vous exécutez l'application Configuration Service sur un système utilisant
l'environnement d'exploitation Solaris, les niveaux de sécurité d'administrateur sont
automatiquement créés pendant la procédure d'installation. Vous n'avez qu'à définir les
mots de passe et affecter les utilisateurs au niveau de permission voulu.

Les fonctions administratives de Configuration Service exigent une ouverture de
session et la saisie de mots de passe d'accès pour éviter l'éventualité qu'un
administrateur ne réattribue ou n'élimine des ressources de stockage appartenant à
d'autres clients et hôtes sans autorisation.

# /etc/init.d/ssagent stop

# ps -e | grep ss

# service ssagent status
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Vous attribuez des mots de passe individuels pour les trois niveaux de sécurité du
programme Configuration Service. Pour ce faire, vous devez configurer trois
utilisateurs sur les agents ayant des périphériques de stockage gérés par
Configuration Service. Ces trois utilisateurs sont automatiquement ajoutés pendant
l'installation de l'agent Configuration Service.

Les niveaux de sécurité Configuration Service doivent avoir exactement les noms
suivants :

■ ssmon

Représente le niveau de surveillance du logiciel.

■ ssadmin

Représente le niveau d'administration du logiciel et fournit l'accès aux fonctions
de reconstruction, de vérification de la parité et de planification de la vérification
de parité, ainsi que de surveillance.

■ ssconfig

Représente le niveau de configuration du logiciel qui donne à l'installateur un
accès direct aux fonctions de configuration et à tous les autres aspects connexes
du programme.

Ces noms sont obligatoires pour les trois niveaux de sécurité. Après l'installation,
vous devez attribuer un mot de passe à chaque nom de sécurité.

ssmon, ssadmin et ssconfig sont les ouvertures de session qui correspondent
uniquement aux niveaux de sécurité dans Configuration Service. Pour les
environnements d’exploitation UNIX (Solaris/Linux OEs), l’interpréteur de commande
par défaut pour ces comptes est affecté à /bin/false de manière à éviter que les
identitités de l’utilisateur ne soient utilisées lors d’ouvertures de session interactives.

Configuration Service peut être configuré pour que les activités de surveillance
n'obligent pas les utilisateurs à taper le mot de passe ssmon. Pour ce faire,
sélectionnez l'option Auto Discovery lorsque les serveurs sont ajoutés à la liste
Managed Servers à la console Configuration Service. Vous pouvez configurer ces trois
ouvertures de session et mots de passe localement sur chaque serveur. (Les comptes
peuvent avoir des mots de passe différents sur chaque serveur, le cas échéant).

Une fois que ces trois ouvertures de session ont été configurées sur les agents à
gérer, l'administrateur du système fournit habituellement l'accès aux utilisateurs de
Configuration Service en attribuant aux employés des mots de passe appropriés,
suivant le niveau de sécurité requis pour accomplir leurs tâches. Par exemple, toute
personne ayant les privilèges d'administration sur un serveur particulier se verrait
affecter le mot de passe établi pour l'utilisateur ssadmin.

Remarque – Pour ajouter des serveurs à la liste Managed Servers, voir « Ajout de
serveurs », page 43.
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▼ Création des mots de passe et des permissions
Créez un mot de passe pour un nouvel utilisateur en tapant

Les administrateurs peuvent aussi vouloir changer les permissions de groupe qui
sont définies dans le fichier svrlist.dat placé dans le répertoire
/opt/SUNWsscs/sscsconsole pendant l'installation.

La console Configuration Service est un utilitaire basé sur Java, qui, par conséquent,
ne peut pas fournir les outils de gestion des permissions ou des appartenances des
fichiers que Configuration Service crée. Le fichier svrlist.dat peut se lire dans un
programme de traitement de texte en format ASCII. Il contient le mot de passe codé
pour l'utilisateur ssmon et peut être décodé.

Remarque – Ne changez ni les permissions ni l'appartenance des groupes dans le
fichier svrlist.dat après avoir ajouté tous les agents à surveiller.

# passwd user-name
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Désinstallation de Configuration Service
Pour la mise à jour de la console ou de l'agent Configuration Service, vous devez
désinstaller Configuration Service. Remarquez que certains fichiers ne sont pas
supprimés car ils ont été créés après l'installation et sont toujours valides pour le
nouvel environnement.

▼ Désinstallation de Configuration Service
Utilisez le nom de la commande rpm -e suivi du package Configuration Service
que vous désirez désinstaller, SUNWscsu.rpm (console) ou SUNWscsd.rpm (agent).

# rpm -e SUNWscsu.rpm

# rpm -e SUNWscsd.rpm
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CHAPITRE 6

Configuration de Configuration
Service

Ce chapitre décrit les procédures type de configuration de Configuration Service.
Les procédures suivantes sont couvertes dans ce chapitre :

■ « Démarrage de Configuration Service », page 38
■ « Ajout de serveurs », page 43
■ « Connexion et déconnexion », page 49
■ « Sélection d'un serveur pour la gestion d'un contrôleur », page 50
■ « Configuration des paramètres de l'agent (optionnelle) », page 54
■ « Vérification des configurations de stockage », page 57
■ « Enregistrement de la configuration du lecteur logique », page 59
■ « Création des partitions sur un serveur », page 60
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Lancement de Configuration Service

Remarque – Vous devez être un superutilisateur/administrateur pour exécuter la
console Configuration Service.

Remarque – Dans la mesure où la console Configuration Service ne reçoit pas
d'alertes d'événement à moins qu'elle ne soit activée, après avoir configuré la baie de
disques, laissez toujours l’exécution de Configuration Service en mode réduit sur le
poste de travail Configuration Service. L'exécution du programme de la console
Configuration Service ne doit pas forcément se passer à l'avant-plan. Vous pouvez
utiliser Diagnostic Reporter, un utilitaire complémentaire de Configuration Service qui
est exécuté à l'arrière-plan et qui envoie des messages des hôtes et de la baie aux
adresses email indiquées. Pour plus de détails, reportez-vous au Guide de l’utilisateur
de Sun StorEdge 3000 Family Diagnostic Reporter 1.2. Une autre méthode pour la
réception des alertes d'événements est décrite dans « Envoi de déroutements SNMP
sans Configuration Service », page 233.

Remarque – Pour que Configuration Service puisse reconnaître et prendre en
charge une baie de disques, toutes les cartes de l'adaptateur de bus hôte (HBA)
doivent être connectées au contrôleur principal.

▼ Démarrage de Configuration Service

Environnement d'exploitation Solaris/Linux

À l'invite de commandes, tapez

Système d'exploitation Microsoft Windows NT/2000

Sélectionnez Start → Programs → Sun StorEdge 3000 Family → Configuration Service.

# ssconsole
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Fenêtre principale avant et après la
première utilisation
Lorsque Configuration Service s'initialise pour la première fois, la fenêtre principale
Configuration Service est vierge. La fenêtre Add Server s'affiche vous permettant
d'ajouter des serveurs à la liste Managed Servers de la console Configuration Service
utilisée. Pour plus d'informations relatives à l'ajout de serveurs, voir « Ajout de
serveurs », page 43.

Chaque fois que vous lancez Configuration Service excepté la première fois et après
avoir sélectionné Managed Servers, la fenêtre principale Configuration Service
affiche des icônes de serveur dans la liste Managed Servers. Cliquez sur OK ou
Cancel pour continuer.

Après avoir configuré une nouvelle baie et initialisé le poste de travail, le
programme risque de ne pas détecter la baie tant que les lecteurs logiques ne sont
pas étiquetés puisque Configuration Service se sert des lecteurs natifs de Sun.

Bloc de la console en cours d’utilisation
Pour les systèmes fonctionnant sous l'environnement d'exploitation Solaris ou Linux,
si la console Configuration Service se bloque en cours d’utilisation, vous pouvez
arrêter Configuration Service, puis fermer et rouvrir la fenêtre sans affecter pour
autant l’agent Configuration Service.

▼ Arrêt de Configuration Service

1. À l'invite de commandes, tapez

2. Exécutez à nouveau le programme.

La fenêtre s'affiche à nouveau sans affecter l'agent Configuration Service.

# ssconsole stop
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Menu, barre d'outils et onglets
Il est conseillé de passer en revue la fenêtre principale Configuration Service, qui
comprend une barre de menus, des onglets et une barre d'outils permettant
d'accéder aux fonctions clés.

Barre de menus
La figure suivante indique les options du menu principal.

Barre d'outils
La barre d'outils située sous la barre de menus est dotée d'icônes qui vous
permettent d'accéder rapidement aux fonctions les plus couramment utilisées.
Sélectionnez une icône pour en activer la fonction. Les icônes de la barre d'outils
peuvent apparaître activées ou désactivées (grisées), et ce en fonction des ressources
disponibles dans la fenêtre principale Configuration Service.

Login
Logout

Server List Setup

Save Report

Exit

View Report

View Group
View Server
View Controller
View Logical Drive
View Physical Drive
View Enclosure 
View FRU

Event Log

Configure Host/WWN (Fibre Channel only) 
LUN Filter Properties (Fibre Channel only)

Save Configuration
Load Configuration

Standard Configure
Custom Configure

Controller Assignment
Controller Maintenance

Download FW for Devices

View Peripheral Device

Rebuild

Parity Check
Schedule Parity Check

Contents

About sscsConsole

Help

Array Admin Progress

Agent Options Management
Display HDD under LD
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Icône Description

Server List Setup. Permet d'ajouter des serveurs à la console
Configuration Service, de modifier les informations relatives
aux serveurs ou d'indiquer qu'un serveur disponible est géré.

Event Log. Cette option permet d'afficher les événements tels
que les changements d'état de périphérique de stockage, les
changements d'état de matériel ou toute autre notification
opérationnelle.

Save Event Log. Cette option affiche la boîte de dialogue Save
Event Log File, qui vous permet de sauvegarder le fichier
journal Event Log sans devoir ouvrir la fenêtre Event Log.

Delete Event Log. Cette option supprime manuellement le
contenu du fichier eventlog.txt. (Configuration Service
accumule jusqu’à 10,000 événements, après quoi le journal
Event Log est automatiquement réduit aux plus récents 500
événements.)

Save Report. Cette option permet de créer un fichier texte
contenant les données Configuration Service sur chacun des
composants de stockage sur les serveurs sélectionnés à la date
actuelle.

Standard Configuration. Cette option permet de créer un ou
plusieurs lecteurs logiques avec un niveau RAID sur le
contrôleur de baie sélectionné. Utilisez-la quand vous désirez
une configuration prédéfinie où Configuration Service effectue
la configuration automatique du stockage automatically
configures storage.

Custom Configuration. Cette option vous permet de choisir
parmi plusieurs types de configurations ou reconfigurations
des lecteurs ou des volumes logiques tout en modifiant les
niveaux RAID sur le contrôleur de baie sélectionné. Utilisez-la
quand vous désirez définir manuellement une configuration y
compris le paramétrage ou la modification des identificateurs et
des paramètres du contrôleur ou encore la modification
d’ensembles RAID et des lecteurs en attente.
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Onglets
Les onglets, situés sous la barre d'outils, vous permettent de passer rapidement à
d'autres affichages de Configuration Service.

Lecteurs de disques physiques (durs)
Quand la baie est complètement configurée, la fenêtre principale Configuration
Service affiche plusieurs éléments. Les lecteurs physiques qui constituent les lecteurs
logiques sont affichés par défaut ; toutesfois, pour naviguer plus aisément dans la
fenêtre principale Configuration Service, choisissez de ne pas afficher les lecteurs
physiques (durs) en désélectionnant la case View → Display HDD under LD.

Navigation dans Configuration Service
Configuration Service utilise les opérations standard au clavier et de navigation de
Java.

Onglet Description

Cliquez sur cet onglet pour passer à la fenêtre principale de
Configuration Service.

Cliquez sur cet onglet pour passer à Resource Allocation View.
(Réservé pour utilisation ultérieure).

Cliquez sur cet onglet pour passer à LUN Filter View.
(uniquement Fibre Channel.)
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▼ Ajout de serveurs
Pour pouvoir surveiller et configurer un serveur, vous devez l'ajouter à la liste
Managed Servers via Server List Setup.

1. Lancez Configuration Service (le cas échéant).

2. Sélectionnez File → Server List Setup.

La fenêtre Server List Setup s'affiche.

3. Organisez les serveurs par groupe :

a. Cliquez sur Groups dans la fenêtre Server List Setup.

La fenêtre Group List Setup s'affiche.

b. Saisissez un nom dans le champ Group Name, puis cliquez sur Add.
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c. Pour supprimer un groupe, sélectionnez le nom du groupe dans la liste
Available Groups et cliquez sur Delete.

d. Après avoir ajouté et supprimé les groupes, cliquez sur OK.

La fenêtre Server List Setup s'affiche.

4. Ajoutez un serveur :

a. Cliquez sur Add dans la liste Available Servers.

La fenêtre Add Server s'affiche.

b. Pour Solaris, saisissez le nom du serveur dans le champ Server Name, puis
appuyez sur Entrée. Pour Microsoft Windows NT/2000, tapez le nom du serveur
dans le champ Server name puis, appuyez sur Entrée.

Il s'agit du nom utilisé pour l'identification du serveur. Si ce nom se trouve dans
votre base de données de noms de serveur de réseau, Configuration Service
détermine l'adresse IP du serveur et l'affiche dans le champ IP Address.

Si Configuration Service ne trouve pas d’adresse IP pour le nom, ce dernier a été,
soit saisi incorrectement, soit n'a pas été enregistré dans la base de données de
noms du serveur.
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c. Le cas échéant, tapez l'adresse TCP/IP du serveur dans le champ IP Address.

À titre d'exemple, 192.168.100.1.

Si Configuration Service n'a pas encore affiché l'adresse IP (tel que décrit dans
l'étape précédente), tapez l'adresse IP manuellement.

Vous pouvez également sélectionner le champ Get IP Address by Name, situé
sous IP Address, pour que Configuration Service rechercher l'adresse IP et
l'affiche automatiquement. Tel qu'indiqué ci-dessus, cette méthode ne fonctionne
que si votre réseau dispose d'une base de données de noms de serveur et que
vous saisissiez exactement le nom du serveur enregistré dans cette base de
données. Sinon, vous devez saisir l'adresse IP manuellement.

5. Sélectionnez ou désélectionnez Automatic Discovery pour les serveurs :

a. Sélectionnez No pour Auto Discovery si vous avez besoin d'un environnement
hautement sécurisé où l'accès est restreint même aux données de l'inventaire du
serveur.

Lorsque vous sélectionnez No, Configuration Service n'extrait pas d'informations
du serveur au démarrage. L'icône du serveur s'affiche en code couleur blanc
(et non en violet actif) pour indiquer qu'il n'a pas été trouvé. Lorsque vous
double-cliquez sur un serveur non découvert, Configuration Service vous invite à
taper le mot de passe utilisateur ssmon. Vous pouvez également sélectionner le
serveur et File → Login.

Sélectionnez Yes pour Auto Discovery pour extraire toutes les informations
disponibles sur ce serveur au démarrage de la console Configuration Service.

b. Si vous sélectionnez Yes pour Auto Discovery, tapez le mot de passe du
moniteur entré auparavant lorsque le mot de passe de l’utilisateur ssmon a été
configuré sur le serveur (ou groupe de serveurs si vous disposez d'un domaine
ou d'une arborescence NDS).

Après avoir établi le ou les serveurs à l'aide de Auto Discovery, vous n'êtes pas
obligé de saisir le mot de passe ssmon lorsque vous ouvrez une session dans
Configuration Service ; les privilèges de surveillance vous sont automatiquement conférés.

Toutefois, lorsque vous choisissez une commande pour exécuter les activités
d'administration ou de configuration, une boîte de dialogue d'ouverture de session
s'affiche vous invitant à changer le niveau de sécurité en saisissant le mot de passe
pour l'utilisateur ssadmin ou ssconfigqui aura été défini précédemment.

c. Cliquez sur OK.

6. Configurez les adresses de courrier électronique :

a. Pour que Configuration Service envoie des messages d'événement via courrier
électronique, sélectionnez l'onglet Mailing Lists et procédez comme suit.

Vous pouvez saisir votre propre adresse de courrier électronique ainsi que les
adresses des utilisateurs sélectionnés afin qu'ils reçoivent les informations sur les
événements critiques ayant lieu sur le serveur.
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Remarque – L'exécution du programme de la console Configuration Service ne doit
pas forcément se passer à l'avant-plan. Vous pouvez utiliser Diagnostic Reporter, un
utilitaire complémentaire de Configuration Service qui est exécuté à l'arrière-plan et
qui envoie des messages des hôtes et de la baie Sun StorEdge aux adresses e-mail
indiquées. Pour des renseignements supplémentaires, reportez-vous au Guide de
l’utilisateur de Sun StorEdge 3000 Family Diagnostic Reporter 1.2. Une autre méthode
pour la réception des alertes d'événements est décrite dans « Envoi de déroutements
SNMP sans Configuration Service », page 233.

b. Saisissez une adresse de courrier électronique par utilisateur dans le champ
Mail Address.

c. Dans la zone de liste Severity, parcourez les différents niveaux de gravité et
choisissez parmi les options suivantes :

Critical – un message requérant une intervention par l'administrateur du réseau
dans le cas d'une panne du périphérique, de l'alimentation ou du ventilateur par
exemple.

Warning – des messages qui indiquent en principe des événements de
programme internes. Si un grand nombre de ces messages s'affichent, il se peut
qu'il y ait un problème avec le serveur ou le réseau.

Informational – des messages sur les périphériques du serveur qui ne requièrent
pas l’intervention de l’administrateur du réseau.
46 Guide de l’utilisateur Sun StorEdge 3000 Family Configuration Service 1.2 • avril 2003



Quel que soit le niveau sélectionné, les messages d'événement s'affichent pour ce
niveau et tout autre niveau à une gravité plus sérieuse. Si vous sélectionnez
Informational, par exemple, vous serez averti de tous les types de
dysfonctionnement. Au contraire, si vous ne souhaitez être averti que des
situations critiques, sélectionnez Critical, et aucun message d'événement
Informational ou Warning ne vous parviendra.

d. Cliquez sur Add to List.

Pour supprimer un utilisateur de la liste, sélectionnez l'adresse de courrier
électronique et cliquez sur Delete from List.

e. Indiquez le serveur de messagerie à utiliser.

Le bouton Setup Mail Server passe à Change Mail Server (si un serveur de
messagerie a été prédéfini).

Pour les nouvelles configurations, cliquez sur Setup Mail Server. Une fenêtre Mail
Server Setup comparable à celle illustrée ci-dessous s'affiche.

f. Saisissez l'adresse IP ou le nom du serveur de messagerie Simple Mail Transfer
Protocol (SMTP) qui transmet les messages de courrier électronique aux
adresses de destination indiquées précédemment.

g. Cliquez sur OK lorsque vous êtes satisfait des informations dans la fenêtre
Mail Server.

La fenêtre Add Server s'affiche indiquant l'onglet Mailing Lists.

7. Complétez la fonction Add Server :

a. Si vous voulez que ce serveur fasse partie d'un groupe, sélectionnez l'onglet
Grouping.

La fenêtre Add Server s'affiche.
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b. Sélectionnez la zone de liste pour afficher les choix disponibles.

c. Sélectionnez le groupe et relâchez le bouton de la souris.

d. Cliquez sur OK pour enregistrer le changement.

8. Pour ajouter d'autres serveurs, répétez les étapes 3 à 7 pour chacun des serveurs.

9. Déplacez les serveurs que cette console doit contrôler vers la liste Managed
Servers (voir « Ajout de serveurs », page 43).

■ Pour que cette console gère tous les serveurs disponibles, cliquez sur Add All
situé au-dessus de la boîte de dialogue.

■ Pour déplacer des serveurs individuellement vers la colonne gérée, sélectionnez les
serveurs un par un et cliquez sur le bouton Add situé entre les deux zones de liste.

■ Si vous devez apporter des modifications au cours de la procédure d'ajout de
serveurs, voir « Modification d'une entrée de serveur », page 186.

10. Après avoir ajouté les serveurs, cliquez sur OK pour revenir à la fenêtre principale.

Remarque – Si la baie est connectée à plusieurs hôtes et que l'agent Configuration
Service est installé sur chaque hôte, chacune des adresses IP des hôtes doit être saisie
et ajoutée à la liste Managed Servers.
48 Guide de l’utilisateur Sun StorEdge 3000 Family Configuration Service 1.2 • avril 2003



▼ Connexion et déconnexion
Les fonctions de connexion/déconnexion de Configuration Service sécurisent l'accès au
programme. Vous définissez les niveaux de sécurité en définissant trois utilisateurs :
ssmon, ssadmin, et ssconfig, chacun d'eux disposant d'un mot de passe.

■ ssmon représente le niveau de surveillance du logiciel ; il affiche les alertes
émises par le contrôleur.

■ ssadmin représente le niveau d'administration du logiciel et fournit l'accès aux
fonctions de reconstruction (Rebuild), de vérification de la parité (Parity Check) et
de planification de la vérification de parité (Schedule Parity Check), ainsi que de
surveillance.

■ ssconfig représente le niveau de configuration ; il permet d'accéder aux
commandes de configuration et à tous les aspects du programme.

1. Pour vous connecter, sélectionnez File → Login.

Conservez un accès continu uniquement en tant qu'utilisateur de surveillance.
Lorsque vous sélectionnez une commande requérant le niveau d'administration ou
de configuration, une boîte de dialogue de connexion s'affiche vous permettant de
vous connecter à ce niveau avec le mot de passe approprié. Après avoir exécuté
votre tâche, déconnectez-vous.

2. Pour vous déconnecter, sélectionnez File → Logout.

Lorsque vous vous déconnectez du niveau d'administration ou de configuration,
vous pouvez soit vous déconnecter pour passer en mode de surveillance, soit
terminer votre session avec le serveur.
Chapitre 6 Configuration de Configuration Service 49



▼ Sélection d'un serveur pour la gestion d'un
contrôleur
Pour la gestion et la surveillance d'une baie de disques, l'agent Configuration Service
doit avoir accès à une unité logique d'hôte mappée à une partition d'un lecteur
logique affecté au contrôleur principal de la baie.

L'agent Configuration Service ignore toutes les unités logiques d'hôte mappées à une
partition d'un lecteur logique affecté à un contrôleur secondaire dans une
configuration redondante d'une baie.

Remarque – Voir « Introduction à RAID », page 189 pour une description des
lecteurs logiques et des unités logiques.

Si la même baie de disques est connectée à plusieurs serveurs, il est possible
d'exécuter l'agent Configuration Service sur chaque serveur à des fins de gestion et
de surveillance de la même baie. En raison de la restriction des commandes de
surveillance à envoyer au contrôleur de baies stipulant qu'elles doivent être
envoyées par un seul serveur à la fois, certaines commandes de surveillance peuvent
échouer si elles sont envoyées simultanément par plusieurs serveurs. L'envoi
simultanée de commandes peut entraîner des rapports incohérents ou l'interruption
de processus de Configuration Service. Pour éviter que cela se produise, vous devez
configurer l’agent Configuration Service de manière à activer/désactiver la
surveillance de la baie sur le serveur.

Affectation d'un contrôleur via la console

Vous pouvez effectuer la procédure suivante depuis la console Configuration Service
pour affecter le contrôle d'un serveur à un contrôleur.

1. Veillez à ce que tous les serveurs directement connectés soient ajoutés
conformément aux instructions stipulées dans « Ajout de serveurs », page 43.

Vous garantissez ainsi la présence du nom des deux hôtes sous Controller
Assignments.

2. Depuis la fenêtre Configuration Service, cliquez sur Array Administration →
Controller Assignment.

La fenêtre Assign Server to Manage a RAID Controller s'affiche.

3. Sélectionnez un serveur dans la liste Server to manage this controller et cliquez
sur Apply.

Cette procédure permet au serveur sélectionné de gérer un contrôleur de baie. Elle
désactive également la gestion de la même baie par les autres serveurs répertoriés.
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4. Cliquez sur Close pour quitter l'affichage.

La fenêtre principale de Configuration Service affiche l'icône du périphérique du
contrôleur de la baie uniquement sous le serveur où la surveillance est activée pour
cette baie.
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Modification de l’affectation d’un serveur
Quand vous affectez un serveur à la gestion d’un contrôleur, les informations
relatives au serveur en question sont fournies. Configuration Service stocke ces
informations sur un contrôleur et les utilise pour suivre les activités du serveur de
gestion. Au cas où un serveur est arrêté, pour un problème de maintenance par
exemple, et vous tentez d’affecter un autre serveur à la gestion du contrôleur,
Configuration Service lit les informations relatives au serveur stockées sur le
contrôleur et vous avise que le contrôleur est déjà sous la gestion d’un serveur.

Remarque – Vous pouvez annuler l’affectation actuelle si vous souhaitez en forcer
une nouvelle.

Vous pouvez visualiser le nom du serveur de gestion à l’aide du menu de l’applicatif
firmware dénommé visualisation et édition des unités logiques d’hôtes → Edit Host-
ID/WWN Name List.

Si vous souhaitez modifier l’affectation du serveur, parce que vous devez déplacer
une baie à un autre emplacement, par exemple, avant de la déplacer, vous devez
annuler l’affectation du serveur de gestion en suivant la procédure indiquée dans
« Désaffectation du serveur de gestion », page 53.

Si vous avez déjà déplacé la baie, au démarrage, vous verrez un message
d’avertissement vous indiquant que le contrôleur est déjà sous la gestion d’un
autre serveur. Vous devez supprimer manuellement le serveur en suivant la
procédure décrite dans « Suppression manuelle d’un serveur à l’aide de la fenêtre
Terminal », page 53. Reportez-vous au Guide de l’utilisateur Sun StorEdge 3000
Family RAID Firmware relatif à votre baie pour tout renseignement concernant
l’accès à l’applicatif firmware.

Configuration Service stocke
le nom du serveur en valeurs
héxadecimales pour les
caractères ASCII.
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▼ Désaffectation du serveur de gestion

1. Depuis la fenêtre Configuration Service, cliquez sur Array Administration →
Controller Assignment.

2. Sélectionnez le contrôleur de baie auquel vous désirez désaffecter le serveur.

3. Depuis le serveur dont vous voulez affecter la gestion au contrôleur : case list,
sélectionnez none.

Cliquez sur Close au prochain message affiché qui confirmera que le contrôleur
sélectionné ne sera plus géré par un serveur.

4. Sélectionnez le serveur dont vous désirez affecter la gestion du contrôleur en suivant
la procédure indiquée dans « Affectation d'un contrôleur via la console », page 50.

▼ Suppression manuelle d’un serveur à l’aide de la fenêtre
Terminal

Reportez-vous au Guide de l’utilisateur Sun StorEdge 3000 Family RAID Firmware
relatif à votre baie pour tout renseignement sur l’accès à l’applicatif firmware.

1. Depuis le menu principal, sélectionnez «view and edit Host luns» (afficher et
modifier les unités logiques d’hôte), puis appuyez sur Entrée.

2. Sélectionnez Edit Host-ID/WWN Name List, et appuyez sur Entrée.

3. Sélectionnez sscsMgr dans la liste Name et appuyez sur Entrée.

4. Sélectionnez la liste Delete Host-ID/WWN Name et appuyez sur Entrée.

5. Sélectionnez «Yes » (oui) et appuyez sur Entrée.
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▼ Configuration des paramètres de l'agent
(optionnelle)
Cette section fournit des étapes pour configurer les paramètres de l'agent, y compris
le temps d'interrogation, le temps de découverte du périphérique périodique, la
surveillance intelligente et la gestion de stockage hors bande via la commande «
View → Agent Options Management ».

1. Dans la fenêtre principale, sélectionnez « View → Agent Options Management ».

La fenêtre Agent Options Management s'affiche.

Remarque – L'option Agent Options Management peut ne pas être disponible si un
ou plusieurs groupes sont configurés et que l'un d'eux est sélectionné dans la fenêtre
principale. Pour l'activer, sélectionnez une icône autre qu'un groupe et cliquez sur View.

2. Pour Monitoring Frequency in Seconds, tapez le nombre de secondes souhaitées.

Cette valeur représente l'intervalle entre l'interrogation successive pour tout
changement d'état de périphériques, contrôleurs de baie et la surveillance du boîtier
par l'agent Configuration Service. La valeur par défaut est 60 secondes. Si vous
souhaitez une actualisation plus fréquente de la console Configuration Service avec
les changements d'état de périphérique, réduisez cette valeur.
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Remarque – L’augmentation de l’intervalle d’interogation peut avoir un impact
négatif sur la messagerie d’erreur en cas d’une charge excessive d’opérations d’E/S.

3. Pour Periodic Device Discovery, saisissez en minutes la valeur de fréquence de
vérification des nouveaux périphériques par Configuration Service.

La valeur de découverte périodique du périphérique est utilisée par Configuration
Service pour déterminer la fréquence d'examen de chaque ID de périphérique pour
un nouveau périphérique. La valeur par défaut de zéro signifie que Configuration
Service ne recherche pas les nouveaux périphériques. Remarquez que la fréquence
d'examen des identificateurs (ID) de périphérique diminue au fur et à mesure que la
valeur numérique augmente.

Par contre, la fréquence d'examen d'ID de périphérique augmente au fur et à mesure
que la valeur numérique diminue. La valeur minimum est de cinq minutes.

4. Pour Interval of trap generation, saisissez le temps (en secondes) entre l'envoi de
chacun des messages d'alarme.

Si la valeur est 60 secondes ou plus, Configuration Service envoie un message à cet
intervalle, pour l'alarme en question jusqu'à ce que l'événement soit effacé ou
rectifié. À titre d'exemple, si un ventilateur est défectueux, un message s'affiche
toutes les 60 secondes jusqu'à ce qu'il soit réparé.

Si la valeur est zéro, Configuration Service (et par conséquent Diagnostic Reporter)
n'envoie qu'un seul message signalant cet événement. À titre d'exemple, si un
ventilateur est en panne, un seul courrier électronique est envoyé.

5. Pour Timeout of heartbeat lost, définissez la durée en minutes indiquant l'attente
entre l'envoi des messages avertissant l'échec du serveur.

La valeur par défaut est 15 minutes ; la plage de valeurs est de 1 à 30 minutes.

6. Pour Enable SMART Monitoring, cochez la case.

Le contrôle SMART permet aux disques durs de rapporter les échecs prévisibles.
La plupart des fournisseurs de disques fournissent cette fonctionnalité. L'agent
Configuration Service contrôle cette fonctionnalité en émettant une détection de
demande non sollicitée. Vous pouvez désactiver le contrôle SMART si cette demande
entre en conflit avec l'environnement d'exploitation hôte/pilotes de périphérique
sous jacents.

7. Si vous avez sélectionné l'une des options précédentes, cliquez sur OK pour
enregistrer les modifications.
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La boîte de message de notification Setting Agent Options s'affiche indiquant
l'adresse du protocole TCP/IP du serveur.

8. Cliquez sur OK pour terminer la procédure.

Pour de plus amples informations sur l'agent principal du contrôleur, voir « Gestion
de stockage hors bande », page 128.

▼ Activation de la prise en charge des unités JBOD
(uniquement SCSI)
Dans le cas de baies de disques Sun StorEdge 3310 SCSI, utilisez la prise en charge
des unités JBOD uniquement lorsqu'une unité JBOD est directement connectée à la
station de travail. Cela vous permet de contrôler les événements et la condition des
périphériques. Lorsqu'une unité JBOD est connectée à la baie de disques RAID, le
contrôleur RAID se charge de contrôler les événements et la condition de l'unité
JBOD pour vous.

Remarque – L’activation de la prise en charge des unités JBOD peut avoir une
influence sur les E/S.

1. Suivez les étapes indiquées dans « Configuration des paramètres de l'agent
(optionnelle) », page 54.

2. Sélectionnez la prise en charge « Enable JBOD ».

Pour de plus amples informations sur le contrôle des unités JBOD, voir
« Surveillance des unités JBODs (SCSI uniquement) », page 205.
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▼ Vérification des configurations de stockage
Après avoir installé Configuration Service et ajouté tous les serveurs pour le stockage
que Configuration Service doit gérer, vous devez vérifier les configurations de stockage.

Remarque – La plupart des baies sont expédiées préconfigurées. Pour supprimer la
configuration existante et recommencer, voir « Configuration intégrale », page 65.
Pour changer la configuration existante ou la compléter, voir « Mise à jour de la
configuration », page 149.

1. Veillez à ce que l'icône du serveur soit en ligne (la couleur du serveur doit être
violette).

Configuration Service est automatiquement lancé au cours du démarrage.

2. Observez la fenêtre principale de Configuration Service et vérifiez la configuration
de stockage.

3. Si vous avez plusieurs serveurs gérés, sélectionnez le serveur à vérifier.

Si l'icône du serveur n'est pas violette, déterminez l'état du serveur (voir
TABLEAU 9-1). Si une antenne satellite est annexée à l'icône du serveur , le
serveur peut être en voie de découverte et sera disponible dans quelques instants.

4. Cliquez sur le symbole du conteneur affiché à gauche du serveur dont le
stockage est à vérifier.

Configuration Service affiche graphiquement chacun contrôleurs de baie connectés
au serveur tel qu'indiqué dans la figure suivante.
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5. Pour de plus amples informations, cliquez sur le symbole du conteneur
affiché près du contrôleur de la baie dont le stockage est à vérifier.

Si la baie n'a pas encore été configurée, aucun lecteur logique (LUN pour les
contrôleurs) n'est affiché.

Si votre baie a été configurée, Configuration Service affiche les périphériques et les
lecteurs logiques associés au contrôleur de baie sélectionnée. Votre configuration
doit être comparable aux périphériques affichés dans la figure suivante.

La sélection du symbole du conteneur à gauche d'un lecteur logique affiche ses
lecteurs physiques affectés.

Remarque – Vous pouvez choisir d’afficher les lecteurs physiques (durs) qui
constituent les lecteurs logiques en sélectionnant ou en désélectionnant View →
Display HDD under LD.

Votre configuration peut différer considérablement de ce qui est illustré dans la
figure précédente en fonction des produits de baies de stockage installés.

Si la baie n'est pas configurée, voir « Configuration intégrale », page 65 pour de plus
amples informations su les configurations.

6. Vérifiez le niveau RAID ainsi que la structure du lecteur logique.

7. Si les baies sont déjà configurées et que la configuration répond à vos besoins,
passez à la section suivante.

Pour modifier la configuration, voir « Configuration intégrale », page 65.
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▼ Enregistrement de la configuration du lecteur
logique
Bien que les informations de la configuration du lecteur logique soient enregistrées
sur les contrôleurs de baie et sur les lecteurs physiques annexés, des situations
particulières telles qu'un incendie peuvent se présenter endommageant le contrôleur
et les lecteurs. Il est par conséquent recommandé de conserver plusieurs copies de
sauvegarde de la configuration de votre lecteur logique actuel (ou unité logique)
sur disquettes ou sur un type de support externe autre que la baie de disques.
Conservez au moins une copie de sauvegarde dans un coffre ou un endroit sûr à
l'extérieur du site. Une copie de sauvegarde de la configuration vous permet de
restaurer la configuration sur un nouveau contrôleur sans devoir reconfigurer
totalement la baie. Si vous n'avez pas de copie de sauvegarde de la configuration
actuelle, les données risquent d'être perdues.

Enregistrez toujours votre configuration de contrôleur de baie sur un fichier à chaque :

■ installation d'un nouveau boîtier de système de stockage ou modification de l'ID
SCSI du contrôleur dans un boîtier existant ;

■ remplacement d'un contrôleur de baie ;

■ reconfiguration ou ajout des lecteurs logiques sur un contrôleur de baie ;

■ reconstruction les données d'un lecteur défectueux sur un lecteur en attente.

Pour restaurer une configuration depuis un fichier, voir « Restauration de la
configuration du lecteur logique », page 143.

1. Sélectionnez le contrôleur avec la configuration à enregistrer.

2. Sélectionnez Configuration → Save Configuration.

La fenêtre Save Configuration s'affiche.
Chapitre 6 Configuration de Configuration Service 59



3. Ouvrez le lecteur et le dossier contenant le ou les fichiers de configuration à
actualiser. Ils sont indiqués par l'extension .cfg.

Enregistrez le ou les fichiers sur une disquette ou un lecteur externe à la baie de disques.
Vous conservez ainsi des copies de ces fichiers de configuration en dehors du site.

4. Indiquez le nom du fichier de configuration et cliquez sur Save.

La fenêtre Save Configuration s'affiche.

5. Saisissez une description de la configuration à enregistrer et cliquez sur OK.

Configuration Service enregistre les informations de configuration du contrôleur
dans un fichier .cfg.

▼ Création des partitions sur un serveur
Après avoir défini la configuration de stockage selon vos besoins, vous pouvez
également créer des partitions de la baie de stockage correspondant à
l'environnement d'exploitation.

Environnement d'exploitation Solaris

Les étapes suivantes sont des directives générales. Pour de plus amples
informations, lisez les informations relatives à la création des partitions et des
systèmes de fichiers dans votre manuel du système d'exploitation Sun Solaris.
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1. Étiquetez une nouvelle unité logique en tapant

La commande format affiche le disque système ainsi que les autres lecteurs annexés
à la baie de disques.

Une nouvelle unité logique doit être étiquetée avec la commande format avant de
pouvoir la configurer pour être utilisée par la baie de disques. Lorsque la commande
format est lancée, les unités logiques et les disques durs disponibles s'affichent.

2. Sélectionnez le périphérique à utiliser.

Étiquetez le périphérique si l'invite s'affiche.

3. Tapez la partition pour afficher la table des partitions existante.

4. Modifiez-la selon le besoin et étiquetez-la si des modifications ont été faites.

5. Créez des systèmes de fichiers sur les partitions à l'aide de la commande newfs.

6. Installez les fichiers systèmes à l'aide de la commandemount ou en modifiant
/etc/vfstab et en utilisant la commande mountall command.

# format
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Partitions Microsoft Windows NT

Avant de passer à cette section, vous devez réinitialiser l'ordinateur afin que
Microsoft Windows NT puisse reconnaître la nouvelle capacité de stockage.
Les étapes ci-dessous ne sont que des directives générales ; pour de plus amples
informations, voir la documentation de Microsoft Windows NT.

Remarque – Vous ne pouvez pas effectuer cette étape à distance. Elle doit être
exécutée sur le serveur.

1. Sélectionnez → Programs → Administrative Tools → Disk Administrator.

2. Sélectionnez « Yes » dans chacune des boîtes de messages Disk Administrator.

3. Sélectionnez le lecteur logique en déplaçant le curseur vers la barre horizontale et
en cliquant ensuite sur le bouton gauche de la souris.

4. Sélectionnez Disk Administrator Partition → Create.

Une fenêtre d'invite s'affiche vous offrant la possibilité de créer une partition ayant
une capacité par défaut égale à la taille du lecteur logique.

5. Pour créer plusieurs partitions sur un lecteur logique, tapez la taille de la partition
souhaitée.

Répétez cette étape jusqu'à ce que la capacité du lecteur logique soit utilisée.

6. Sélectionnez Disk Administrator Partition → Commit Changes Now.

Cette fonction permet de formater et d'utiliser le lecteur logique sans relancer le
système d'exploitation Windows NT.

7. Sélectionnez la nouvelle partition du lecteur logique.

8. Sélectionnez Disk Administrator Tools → Format. Sélectionnez le format NTFS
(Système de fichiers NT).

Répétez les étapes 7 et 8 pour formater chacune des partitions créées sur le lecteur
logique.

9. Après avoir formaté les partitions, fermez Disk Administrator.
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Partitions Microsoft Windows 2000

Les étapes ci-dessous ne sont que des directives générales ; pour de plus amples
informations, voir la documentation de Microsoft Windows 2000.

1. Sélectionnez Settings → Control Panel → Administrative Tools → Computer
Management → Disk Management.

Veillez à ce que vous puissiez voir les nouveaux lecteurs marqués par l’icône en
forme de disque sous Disk Management.

2. Cliquez avec le bouton droit de la souris sur le disque où vous souhaitez inscrire
une signature et sélectionnez Write Signature.

3. Sélectionnez le disque dans lequel vous souhaitez créer une partition, et cliquez
sur OK.

4. Cliquez avec le bouton droit de la souris sur le lecteur (où la capacité du lecteur
est indiquée) puis, sélectionnez Create Partition.

5. Répondez aux invites de l’assistant des partitions.

Cliquez avec le bouton droit
de la souris sur le disque où
vous souhaitez inscrire une
signature.

Cliquez avec le bouton droit
de la souris sur le lecteur où
vous souhaitez créer une partition.
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Que faire ensuite
Configuration Service (console et agent) est maintenant installé, configuré et prêt à
être utilisé. Voir les chapitres suivants pour les tâches additionnelles :

■ « Surveillance de la baie », page 97, pour de plus amples informations sur
l'utilisation de Configuration Service comme outil de contrôle des périphériques
de stockage.

■ « Maintenance de la baie », page 135, pour tout renseignement sur la gestion de la
baie de disques. Ce chapitre comprend des informations détaillées sur le contrôle
de parité, la programmation des contrôles de parité, la reconstruction des lecteurs
ayant échoué et la restauration d'une configuration à partir d'un fichier de
sauvegarde.

■ « Mise à jour de la configuration », page 149, pour actualiser la configuration de la
baie de stockage. Ce chapitre couvre également le changement des fonctionnalités
du contrôleur, la création ou le changement d'un lecteur en attente ainsi que la
modification d'informations pour les serveurs disponibles.
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CHAPITRE 7

Configuration intégrale

Sun préconfigure les lecteurs logiques sur la baie de disques avant l'expédition.
Lisez ce chapitre uniquement si la baie de disques n'est pas configurée ou si vous
voulez supprimer entièrement la configuration existante et recommencer. Pour
modifier des parties de la configuration existante, voir « Mise à jour de la
configuration », page 149.

La configuration intégrale comprend les rubriques suivantes :

■ « Configuration des lecteurs et des volumes logiques », page 66

■ « Utilisation de Standard Configuration pour configurer les lecteurs logiques »,
page 66

■ « Utilisation de Custom Configuration pour configurer les lecteurs et les volumes
logiques », page 69

■ « Création et partition d’un volume logique », page 79

■ « Suppression d'une configuration », page 81

■ « Déconnexion du niveau de configuration », page 81

■ « Affectations d'unités logiques d'hôte », page 82

■ « Ajout (mappage) d'une unité logique d'hôte », page 82

■ « Suppression (annulation du mappage) d'une unité logique d'hôte », page 84

■ « Configuration File », page 84

■ « Enregistrement de la configuration dans un fichier de sauvegarde », page 85

Si vous envisagez d'installer une configuration en cluster, consultez « Utilisation de
la configuration de cluster », page 213.

Les commandes du menu Configuration et les icônes d'outil peuvent être
désactivées temporairement si un processus d'administration de baies, tel qu'un
contrôle de parité, est en cours. La commande du menu est également désactivée
lorsque la console Configuration Service actualise son inventaire sur le serveur.
Le symbole d'une antenne satellite est placé près de l'icône du serveur pendant le
processus d'actualisation.
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Précaution – Effectuez une sauvegarde des données existantes sur un périphérique
externe avant de configurer la baie de disques. La reconfiguration remplace toute
configuration existante du lecteur logique. Lorsque la configuration du lecteur
logique existante est remplacée, les données sont effacées.

Configuration des lecteurs et des
volumes logiques
En fonction de votre choix d’utiliser un ou plusieurs niveaux RAID, il est possible de
configurer les lecteurs logiques à l’aide des outils Standard ou Custom Configuration.
Il n’est possible de créer des volumes logiques qu’à travers l’outil Custom Configuration.

Remarque – Sur une baie Sun StorEdge 3310 SCSI, vous pouvez créer huit lecteurs
logiques maximum et 32 partitions maximum par lecteur logique. Remarquez que
vous pouvez affecter un maximum de 128 unités logiques. Le volume logique peut
être divisé en 32 partitions au maximum. Sur une baie Sun StorEdge 3510 FC, vous
pouvez créer huit lecteurs logiques maximum et 128 partitions maximum par lecteur
logique. Vous pouvez affecter un maximum de 1024 unités logiques (le nombre
d’unités logiques maximum affectées à chaque identité d’hôte est de 32). Le volume
logique peut être divisé en 128 partitions au maximum.

▼ Utilisation de Standard Configuration pour
configurer les lecteurs logiques
Standard Configuration Options permet de configurer rapidement tous les
périphériques de stockage reliés à un contrôleur de baie en utilisant un niveau
RAID. Il vous suffit d'avoir un contrôleur RAID et un niveau RAID. Vous devez
également indiquer si vous souhaitez un lecteur en attente. Configuration Service
configure automatiquement le stockage, créant un ou plusieurs lecteurs logiques, en
fonction du niveau RAID et du nombre des lecteurs disponibles. Le cache à écriture
différée est sélectionné par défaut. Vous pouvez consulter la configuration résultante
et la valider ou rejeter avant que le processus ne se termine.

Précaution – Avant d'utiliser Standard Configuration, effectuez une sauvegarde
des données existantes sur un périphérique externe. Standard Configuration
recouvre toute configuration existante du lecteur logique. Lorsque la configuration
du lecteur logique existante est remplacée, les données sont effacées.
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1. Connectez-vous en tant qu'utilisateur ssconfig.

2. Sélectionnez le contrôleur RAID désiré dans la fenêtre principale de
Configuration Service.

3. Sélectionnez Configuration → Standard Configure.

Un avertissement Standard Configuration est affiché. Cliquez sur OK pour continuer.

La fenêtre Standard Configuration Options s'affiche. Si vous n'êtes actuellement pas
connecté en tant qu'utilisateur de niveau ssconfig, une boîte de dialogue de
connexion s'affiche.

Les options de la fenêtre peuvent être désactivées en fonction du nombre de lecteurs
disponibles et du système/environnement d'exploitation exécuté sur le serveur
(Microsoft Windows NT ou Solaris).

L'option NT Cluster crée un lecteur logique quorum RAID 5 (100 Mo) et affecte
ensuite la capacité restante aux deux grands lecteurs logiques RAID 5. Dans le cas de
cette option, trois lecteurs physiques minimum sont requis.

4. Vérifiez les ID du serveur et du contrôleur affichés en haut de la fenêtre.

Si le serveur et le contrôleur affichés en haut de la fenêtre ne sont pas corrects,
cliquez sur Cancel pour quitter la fenêtre de configuration et revenir à le fenêtre
principale de Configuration Service. Sélectionnez d'abord le périphérique approprié
puis à nouveau la fenêtre.
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5. Indiquez si vous voulez utiliser un des lecteurs comme lecteur en attente :

Lorsque vous sélectionnez l'option Use a standby drive, Configuration Service
désactive les niveaux RAID qui ne se servent pas de lecteurs en attente. (À titre
d'exemple, RAID 0 n'a pas de tolérance de panne et par conséquent, un lecteur en
attente ne représente aucun intérêt).

6. Parmi les niveaux RAID désormais disponibles, sélectionnez le niveau RAID
approprié pour le lecteur logique à configurer.

Pour les définitions des niveaux RAID, voir « Introduction à RAID », page 189.

Si vous sélectionnez RAID 3 ou 5, Standard Configuration configure en principe un
seul grand lecteur logique. Toutefois, si la baie est munie de plus de 31 lecteurs
physiques, plus d’un lecteur logique est créé. Vous devez avoir un minimum de trois
lecteurs pour pouvoir utiliser RAID 3 ou 5.

Si vous sélectionnez RAID 1, chaque lecteur logique requiert au moins deux lecteurs
physiques et un maximum de 44 (si vous sélectionnez deux lecteurs au moins, un
lecteur logique avec RAID 0+1 est créé).

Si vous sélectionnez RAID 0 et que la baie a plus de 44 lecteurs, plus d’un lecteur
logique est créé.

7. (Environnement d’exploitation Solaris uniquement). Si vous voulez
automatiquement ajouter un nouveau lecteur logique à l'environnement
d'exploitation sans réinitialisation, cliquez sur Write a new label to the new LD.

8. Après avoir sélectionné un niveau RAID, cliquez sur OK.

La fenêtre Confirm Configuration Operation s'affiche indiquant la nouvelle
configuration.

9. Cliquez sur OK pour valider la configuration indiquée ou sur Cancel pour revenir
à la console Configuration Service.
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▼ Utilisation de Custom Configuration pour
configurer les lecteurs et les volumes logiques
Custom Configuration vous offre plusieurs choix de configuration ou de
reconfiguration des lecteurs logiques avec divers niveaux RAID et autres paramètres
RAID. Cela vous donne également la possibilité d’ajouter des nouveaux lecteurs
logiques aux volumes logiques.

1. Connectez-vous en tant qu'utilisateur de niveau ssconfig.

2. Sélectionnez le contrôleur RAID dans la fenêtre principale de Configuration
Service.

3. Sélectionnez Configuration → Custom Configure.

La fenêtre Custom Configuration Options s'affiche.
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■ New Configuration – Configure les nouveaux lecteurs logiques avec les différents
niveaux RAID et autres paramètres RAID et vous permet d’ajouter les nouveaux
lecteurs logiques aux volumes logiques. La commande New Configuration efface
la configuration existante sur le contrôleur de baie.

■ Add LDs/LVs to the Current Configuration – Ajoute de nouveaux
lecteurs/volumes logiques à une configuration existante. Cette commande
n'efface pas les autres lecteurs logiques configurés sur le contrôleur.

■ Dynamically Grow and/or Reconfigure LDs/LVs – Vous permet d’agrandir la
capacité de lecteurs et de volumes logiques, d’ajouter des lecteurs SCSI aux
lecteurs et volumes logiques existants, et de copier et remplacer tous les lecteurs
membres par des lecteurs de capacité supérieure.

■ Make or Change Standby Drives – Ajoute un ou plusieurs lecteurs en attente à
associer au contrôleur de baie.

■ Change Host LUN Assignments – Permet d'affecter des lecteurs logiques, des
volumes logiques et des partitions à un canal d'hôte.

■ Change Controller Parameters – Permet de modifier les paramètres du contrôleur.

■ Manage Existing LDs/LVs and Partitions – Permet de supprimer des lecteurs et
des volumes logiques et de créer/supprimer des partitions à partir de lecteurs et
volumes logiques existants.

■ Configure Web Server – Permet de configurer un serveur web de manière à
pouvoir gérer/surveiller une baie par le biais d’un navigateur Internet.

Ce chapitre décrit en détail l'option New Configuration. Configure Web Server est
décrit dans « Gestion du stockage via Internet », page 132. Les autres options sont
couvertes dans « Mise à jour de la configuration », page 149.

Option New Configuration
L'option New Configuration permet de personnaliser la configuration du lecteur
logique pour répondre aux besoins spécifiques de votre environnement. Vous
pouvez configurer un ou plusieurs lecteurs logiques avec divers niveaux RAID et
partitions. Vous pouvez ensuite ajouter deux lecteurs logiques ou plus (non
partitionnés) à un volume logique et diviser le volume logique en 32 partitions
maximum pour SCSI et en 128 partitions pour Fibre Channel.

Remarque – Pour les systèmes fonctionnant sous l'environnement d'exploitation
Solaris, si la console Configuration Service s'arrête pendant l'utilisation, vous pouvez
obtenir le numéro de processus puis fermer et réouvrir la fenêtre comme indiqué
dans la section « Bloc de la console en cours d’utilisation », page 39.
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Avant d’utiliser New Configuration

Avant d’utiliser New Configuration afin de créer pour la première fois un lecteur ou
un volume logique, il est très utile de se familiariser avec les informations contenues
dans les étapes suivantes. Une connaissance préalable de ces informations vous
facilitera la création de lecteurs ou de volumes logiques.

1. Déterminez le nombre total de disques physiques que vous voulez installer dans
le lecteur logique.

Si la sécurité de vos données est importante, laissez les disques restants pour les
lecteurs en attente.

Remarque – Si le lecteur logique à créer est supérieur à 253 Go, consultez la section
« Préparation pour des lecteurs logiques de plus de 253 Go », page 73.

2. Déterminez si un lecteur en attente (de réserve) doit être local ou global.

Un lecteur en attente est un lecteur marqué comme lecteur de réserve pour la
reconstruction automatique des données à la suite de la défaillance d'un lecteur
physique associé à un lecteur logique. Pour qu’un lecteur en attente puisse prendre
la place d’un autre lecteur, il doit être au moins d’une taille équivalente à celle du
lecteur défaillant. Le lecteur défaillant doit être RAID 1, 3, ou 5.

Un lecteur de réserve local est un lecteur de secours affecté à un lecteur logique
donné. En cas de défaillance d'un lecteur membre de ce lecteur logique, le lecteur de
réserve local en devient membre et sa reconstruction commence immédiatement.

Un lecteur de réserve global sert plusieurs lecteurs logiques. En cas de défaillance
d'un membre de n'importe quelle unité logique, le lecteur de réserve global se joint à
ce lecteur logique et lance automatiquement la reconstruction des données.

3. Sélectionnez un niveau RAID; Configuration Service calcule automatiquement la
taille maximale du lecteur logique pouvant être créé à ce niveau RAID.

4. Déterminez si vous voulez partitionner le lecteur logique.

Une partition représente une division logique d'un lecteur logique (ou d’un volume
logique). Les partitions vous permettent de créer l'apparence d'avoir des lecteurs
logiques (ou des volumes logiques) distincts pour la gestion des fichiers, des
utilisateurs multiples ou à d'autres fins.

Remarque – Les partitions peuvent être créées lors de la configuration initiale ou
après la création du lecteur logique.

Remarque – Les lecteurs logiques partitionnés ne peuvent pas être ajoutés à un
volume logique.
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5. Comprendre les capacités des disques affichées dans la fenêtre New Configuration.

■ Max Drive Size (MB) – affiche la taille de lecteur maximum pour chaque disque
physique sélectionné (capacité totale de chaque disque).

Un lecteur logique plus petit peut être créé en réduisant cette valeur. Le reste peut
être utilisé par la suite en augmentant le lecteur (voir « Expansion de la capacité
d’un lecteur ou d’un volume logique », page 161).

■ Le champ Part Size (MB) – affiche la capacité totale de tous les disques, ce qui
représente la taille totale du lecteur ou du volume logique.

Remarque – La capacité maximale utilisable d'un lecteur logique est égale à la
taille du plus petit disque physique. À titre d'exemple, si vous avez un disque de 18
Go et un disque de 70 Go dans le lecteur logique, la capacité maximale utilisable par
lecteur est de 18 Go.

6. Déterminez si le lecteur logique devra faire partie du volume logique.

Remarque – Les lecteurs logiques qui ont été partitionnés ne peuvent pas être
ajoutés à un volume logique.

7. Déterminez si vous voulez partitionner le volume logique.

Remarque – Les partitions peuvent être créées lors de la configuration initiale ou
après la création du volume logique.

8. Déterminez le taux d'utilisation en arrière-plan, qui représente le pourcentage de
temps processeur affecté aux activités d'administration de la baie de disques, par
exemple la reconstruction des lecteurs, les contrôles de parité et l'initialisation.

Si l'on donne la valeur 100 % à ce taux, les activités d'administration ont une priorité
supérieure à celle des autres activités de système. Lorsque l'on donne la valeur 0 %,
les activités d'administration sont uniquement effectuées s'il n'y a pas d'autre
activité dans le contrôleur.
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▼ Préparation pour des lecteurs logiques de plus de 253 Go
L’environnement d’exploitation Solaris requiert une géométrie de lecteur pour
plusieurs opérations, par exemple newfs. Pour que la géométrie de lecteur
présentée à l’environnement d’exploitation Solaris pour des lecteurs logiques de
plus de 253 Go soit appropriée, vous devez configurer Host Cylinder/Head/Sector
Mapping Configuration à l’aide de l’application firmware. Consultez le Guide de
l’utilisateur Sun StorEdge 3000 Family RAID Firmware relatif à votre baie pour de plus
amples informations sur l’accès à l’application firmware.

1. Dans l’application firmware, sélectionnez les paramètres de configuration view et
edit du menu principal.

2. Sélectionnez Host-Side SCSI Parameters.

3. Sélectionnez Host Cylinder/Head/Sector Mapping Configuration.

4. Sélectionnez Sector Ranges et spécifiez 255.

5. Sélectionnez Head Ranges et spécifiez 64.

6. Sélectionnez Cylinder Ranges et spécifiez <65536.

▼ Pour créer et partitionner un lecteur logique avec
New Configuration

Avant de créer et partitionner pour la première fois un lecteur logique avec New
Configuration, il est utile de revoir les étapes décrites à la section « Avant d’utiliser
New Configuration », page 71.

Les étapes suivantes donnent un exemple pratique de comment créer une nouvelle
configuration pour un nouveau lecteur logique. Trois lecteurs logiques sont
sélectionnés et configurés en un lecteur logique RAID 5. Un petit lecteur logique est
créé et partitionné.

Précaution – Avant d’exécuter la commande New Configuration, effectuez une
sauvegarde de secours des données existantes sur un périphérique externe.
Configuration Service initialise automatiquement les nouveaux lecteurs logiques
définis sur le contrôleur de la baie de disques.

1. Connectez-vous en tant qu'utilisateur de niveau ssconfig.

2. Sélectionnez le contrôleur RAID dans la fenêtre principale de Configuration
Service.

3. Sélectionnez Configuration → Custom Configure.

4. Cliquez sur New Configuration.
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La boîte de message New Configuration Warning s'affiche.

5. Cliquez sur OK.

6. Vérifiez le serveur et le contrôleur affichés en haut de la fenêtre.

Si le serveur et le contrôleur affichés ne sont pas corrects, cliquez sur Cancel pour
quitter la fenêtre New Configuration et retourner à la fenêtre principale de
Configuration Service. Sélectionnez le contrôleur de disque approprié et
resélectionnez New Configuration.

7. Réglez le taux Background Rate pour le contrôleur, si besoin.

8. Dans la zone de liste Select disks for Logical Drive, sélectionnez le premier
disque et cliquez sur Add Disk.

Ajoutez les deux disques suivants de manière à ce que trois disques soient affichés
dans la zone de liste inférieure.

Si vous faites une erreur ou changez d'avis, sélectionnez le lecteur dans la liste des
lecteurs et cliquez sur Remove Disk.

Remarque – Comme le lecteur logique n’a pas encore été partitionné, les champs
Part Size (MB) et Available Size (MB) sont égaux. Un disque logique est considéré
comme une partition.
74 Guide de l’utilisateur Sun StorEdge 3000 Family Configuration Service 1.2 • avril 2003



9. Sélectionnez le niveau RAID. Pour cet exemple, sélectionnez RAID Level 5.

Cette procédure peut être utilisée pour tous les disques de ce lecteur logique.

Dans cet exemple, le nouveau lecteur logique se compose de trois disques physiques
totalisant 103428 Mo, comme l'indique le champ Available Size (MB).

Le nombre maximum de lecteurs pour chaque lecteur logique et pour chaque niveau
RAID est:

■ RAID 0 - 44
■ RAID 1 - 2
■ RAID 0+1 - 44
■ RAID 3 ou 5 - 31

Remarquez que si vous sélectionnez quatre lecteurs ou plus, un lecteur logique avec
RAID 0+1 est créé.

10. Définissez la taille de lecteur maximale Max Drive Size.

La valeur de Max Drive Size affiche la capacité totale de chacun des disques.
Un lecteur logique plus petit peut être créé en réduisant cette valeur.

Max Drive Size – affiche
la capacité totale de
chaque disque

Available Size – affiche
la capacité totale de tous les
disques, correspondant à la
taille totale du lecteur logique
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Remarque – Si vous ne changez pas la valeur de Max Drive Size mais que vous
modifiez Partition Size, Configuration Service crée une nouvelle partition à la taille
de partition indiquée. La capacité restante du lecteur logique est transférée vers la
dernière partition. La capacité restante peut être utilisée par la suite en augmentant
la taille du lecteur (voir « Expansion de la capacité d’un lecteur ou d’un volume
logique », page 161). Après la création de la partition, la capacité du lecteur n'est
plus modifiable.

11. Sélectionnez le canal et l'ID SCISI d'hôte auxquels vous voulez mapper le
nouveau lecteur logique dans les listes Channel et SCSI ID.

Remarque – Si vous ne voulez pas mapper le lecteur logique à ce moment-là,
sélectionnez Do Not Map dans la liste Channel.

Remarque – Sur une baie Sun StorEdge 3310 SCSI, vous pouvez créer huit lecteurs
logiques maximum et 32 partitions maximum par lecteur logique. Vous pouvez
affecter un maximum de 128 unités logiques. Le volume logique peut être divisé en
32 partitions au maximum. Sur une baie Sun StorEdge 3510 FC, vous pouvez créer
huit lecteurs logiques maximum et 128 partitions maximum par lecteur logique.
Il est possible d’affecter 1024 unités logiques maximum (le nombre maximum
d’unités logiques affectées à chaque ID d’hôte est de 32). Le volume logique peut
être divisé en 128 partitions au maximum.

12. Cette étape dépend de ce que vous voulez faire ensuite :

■ Pour créer un autre lecteur logique, cliquez sur New LD et répétez les étapes 1 à 11.

■ Pour ajouter ce lecteur logique à un volume logique, cliquez sur Add to LV et
consultez la section « Création et partition d’un volume logique », page 79.

■ Pour partitionner ce lecteur logique, exécutez les étapes suivantes. Dans cet
exemple, un petit lecteur logique est créé et partitionné.

13. Pour créer un petit lecteur logique, tapez 2000 dans le champ Max Drive Size.

Remarque – Un total de 4000 Mo est indiqué pour la taille du lecteur logique et
non 6000 Mo ; dans la mesure où il s'agit d'un niveau RAID 5, vous perdez la
capacité égale à 1 lecteur (soit 2 000 Mo) pour la parité.
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14. Pour créer une partition, tapez 1000 dans le champ Part Size et cliquez sur Add
Partition.

Remarque – Ne partitionnez pas un lecteur logique si vous pensez l’ajouter ensuite
à un volume logique. Une fois qu’un lecteur logique est partitionné, il n’est plus
possible de l’ajouter au volume logique.

Pour créer plusieurs partitions de la même taille, cliquez sur Add Partition le
nombre de fois correspondant au nombre de partitions que vous voulez créer. Vous
pouvez aussi saisir la taille de la partition dans le champ Part Size et le multliplier
(*) par le nombre de partitions que vous voulez créer, par exemple 100*128. Tout MB
restant est ajouté à la dernière partition.

Au fur et à mesure que vous ajoutez des partitions, la capacité restante affichée dans
le champ Available Size (MB) diminue en fonction de la taille de la partition.

Comme l'illustre l'exemple suivant, des 4 000 Mo d'origine, un total de 1000 Mo a été
affecté à la partition 0. Les 3 000 Mo qui restent sont ensuite automatiquement
transférés vers la partition 1. La capacité utilisable restante est affichée dans le
champ Available Size (MB).
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15. (Environnement d’exploitation Solaris uniquement). Si vous voulez ajouter
automatiquement un nouveau lecteur logique à l'environnement d'exploitation
sans réinitialisation, cliquez sur Write a new label to the new LD.

16. Cliquez sur Commit pour terminer la configuration du lecteur logique, ou sur
New LD pour configurer un autre lecteur logique.

Lorsque vous cliquez sur New LD, tous les disques disponibles qui n'ont pas été
utilisées s'affichent.

Après avoir complété la configuration du lecteur logique de cette baie Sun StorEdge,
cliquez sur Commit, puis sur OK. La configuration terminée s'affiche.

Remarque – Après avoir cliqué sur OK, vous ne pouvez plus changer la
configuration du lecteur logique.

Remarque – Pendant l’initialisation, la taille de LD/LV affichée est 0 Mo.
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▼ Création et partition d’un volume logique
Un volume logique est composé de deux lecteurs logiques au moins et peut être
divisé en 32 partitions maximum pour SCSI et en 128 pour Fibre Channel. Au cours
du fonctionnement, l'hôte perçoit le volume logique non partitionné ou une partition
d'un volume logique comme un lecteur physique simple.

1. Créez un lecteur logique en suivant la description des étapes 1 à 11 à la section
« Pour créer et partitionner un lecteur logique avec New Configuration », page 73.

Remarque – Ne partitioinnez pas le lecteur logique que vous ajoutez au volume logique.
Un lecteur logique qui a été partitionné ne peut pas être ajouté à un volume logique.

2. Avant de cliquer sur Commit, pour ajouter le lecteur logique au volume logique,
cliquez sur Add to LV.

Le lecteur logique est ainsi ajouté à la zone de définition LV. La taille totale du
volume logique est affichée dans le champ Available Size (MB).

Remarque – Le volume logique n’ayant pas encore été partitionné, les champs Part
Size (MB) etAvailable Size (MB) sont égaux. Un volume logique est considéré comme
une partition.
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3. Pour créer un autre lecteur logique à ajouter au volume logique, cliquez sur New LD.

4. Créez le lecteur logique et ajoutez-le au volume logique en cliquant sur Add to LV.

Répétez cette étape pour chaque lecteur logique à ajouter au volume logique.

5. Pour créer une partition, tapez la taille de la partition dans le champ Part Size et
cliquez sur Add Partition.

Pour créer plusieurs partitions de la même taille, cliquez sur Add Partition le
nombre de foix correspondant au nombre de partitions que vous voulez créer. Vous
pouvez aussi saisir la taille de la partition dans le champ Part Size et le multiplier (*)
par le nombre de partitions que vous voulez créer, par exemple 100*128.

Au fur et à mesure que vous ajoutez des partitions, la capacité restante affichée dans
le champ Available Size (MB) diminue en fonction de la taille de la partition.

6. Quand vous avez fini d’ajouter des lecteurs logiques au volume logique, cliquez
Commit LV pour créer un autre lecteur ou un autre volume logique.

Quand vous avez fini de créer des volumes logiques et ne désirez plus créer de
lecteur logique, cliquez sur Commit.

Au fur et à mesure que les
lecteurs logiques sont ajoutés
au volume logique, ils sont affichés
dans la zone de définition LV

Available Size – affiche la
capacité totale de tous les
disques, qui correspond à
la taille totale du volume logique
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Remarque – Quand vous avez fini de créer des volumes logiques et que vous
désirez quitter la fenêtre New Configuration, si vous cliquez par erreur sur Commit
LV au lieu de Commit, vous devrez créer un nouveau lecteur logique ; sinon, cliquez
sur Cancel et configurez à nouveau le volume logique.

Pour ajouter ou supprimer un volume logique ou pour partitionner un volume
logique dans une configuration existante, consultez la section « Mise à jour de la
configuration », page 149.

▼ Suppression d'une configuration
Si au cours de la configuration, vous n'êtes pas satisfait des résultats dans la fenêtre
New Configuration vous pouvez l’effacer.

1. Cliquez sur Clear pour supprimer tous les lecteurs physiques et logiques de
l'affichage.

2. Cliquez soit sur New LD pour définir un nouveau lecteur logique, soit sur Commit.

3. Lorsque vous sélectionnez Commit, un avertissement s'affiche, cliquez ensuite sur
OK.

Configuration Service initialise toute la configuration sur le contrôleur de baie
sélectionné.

Remarque – Les unités logiques d'hôte sont automatiquement mappées après le
processus d'initialisation des lecteurs logiques.

▼ Déconnexion du niveau de configuration
Lorsque vous avez terminé avec les activités de configuration, reconnectez-vous au
niveau de surveillance.

1. Sélectionnez File → Logout

2. Sélectionnez Logout to monitoring mode et cliquez sur OK.
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Affectations d'unités logiques d'hôte
Pour que le serveur puisse reconnaître un lecteur/volume logique, il doit d'abord
être mappé à un canal/ID d'hôte. Lorsque le lecteur/volume logique est mappé à un
canal/ID d'hôte, il devient une unité logique. La section suivante décrit le processus
d'ajout ou de suppression d'un lecteur/volume logique sur un canal d'hôte.

Remarque – Quand des lecteurs/volumes logiques viennent d’être créés, et à
condition que Do Not Map ne soit pas sélectionné, les unités logiques de l’hôte sont
mappées automatiquement une fois que les lecteurs/volumes logiques ont terminé
le processus d’initialisation.

Remarque – Sur une baie Sun StorEdge 3310 SCSI, vous pouvez créer huit lecteurs
logiques maximum et 32 partitions maximum par lecteur logique. Vous pouvez
affecter un maximum de 128 unités logiques. Le volume logique peut être divisé en
32 partitions au maximum. Sur une baie Sun StorEdge 3510 FC, vous pouvez créer
huit lecteurs logiques maximum et 128 partitions maximum par lecteur logique.
Il est possible d’affecter 1024 unités logiques maximum (le nombre maximum
d’unités logiques affectées à chaque ID d’hôte est 32). Le volume logique peut être
divisé en 128 partitions au maximum.

▼ Ajout (mappage) d'une unité logique d'hôte
1. Sélectionnez Configuration → Custom Configure.

2. Dans le menu Custom Configuration Options, sélectionnez Change Host LUN
Assignments.
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La fenêtre Change Host LUNs Assignments s'affiche.

3. À l'aide de la zone de liste Select Host Channel and SCSI ID, sélectionnez le canal
et l'ID auxquels l'unité logique doit être affectée.

Toutes les unités logiques disponibles sont affichées sous Partitions. Pour référence,
Used LUNs affiche une liste d’unités logiques utilisées par un certain canal, et
Partition Assignment affiche une liste de canaux, d’ID et d’unités logiques auxquels
une partition a été affectée.

Remarque – Quand un volume logique est ajouté ou créé, il est affecté en tant que
volume principal ou secondaire (controller assignment). Un lecteur/volume logique
est ensuite initialisé et mappé à une ID de canal principale ou secondaire. Si vous
annulez le mappage d’un lecteur/volume logique et le mappez à l’ ID de canal d’un
autre hôte ayant un autre controller assignment, vous devez réinitialiser le contrôleur.
Si vous annulez le mappage d’un lecteur/volume logique et le mappez à une l’ID de
canal d’un autre hôte ayant le même controller assignment, il n’est pas nécessaire de
réinitialiser le contrôleur. Si un lecteur/volume logique a des partitions encore
mappées, les partitions non mappées ne peuvent l’être qu’à l’ID de canal d’un hôte
ayant le même controller assignment.
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4. Sélectionnez la partition désirée dans le champ LDs/LVs, puis cliquez sur Assign
Host LUN pour accepter le changement.

Pour mapper plusieurs partitions (32 maximum), sélectionnez la première partition,
parcourez la liste jusqu’à la dernière partition et cliquez tout en maintenant appuyée
la touche Shift pour sélectionner tous les élements contenus dans la liste. Cliquez
ensuite sur Assign Host LUN.

En conséquence, la fonction Delete Host LUN est activée.

5. Une fois terminé, cliquez sur OK pour enregistrer vos modifications et revenir au
menu principal.

Remarque – Au cas où un message d'erreur s'affiche lors du mappage d'un canal
d'hôte, répétez les étapes 1 à 5.

▼ Suppression (annulation du mappage) d'une
unité logique d'hôte

1. Avec la fenêtre Change Host LUN Assignments affichée, sélectionnez les unités
logiques que vous voulez supprimer du champ Host LUN Assignments.

2. Cliquez sur Delete Host LUN.

3. Une fois terminé, cliquez sur OK pour enregistrer vos modifications et revenir au
menu principal.

Configuration File
Conservez une copie de sauvegarde de la configuration de votre lecteur logique actuel
sur disquettes ou sur un périphérique externe autre que la baie de disques. Bien que
les informations de la configuration soient enregistrées sur les contrôleurs de baie et
sur les lecteurs physiques annexés, des situations particulières telles qu'un incendie ou
une inondation peuvent se présenter endommageant le contrôleur et les lecteurs. Une
copie de sauvegarde de la configuration vous permet de restaurer la configuration sur
un nouveau contrôleur sans devoir reconfigurer totalement la baie de stockage.

Enregistrez toujours la configuration de contrôleur de baie sur un fichier à chaque :

■ installation d'un nouveau boîtier de système de stockage ou modification de l'ID
SCSI du contrôleur dans un boîtier existant ;

■ remplacement d'un contrôleur de baie ;

■ reconfiguration ou ajout des lecteurs logiques sur un contrôleur de baie ;

■ reconstruction les données d'un lecteur défectueux sur un lecteur en attente.
84 Guide de l’utilisateur Sun StorEdge 3000 Family Configuration Service 1.2 • avril 2003



▼ Enregistrement de la configuration dans un
fichier de sauvegarde

1. Sélectionnez le contrôleur avec la configuration à enregistrer.

2. Sélectionnez Configuration → Save Configuration.

La fenêtre Save Configuration est affichée.

3. Si besoin, naviguez vers le lecteur et le dossier où vous voulez enregistrer le
fichier de configuration.

Enregistrez le fichier sur une disquette ou sur un lecteur externe à la baie de disques.

4. Indiquez le nom du fichier de configuration et cliquez sur Save.

La fenêtre Save Configuration s'affiche.

5. Tapez une description de la configuration à enregistrer.
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6. Cliquez sur OK.

Configuration Service enregistre les informations de configuration du contrôleur
dans un fichier .cfg.

Chargement de la configuration
Si un lecteur ou un contrôleur est endommagé et doit être remplacé, voir
« Restauration de la configuration du lecteur logique », page 143, qui décrit le
processus de chargement d'un fichier de configuration et de restauration de la
configuration d'un lecteur logique.
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CHAPITRE 8

Filtrage des unités logiques
(uniquement Fibre Channel)

Ce chapitre décrit la procédure de création d’un filtre d’unité logique (LUN) pour la
baie de disques Sun StorEdge 3510 Fibre Channel pour la gestion de grands réseaux
Fibre Channel partageant un stockage commun. Les rubriques suivantes sont
couvertes dans ce chapitre :

■ « Vue d'ensemble », page 87
■ « Affectation d’un filtre d’unité logique », page 89
■ « Pour ouvrir LUN Filter View », page 89
■ « Pour ajouter manuellement les périphériques HBA », page 90
■ « Pour supprimer le mappage d’hôte standard », page 92
■ « Pour effectuer un mappage des lecteurs logiques aux hôtes », page 93
■ « Pour supprimer un filtre d’unité logique », page 96

Vue d'ensemble
L’activité de gestion d’une infrastructure de stockage est d’autant plus efficace que
les données résultent tout le temps accessibles et sécurisées. Grâce à la prise en
charge du filtrage LUN, Configuration Service offre un utilitaire de gestion sécurisée
de l’accès au stockage centralisé.

Lorsque plusieurs serveurs sont connectés à la même baie, le filtrage LUN offre un
chemin exclusif depuis un serveur vers un lecteur logique et ne permet pas aux
autres serveurs connectés de voir le même lecteur logique ou d’y accéder. Le filtre
d’unité logique organise ainsi le mode d’accès et de vision des périphériques de
baies de la part des périphériques hôtes et, en général, effectue le mappage de la baie
à un seul hôte de manière à empêcher l’accès et l’utilisation du même périphérique
de baie de disques de la part d’autres hôtes. Le filtrage LUN autorise aussi le
mappage de plusieurs lecteurs logiques ou partitions sur le même numéro de LUN,
permettant ainsi d’amorcer plusieurs serveurs à partir de leur propre LUN 0, le cas
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échéant. Le filtrage de LUN est en mesure aussi de clarifier le mappage lorsque
chaque adaptateur de bus hôte (HBA) voit habituellement, via un concentrateur, un
nombre double de lecteurs logiques.

Un identificateur unique, nommé World Wide Name (WWN), est associé à chaque
périphérique Fibre Channel. Le WWN est donné par l’institut IEEE et est semblable
à une adresse MAC du protocole IP ou à une adresse URL sur l’Internet. Ces
identificateurs WWN se conservent pendant toute la vie des périphériques auxquels
ils sont associés. Le filtrage LUN les utilise pour spécifier le serveur qui aura l’usage
exclusif d’un lecteur logique déterminé. Avec un simple glisser-déposer, vous
pouvez effectuer le mappage de chaque lecteur logique à la carte HBA Fibre Channel
d’hôte, identifiée par un WWN.

Comme l'illustre l'exemple suivant, lorsque vous effectuez le mappage de LUN 01 au
canal hôte 0 et que vous sélectionnez WWN1, le serveur A est propriétaire d’un
chemin à ce particulier lecteur logique. Tous les serveurs continuent de voir et
d’accéder à LUN 02 et à LUN 03 à moins de créer des filtres sur eux.

FIGURE 8-1 Exemple de filtrage de LUN

Un des avantages du filtrage des LUN est la possibilité d’associer plusieurs hôtes tel
que Windows NT à une baie de disques via un port commun Fibre Channel tout en
préservant la sécurité du LUN.

02 03

WWN
(1) 210000E08B021D15

(2) 210000E08B02DE2F

(3) 210000E08B22DE2F

LUN ID LUN ID LUN ID
01 XX XX

XX 02 XX

XX XX 03

WWN1 WWN2 WWN3

A: B C:

01
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Affectation d’un filtre d’unité logique
L’affectation d’un filtre d’unité logique comporte les étapes suivantes :

■ Ouvrez la fenêtre LUN Filter

■ Ajoutez manuellement un périphérique HBA (si vous ne voyez pas le HBA voulu)

■ Supprimez le mappage standard

■ Effectuez le mappage des lecteurs logiques aux hôtes

▼ Pour ouvrir LUN Filter View
1. Cliquez sur l’onglet Filter View pour ouvrez LUN Filter View.

2. Cliquez sur le symbole du conteneur pour développer les arborescences du
lecteur et voir en détail les serveurs affichés à gauche et les périphériques de baie
à droite.
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▼ Pour ajouter manuellement les périphériques
HBA
Si le périphérique HBA voulu n’apparaît pas sous la liste Hosts, ajoutez-le
manuellement dans la fenêtre Configure Host/WWN.

1. Sélectionnez Configuration → Configure Host/WWN.

2. Dans la liste Available Hosts, sélectionnez l’hôte auquel vous voulez ajouter le
périphérique HBA et cliquez sur Edit.

Si l’hôte se trouve dans la liste Connected Hosts, sélectionnez-le et cliquez sur
Remove pour le placer dans la liste Available Hosts.

3. Dans la case Add/Edit Host, cliquez sur Add.
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4. Dans la case suivante Add/Edit HBA, saisissez le nouveau Adapter Name et le
WWN approprié, puis cliquez sur OK.

Pour obtenir de plus amples informations sur la détermination du WWN, voir
« Détermination des noms d’hôtes universels WWN », page 219.

5. Dans la fenêtre Configure Host/WWN, sélectionnez l’hôte saisi et cliquez sur Add
pour le placer dans la liste Connected Hosts list, puis cliquez sur OK.

Lorque vous allez sur LUN Filter view, le nouveau périphérique HBA est grisé et
disponible pour le filtrage LUN.
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▼ Pour supprimer le mappage d’hôte standard
Le mappage standard permet à tous les hôtes de voir tous les lecteurs logiques avec
mappage standard. Le filtrage LUN limite le mappage à un ou à plusieurs hôtes
spécifiques. Avant d’affecter un filtre d’unité logique, vous devez supprimer le
mappage d’hôte standard (indiqué par les étiquettes M ) de la baie.

1. Cliquez sur chaque élément de All Hosts et glissez-déposez dans Storage Pools.

2. Cliquez sur OK dans le message suivant :

Un message vous confirmant que la suppression du mappage d'unité logique d'hôte
standard a été faite avec succès s’affiche.

3. Si l’hôte n’est pas l’agent primaire de la baie et vous voulez effectuer un mappage
du périphérique à l’hôte, sélectionnez le périphérique puis, Configuration →
Configure Host/WWN.

4. Mettez en surbrillance l’hôte voulu dans la liste Available Hosts list et cliquez sur
Add pour ajouter l’hôte à la liste Connected Hosts.

Un message confirmant l’ajout du serveur hôte s’affiche.

5. Cliquez sur Close pour sauvegarder la configuration et fermer la fenêtre.

6. Si vous voulez effectuer un mappage de plusieurs hôtes à une baie, sélectionnez
Configuration → LUN Filter Properties, puis sélectionnez la baie dans le menu
déroulant.

7. Cochez les cases Hardware Filter et Map to Multiple Hosts puis, cliquez sur OK.

Remarque – Si vous ne cochez pas la case Hardware Filter, vous ne pouvez pas
créer un mappage du filtre mais uniquement un mappage standard.

Operation will delete all standard maps of Logical Drive X
Partition X. Do you want to continue?
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▼ Pour effectuer un mappage des lecteurs logiques
aux hôtes

1. Veillez à ce que vous vous trouviez encore dans LUN Filter view ; autrement,
cliquez sur l’onglet Filter View.

2. Sélectionnez un lecteur logique dans Storage Pools puis, glissez-déposez dans la
carte HBA appropriée sous Hosts.

Si la carte HBA connectée à la baie n’est pas connue, glissez-déposez le lecteur
logique sur l’hôte.

Le programme vous invite à filtrer la baie pour chaque carte HBA d’hôte (ce qui
signifie qu’elle est visible à la carte HBA associée et qu’elle n’apparaît pas aux autres
cartes HBA).
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3. Quand le message vous confirmant le mappage s’affiche, cliquez sur OK.

La fenêtre Specify Map Information s’affiche. Remarquez que Configuration Service
effectue automatiquement le mappage du lecteur logique à la première carte HBA
listée dans l’hôte, s’il y a plus d’une carte HBA.

4. Associez le lecteur logique au contrôleur primaire ou secondaire avec les numéros
de canal et de LUN ID voulus, puis cliquez sur OK.

L’association du contrôleur primaire ou secondaire à la carte HBA est sélectionnée à
l’association initiale du filtre d’unité logique et elle ne peut être modifiée à moins
que vous ne supprimiez l’association du filtre d’unité logique et ne recommenciez.
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Pour appliquer un filtre d’unité logique à un deuxième hôte pour une baie, répétez de
l’étape 6 sous « Pour ajouter manuellement les périphériques HBA », page 90 à l’étape 3
sous « Pour effectuer un mappage des lecteurs logiques aux hôtes », page 93.

Un message s’affiche vous informant que deux utilisateurs accédant au même
lecteur logique en même temps peuvent causer la corruption des données ;
cliquez sur OK pour ajouter l’hôte supplémentaire.

Dans l’exemple qui suit, le périphérique Sun StorEdge 3510 Fibre Channel a deux
filtres LUN (notez la lettre F indiquant le filtre) pour deux hôtes différents.
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▼ Pour supprimer un filtre d’unité logique
1. Sélectionnez le WWN associé.

2. Glissez-déposez dans Storage Pools.

3. Lorsque le message vous confirmant que le mappage est supprimé s’affiche,
cliquez sur OK.

4. Lorsque le second message de confirmation s’affiche, cliquez sur OK.
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CHAPITRE 9

Surveillance de la baie

Ce chapitre explique comment surveiller la baie avec Configuration Service. Il décrit la
fenêtre principale de Configuration Service ainsi que les fenêtres des composants
disponibles lorsque vous double-cliquez sur une icône dans la fenêtre principale. Il
couvre également le fonctionnement d'Event Log ainsi que l'utilisation de la fonction de
rapport de Configuration Service. Ce chapitre s'articule selon les sections suivantes :

■ « Fenêtre principale de Configuration Service », page 97
■ « Affichage d'informations détaillées sur le périphérique », page 104
■ « Event Log », page 118
■ « Save Report », page 122
■ « View Report », page 128
■ « Gestion de stockage hors bande », page 128
■ « Gestion du stockage via Internet », page 132

Fenêtre principale de Configuration
Service
La fenêtre principale de Configuration Service permet de déterminer très rapidement
l'état de tous les périphériques de baie. Elle indique l'état de ces périphériques ainsi
que des lecteurs logiques connectés aux serveurs surveillés par la console
Configuration Service. Les périphériques incluent les contrôleurs de baie, les boîtiers
de stockage de disque, les lecteurs de disque physiques et d’autres périphériques SCSI.

La structure arborescente de cette fenêtre offre des détails sur tous les périphériques
connectés à chacun des serveurs. Le symbole du conteneur ou à gauche de
l'arborescence indique si l'affichage des périphériques est développé ou réduit. Le
symbole du conteneur signifie que vous pouvez cliquer dessus pour afficher plus
de périphériques. Le symbole du conteneur indique que tous les dispositifs à ce
niveau ou à un niveau inférieur sont affichés.
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La figure suivante illustre un exemple de l'affichage développé de la fenêtre
Configuration Service.

Remarque – Le numéro SN# représente l'ID unique de la baie.

La figure ci-dessous illustre un exemple d'un affichage réduit.

Pour de plus amples informations, double-cliquez sur une icône qui ouvre la fenêtre
d'affichage d'un composant. Les affichages de composants sont traités par la suite
dans ce chapitre.
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La fenêtre principale de Configuration Service affiche les états des périphériques
avec des couleurs et des symboles, ce qui permet d'identifier facilement si un
périphérique a besoin d'une attention immédiate. L'état se propage le long de
l'arborescence du périphérique vous permettant de retracer la défaillance jusqu'au
niveau du périphérique. Voir TABLEAU 9-1 pour de plus amples informations sur l'état
des périphériques.

Aide en ligne
Pour accéder à l’aide en ligne, sélectionnez Help → Contents. L'aide en ligne est
au format HTML et vous pouvez y accéder via Internet Explorer ou Netscape.
Elle contient des informations sur les fonctions principales de ce programme.

TABLEAU 9-1 État des périphériques

Couleur Symbole État

Violet Aucun Le groupe, le serveur ou le périphérique sont en ligne.

Blanc Aucun L'utilisateur n'est pas connecté à ce serveur.

Jaune Un ou plusieurs composants de ce groupe ou serveur ne
fonctionnent pas correctement mais la baie de disques est
toujours opérationnelle. À titre d'exemple, un lecteur
logique qui aurait un lecteur physique défaillant
fonctionne dans un état détérioré.

Rouge Un ou plusieurs composants de ce groupe ou serveur ne
fonctionnent pas. Un lecteur logique avec deux lecteurs de
disque défaillants ou un boîtier avec trois ventilateurs
défaillants serait dans un état critique.

Gris Le groupe, le serveur ou le périphérique ne répondent pas.

?
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Affichage arborescent des configurations du
produit
Pour chacun des serveurs (ou groupes de serveurs), les périphériques figurant dans
l'arborescence sont organisés hiérarchiquement avec le serveur (ou groupe) en haut,
suivi des contrôleurs de la baie. L'affichage des périphériques restants (à savoir
lecteurs logiques, lecteurs physiques et boîtiers) sont indiqués différemment en
fonction de la baie et du contrôleur affichés. Cette section présente des exemples de
fenêtre pouvant être représentées en une arborescence.

Groupes

Un groupe représente un ensemble logique de serveurs dans l'arborescence de
périphériques. Ce nouvel objet de données permet de contenir des serveurs
multiples sous une seule catégorie.

L'objet de groupe ressemble et se comporte comme les objets type dans
l'arborescence. Sa représentation est sous forme d'icône et il adopte en principe l'état
de ses serveurs. La figure suivante illustre l'icône de groupe développé affichant les
objets du serveur subordonnés ou sous-jacents.

Un groupe représente un nouvel objet de données permettant de contenir des
serveurs multiples sous une seule catégorie. D'un point de vue conceptuel, les
groupes sont semblables aux domaines. Ils permettent de mieux organiser les
serveurs dans Configuration Service. Au lieu d'organiser les serveurs gérés en une
arborescence linéaire, l'opérateur Configuration Service peut les grouper en
ensembles ou groupes de serveurs semblables.
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Les groupes, tout comme les serveurs, sont codés en couleurs et en symboles. Pour ce
schéma, les états avec leur couleur correspondante ont l'ordre de précédence suivant :

■ Critique – rouge (priorité la plus sérieuse)
■ Sans réponse – gris
■ Détérioré – jaune
■ Optimal – violet
■ Non connecté – blanc

Une icône de serveur adopte la couleur de l'état le plus critique de l'un des systèmes
de stockage. Une icône de groupe adopte l'état le plus critique de l'un de ses
serveurs, avec les exceptions suivantes impliquant des serveurs qui ne répondent
pas ou qui sont déconnectés.

Lorsqu'une icône de groupe est désactivée, cela signifie que tous les serveurs connectés à
ce groupe ne répondent pas ; si au moins un serveur répond, l'icône de groupe s'affiche
en rouge, représentant un état critique. À titre d'exemple, s'il y a quatre serveurs dans le
groupe et que trois serveurs ou moins ne répondent pas, l'icône du groupe est rouge.

Lorsqu'une icône de groupe est blanche (indiquant pas de déconnexion à Configuration
Service), cela signifie qu'un ou plusieurs serveurs dans ce groupe n'ont pas encore été
totalement configurés ou qu'il s'agit d'une période de transition d'état. Le TABLEAU 9-2
illustre un exemple de codage couleur différent d'un groupe à deux serveurs.

La définition de groupes n'est pas obligatoire. On peut configurer Configuration
Service pour zéro groupe et quinze serveurs, par exemple, ou pour un groupe
comprenant dix serveurs et cinq serveurs figurant à la racine de l'arborescence.
Configuration Service permet toutes les combinaisons possibles.

Le nombre de groupes et le nombre de serveurs par groupe ne sont limités que par
la mémoire du système disponible. Lorsqu'un utilisateur supprime un groupe de la
zone de liste des groupes, Configuration Service réaffecte les serveurs appartenant à
ce groupe à la catégorie « aucun groupe ». Configuration Service actualise
automatiquement l'arborescence dans la fenêtre principale.

TABLEAU 9-2 Couleurs d'un groupe à deux serveurs

Serveur 1
Couleur d'icône

Serveur 2
Couleur d'icône Couleur d'icône de groupe

Gris
Gris

Gris
Jaune, Rouge, Violet ou Blanc

Gris (aucune réponse)
Rouge (critique)

Blanc Blanc Blanc (non connecté)

Blanc Jaune Jaune (détérioré)

Blanc Rouge Rouge (critique)

Blanc
Rouge

Violet
Toutes les couleurs

Violet (optimal)
Rouge (critique)

Jaune
Violet

Jaune ou violet
Violet

Jaune (détérioré)
Violet (optimal)
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Processus de surveillance de Configuration
Service
La console de Configuration Service surveille les périphériques de stockage sur un
réseau en communiquant avec l'agent Configuration Service sur les serveurs.

Au lancement de Configuration Service, le logiciel de la console commence à établir
le contact avec l'agent Configuration Service sur tous les serveurs gérés si l'option
Auto Discovery a été indiquée lors de la configuration du serveur. Si l’option Auto
Discovery n'a pas été indiquée, vous devez double-cliquer sur chacun des serveurs et
saisir un mot de passe pour lancer le processus de découverte de ce serveur.

L'établissement d'une connexion TCP/IP entre la console et l'agent Configuration
Service sur chacun des serveurs et le retour d'information d'inventaire peut prendre
quelques minutes en fonction de la complexité du réseau. Dans ce cas, l'icône du
serveur dans la fenêtre principale de Configuration Service affiche une antenne
satellite à sa droite. Après l'actualisation de l'inventaire, le symbole de l'antenne
satellite est remplacé par un symbole de serveur actif.

L'agent sur chacun des serveurs effectue une analyse périodique de son inventaire
afin de vérifier si des changements ont eu lieu. S'il détecte un changement, il envoie
un événement à la console. En fonction de l'événement, la console peut demander
l'inventaire de la dernière analyse du serveur dont elle se servira pour l'actualisation
de la représentation du serveur telle qu'affichée sur la fenêtre principale de
Configuration Service. Au cours de ce processus, l'icône en forme d'antenne satellite
s'affiche près de l'icône du serveur et vous ne pouvez pas exécuter de commande de
configuration et de baie sur ce serveur tant que le processus d'actualisation est en
cours et que la fenêtre principale de la console est actualisée.

Lorsque Configuration Service est en marche, que l'agent du serveur et la console
sont connectés, l' agent envoie des commandes ping ou transmet un signal
périodique à la console afin de vérifier l'état du serveur. Si la console ne reçoit pas
un certain nombre de réponses consécutives (protocole de transfert) de l'agent, la
console marque le serveur comme hors ligne et se déconnecte du serveur. L'icône du
serveur est inactive et signalée par un point d'interrogation.

Si un serveur non actif a été activé via la fonction Auto Discovery, la console essaie
régulièrement de rétablir la communication au serveur.

Il est recommandé d'effectuer un inventaire sur un serveur entre les analyses
périodiques d'état. Pour ce faire, double-cliquez sur l'icône du serveur afin d’afficher
la fenêtre, puis cliquez sur Rescan dans cette fenêtre.
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Options d'Auto Discovery
Si vous avez sélectionné l'option Auto Discovery (au cours du processus d'ajout de
serveurs à la liste Managed Servers, voir, « Sélectionnez ou désélectionnez
Automatic Discovery pour les serveurs : », page 45), Configuration Service analyse
et exécute automatiquement un inventaire de ces serveurs. Vous n'êtes pas obligé de
saisir un mot de passe de surveillance pour extraire des informations fournies par
Configuration Service. En fonction de la complexité du réseau et du nombre de
serveurs, le processus de découverte peut prendre quelques minutes.

Cependant, si vous décidez de ne pas utiliser l'option Auto Discovery au démarrage,
les icônes du serveur sont blanches, indiquant qu'il n'y a pas d'informations
disponibles sur ces serveurs. Dans ce cas, vous devez double-cliquer sur chacune des
icônes de serveur et indiquer le mot de passe de surveillance approprié.

Vous pouvez également sélectionner File → Login. Après avoir indiqué le mot de
passe d'un serveur, Configuration Service lance le processus de découverte pour
l'exécution d'un inventaire sur le serveur sélectionné.

Remarque – Si vous avez besoin d'un environnement avec accès restreint aux données
d'inventaire du serveur, Sélectionnez No pour Auto Discovery (voir « Sélectionnez ou
désélectionnez Automatic Discovery pour les serveurs : », page 45).
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Affichage d'informations détaillées sur le
périphérique
Configuration Service fournit des informations détaillées sur chacun des agents
Configuration Service ou serveurs ainsi que sur les périphériques de baie qui lui
sont connectés. Les champs de chacune de ces vues varient en fonction de la capacité
du contrôleur de disque.

À l’exception de Save Report et View Report, qui sont situés sous le menu File, vous
pouvez accéder aux commandes et aux fenêtres décrites dans cette section via le
menu View.

■ View Group
■ View Server
■ View Controller Configuration
■ View Logical Drive
■ View Physical Drive
■ View Enclosure
■ View FRU
■ Array Administration Progress
■ Agent Options Management
■ Save Report
■ View Report
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View Group
La commande View Group affiche les serveurs formant le groupe sélectionné dans la
fenêtre principale Configuration Service.

Pour accéder à View Group, double-cliquez sur l'icône de groupe dans la
fenêtre principale de Configuration Service ou sélectionnez d'abord l'icône de
groupe, puis View → View Group.

La liste Server List affiche tous les serveurs connectés au groupe spécifié.

Pour afficher plus d'informations sur l'un des serveurs répertoriés, sélectionnez
l'enregistrement d'état approprié dans la liste et cliquez ensuite sur View ou double-
cliquez sur l'enregistrement d'état. Une fenêtre décrivant le serveur correspondant
s'affiche.
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View Server
La commandeView Server affiche les caractéristiques du serveur sélectionné dans la
fenêtre principale de Configuration Service.

Pour accéder à View Server, double-cliquez sur l’icône du serveur dans la fenêtre
principale de Configuration Service ou sélectionnez d'abord l'icône du serveur puis
View → View Server.

Remarque – Des entrées distinctes représentent les adaptateurs de bus hôte (HBA) à
double port dans la mesure où ils sont dotés de canaux séparés pour les périphériques.

Une partie du réseau TCP/IP, le port du connecteur établit une connexion entre le
serveur et le client.

■ Rescan – cette fonction permet d'envoyer une commande au serveur sélectionné
lui indiquant d'analyser à nouveau l'inventaire existant et de régénérer la console.
En principe, tous les serveurs gérés exécutent une analyse périodique de leur
inventaire et actualisent la console en cas de modification. Pour diagnostiquer
tous les périphériques affectés, cliquez sur Rescan ; ce bouton permet de
contourner les actualisations d'état périodiques et automatiques.
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■ Probe – cette fonction envoie une commande au serveur sélectionné lui indiquant
de détecter tout nouvel inventaire (comme par exemple, des contrôleurs RAID, des
JBOD et des unités d'extension). Lorsqu'un nouveau périphérique a été ajouté ou
qu'un nom de périphérique a changé et que vous voulez l'afficher immédiatement
dans l'arborescence de la fenêtre de Configuration Service, cliquez sur Probe.

■ Card List – cette fonction permet d'afficher les adaptateurs hôtes ainsi que les
contrôleurs de baie qui ont été installés ou connectés à un serveur spécifié. Pour
afficher plus d'informations sur l'un des adaptateurs hôtes ou contrôleurs de baie
de la liste, sélectionnez l'enregistrement dans la liste et cliquez ensuite sur View
ou double-cliquez sur l'enregistrement d'état sélectionné. Une fenêtre décrivant
l'adaptateur hôte ou le contrôleur de baie correspondant s'affiche.

View Controller Configuration
View Controller Configuration affiche les composants qui forment la baie.

Pour accéder à View Controller Configuration, double-cliquez sur l'icône de la baie
dans la fenêtre principale de Configuration Service ou sélectionnez l'icône,

puis View → View Controller.
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Si la batterie défaille, la baie affiche le symbole jaune d’état de périphérique (détérioré)
dans la fenêtre principale de Configuration Service et le champ Battery indique Bad.

Les onglets en bas de la fenêtre fournissent des informations détaillées sur les unités
logiques du contrôleur RAID, sur les lecteurs physiques qui lui sont connectés, sur
le boîtier où se trouve le contrôleur et sur la configuration des périphériques.
Pour afficher les informations d'un autre onglet, cliquez sur l'onglet.

Onglet Controller

Pour accéder à cette fenêtre, double-cliquez sur l’icône de la baie dans la
fenêtre principale de Configuration Service ou sélectionnez d'abord l'icône puis
View → View Controller. Cliquez ensuite sur l’onglet Controller.

L'onglet Controller affiche les deux contrôleurs. Pour afficher advantage
d'informations sur l'un des contrôleurs, double-cliquez sur le contrôleur voulu ou
sélectionnez le contrôleur, puis cliquez sur View. Si le contrôleur est principal, la
fenêtre View Primary s'affiche ; s'il est secondaire, la fenêtre View Secondary
Controller Configuration s'affiche. Voir « View Primary/Secondary Controller
Configuration », page 111.
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Onglet Physical Drives
Pour accéder à cette fenêtre, double-cliquez sur l’icône de la baie dans la
fenêtre principale de Configuration Service ou sélectionnez d'abord l'icône puis
View → View Controller. Cliquez ensuite sur l'onglet Physical Drives.

La figure suivante montre View Controller Configuration avec l'onglet Physical Drives.

L'onglet Physical Drives affiche les lecteurs physiques associés à la baie. Pour afficher de
plus amples informations sur l'un des lecteurs physiques, double-cliquez sur le lecteur
ou sélectionnez le lecteur, puis cliquez sur View. La fenêtre View Physical Drive s'affiche.

Pour de plus amples informations sur View Physical Drive, voir « View Physical
Drive », page 114.
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Onglet Enclosure Info

Pour accéder à cette fenêtre, vous pouvez double-cliquer sur l'icône Enclosure
dans la fenêtre principale de Configuration Service, ou sélectionner d’abord l’icône
de la baie puis View → View Controller. Sélectionnez l’onglet Enclosure Info.
Sélectionnez un boîtier et cliquez sur View.

L’onglet Enclosure Info comprend les informations relatives à l'état de l'alimentation,
des ventilateurs ainsi que la température du boîtier. Pour plus d'informations sur
View Enclosure, voir « View Enclosure », page 115.

View FRU

Pour afficher les informations relatives à l’identité de l'unité remplaçable par
l'utilisateur de la baie (FRU ID), cliquez sur View FRU. Pour obtenir des exemples
d’informations relatifs à l'ID de l'unité remplaçable par l'utilisateur, consultez la
section « View FRU », page 117.

View Controller Parameters

Cliquez sur View Controller Parameters pour afficher des informations détaillées
sur Channels, RS 232, Cache, Disk Array, Drive I/F, Host I/F et Redundancy.
Pour afficher les informations, cliquez sur l'onglet correspondant à l’élément voulu.
Pour changer les paramètres du contrôleur, voir « Modification des paramètres du
contrôleur », page 173.
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View Primary/Secondary Controller Configuration
Les fenêtres View Primary et View Secondary Controller Configuration affichent les
caractéristiques du contrôleur RAID qui est sélectionné dans la fenêtre principale de
Configuration Service. Pour afficher les caractéristiques du contrôleur principal,
sélectionnez-le dans la fenêtre principale de Configuration Service puis View →
View Controller, ou double-cliquez sur le contrôleur principal.

Les deux exemples suivants illustrent le contrôleur principal.
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Les deux exemples suivants illustrent le contrôleur secondaire.
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Onglet Logical Drives
Pour accéder à cette fenêtre d’affichage, double-cliquez sur l'icône du
contrôleur RAID principal ou secondaire dans la fenêtre principale de Configuration
Service, ou sélectionnez l’icône du contrôleur puis View → Controller.

Cliquez sur View Controller Params pour afficher les paramètres modifiables des
composants dans la fenêtre RAID Controller Parameters.

Pour afficher un lecteur logique, sélectionnez et double-cliquez un lecteur dans
l'onglet Logical Drives ou sélectionnez un lecteur puis cliquez sur View.

View Logical Drive
La commande View Logical Drive affiche les caractéristiques du lecteur logique
sélectionné dans la fenêtre principale de Configuration Service.

Vous pouvez accéder à cette fenêtre à l'aide d'une des méthodes suivantes.

■ Double-cliquez sur l'icône du lecteur logique dans la fenêtre principale de
Configuration Service.

■ Sélectionnez l’icône du lecteur logique, puis View → View Logical Drive.

■ Double-cliquez sur l'icône du contrôleur RAID , sélectionnez un lecteur
logique dans la liste, puis cliquez sur View.

Pour afficher de plus amples informations sur l'un des lecteurs de disque de la liste,
double-cliquez sur l'enregistrement d'état du lecteur ou sélectionnez le lecteur, puis
cliquez sur View. La fenêtre View Physical Drive s'affiche.
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View Physical Drive
La commande View → View Physical Drive présente les caractéristiques du
périphérique physique sélectionné. Le titre de la fenêtre qui s'affiche varie en
fonction du périphérique sélectionné.

■ Pour un lecteur de disque , il s’agit de la fenêtre View Physical Drive.

■ Pour un lecteur de bande , il s’agit de la fenêtre View Tape.

■ Pour un lecteur de CD , il s’agit de la fenêtre View CD-ROM.

Vous pouvez accéder à ces fenêtres en double-cliquant sur le périphérique physique
dans la fenêtre principale de Configuration Service ou en sélectionnant le
périphérique puis View → View Physical Drive.
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■ Associated Partitions – zone de la fenêtre qui s'affiche uniquement lorsque le
périphérique sélectionné est associé à l'une ou plusieurs partitions du lecteur
logique.

■ View – le champ est activé lorsque des lecteurs logiques sont associés.

La figure précédente affiche un exemple de la fenêtre View Physical Drive où le
lecteur physique sélectionné est associé à une seule partition.

■ Remaining Size – il s'agit de la capacité inutilisée restante lorsqu'une partie du
lecteur du disque a été utilisée pour un ou plusieurs lecteurs logiques.

■ RPM – les révolutions par minute du lecteur physique.

■ SMART Drive – indique si le lecteur est doté d'une capacité de prévision des
défaillances.

Vous pouvez également sélectionner le lecteur physique puis View. La fenêtre View
Logical Drive s’affiche sans tableau.

Les fenêtres View Tape et View CD-ROM ressemblent à celles qui sont affichées dans
la figure précédente mais les catégories diffèrent légèrement.

View Enclosure
La fenêtre View Enclosure affiche les caractéristiques des composants et des alarmes
du boîtier d’une baie sélectionnée dans la fenêtre principale de Configuration
Service (identifiée par le nom Sun StorEdge 3310 A; l’Id est toujours 14 ou 15).

1. Sélectionnez une icône EMU .

2. Sélectionnez View → View Enclosure.

Les deux sections supérieures de la fenêtre identifient le boîtier et fournissent des
informations connexes. Remarquez que lorsque vous disposez d'une baie de disques
avec des boîtiers multiples, vous pouvez utiliser la liste Enclosure Number (située en
haut à droite de la fenêtre) pour refléter un autre boîtier annexé au même contrôleur
de baie.

Pour afficher les identités FRU ID ainsi que les informations pour toutes les unités
remplaçables dans la baie, cliquez sur View FRU.
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La section Alarm State de la fenêtre n'a d'incidence que si vous disposez d'une baie
dotée d'une carte SCSI Accessed Fault-Tolerant Enclosure (SAF-TE) ou SCSI
Enclosure Services (SES).

■ Si le champ Alarm State affiche Alarm! et que le bouton Reset est actif, cela
signifie qu'il y a un état d'alarme résultant d'une panne d’un lecteur, d'un
ventilateur, d'alimentation ou de batterie ou d'une température anormale dans le
boîtier. L'alarme sonore retentit.

■ Pour que Configuration Service puisse poursuivre la surveillance après le
début de la condition d'alarme, vous devez cliquer sur Reset dans cette fenêtre.
Vous pouvez également cliquer sur Reset sur le boîtier de la baie.

■ Seuls les utilisateurs disposant des privilèges de sécurité de configuration sont en
droit de réenclencher l'alarme via Configuration Service. Remplacez le composant
défaillant ou inspectez le boîtier si la température interne est anormale.

La partie inférieure de la fenêtre indique l'état des composants de la fenêtre.
Lorsqu'un périphérique se trouve dans le logement, il est représenté par une icône
de lecteur colorée et dotée d'un symbole représentant son état.
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View FRU
Une unité FRU est une unité remplaçable par l'utilisateur. Il s'agit d'une pièce
utilisée pour assembler un nouveau système ou pour réparer un système sur site.
Le programme Sun FRU ID (ID de l'unité remplaçable par l'utilisateur) est une
solution Sun permettant de capturer, transmettre et analyser une configuration
spécifique à l'unité remplaçable par l'utilisateur, de diagnostiquer et d'obtenir des
informations relatives à la panne résidant sur l'unité remplaçable par l'utilisateur.

Sélectionnez View → View FRU pour afficher les ID des unités remplaçables par
l'utilisateur ainsi que les informations pour toutes les unités remplaçables par
l'utilisateur dans la baie, y compris Serial Number, Model, Description, Vendor ID,
Time (heure de la programmation de l'unité remplaçable par l'utilisateur) et Location.

Remarque – Vous pouvez également afficher les unités remplaçables par
l'utilisateur pour un contrôleur donné en cliquant sur View FRU de la fenêtre View
Controller Configuration, celle de View Primary Controller Configuration et View
Secondary Controller Configuration.
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Array Administration Progress
La fenêtre Array Admin Progress affiche les progrès de l'initialisation d'un ou des
nouveaux lecteurs logiques. Vous pouvez accéder à cette commande en sélectionnant
View → Array Admin Progress.

Agent Options Management
La commande Agent Options permet de personnaliser les options de l'agent
Configuration Service, y compris le temps d'interrogation, le temps de découverte
périodique de périphérique et la surveillance SMART.

Pour accéder à Agent Options, sélectionnez View → Agent Options Management.
Pour plus d'informations, voir « Configuration des paramètres de l'agent
(optionnelle) », page 54.

Event Log
La console de Configuration Service reçoit, enregistre et affiche les événements générés
par les serveurs pris en charge et par la console de Configuration Service elle-même.

La majorité des événements est générée par les agents Configuration Service se
trouvant sur les serveurs pris en charge :

■ Changement d'état sur un des périphériques d'un serveur pris en charge, y
compris le serveur lui-même (suite à une panne, un mauvais fonctionnement ou
une déconnexion d'un périphérique)

■ Changements d'inventaire (ajout ou retrait de périphériques)

■ Changements de configuration (changements dans la configuration initiale et
subséquente)

■ Processus de baie exécutés sur le serveur (initialisation, contrôle de parité,
reconstruction)

Bien que les processus de baie soient initiés par la console Configuration Service,
c'est l'agent du serveur qui génère les événements de notification des opérations
après le lancement de ces processus sur le serveur.

La console de Configuration Service génère un plus petit nombre d'événements.
À titre d'exemple, elle génère un événement si elle ne reçoit pas un certain nombre
de pulsations consécutives d'un serveur pris en charge.
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Lorsque la console reçoit un événement, elle l'enregistre dans le fichier Event Log de
Configuration Service,, eventlog.txt, et l’affiche dans la fenêtre Event Log. Si
l'événement s'est produit sur un serveur, la notification de l'événement est envoyée
au journal d'événement d'environnement/système d'exploitation du serveur. Dans le
cas d'un serveur NT, il serait transféré au journal d'événement NT. En outre, lorsque
l'événement se produit sur un serveur et que ce serveur est configuré pour envoyer
des déroutements vers une console de gestion d'entreprise SNMP, telle que HP
OpenView, l'agent du serveur envoie un message de déroutement à cet ordinateur.

En fonction de l'événement reçu, la console peut initier un processus de régénération
pour demander l'inventaire de la dernière analyse périodique du serveur impliqué,
de sorte que la console puisse actualiser l'inventaire du serveur sur la fenêtre
principale de Configuration Service.

Au cours de ce processus de régénération, l'icône sous forme d'antenne satellite
s'affiche près de l'icône du serveur et vous ne pouvez pas exécuter de commandes de
configuration et de baie via Configuration Service sur ce serveur tant que le processus
d'actualisation est en cours et que la fenêtre principale de la console est actualisée.

Fichier Event Log
La fenêtre Event Log de Configuration Service affiche jusqu’à 500 événements à la
fois. Si vous avez plus de 500 événements, seuls les 500 événements les plus récents
s'affichent dans la fenêtre ; toutefois, Configuration Service ne supprime aucun
événement du fichier Event Log, eventlog.txt, et ne le fera que lorsque vous avez
atteint 10 000 événements.

■ Après avoir atteint les 10 000 événements, Configuration Service réduit le fichier
Event Log aux 500 événements les plus récents et accumule ensuite les
événements jusqu'à ce que la limite de 10 000 soit à nouveau atteinte.

■ Les champs de chacun des enregistrements d'événements sont séparés par un
point virgule vous permettant ainsi d'importer facilement le fichier dans une base
de données.

■ Le fichier eventlog.txt est situé dans le répertoire d'installation des fichiers
du programme de la console de Configuration Service.
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Fenêtre Event Log
Pour accéder à Event Log, sélectionnez View → Event Log. Vous pouvez masquer
cette fenêtre en cliquant sur Close et l'ouvrir à nouveau (dans le menu View) sans en
perdre le contenu.

Les consoles de Configuration Service commencent à recevoir des événements
lorsqu'elles sont activées et cela, que la fenêtre Event Log soit ouverte ou non.

1. Pour supprimer le fichier journal, cliquez sur Delete Logfile.

La fenêtre Confirmation s'affiche vous demandant d'enregistrer le fichier journal.

2. Sélectionnez l'une des options suivantes :

■ Sélectionnez yes à l'invite, puis un dossier et un nom de fichier pour enregistrer le
fichier journal.

■ Sélectionnez no à l'invite.

Le contenu du fichier journal est supprimé.

Remarque – Vous pouvez également sauvegarder ou supprimer le contenu du
fichier eventlog.txt à l’aide des icônes Save Event Log et Delete Event Log
situées sur la barre d’outils.
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Chacun des enregistrements d'événement contient les champs indiqués dans le
tableau suivant.

Niveaux de gravité
■ Critical. Un message ne requérant aucune intervention de l'administrateur du

réseau dans le cas d'une panne du périphérique, de l'alimentation ou du
ventilateur par exemple.

■ Warning. Des messages qui indiquent en principe des événements de programme
interne. Toutefois, si un grand nombre de ces messages s'affiche, il se peut qu'il y
ait un problème avec le serveur ou le réseau.

■ Informational. Un message sur les périphériques du serveur qui ne requiert pas
l'intervention de l'administrateur du réseau.

Vous recevez une alarme correspondant au niveau sélectionné ainsi que tout autre
niveau d'une gravité plus sérieuse. Ainsi, si vous sélectionnez Informational, vous
serez averti de toutes les conditions d'alarme. Toutefois, si vous sélectionnez Critical,
vous ne serez averti qu'en cas d'alarme critique.

Pour plus d'informations sur les messages, voir « Dépannage », page 235.

TABLEAU 9-3 Champs d'enregistrement d'événement

Date La date sur le serveur à laquelle s'est produit l'événement.

Time L'heure sur le serveur à laquelle s'est produit l'événement.

Server L'adresse IP du serveur et le nom du serveur.

Card Le nom de la carte, le cas échéant, pour l'événement.

Severity
Un des trois niveaux de gravité : Critical, Warning ou Informational
(ces états sont décrits dans les sous-sections suivantes).

Error Code Le code d'erreur de base et le code d'erreur étendue, séparés par un tiret.

Text Message Un message textuel décrivant l'événement.
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Save Report
Utilisez l'option Save Report de Configuration Service pour créer un fichier texte
contenant toutes les informations disponibles à Configuration Service sur une baie
de disques spécifique.

1. Sélectionnez File → Save Report.

La boîte de dialogue Report servant à confirmer l'ID du serveur s'affiche.

2. Sélectionnez Save report.

La fenêtre Save Report File s’affiche. Les fichiers de compte-rendu sont enregistrés
au format de fichier texte (ASCII).
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3. Saisissez un nom de fichier avec une extension .txt pour identifier le type de
fichier et cliquez ensuite sur Save.

Configuration Service écrit le compte-rendu sur l'inventaire et sur l'état du serveur
sélectionné et de ses périphériques.

L'emplacement par défaut pour l'enregistrement du fichier compte-rendu se trouve
dans le répertoire d'installation de Configuration Service. Il est recommandé de créer
un sous-répertoire pour l'enregistrement des compte-rendus ce qui évite
d'encombrer le répertoire d'installation.

La figure ci-dessous exemplifie un compte-rendu.
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View Report
Utilisez l'option View Report de Configuration Service pour passer en revue un
compte-rendu qui a été généré.

1. Sélectionnez File → View Report.

La boîte de dialogue Open permettant de sélectionner le compte-rendu s'affiche.

2. Sélectionnez le compte-rendu à réviser et cliquez sur Open.

Gestion de stockage hors bande
La capacité de gestion de stockage hors bande de Configuration Service permet de
surveiller et de gérer les baies sur le réseau en utilisant le protocole TCP/IP.
Contrairement à la gestion de stockage intrabande (la méthode standard de gestion
de stockage), qui nécessite l'exécution d'un agent Configuration Service sur le
serveur connecté physiquement à l'unité de stockage, la gestion hors bande ne
présente pas cette exigence. La gestion de stockage hors bande élimine la nécessité
de charger des logiciels supplémentaires dans le serveur et offre la souplesse d'une
surveillance et gestion de stockage à partir de n'importe quel endroit du réseau.
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Les figures suivantes exemplifient des configurations de gestion de stockage
intrabande et hors bande.

FIGURE 9-1 Gestion intrabande

FIGURE 9-2 Gestion de stockage hors bande
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▼ Utilisation de la gestion de stockage hors bande

Remarque – Avant de commencer, assurez-vous qu'une adresse IP statique ou
dynamique a été créée pour la baie.

Remarque – Le contrôleur, SAF-TE et le firmware de lecteur ne peuvent pas être
mis à niveau via une gestion hors bande.

1. Sélectionnez un serveur.

2. Sélectionnez View → Agent Options Management.

3. Dans la fenêtre Agent Options Management, cochez la case Out-Of-Band Agent
preferred over In-Band.

Remarque – Lorsque cette option est cochée, la méthode hors bande prend
précédence sur la gestion de stockage. Si la configuration hors bande est supprimée,
Configuration Service passe au stockage et à la surveillance intrabande après le
lancement/relancement des services.

4. Saisissez l'adresse IP de la baie dans le champ IP Address, puis cliquez sur Add.

5. Pour que Configuration Service puisse reconnaître la baie hors bande et l'afficher
dans la fenêtre principale, sélectionnez le serveur.

6. Sélectionnez View → View Server.
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7. Cliquez sur Probe.

Un adaptateur de bus hôte hors bande s'affiche dans la fenêtre principale de
Configuration Service.
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▼ Suppression d'une baie de disques d’une gestion
hors bande

1. Sélectionnez un serveur.

2. Sélectionnez View → Agent Options Management.

3. Sélectionnez la baie à supprimer sur la liste Managed Primary Agent et cliquez
sur Remove.

L'adaptateur de bus hôte est toujours visible dans la fenêtre principale de
Configuration Service ; pour le supprimer, vous devez arrêter/relancer les services.

Gestion du stockage via Internet
La capacité de gestion de stockage via Internet de Configuration Service permet de
gérer la baie de disques via Internet sans devoir charger tout le package de
Configuration Service. Les étapes suivantes décrivent l'installation de la baie pour
une gestion via Internet et l'accès par un navigateur Internet.

Remarque – Cette fonction n’est pas prise en charge par Linux ; cela signifie que si
l’agent a été installé sur un système utilisant l’environnement d’exploitation Linux,
l’option Configure Web Server de la fenêtre Custom Configure n’est pas disponible.
Vous pouvez charger la console à l’aide d’un navigateur Internet Linux, mais l’agent
doit être installé sur un système fonctionnant sous l’environnement d’exploitation
Solaris.

Conditions relatives au navigateur Internet

Environnement d'exploitation Solaris
■ Netscape 4.76
■ Plug-in Java 1.2.2_02
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Systèmes d'exploitation Microsoft Windows NT/2000
■ Internet Explorer 5.0 ou version ultérieure
■ Plug-in Java 1.2.2_02

ou

■ Netscape 4.76
■ Plug-in Java 1.2.2_02

Configuration de la baie
Bien qu’il ne soit pas nécessaire de charger le package Configuration Service au
complet sur la machine qui servira à accéder à la baie à partir du web, certains
fichiers de Configuration Service sont absolument nécessaires ; par conséquent, le
package de Configuration Service au complet doit être installé sur un autre serveur
pour que vous puissiez transférer les fichiers sur la baie. La procédure suivante
indique comment transférer facilement les fichiers nécessaires à la gestion Internet.

1. Veillez à ce que vous ayez une connexion Ethernet entre le réseau et la baie, et que
vous ayez créé une adresse IP pour la baie.

2. Sélectionnez Configuration → Custom Configure sur le serveur qui a le package
complet de Configuration Service.

3. Sélectionnez Configure Web Server.

4. Vérifiez l’adresse IP de l’agent de gestion (c’est-à-dire l’agent activé sur le serveur
connecté directement au stockage).

5. Tapez l’adresse IP de la baie où les fichiers doivent être transférés et cliquez sur OK.

Remarque – Par défaut, aucun mot de passe n’est créé pour la baie. Si vous en avez
créé un à l’aide de l’application firmware, vous devez le saisir. Pour de plus amples
informations sur la création ou le changement d’un mot de passe, consultez le
Guide de l’utilisateur Sun StorEdge 3000 Family RAID Firmware relatif à votre baie.
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Une fois que le transfert des fichiers a été effectué avec succès, un message de
confirmation s’affiche et il est dès lors possible d’accéder à la console via Internet.

▼ Pour accéder à la console via navigateur Internet
1. Ouvrez le navigateur Web.

2. Tapez l’adresse URL suivante :

3. Poursuivez la surveillance, l'entretien et la mise à jour du stockage conformément
aux instructions stipulées dans les chapitres correspondants dans ce guide.

http:// ip address of workstation/esm.html
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CHAPITRE10

Maintenance de la baie

Ce chapitre décrit comment préserver l'intégrité de la baie grâce à Array
Administration. Les rubriques suivantes sont couvertes dans ce chapitre :

■ « Activités d'Array Administration », page 135
■ « Contrôle de parité », page 136
■ « Planification d'un contrôle de parité », page 137
■ « Lecteurs défaillants », page 139
■ « Reconstruction automatique d'un lecteur à l'aide d'un lecteur en attente »,

page 139
■ « Reconstruction d'un périphérique sans lecteur en attente », page 140
■ « Vérification des progrès du processus de reconstruction », page 141
■ « Reconstruction manuelle d'un lecteur défaillant », page 141
■ « Restauration de la configuration du lecteur logique », page 143
■ « Réinitialisation du contrôleur », page 146
■ « Désactivation du signal sonore du contrôleur », page 146
■ « Réactivation d'un contrôleur défaillant », page 147
■ « Affichage des statistiques de performances », page 148

Activités d'Array Administration
Les activités d’administration de la baie telles que l’initialisation, la reconstruction
du lecteur et le contrôle de parité peuvent durer un certain temps, selon la taille du
lecteur logique ou des lecteurs physiques concernés.

Après avoir lancé un de ces processus, la fenêtre Controller Array Progress s'affiche.
Si vous fermez la fenêtre, vous pouvez visualiser les progrès en cliquant sur
l’icône Progress Indicator ou en sélectionnant View → Array Admin Progress.
135



▼ Contrôle de parité
Le contrôle de parité permet de vérifier l'intégrité des données redondantes stockées
sur des lecteurs ou unités logiques à tolérance de pannes (RAID 3 et 5).

1. Sélectionnez le lecteur logique sur lequel vous souhaitez exécuter le contrôle de
parité.

2. Sélectionnez Array Administration → Parity Check.

Remarque – Vous devez être connecté soit comme ssadmin soit comme ssconfig
pour accéder aux options de ce menu.

3. Lorsque la fenêtre Logical Drive Parity Check s'affiche, sélectionnez le lecteur
logique sur lequel vous souhaitez exécuter un contrôle de parité.
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Pour exécuter un contrôle de parité sur plusieurs lecteurs, utilisez la commande
Array Administration → Schedule Parity Check pour planifier un contrôle de parité
à exécuter très prochainement (dans trois minutes par exemple). Lorsque le contrôle
de parité planifié est exécuté, il effectue automatiquement l'un après l'autre tous les
contrôles de parité.

4. Cliquez sur le bouton Parity Check pour lancer le processus de contrôle de parité.

Une fois le contrôle de parité lancé, l'indicateur Progress Indicator est
automatiquement affiché. Si cette fenêtre est fermée, vous pouvez la réouvrir en
sélectionnant View → Array Admin Progress ou en cliquant sur l’icône Progress
Indicator. Une fenêtre s'affiche indiquant le pourcentage du progrès d'exécution
pour chacune des baies.

▼ Planification d'un contrôle de parité
Sélectionnez Array Administration → Schedule Parity Check pour contrôler la parité
d'un baie de lecteur logique spécifique aux intervalles planifiés (à titre d'exemple,
pendant les heures creuses).

■ Vous pouvez planifier le contrôle de parité pour n'importe quel nombre de
lecteurs logiques configurés sur un serveur géré ; toutefois, vous ne pouvez
établir qu'un programme par contrôleur de baie.

■ Lorsque vous planifiez plusieurs lecteurs logiques, le contrôle s'effectue en
séquence ascendante en commençant par le numéro du lecteur logique le plus bas.

■ Un contrôle de parité requiert environ cinq minutes par giga-octet de données.

■ Vous pouvez déterminer les ressources système affectées au contrôle de parité en
changeant le taux d'utilisation en arrière-plan.

■ Un contrôle de parité peut être arrêté une fois lancé. Cette action ne risque pas de
corrompre les données.

Remarque – Vous devez être connecté soit comme ssadmin soit comme ssconfig
pour accéder aux options de ce menu.

1. Sélectionnez le contrôleur sur lequel vous souhaitez planifier le contrôle de parité.

2. Sélectionnez Array Administration → Schedule Parity Check.

La fenêtre Schedule Parity Check s'affiche.
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3. Effectuez les sélections dans les champs appropriés de cette fenêtre.

■ Listed Logical Drives – Liste des baies logiques à tolérance de pannes disponibles.
Sélectionnez plusieurs lecteurs à l'aide de la touche Maj.

■ Background Rate – Pourcentage de temps processeur disponible du contrôleur de
baie affecté aux activités d'administration de la baie. Sélectionnez Change
Controller Parameters dans la fenêtre Custom Configuration Options pour
changer le taux d'utilisation en arrière-plan (background rate).

■ How Often – Indiquez la fréquence du contrôle de parité.

■ Starting Day – Indiquez le jour de la semaine pour le lancement de cette planification.

■ Starting Time – Indiquez l'heure du jour de lancement de cette planification.

■ Existing Schedule – La planification de parité courante : lecteur logique,
fréquence, jour de lancement et heure.

■ Next Parity Check – La date et l'heure de lancement du prochain contrôle de parité.

4. Si vous êtes satisfait de la planification, cliquez sur OK.
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Lecteurs défaillants
Cette section porte sur les procédures de recouvrement d'un lecteur défaillant avec
et sans lecteur en attente. Si, pour une raison quelconque, ces procédures ne
lançaient pas le processus de reconstruction, des instructions de lancement manuel
d'une reconstruction après défaillance du lecteur sont également indiquées.

Précaution – Installez des lecteurs locaux ou globaux en attente précédemment
installés et configurés pour chacune des baies de lecteur logique avant qu'une panne
ne survienne. En fonction du type de niveau RAID utilisé et de la procédure
d'archivage implantée, d'importantes pertes de données peuvent se produire en cas
de défaillances d'un seul ou de plusieurs lecteurs. Mettez également à disposition
sur le site des lecteurs de réserve testés qui peuvent être utilisés immédiatement en
cas de mauvais fonctionnement.

▼ Reconstruction automatique d'un lecteur à l'aide
d'un lecteur en attente
Lorsqu'un lecteur associé à un lecteur à tolérance de pannes est défaillant et qu'un
lecteur en attente a été installé et configuré précédemment comme réserve globale
ou locale, le lecteur défaillant est automatiquement substitué et ses données sont
reconstruites à l'aide du lecteur de réserve désigné. Pour que cette opération se
déroule sans problème, la capacité du lecteur de réserve doit toujours être égale ou
supérieure au lecteur défaillant à remplacer.

Le processus de reconstruction est en principe lancé dans une ou deux minutes.
Il est exécuté en arrière-plan et prend environ huit minutes par giga-octet s'il n'y a
pas d'autres activités sur le contrôleur.

Pendant le processus de reconstruction automatique, l'activité normale peut se
poursuivre, bien que les performances puissent être affectées. Le degré
d'appauvrissement des performances est déterminé par le taux d'utilisation en
arrière-plan défini pour le contrôleur.

Le progrès du processus de reconstruction s'affiche lorsque vous sélectionnez View
→ Array Admin Progress.
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1. Rétablissez la capacité de reconstruction automatique en remplaçant le lecteur
défaillant à l'aide des instructions contenues dans le Manuel d'installation,
d'utilisation et d'entretien Sun StorEdge 3000 Family Installation relatif à votre baie.

2. Attendez au moins 60 secondes après avoir enlevé le lecteur défaillant avant
d'insérer un nouveau lecteur.

Assurez-vous que le lecteur de remplacement est au moins égal au lecteur le plus
grand dans le boîtier. Installez le lecteur de remplacement dans le même logement
que le lecteur défaillant ; le lecteur de remplacement devient alors le nouveau
lecteur en attente.

3. Une fois que le processus de reconstruction est terminé et que le lecteur logique
est à nouveau en ligne, effectuez une sauvegarde de la configuration du contrôleur
de la baie dans un fichier sur un lecteur externe ou sur une disquette.

Voir « Enregistrement de la configuration du lecteur logique », page 59.

▼ Reconstruction d'un périphérique sans lecteur
en attente
S'il n'y a pas de lecteur en attente dans la baie, vous devez remplacer le lecteur
défaillant avant de lancer le processus de reconstruction automatique.

1. Pour récupérer un lecteur défaillant lorsqu'il n'y a pas de lecteur en attente,
remplacez le lecteur défaillant selon les instructions contenues dans le Manuel
d'installation, d'utilisation et d'entretien Sun StorEdge 3000 Family Installation
relatif à votre baie.

2. Attendez au moins 60 secondes après avoir enlevé le lecteur défaillant avant
d'insérer un nouveau lecteur.

Assurez-vous que la capacité du lecteur de remplacement est au moins égale à celle
du lecteur défaillant. Installez le lecteur de remplacement à la même adresse (même
logement) que le lecteur défaillant.

3. Une fois que le lecteur défaillant a été remplacé dans le même logement, vous
devez l’analyser.

Pour plus de détails sur l’analyse d’un nouveau lecteur, consultez « Analyse de
nouveaux disques durs », page 166.

4. Une fois l'analyse du lecteur terminée, vous devez le reconstruire manuellement
en sélectionnant Array Administration → Rebuild.
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▼ Vérification des progrès du processus de
reconstruction

1. Sélectionnez View → Array Admin Progress ou cliquez sur l’icône Progress
Indicator à droite en haut de la fenêtre .

La fenêtre Controller Array Progress s'affiche indiquant le pourcentage d'exécution
de la reconstruction. Toutefois, si des activités de baie (telles que l'initialisation, la
reconstruction ou le contrôle de parité) ont lieu sur plusieurs contrôleurs, la fenêtre
Select Controller Progress s’affiche en premier.

2. Sélectionnez le contrôleur dont vous souhaitez voir les progrès, puis cliquez sur
OK.

La fenêtre Controller Array Progress s'affiche indiquant les progrès de la baie du
contrôleur sélectionné. Voir « Activités d'Array Administration », page 135.

▼ Reconstruction manuelle d'un lecteur défaillant
Dans la plupart des cas, vous n'avez pas besoin d'utiliser le processus de
reconstruction manuelle dans la mesure où les lecteurs remplacés sont
automatiquement reconstruits.

Si une panne se produit et qu'il n'y a pas de lecteur de réserve ou que, pour une
raison quelconque, le lecteur ne se reconstruit pas, vous pouvez utiliser l'option
Rebuild pour lancer manuellement le processus de reconstruction. En outre, si la
reconstruction est interrompue par une réinitialisation, utilisez l'option Rebuild pour
relancer le processus de reconstruction.

1. Remplacez le lecteur défaillant selon les instructions stipulées dans le Manuel
d'installation, d'utilisation et d'entretien Sun StorEdge 3000 Family Installation
relatif à votre baie.

2. Attendez au moins 60 secondes après avoir enlevé le lecteur défaillant avant
d'insérer un nouveau lecteur.

Assurez-vous que la capacité du lecteur de remplacement est au moins égale à celle
du plus grand lecteur dans le boîtier.

3. Sélectionnez Array Administration → Rebuild.

La fenêtre Rebuild s’affiche.
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4. Sélectionnez l'enregistrement d'état du lecteur de remplacement.

5. Cliquez sur OK pour lancer le processus de reconstruction.

Le processus de reconstruction est exécuté en arrière-plan et prend environ huit
minutes par giga-octet s'il n'y a pas d'autres activités sur le contrôleur de la baie.
Pendant le processus de reconstruction, l'activité normale peut se poursuivre, bien
que les performances puissent être affectées. Le degré d'appauvrissement des
performances est déterminé par le taux d'utilisation en arrière-plan défini pour le
contrôleur.

6. Pour vérifier les progrès du processus de reconstruction, sélectionnez View →
Array Admin Progress ou cliquez sur l’icône Progress Indicator en haut à droite de
la fenêtre.

La fenêtre Controller Array Progress s'affiche indiquant le pourcentage d'exécution
de la reconstruction.

Si des activités de baie (telles que l'initialisation, la reconstruction ou le contrôle de
parité) ont lieu sur plusieurs contrôleurs, la fenêtre Select Controller Progress
s'affiche en premier.

7. Sélectionnez le contrôleur dont vous souhaitez voir les progrès, puis cliquez sur OK.

La fenêtre Controller Array Progress s'affiche indiquant les progrès de
reconstruction de la baie de ce contrôleur.
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▼ Restauration de la configuration du lecteur
logique
Cette section décrit le processus de restauration des informations de configuration
de la baie à partir du fichier de sauvegarde. Vous devez posséder un fichier de
sauvegarde que vous avez créé à l'aide de la commande Save tel qu'expliqué dans la
section « Configuration File », page 84. Si le contrôleur de la baie et ses lecteurs sont
endommagés, vous pouvez restaurer la configuration de la baie sur un nouveau
contrôleur sans devoir totalement reconfigurer la baie de stockage.

Précaution – Restaurez la configuration de la baie depuis un fichier uniquement si
le fichier de configuration est actualisé. La perte des données résulte de la
restauration d'une configuration ancienne ou incorrecte.

Si vous êtes certain que le fichier de sauvegarde contient des informations correctes
de configuration de baie, continuez la procédure pour restaurer la configuration.

1. Sélectionnez le contrôleur pour la baie appropriée

2. Sélectionnez Configuration → Load Configuration.

La fenêtre Select Configuration File s’affiche.

3. Indiquez le nom et l'emplacement du fichier de configuration de sauvegarde et
cliquez sur Open.
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La fenêtre Load Configuration s’affiche. Pour visualiser une arborescence de la
configuration, cliquez sur l'onglet Configuration View.

L’onglet Saveset Description affiche la description du fichier précisé lors de la
création du fichier de configuration.
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4. Pour charger la configuration enregistrée, sélectionnez OK.

La fenêtre Load Configuration Confirmation s'affiche.

Passez soigneusement en revue les informations contenues dans la fenêtre Load
Configuration Confirmation avant de continuer.

5. Cliquez sur Apply pour charger cette configuration ou sur Cancel pour terminer.

La fonction Apply permet de poursuivre le processus de configuration. La fenêtre
des progrès s'affiche.

Remarque – N’initialisez pas le ou les unités logiques après la restauration du
contenu du fichier de sauvegarde de la configuration de la baie.

6. Si vous utilisez Microsoft Windows NT, arrêtez et redémarrez le système
d'exploitation.

La réinitialisation du système d'exploitation est requise pour permettre à Windows
NT de reconnaître la configuration du lecteur logique.
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▼ Réinitialisation du contrôleur
Chaque fois que vous modifiez les paramètres du contrôleur, un message s'affiche
vous demandant si vous voulez réinitialiser le contrôleur afin de permettre aux
modifications d'entrer en vigueur. Si vous apportez plusieurs modifications, vous
pouvez préférer apporter toutes les modifications et ne réinitialiser le contrôleur
qu'une seule fois. Utilisez alors l'option Issue Reset to the Controller pour
réinitialiser le contrôleur manuellement après avoir apporté des modifications à
plusieurs paramètres.

1. Sélectionnez une icône de stockage dans la fenêtre principale.

2. Sélectionnez Array Administration → Controller Maintenance.

3. Si vous n'êtes pas encore connecté comme ssconfig, une invite s'affiche vous
demandant le mot de passe, tapez ssconfig.

Le menu Controller Maintenance Options s'affiche.

4. Cliquez sur Issue Reset to the Controller.

▼ Désactivation du signal sonore du contrôleur
Lorsqu'un événement se produit déclenchant le signal sonore du contrôleur, par
exemple lorsqu'un lecteur logique tombe en panne pendant une reconstruction ou lors
de l'ajout d'un lecteur SCSI, vous pouvez désactiver le signal sonore du contrôleur.

1. Sélectionnez l'icône du contrôleur dans la fenêtre principale.

2. Sélectionnez Array Administration → Controller Maintenance.

3. Si vous n'êtes pas encore connecté comme ssconfig, une invite s'affiche vous
demandant le mot de passe, tapez ssconfig.

Le menu Controller Maintenance Options s'affiche.

4. Cliquez sur Mute Controller Beeper.

ou

1. Sélectionnez l'icône du contrôleur souhaité dans la fenêtre principale.

2. Sélectionnez Configuration → Custom Configure.

3. Sélectionnez Change Controller Parameters.

4. Cliquez sur Mute Beeper.
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▼ Réactivation d'un contrôleur défaillant
Si un contrôleur tombe en panne, réactivez-le en procédant comme suit.

1. Sélectionnez l'icône du contrôleur souhaité dans la fenêtre principale.

2. Sélectionnez Array Administration → Controller Maintenance.

3. Si vous n'êtes pas encore connecté comme ssconfig, une invite s'affiche vous
demandant le mot de passe, tapez ssconfig.

Le menu Controller Maintenance Options s'affiche.

4. Cliquez sur Deassert Failed Redundant Controller.

ou

1. Sélectionnez l'icône du contrôleur souhaité dans la fenêtre principale.

2. Sélectionnez Configuration → Custom Configure.

3. Sélectionnez Change Controller Parameters.

4. Sélectionnez l'onglet Redundancy.

5. Dans le champ Set Controller Config, sélectionnez Redundant Deassert Reset.
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▼ Affichage des statistiques de performances
Grâce aux statistiques de performances de Configuration Service, vous pouvez
déterminer le taux de transfert de données, à savoir la vitesse à laquelle la baie
fonctionne.

1. Sélectionnez Array Administration → Controller Maintenance.

2. Si vous n'êtes pas encore connecté comme ssconfig, une invite s'affiche vous
demandant le mot de passe, tapez ssconfig.

Le menu Controller Maintenance Options s'affiche.

3. Cliquez sur Performance Statistics.

La fenêtre Performance Statistics s’affiche.
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CHAPITRE11

Mise à jour de la configuration

Consultez ce chapitre pour modifier la configuration en cours ou la compléter. Il
décrit les tâches suivantes :

■ « Ajout d’un lecteur logique ou d’un volume logique à partir de nouveaux
lecteurs logiques », page 150

■ « Suppression d’un lecteur ou d’un volume logique », page 154

■ « Création d'une partition », page 157

■ « Suppression d'une partition », page 159

■ « Expansion de la capacité d’un lecteur ou d’un volume logique », page 161

■ « Ajout de lecteurs SCSI à un lecteur logique existant », page 163

■ « Copie et remplacement des lecteurs membres », page 164

■ « Analyse de nouveaux disques durs », page 166

■ « Téléchargement d'un firmware du contrôleur RAID », page 167

■ « Mise à niveau du firmware et de l'enregistrement de démarrage », page 169

■ « Mise à niveau du firmware sur disques durs », page 170

■ « Mise à niveau du firmware sur les périphériques SAF-TE », page 172

■ « Modification des paramètres du contrôleur », page 173

■ « Désactivation du signal sonore du contrôleur », page 184

■ « Enregistrement des valeurs modifiées », page 184

■ « Affectation ou modification des lecteurs en attente », page 185

■ « Modification d'une entrée de serveur », page 186

Les commandes du menu Configuration et les icônes d'outil peuvent être
désactivées temporairement si un processus d'administration de baies, tel qu'un
contrôle de parité, est en cours. La commande du menu est également illustrée à
l'état désactivé lorsque la console Configuration Service actualise son inventaire sur
le serveur. Le symbole d'une antenne satellite est placé près de l'icône du serveur
pendant le processus d'actualisation .
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Pour utiliser les options Configuration, vous devez vous connecter au niveau de
sécurité du logiciel ssconfig avec le mot de passe ssconfig. Lorsque vous avez
terminé avec les activités de configuration, reconnectez-vous au niveau de surveillance.

▼ Ajout d’un lecteur logique ou d’un volume
logique à partir de nouveaux lecteurs logiques
Cette option permet d’ajouter un ou plusieurs lecteurs logiques à une configuration
existante d’ensembles RAID ou d’ajouter un volume logique à partir de nouveaux
lecteurs logiques. Pour ajouter un volume logique à partir de lecteurs logiques
existants, voir « Ajout d’un volume logique à partir de lecteurs logiques existants »,
page 153.

Remarque – Si le lecteur logique à ajouter a une capacité supérieure à 253 Go, voir
« Préparation pour des lecteurs logiques de plus de 253 Go », page 73.

1. Sélectionnez la baie appropriée.

2. Sélectionnez Configuration → Custom Configure.

Remarque – Cette sélection est inactive à moins que vous ne sélectionniez une baie
des lecteurs physiques disponibles.

3. Sélectionnez Add LDs/LVs to the Current Configuration dans la fenêtre Custom
Configuration Options.

4. Vérifiez le serveur et le contrôleur qui sont affichés en haut de la fenêtre.

5. Sélectionnez un disque que vous voulez inclure dans le nouveau lecteur logique
et cliquez sur Add Disk.

Si vous commettez une erreur ou vous changez d’avis, sélectionnez le lecteur et
cliquez sur Remove Disk.

6. Sélectionnez un niveau RAID.

Pour les définitions des niveaux RAID, voir « Introduction à RAID », page 189.

7. Sélectionnez le canal et l'ID SCSI d'hôte auxquels vous voulez mapper le nouveau
lecteur logique dans les zones de listes Channel et SCSI ID.

8. Définissez la taille de lecteur maximale Max Drive Size.

Le champ Max Drive Size affiche la capacité totale de chacun des disques. Un lecteur
logique plus petit peut être créé en réduisant cette valeur.
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Remarque – Si vous ne changez pas la valeur de Max Drive Size mais que vous
modifiez Partition Size, Configuration Service crée une nouvelle partition à la taille de
partition indiquée. La capacité restante du lecteur logique est transférée vers la dernière
partition. La capacité restante peut être utilisée par la suite en augmentant la taille du
lecteur (voir « Expansion de la capacité d’un lecteur ou d’un volume logique », page 161).
Après la création de la partition, la capacité du lecteur n'est plus modifiable.

Remarque – Si vous souhaitez créer un nouveau lecteur logique sur le même
contrôleur, cliquez sur New LD. Configuration Service crée le lecteur logique que
vous venez de définir et retourne au haut de la fenêtre pour vous permettre de créer
un nouveau lecteur logique. Sur une baie Sun StorEdge 3310 SCSI, vous pouvez
créer jusqu’à huit lecteurs logiques et 32 partitions maximum par lecteur logique.
Sur une baie Sun StorEdge 3510 FC, vous pouvez créer huit lecteurs logiques
maximum et 128 partitions maximum par lecteur logique.

9. Pour ajouter un lecteur logique à un volume logique, cliquez sur New LD et
consultez la section « Ajout d’un lecteur logique à un volume logique », page 152.

10. Lorsque vous êtes satisfait des sélections affichées sur la fenêtre et que vous ne
voulez pas définir d'autre lecteur logique, cliquez sur Commit.

Une fenêtre de confirmation s'affiche indiquant la nouvelle configuration.

11. Cliquez sur OK pour valider la configuration.
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12. Sélectionnez Cancel pour revenir à la console Configuration Service.

Cette opération optimise la tolérance de pannes. Un lecteur peut toujours redevenir
disponible lorsque vous en avez besoin.

Remarque – Après avoir cliqué sur OK, vous ne pouvez plus changer la
configuration du lecteur logique.

Remarque – Pendant l’initialisation, la taille du lecteur/volume logique affichée est
0 Mo.

▼ Ajout d’un lecteur logique à un volume logique

Un volume logique est composé de deux lecteurs logiques au moins et peut être
divisé en 32 partitions au maximum. Au cours du fonctionnement, l'hôte perçoit le
volume logique non partitionné ou une partition d'un volume logique comme un
lecteur physique simple.

1. Créez un lecteur logique en suivant les indications des étapes de 1 à 8 de la
section « Ajout d’un lecteur logique ou d’un volume logique à partir de nouveaux
lecteurs logiques », page 150.

Remarque – Ne partitionnez pas le lecteur logique que vous ajoutez au volume logique.
Il n’est pas possible d’ajouter un lecteur logique partitionné à un volume logique.

2. Pour ajouter un lecteur logique à un volume logique, cliquez sur Add to LV avant
de cliquer sur Commit.

Le lecteur logique est ajouté dans la case LV Definition La taille totale du volume
logique est affichée dans le champ Available Size (MB).

Remarque – Le volume logique n’ayant pas encore été partitionné, les champs
Part Size (MB) et Available Size (MB) sont égaux. Un volume logique seul est
considéré comme une seule partition.

3. Pour créer un nouveau lecteur logique à ajouter au volume logique, cliquez sur
New LD.

4. Créez le lecteur logique et ajoutez-le au volume logique en cliquant sur Add to LV.

Répétez cette étape pour chaque lecteur logique que vous désirez ajouter au volume
logique.

5. Pour créer une partition, voir « Création d'une partition », page 157.
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6. Quand vous avez fini d’ajouter des lecteurs logiques au volume logique, cliquez
sur Commit LV pour créer un nouveau volume logique ou un lecteur logique seul.

Lorsque vous avez fini de créer des volumes logiques et ne désirez pas créer un
lecteur logique seul, cliquez sur Commit.

Remarque – Quand vous avez fini de créer des volumes logiques et que vous
souhaitez quitter la fenêtre New Configuration, si vous cliquez sans le vouloir sur
Commit LV au lieu de Commit, vous devez créer un nouveau lecteur logique ; il est
également possible de cliquer sur Cancel et de reconfigurer le volume logique.

▼ Ajout d’un volume logique à partir de lecteurs
logiques existants

Remarque – Avant de pouvoir ajouter un volume logique à partir des lecteurs
logiques existants, vous devez annuler le mappage des lecteurs logiques.

1. Sélectionnez la baie appropriée.

2. Sélectionnez Configuration → Custom Configure.

Remarque – Cette sélection est inactive à moins que vous ne sélectionniez une baie
avec des lecteurs physiques disponibles.

3. Sélectionnez Add LDs/LVs to the Current Configuration dans la fenêtre Custom
Configuration Options.

4. Vérifiez que le serveur et le contrôleur affichés en haut de la fenêtre sont corrects.

5. Sélectionnez Use existing LDs to create LVs.

Si aucun lecteur logique n’est inscrit dans le champ Select a Logical Drive, l’annulation
du mappage des lecteurs logiques n’a pas été effectuée et ceux-ci ne sont par conséquent
pas disponibles. Vous devez d’abord annuler le mappage des lecteurs logiques.

6. Sélectionnez un lecteur logique et cliquez sur Add to LV.

7. Quand vous avez fini d’ajouter des lecteurs logiques au volume logique, cliquez
sur Commit LV pour créer un nouveau volume logique ou un lecteur logique seul.

Lorsque vous avez fini de créer des volumes logiques et ne désirez pas créer un
lecteur logique seul, cliquez sur Commit.
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Remarque – Quand vous avez fini de créer des volumes logiques et que vous
souhaitez quitter la fenêtre New Configuration, si vous cliquez sans le vouloir sur
Commit LV au lieu de Commit, vous devez créer un nouveau lecteur logique ; il est
également possible de cliquer sur Cancel et de reconfigurer le volume logique.

▼ Suppression d’un lecteur ou d’un volume
logique
Utilisez cette option pour supprimer un ou plusieurs lecteurs ou volumes logiques
d'une configuration existante d'ensembles RAID.

Remarque – Avant de pouvoir supprimer un lecteur ou un volume logique, vous
devez annuler le mappage de toutes les unités logiques affectées.

1. Sélectionnez la baie appropriée.

2. Affichez les lecteurs ou volumes logiques à supprimer.

Si aucun lecteur logique n’est
affiché après la sélection de
Use existing LDs to create LVs,
l’annulation du mappage des
lecteurs logiques n’a pas été
effectuée. Vous devez d’abord
annuler le mappage des
lecteurs logiques
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3. Si des unités logiques d'hôte sont affectées à l'un des lecteurs ou des volumes
logiques, passez à l'étape 4 ; si ce n'est pas le cas, passez à l'étape 8.

4. Sélectionnez Configuration → Custom Configure.

5. Sélectionnez Change Host LUN Assignments.

6. Sélectionnez les unités logiques d'hôte associées au lecteur ou au volume logique
dont vous souhaitez annuler le mappage, puis cliquez sur Unmap Host LUN.

7. Cliquez sur OK, puis sur Close.

8. Sélectionnez Configuration → Custom Configure.

9. Sélectionnez Manage Existing LDs/LVs and Partitions dans la fenêtre Custom
Configuration Options.

10. Sélectionnez l’onglet LDs/LVs.

11. Sélectionnez le lecteur ou le volume logique que vous voulez supprimer, et
cliquez sur Delete puis sur OK.

Lors de la suppression d’un volume logique, le volume logique est supprimé quand
vous cliquez sur Delete, mais les lecteurs logiques qui constituent le lecteur logique
sont affichés.

12. Cliquez sur OK dans la fenêtre Confirm Configuration Operation pour terminer
l’opération, puis sur Close.
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À propos du numéro d'unité/volume logique

Le numéro d’unité logique/de volume logique référencé à chaque lecteur logique est
dynamique ; il change à chaque création/suppression de lecteurs logiques. Ce
numéro est affiché dans le champ LDs/LVs (lecteur logique) de plusieurs fenêtres de
Configuration Service, y compris Dynamically Grow and/or Reconfigure LDs/LVs,
Change Host LUN Assignments, Manage Existing LDs/LVs and Partitions, et la
fenêtre principale de Configuration Service.

Utilisé uniquement comme espace réservé vous permettant de suivre visuellement les
lecteurs et les volumes logiques, ce numéro n'a aucune incidence sur le contrôleur.
Cela signifie que le contrôle ne fait aucun rapport sur les lecteurs ou volumes logiques
en fonction de ce numéro. À titre d'exemple, si quatre lecteurs logiques existent et que
LD2 est supprimé, LD3 existant devient automatiquement LD2, et LD4 devient LD3.
Seul le numéro de lecteur et volume logique (LD/LV) change ; les données et le
mappage des unités logiques sur les lecteurs logiques restent tels quels.

Le numéro LD/LV actuel affiché dans le champ LD/LV n'a aucune importance
puisque le contrôleur rapporte le nombre total de lecteurs logiques qui est trois, dans
ce cas. Dans cet exemple, si un nouveau lecteur logique est créé, il adopte le numéro
LD du lecteur logique supprimé et le contrôleur rapporte qu'il y a un total de quatre
lecteurs logiques. Tous les lecteurs logiques existants reviennent à leur désignation
primaire/secondaire initiale.

Remarque – Comme l’illustre l’exemple suivant, le numéro LG dde l’option du
menu du terminal firmware View and Edit Logical Drives n’est pas visuellement
dynamique. Après la suppression d’un lecteur logique, vous ne voyez qu’un espace
réservé vide. Lorsqu'un lecteur logique est créé à partir de la console ou du terminal,
cet espace réservé vide est renseigné par le nouveau lecteur logique.
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▼ Création d'une partition

Remarque – Avant de créer une partition, vous devez supprimer toutes les unités
logiques affectées.

1. Sélectionnez la baie appropriée.

2. Affichez le ou les lecteurs logiques sur lesquels vous souhaitez créer des partitions.

3. Si des affectations de numéros d'unité logique d'hôte existent pour l'un des
lecteurs logiques, passez à l'étape 4 ; si ce n'est pas le cas, passez à l'étape 8.

4. Sélectionnez Configuration → Custom Configure.

5. Sélectionnez Change Host LUN Assignments.

6. Sélectionnez l’unité/les unités logique(s) d'hôte associées au(x) lecteur(s)
logique(s) à partitionner, et cliquez sur Unmap Host LUN.

7. Cliquez sur OK, puis sur Close.

8. Sélectionnez Configuration → Custom Configure.

Le champ LD de la fenêtre Manage Existing LDs/LVs and Partitions (à droite) est dynamique ; il change
lorsque des lecteurs logiques sont créés/supprimés. Dans cet exemple, LD2 a été supprimé, donc LD4

Drives (à gauche), le champ LG n’est pas dynamique ; un logement vide indique que LD2 a été supprimé.
est devenu LD3, et LD 2 est devenu LD1. Dans l’option de menu du terminal View and Edit Logical
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9. Sélectionnez Manage Existing LDs/LVs and Partitions dans la fenêtre Custom
Configuration Options.

10. Sélectionnez l'onglet Partitions.

11. Sélectionnez un lecteur ou un volume logique à partitionner.

12. Indiquez une valeur en méga-octets dans Partition Size et cliquez sur Create.

Pour créer plusieurs partitions de la même taille, cliquez sur Add Partition le
nombre de fois équivalent au nombre de partitions que vous souhaitez créer.
Vous pouvez aussi saisir la taille de partition dans le champ Part Size et le multiplier
(*) par le nombre de partitions que vous voulez créer, par exemple 100*128. Tout Mo
restant est ajouté à la dernière partition.

Au fur et à mesure que vous ajoutez des partitions, la capacité restante affichée dans
le champ Available Size (MB) augmente en fonction de la taille de partition.

13. Pour changer la taille d'une partition que vous avez déjà créée, sélectionnez le
lecteur/le volume logique et cliquez sur Modify Size.

14. Indiquez une nouvelle valeur (en méga-octets) dans Partition Size et cliquez sur OK.

15. Cliquez sur OK dans la fenêtre Confirm Configuration Operation pour terminer
l’opération, puis cliquez sur Close.

Après la partition d’un lecteur ou d’un volume logique, lorsque vous ouvrez un
lecteur ou un volume logique dans la fenêtre principale de Configuration Service, les
partitions sont affichées .
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À propos du numéro de lecteur/volume logique

Pour toute information importante relative au numéro du lecteur/volume logique
affiché dans le champ LDs/LVs de la fenêtre Manage Existing LDs/LVs and Partitions,
voir la section « À propos du numéro d'unité/volume logique », page 156.

▼ Suppression d'une partition

Remarque – Pour supprimer une partition sur un lecteur ou un volume logique,
vous devez annuler le mappage de toutes les unités logiques affectées.

1. Sélectionnez la baie appropriée.

2. Visualisez les lecteurs/volumes logiques sur lesquels vous souhaitez supprimer
les partitions.

Si des unités logiques d'hôte sont mappées à l'une des partitions de lecteur logique,
passez à l'étape 3 ; si ce n'est pas le cas, passez à l'étape 7.

3. Sélectionnez Configuration → Custom Configure.

4. Sélectionnez Change Host LUN Assignments.

5. Sélectionnez les unités logiques mappées aux partitions du lecteur/volume
logique à supprimer et cliquez sur Unmap Host LUN.

6. Cliquez sur OK, puis sur Close.

7. Sélectionnez Configuration → Custom Configure.

8. Sélectionnez Manage Existing LDs/LVs and Partitions dans la fenêtre Custom
Configuration Options.

9. Sélectionnez l'onglet Partitions.
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10. Sélectionnez une partition à modifier ou à supprimer, en commençant par la
dernière partition du lecteur ou du volume logique.

11. Cliquez sur Delete, puis sur OK.

12. Cliquez sur OK dans la fenêtre Confirm Configuration Operation pour terminer
l'opération puis sur Close.
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▼ Expansion de la capacité d’un lecteur ou d’un
volume logique
Cette option permet d'agrandir la capacité d'un lecteur ou d’un volume logique
existant. À titre d'exemple, votre lecteur pouvait avoir à l'origine 18 Go dont 9 Go
ont été sélectionnés pour construire un lecteur logique. Pour utiliser les 9 Go
restants, vous devez agrandir le lecteur logique.

Remarque – Pour agrandir un volume logique, vous devez d’abord agrandir les
lecteurs logiques qui forment le volume logique.

1. Sélectionnez la baie appropriée.

2. Sélectionnez Configuration → Custom Configure.

3. Sélectionnez Dynamically Grow and/or Reconfigure depuis la fenêtre Custom
Configuration Options.

4. Sélectionnez le lecteur ou le volume logique à agrandir.

5. Sélectionnez l’onglet Expand LD/LV.

6. Indiquez la capacité en méga-octets d'agrandissement du lecteur logique dans le
champ Maximum Drive Expand Capacity et cliquez sur OK.

La valeur de Maximum Drive Expand Capacity ne peut pas dépasser celle de
Maximum Available Drive Free Capacity.
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7. Cliquez sur OK dans la fenêtre Confirm Configuration Operation pour terminer
l’opération, puis sur Close.

À propos du numéro d'unité/volume logique

Pour tout renseignement important concernant le numéro de lecteur/volume logique
affiché dans le champ LD/LV de la fenêtre Dynamically Grow and/or Reconfigure
LDs/LVs, voir la section « À propos du numéro d'unité/volume logique », page 156.

Si vous avez utilisé la capacité totale du
lecteur logique quand vous l’avez créé,
la valeur 0 est affichée ; cela signifie
qu’il n’y a pas d’espace disponible pour
augmenter la capacité, à moins d’ajouter
un nouveau lecteur logique
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▼ Ajout de lecteurs SCSI à un lecteur logique
existant

1. Sélectionnez la baie appropriée.

2. Sélectionnez Configuration → Custom Configure.

3. Sélectionnez Dynamically Grow and/or Reconfigure depuis la fenêtre Custom
Configuration Options.

4. Sélectionnez le lecteur logique auquel vous souhaitez ajouter un lecteur SCSI.

5. Sélectionnez l’onglet Add SCSI Drives.

6. Dans la liste Available disks, sélectionnez le lecteur à ajouter au lecteur logique.

7. Cliquez sur Add Disk.

Le lecteur est déplacé vers la liste Add disk(s) to LD.

Si vous faites une erreur ou changez d'avis, sélectionnez le disque dans la liste Add
disk(s) to LD et cliquez ensuite sur Remove.

8. Après avoir ajouté les lecteurs SCSI, cliquez sur OK.

9. Cliquez sur OK dans la fenêtre Confirm Configuration Operation pour terminer
l’opération, puis sur Close.
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À propos du numéro d'unité/volume logique
Pour tout renseignement important concernant le numéro de lecteur/volume logique
affiché dans le champ LD/LV de la fenêtre Dynamically Grow and/or Reconfigure
LDs/LVs, voir la section « À propos du numéro d'unité/volume logique », page 156.

▼ Copie et remplacement des lecteurs membres
Cette option permet de copier et de remplacer les lecteurs membres existants avec
des lecteurs d'une capacité supérieure. À titre d'exemple, un lecteur logique qui est
initialement composé de trois lecteurs membres, chacun d'eux ayant une capacité de
18 Go, peut être remplacé par de nouveaux lecteurs membres ayant chacun une
capacité de 36 Go (voir la figure suivante).

FIGURE 11-1 Copie et remplacement de lecteurs membres

1. Sélectionnez la baie appropriée.

2. Sélectionnez Configuration → Custom Configure.

3. Sélectionnez Dynamically Grow and/or Reconfigure LDs/LVs dans la fenêtre
Custom Configuration Options.

4. Sélectionnez le lecteur logique pour lequel vous allez effectuer une opération de
copie/remplacement.

5. Sélectionnez l'onglet Copy and Replace Drive dans la fenêtre Dynamically Grow
and/or Reconfigure LDs/LVs.

18 Go18 Go18 Go
Nouveau

36 Go

36 (Go)36 (Go) 36 (Go)

RAID 5 (4 Go)

En cours d'utilisation

Inutilisé

Nouveau

36 Go

Nouveau

36 Go

RAID 5 (4 Go)

lecteur lecteur lecteur
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6. Dans la liste Drive to Copy Data From, sélectionnez le nouveau disque dur.

7. Dans la liste Drive to Copy Data To, sélectionnez le disque dur à remplacer et
cliquez sur OK.

Pour utiliser la capacité additionnelle fournie par les nouveaux lecteurs, procédez
selon les instructions de la section « Expansion de la capacité d’un lecteur ou d’un
volume logique », page 161.

8. Cliquez sur OK dans la fenêtre Confirm Configuration Operation pour terminer
l'opération puis sur Close.

9. Une fois l'opération terminée, fermez la fenêtre des progrès.

À propos du numéro d'unité/volume logique
Pour tout renseignement important concernant le numéro de lecteur/volume logique
affiché dans le champ LD/LV de la fenêtre Dynamically Grow and/or Reconfigure
LDs/LVs, voir la section « À propos du numéro d'unité/volume logique », page 156.
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▼ Analyse de nouveaux disques durs
Un disque dur peut être analysé et mis à disposition sans devoir arrêter la baie.

1. Double-cliquez sur la baie appropriée.

2. La fenêtre View Controller Configuration s'affiche.

3. Sélectionnez l'onglet Physical Drives et cliquez sur Scan SCSI Drive.

4. Sélectionnez le canal/ID utilisés par le lecteur.

Si l'analyse a réussi, le lecteur est affiché et mis à disposition.
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▼ Téléchargement d'un firmware du contrôleur
RAID
Les procédures suivantes sont utilisées pour mettre à niveau le firmware du
contrôleur pour une configuration de contrôleur simple et redondante.

1. Sélectionnez l'icône du contrôleur souhaité dans la fenêtre principale.

2. Sélectionnez Array Administration → Controller Maintenance.

3. Si vous n'êtes pas encore connecté comme ssconfig, une invite s'affiche vous
demandant le mot de passe, tapez ssconfig.

Le menu Controller Maintenance Options s'affiche.
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4. Dans le cas d'une mise à niveau du firmware (pas d'enregistrement de démarrage),
sélectionnez l'option Download Firmware.

La fenêtre Select Firmware File s'affiche.

5. Sélectionnez le firmware à télécharger et cliquez sur Open.

L'invite Confirmation Dialog s'affiche.

6. Cliquez sur Yes.

Une barre des progrès s'affiche pendant le téléchargement du firmware vers le
contrôleur RAID.
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7. Lorsque la barre des progrès a atteint 100 %, cliquez sur OK.

8. Après avoir téléchargé le firmware, vérifiez les paramètres pour en garantir une
configuration appropriée.

▼ Mise à niveau du firmware et de
l'enregistrement de démarrage

1. Allez à Array Administration → Controller Maintenance.

2. Si vous n'êtes pas encore connecté comme ssconfig, une invite s'affiche vous
demandant le mot de passe, tapez ssconfig.

Le menu Controller Maintenance Options s'affiche.

3. Sélectionnez Download Firmware with Boot Record.

La fenêtre Select Boot Record File s'affiche.
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4. Sélectionnez l'enregistrement de démarrage et cliquez sur Open.

5. Sélectionnez le fichier du firmware approprié.

La fenêtre Select Firmware File s'affiche.

6. Cliquez sur Open.

La fenêtre Confirmation Dialog s'affiche.

7. Répétez les étapes 6 à 8 dans la sous-section précédente.

Téléchargement du firmware pour
périphériques
Cette option permet de mettre à niveau le firmware sur disques durs et les
périphériques SAF-TE.

▼ Mise à niveau du firmware sur disques durs
1. Sélectionnez la baie appropriée.

2. Sélectionnez Array Administration → Download FW for Devices.

3. Cliquez sur l'onglet Download FW for Disks.

4. Sélectionnez soit To All disks under Controller, puis une baie dans le menu, soit
To All disks under LD, puis un lecteur logique dans le menu.

■ Si vous n'avez pas l'intention de télécharger le nouveau firmware sur certains
lecteurs, sélectionnez-les dans la liste Selected Disks, puis cliquez sur Remove.

■ Si vous avez l'intention d'ajouter des lecteurs logiques, sélectionnez-les dans la
liste Available Disks et cliquez sur Add.

■ Si vous disposez de plusieurs lecteurs ayant un ID de produit différent,
sélectionnez l'ID par lecteur vers lequel vous voulez télécharger le firmware dans
la zone de liste Product ID.
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5. Cliquez sur Browse et recherchez le fichier du firmware à télécharger.

Sélectionnez Open.

6. Sélectionnez le fichier du firmware à télécharger, cliquez sur Open, puis sur OK.

Le téléchargement du firmware s'effectue.

7. Lorsque l'indicateur de progrès a atteint 100 %, cliquez sur OK.

8. Pour vous assurer que le firmware a été téléchargé, sélectionnez View → View
Physical Drive, et veillez à ce que la version du firmware ait été modifiée dans le
champ Product Revision.
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▼ Mise à niveau du firmware sur les périphériques
SAF-TE

Remarque – Les périphériques SAF-TE sont utilisées sur les baies SCSI et les
périphériques SES sur les baies Fibre Channel.

1. Sélectionnez la baie.

2. Sélectionnez Array Administration → Download FW for Devices.

3. Cliquez sur l'onglet Download FW for SAFTE/SES Devices.

■ Pour ajouter un périphérique, sélectionnez-le dans la liste Available SAF-TE
Devices et cliquez ensuite sur Add.

■ Pour supprimer un périphérique, sélectionnez-le dans la liste Selected SAF-TE
Devices et cliquez ensuite sur Remove.

4. Cliquez sur Browse et recherchez le fichier du firmware à télécharger.

5. Sélectionnez le fichier du firmware à télécharger, cliquez sur Open, puis sur OK.

Le téléchargement du firmware s'effectue.

6. Lorsque l'indicateur de progrès a atteint 100 %, cliquez sur OK.

7. Pour vous assurer que le firmware a été téléchargé, sélectionnez View → View
Enclosure, et veillez à ce que la version du firmware ait changé dans le champ
Firmware Rev.
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▼ Modification des paramètres du contrôleur
1. Sélectionnez le contrôleur de baie approprié dans le menu principal.

2. Sélectionnez Configuration → Custom Configure.

Le cas échéant, connectez-vous au niveau de configuration du programme avec le
mot de passe ssconfig.

3. Dans la fenêtre Custom Configuration Options sélectionnez Change Controller
Parameters.

La fenêtre Change Controller Parameters avec l'onglet Channel sélectionné s'affiche.

Remarque – Pour la baie Sun StorEdge 3510 FC, le CurClk est 2.0 GHz.

■ Controller Name – Si le nom du contrôleur a besoin d'être défini, sélectionnez
Controller Name et saisissez le nom. Cliquez sur OK pour enregistrer la modification.

■ Controller Unique ID – Cet ID est défini automatiquement.
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Onglet Channel

1. Dans l'onglet Channel Settings, sélectionnez le canal à modifier.

2. Cliquez sur Change Settings

La fenêtre Change Channel Settings est affichée. Pour que le serveur puisse
reconnaître la baie, l'ID d'un canal d'hôte doit avoir été affecté à un lecteur logique et
un lecteur logique mappé à ce canal/ID d'hôte. Cette fenêtre permet de configurer
l'hôte/canal de lecteur.

3. Dans la zone de liste Channel Mode, sélectionnez Host ou Drive.

Les lecteurs sont connectés à un canal de lecteur (interne ou externe). Un canal
d'hôte est connecté au serveur.

Remarque – En fonction de la configuration du contrôleur, vous pouvez avoir besoin
de sélectionner les ID de canal principal et secondaire (voir les étapes suivantes).

4. Dans la zone de liste Available SCSI IDs, sélectionnez tout d'abord l'ID du canal
principal, qui est désigné sous PID. Cliquez ensuite sur Add PID.

5. Si vous avez deux contrôleurs installés, sélectionnez un ID de canal secondaire de
la zone de liste Available SCSI IDs, puis cliquez sur Add SID.
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Modification de l’ID d’hôte dans une configuration Fibre

1. Si vous voulez un ID supérieur à 15, cliquez sur Select SCSI ID Range et
sélectionnez la plage.

Remarque – Tous les ID de canal doivent être compris dans la même plage.

2. Cliquez sur Remove pour supprimer le PID ou le SID.

3. Après avoir effectué vos sélections, cliquez sur OK pour revenir à la fenêtre
précédente.

Onglet RS 232

1. Après avoir défini tous les paramètres de canal, dans la fenêtre Change Controller
Parameters, sélectionnez l'onglet RS 232.

2. Sélectionnez le port et cliquez sur Change Settings.

La fenêtre Change RS232 Port Setting s'affiche.
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3. Sélectionnez un débit en bauds (le paramètre par défaut est de 9600), puis cliquez
sur OK pour revenir à la fenêtre précédente.

Onglet Cache

1. Dans la fenêtre Change Controller Parameters, sélectionnez l'onglet Cache.

2. Sélectionnez Optimization dans la zone de liste ou validez le paramétrage actuel.

Cette option indique la quantité de données inscrites sur chacun des lecteurs d'une
baie de disques. Sequential I/O indique de grands blocs de données ; random I/O
indique de petits blocs de données.

Si un lecteur logique existant a été créé avec l'option Optimization set for Random
I/O, le même lecteur logique n'est pas capable de lire ni d'écrire de données après
son passage au mode Sequential I/O. L'inverse est également vrai dans la mesure où
le facteur d'entrelacement est différent pour chaque mode.

3. Pour utiliser l'option Write Back, cliquez sur la zone de liste et sélectionnez
Enabled ou Disabled.
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Onglet Disk Array

1. Dans la fenêtre Change Controller Parameters, sélectionnez l’onglet Disk Array.

2. Sélectionnez Disabled ou Enabled dans les trois zones de liste Write Verify.

En principe, des erreurs peuvent se produire lorsqu'un disque dur écrit des données.
Pour éviter toute erreur d'écriture, le contrôleur peut forcer les disques durs à
vérifier les données écrites.

■ Write Verify on Initialization - permet d'effectuer une vérification après écriture
lors de l'initialisation du lecteur logique.

■ Write Verify on Rebuild - permet d'effectuer une vérification après écriture lors du
processus de reconstruction.

■ Write Verify on Normal - permet d'effectuer une vérification après écriture lors
des demandes E/S normales.
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3. Sélectionnez parmi les quatre options disponibles dans la zone de liste Rebuild
Priority : Low, Normal, Improved ou High.

Le contrôleur RAID fournit une capacité de reconstruction en arrière-plan. Cela
signifie que le contrôleur est capable de répondre à d'autres demandes E/S tout en
reconstruisant les lecteurs logiques. Le temps requis à la reconstruction d'un
ensemble de lecteurs dépend en grande partie de la capacité totale du lecteur
logique à reconstruire. En outre, le processus de reconstruction est totalement
transparent à l'ordinateur hôte ou à l'environnement d'exploitation.

■ Low – valeur par défaut qui utilise les ressources minimales du contrôleur pour la
reconstruction

■ Normal – permet d'accélérer le processus de reconstruction

■ Improved – permet d'affecter plus de ressources au processus de reconstruction

■ High – permet d'utiliser les ressources maximales du contrôleur pour terminer le
processus de reconstruction dans le délai le plus bref
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Onglet Drive I/F

1. Dans la fenêtre Change Controller Parameters, sélectionnez l'onglet Drive I/F.

2. Dans le champ SCSI Motor Spin Up, sélectionnez Disabled ou Enabled.

La fonction SCSI Motor Spin Up décide comment les lecteurs SCSI d'une baie de
disques démarrent. Lorsque l'alimentation électrique est incapable de fournir une
intensité suffisante pour démarrer simultanément les disques durs et les contrôleurs,
le démarrage séquentiel des disques durs est une des meilleures méthodes de
réduction de l'intensité de démarrage. Par défaut, tous les disques durs démarrent à
la mise sous tension.

3. Dans le champ Power Up SCSI Reset, sélectionnez Enabled ou Disabled.

Par défaut, lorsque le contrôleur est mis en marche, il envoie une commande de
réinitialisation du bus SCSI au bus SCSI. Lorsque le contrôleur est désactivé, il n'envoie
pas de commande de réinitialisation du bus SCSI à la prochaine mise sous tension.

Lors d'une connexion des ordinateurs d'hôte doubles à un même bus SCSI, la
réinitialisation du bus SCSI interrompt toutes les demandes lecture/écriture en
cours. Ceci risque d'affecter la performance de certains environnements
d'exploitation ou ordinateurs hôtes. Désactivez l'option Power Up SCSI Reset à la
mise sous tension pour éviter cette situation.

4. Définissez l’option Disk Access Latency.

Cette fonction établit la durée de l'intervalle au bout duquel le contrôleur essaie
d'accéder aux disques durs après la mise sous tension. La valeur par défaut est
15 secondes.

5. Définissez Tag Count Per drive.

Il s'agit du nombre maximal de requêtes pouvant être envoyées vers chacun des
lecteurs en même temps. Un lecteur est doté d'une mémoire cache incorporée
utilisée pour trier les requêtes d'E/S envoyées au lecteur, ce qui lui permet de les
effectuer plus rapidement.

La taille de la mémoire cache et le nombre maximal de requête varient en fonction
des marques et des modèles de lecteur. Utilisez la valeur par défaut qui est 32.
Le changement du nombre de requête maximal sur Disable ignore la mémoire cache
interne du lecteur (non utilisé).

Le contrôleur prend en charge la mise en file d'attente de la commande de requête
avec un nombre de requêtes modifiables allant de 1 à 128.

6. Dans le champ SAF-TE Polling Period (Sec), sélectionnez les options de temps
variable indiquées dans la zone de liste ou sélectionnez 0,0 pour désactiver cette
fonction de sorte que tous les modules Event Recording Modules (ERM) installés
ne soient jamais interrogés.
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7. Dans le champ SCSI I/O Timeout (Sec), sélectionnez entre 0,5 et 10 secondes.
L'intervalle « SCSI I/O Timeout » (temporisation d'E/S SCSI) est la période de temps
pendant laquelle un contrôleur attend la réponse d'un lecteur. Lorsqu'un contrôleur
essaie de lire ou d'écrire des données dans un lecteur et que celui-ci ne répond pas
dans le délai imparti (SCSI I/O timeout), le lecteur est considéré comme défaillant.
Le paramètre par défaut pour SCSI I/O Timeout est de 7 secondes. Ne changez pas
ce paramètre. Si vous réglez le délai imparti à une valeur inférieure, le contrôleur
juge un lecteur comme défaillant alors que ce lecteur est toujours en train d'essayer
ou alors que ce lecteur n'est pas capable d'arbitrer le bus SCSI. Si vous réglez le délai
à une valeur supérieure, le contrôleur attend un lecteur et cela peut parfois entraîner
un délai de l'hôte.
Lorsque le lecteur détecte une erreur de support pendant la lecture du plateau de
lecteurs, il retente la lecture précédente ou étalonne à nouveau la tête. Lorsque le
lecteur rencontre un mauvais bloc sur le média, il réaffecte le mauvais bloc vers un
autre bloc de réserve sur le même lecteur de disque. Ce transfert prend toutefois un
certain temps. Le temps d'exécution de ces opérations varie en fonction des marques
et des modèles de lecteur.
Au cours de l'arbitrage du bus SCSI, un périphérique avec une priorité plus élevée
peut utiliser le bus en premier. Un périphérique avec une priorité inférieure reçoit
parfois un délai d'expiration SCSI I/O Timeout lorsque les périphériques avec une
priorité plus élevée continuent d'utiliser le bus.

8. Dans le champ Drive Check Period (Sec), sélectionnez entre 0,5 et 30 secondes.
La valeur de Periodic Drive Check Time représente un intervalle de contrôle des
lecteurs du bus SCSI utilisé par le contrôleur. La valeur par défaut est Disabled,
ce qui signifie que s'il n'y a pas d'activité sur le bus, le contrôleur ne sait pas si un
lecteur est en panne ou a été retiré. Le réglage de cet intervalle permet à
Configuration Service de détecter une défaillance de lecteur lorsqu'il n'y a pas
d'activité de baie ; toutefois, la performance est affectée.
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Onglet Host I/F Tab

1. Dans la fenêtre Change Controller Parameters, sélectionnez l’onglet Host I/F.

2. Définissez la valeur de Set the Max Queued IO Count.

Cette fonction permet de configurer la taille maximale en octets de la file d'attente
des E/S que le contrôleur peut accepter de l'ordinateur hôte. La valeur par défaut est
256. La plage de réglage prédéfinie est de 1 à 1 024 octets. Vous pouvez également
choisir le mode Auto Computer (configuration automatique).

3. Définissez la valeur de LUNs Per Host.

Cette fonction permet de changer le nombre d'unités logiques pour chaque
identificateur SCSI de l'hôte. La valeur par défaut est de 32 unités logiques, avec une
plage prédéfinie de 1 à 32 unités logiques disponibles.
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Onglet Redundancy

1. Dans la fenêtre Change Controller Parameters, sélectionnez l'onglet Redundancy.

Trois champs lecture seulement sont affichés : Controller Configuration, Controller
Status, et Secondary Serial No.

2. Sélectionnez une option dans le champ Set Controller Config.

■ Redundant Deassert Reset – si vous avez forcé l'échec d'un contrôleur et que vous
voulez le remettre en ligne.

■ Redundant Force Sec Fail – si vous voulez forcer l'échec du contrôleur secondaire.

■ Redundant Force Pri Fail – si vous voulez forcer l'échec du contrôleur principal.

Remarque – Définissez les deux contrôleurs sur la configuration Redundant
Primary. Les contrôleurs déterminent ensuite celui qui est principal et celui qui est
secondaire. Cette configuration empêche tout conflit entre les contrôleurs.
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3. Pour enregistrer les modifications dans la fenêtre Change Controller Parameters,
cochez la case Issue Controller Reset.

4. Cliquez sur Close pour revenir au menu principal de Configuration Service.

Onglet Network

1. Dans la fenêtre Change Controller Parameters, sélectionnez l'onglet Network.

2. Pour configurer manuellement une adresse IP, un masque de sous-réseau ou une
adresse de passerelle, cliquez sur « Change Settings ».

3. Lorsque la baie a été installée dans un environnement comportant un serveur
DHCP/RARP, il est possible de sélectionner l'activation de l'affectation
dynamique IP (Enable Dynamic IP Assignment) pour permettre à la baie d'obtenir
automatiquement une adresse IP du réseau.
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▼ Désactivation du signal sonore du contrôleur
Lorsqu'un événement se produit déclenchant le signal sonore du contrôleur, comme
par exemple, un lecteur logique qui tombe en panne pendant une reconstruction, ou
lors de l'ajout d'un lecteur SCSI, vous pouvez désactiver le signal sonore.

1. Sélectionnez l'icône du contrôleur souhaité dans la fenêtre principale.

2. Sélectionnez Array Administration → Controller Maintenance.

3. Si vous n'êtes pas encore connecté comme ssconfig, une invite s'affiche vous
demandant le mot de passe, tapez ssconfig.

Le menu Controller Maintenance Options s'affiche.

4. Cliquez sur Mute Controller Beeper.

ou

1. Sélectionnez l'icône du contrôleur souhaité dans la fenêtre principale.

2. Sélectionnez Configuration → Custom Configure.

3. Sélectionnez Change Controller Parameters.

4. Cliquez sur Mute Beeper.

▼ Enregistrement des valeurs modifiées
1. Si les modifications des variables décrites ci-dessus vous paraissent satisfaisantes,

sélectionnez Configuration → Custom Configuration.

2. Cliquez sur Change Controller Parameters.

3. Sélectionnez Issue Controller Reset.

4. Cliquez sur OK puis sur Close pour revenir au menu principal de Configuration
Service.
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▼ Affectation ou modification des lecteurs en
attente
Un lecteur en attente agit comme lecteur de réserve pour la reconstruction
automatique des données à la suite de la défaillance d'un lecteur physique associé à
un lecteur logique à tolérance de panne (non-RAID 0). Pour qu'un lecteur en attente
prenne la place d'un autre lecteur, sa taille doit être au moins égale à celle du lecteur
défaillant et tous les lecteurs logiques dépendant du lecteur de disque défaillant
doivent être dotés de la redondance (RAID 1, 3, 5 et 1+0).

Cette fonction vous permet d'affecter un lecteur en attente global ou local, de changer
un état d'un lecteur prêt à en attente et de changer un état de lecteur en attente à prêt.
Un lecteur qui est affecté comme réserve globale reconstruit si un membre de
n'importe quel lecteur existant est défaillant. Vous pouvez associer un ou plusieurs
lecteurs en attente à un contrôleur de baie. Une réserve locale doit être affectée à un
lecteur logique particulier et ne reconstruit que pour un membre de ce lecteur logique.

1. Dans la fenêtre principale de Configuration Service, sélectionnez le contrôleur de
baie souhaité.

2. Sélectionnez Configuration → Custom Configure ou cliquez sur l’outil Custom
Configuration.

Le cas échéant, connectez-vous au niveau de configuration du programme avec le
mot de passe ssconfig. La fenêtre Custom Configuration Options s'affiche.

3. Sélectionnez Make or Change Standby Drives dans la fenêtre Custom
Configuration Options.

La fenêtre Make or Change Standby Drives s’affiche.
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4. Vérifiez les ID du serveur et du contrôleur affichés en haut de la fenêtre.

Pour sélectionner un autre serveur ou autre contrôleur, cliquez sur Cancel pour
revenir à l'affichage arborescent Configuration Service, sélectionnez le serveur ou le
contrôleur approprié dans l'arborescence et répétez les étapes 2 et 3.

5. Sélectionnez un lecteur à affecter ou à modifier.

6. Modifiez ou affectez l'état du lecteur en sélectionnant Ready, Global StandBy ou
StandBy for LD# (local).

7. Cliquez sur Modify.

8. Cliquez sur Apply, puis sur Close.

9. Lorsque vous apportez des modifications à la configuration, enregistrez la
nouvelle configuration vers un fichier. (Pour de plus amples informations, voir
« Configuration File », page 84).

Serveurs disponibles
De temps à autre, vous devez modifier ou supprimer une entrée des listes Available
ou Managed Servers dans la fenêtre Server List Setup.

▼ Modification d'une entrée de serveur
1. Sélectionnez File → Server List Setup. La fenêtre Server Setup s’affiche.

Le cas échéant, déplacez le nom du serveur de la liste Managed Servers vers la liste
Available Servers dans la fenêtre Server List Setup. Seules les entrées de serveur de
la liste Available Servers peuvent être modifiées.
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2. Sélectionnez le nom du serveur dans la liste Available Servers, puis cliquez sur Edit.

La fenêtre Edit Server s'affiche.
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3. Effectuez les modifications nécessaires. Cliquez sur OK pour enregistrer les
modifications.

Pour toute description concernant les champs affichés dans cette fenêtre, voir
« Ajout de serveurs », page 43. Les fenêtre Add Server et Edit Server contiennent les
mêmes champs.

Raccourci d'adresse IP : si l'adresse du réseau a changé, cliquez sur Get IP Addr by
Name. Configuration Service recherche l'adresse IP correcte et l'affiche si vous
fournissez le nom du serveur tel qu'il est enregistré par le service de nom de votre
réseau.

Si le nom utilisé pour le serveur n'est pas le même que celui du réseau du serveur ou
si le service de nom n'a pas encore été actualisé, supprimez le serveur et rajoutez-le.

4. Redéplacez le nom du serveur à la liste Managed Servers.

5. Cliquez sur OK pour quitter la fenêtre Edit Server.
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ANNEXE A

Introduction à RAID

Cette annexe fournit des informations contextuelles sur le RAID, notamment une
vue d’ensemble de la terminologie RAID et des niveaux de RAID. Les rubriques
suivantes sont couvertes dans ce chapitre :

■ « Vue d’ensemble de la terminologie RAID », page 189
■ « Niveaux RAID », page 195
■ « Lecteurs de réserve locaux et globaux », page 202

Vue d’ensemble de la terminologie RAID
Un RAID (baie redondante de disques indépendants) est une technologie de
stockage utilisée pour améliorer les capacités de traitement des systèmes de
stockage. Cette technologie est conçue pour conférer de la fiabilité aux systèmes de
baies de disques et pour tirer partie des gains de performances offerts par une baie
de plusieurs disques par rapport au stockage sur un disque unique.

Les deux principes de base d’un RAID sont les suivants :

■ la distribution des données sur plusieurs unités de disque améliore les performances

■ l’utilisation correcte de plusieurs lecteurs autorise la défaillance d'un lecteur sans
perte de données ni temps mort du système

En cas de défaillance d’un disque, l’accès aux unités continue normalement et la
défaillance est transparente au niveau du système hôte.
189



Lecteur logique
Un lecteur logique est un ensemble de lecteurs physiques indépendants. La création de
lecteurs logiques permet d’augmenter la disponibilité, la capacité et les performances.
Le lecteur logique apparaît à l'hôte comme un lecteur de disque dur local.

FIGURE 11-2 Lecteur logique comprenant plusieurs lecteurs physiques

Volume logique
Un volume logique se compose de deux lecteurs logiques ou plus. Le volume logique
peut être divisé en un maximum de 32 partitions en SCSI et 128 partitions en Fibre
Channel. Au cours du fonctionnement, l'hôte perçoit le volume logique non
partitionné ou une partition d'un volume logique comme un lecteur physique simple.

Lecteur de réserve local
Un lecteur de réserve local est un lecteur de secours affecté à un lecteur logique
donné. En cas de défaillance d'un lecteur membre de ce lecteur logique, le lecteur de
réserve local en devient membre et sa reconstruction commence immédiatement.

Lecteur de réserve global
Un lecteur de réserve global ne sert par seulement un lecteur logique spécifique.
En cas de défaillance d'un membre de n'importe quelle unité logique, le lecteur de
réserve global se joint à ce lecteur logique et lance automatiquement la
reconstruction des données.
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Canal SCSI
Un canal SCSI (bus SCSI) peut connecter 15 périphériques au maximum (à l'exclusion
du contrôleur lui-même) lorsque la fonction Wide est activée (SCSI 16 bits). Fibre
Channel permet de connecter 125 périphériques dans une boucle. Chacun des
périphériques est doté de son propre ID SCSI.

La FIGURE A-1 illustre ce concept. Si vous archivez les documents dans une armoire,
vous devez placer le document dans l'un des tiroirs. Du point de vue SCSI, un ID
SCSI joue en quelque sorte le rôle d'une armoire et les unités logiques représentent
les tiroirs. Chacun des ID SCSI active 32 unités logiques. Les données peuvent être
stockées dans une des unités logiques de l'identificateur SCSI. La plupart des cartes
hôtes SCSI traitent une unité logique comme un autre périphérique SCSI.

FIGURE A-1 ID SCSI/unité logique

Un lecteur logique se compose d'un groupe de lecteurs SCSI ou Fibre Channel.
Les lecteurs physiques d'un lecteur logique ne doivent pas forcément provenir du
même canal SCSI. En outre, chacun des lecteurs logiques peut être configuré pour un
niveau RAID différent.
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Un lecteur peut être affecté comme lecteur de réserve local à un lecteur logique
spécifié ou comme lecteur de réserve global. Un lecteur de réserve n'est pas disponible
pour les lecteurs logiques qui n'ont pas de redondance de données (RAID 0).

FIGURE A-2 Affectation des lecteurs dans des configurations de lecteur logique

Canal de lecteur 0

Lecteur logique 1

Lecteur de Lecteur de réserve

Lecteur logique 0

Canal de lecteur 1

4
Go

4
Go

2
Go

2
Go

4
Go

4
Go

2
Go

2
Go

ID5 ID0

ID6 ID1 ID0 ID14

ID3 ID2

RAID 5
8 Go

RAID 3
6 Go

réserve global local pour LD1
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Vous pouvez partager le lecteur logique ou volume logique en plusieurs partitions ou
utiliser tout le lecteur logique comme une seule partition.

FIGURE A-3 Partitions dans des configurations de lecteur logique

Lecteur logique 0

RAID 5 (8 Go)

Lecteur logique 1

RAID 3 (6 Go)

Partition 0 2 Go

Partition 1 1 Go

Partition 2 5 Go

Partition 0 2,5 Go

Partition 1 1,5 Go

Partition 2 2 Go
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Chacune des partitions est mappée aux unités logiques sous les ID SCSI d'hôte ou
les ID sur les canaux d'hôte. Chacun des ID SCSI/unité logique agit comme un
disque dur individuel pour l'ordinateur hôte.

FIGURE A-4 Mappage des partitions aux identificateur/unités logiques d'hôte

FIGURE A-5 Mappage des partitions aux unités logiques sous un ID
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Canal SCSI d'hôte
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Lecteur logique 1
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Lecteur logique 0
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Lecteur logique 0
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Partition 1Partition 1 Partition 2

4,5 Go 5 Go 2 Go

1 Go 1.5 Go 2 Go
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Niveaux RAID
Il existe différentes manières de mettre en œuvre une baie RAID, en utilisant certaines
combinaisons de technologies de miroir, d’entrelacement, de duplex et de parité. Ces
différentes techniques sont connues sous l'appellation de niveaux RAID. Chacun des
niveaux offre différentes combinaisons de performances, de fiabilité et de coût. Chaque
niveau utilise un algorithme différent pour mettre en œuvre la tolérance de panne.

Huit choix de niveau RAID sont disponibles : RAID 0, 1, 0+1, 3, 5, 1+0 (10), 3+0 (30)
et 5+0 (50). Les niveaux RAID 1, 3 et 5 sont les plus couramment utilisés.

Le tableau ci-après fournit une vue d’ensemble succincte des niveaux RAID.

La capacité se rapporte au nombre total (N) de lecteurs physiques disponibles pour
le stockage des données. Par exemple, si la capacité = N-1 et le nombre total de
lecteurs de disque dans le lecteur logique est de six lecteur 36 Mo, l’espace disque
disponible pour le stockage est égal à cinq lecteurs de disque — 5 x 36 Mo (180 Mo).
Le -1 correspond à l'entrelacement à travers les six lecteurs, qui fournit la
redondance des données et qui est égal à la taille de l'un des lecteurs de disque.

Pour les RAID 3+0 (30) et 5+0 (50), la capacité correspond au nombre total de lecteurs
physiques (N) moins un lecteur physique (#) pour chaque lecteur logique du volume.
Par exemple, si le nombre total de lecteurs de disque du lecteur logique est de vingt
lecteurs 36 M et que le nombre total de lecteurs logiques est 2, l’espace disque
disponible pour le stockage est égal à 18 lecteurs de disques — 18 x 36 Mo (648 Mo).

TABLEAU A-1 Vue d’ensemble des niveaux RAID

Niveaux RAID Description
Nombre de lecteurs
pris en charge Capacité Redondance

0 Entrelacement 2-44 N Non

1 Écriture en miroir 2 N/2 Oui

0+1 Mise en miroir et
entrelacement

4-44 (nombre pair
seulement)

N/2 Oui

3 Entrelacement avec parité
dédiée.

3-31 N-1 Oui

5 Entrelacement avec parité
distribuée

3-31 N-1 Oui

1+0 (10) Entrelacement de lecteurs
logiques RAID 1

2 à 8 lecteurs
logiques

N/2 Oui

3+0 (30) Entrelacement de lecteurs
logiques RAID 3

2 à 8 lecteurs
logiques

N-# de lecteurs
logiques

Oui

5+0 (50) Entrelacement de lecteurs
logiques RAID 5

2 à 8 lecteurs
logiques

N-# de lecteurs
logiques

Oui
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RAID 0
RAID 0 met en œuvre l’entrelacement de bloc, dans lequel les données sont
fractionnées en blocs logiques et entrelacées sur plusieurs lecteurs. Contrairement
aux autres niveaux RAID, la redondance n’est pas prévue. En cas de défaillance d'un
disque, les données sont perdues.

Dans l’entrelacement de blocs, la capacité totale du disque est équivalente à la
somme des capacités de tous les lecteurs de la baie. Cette combinaison de lecteurs
est considérée comme un seul lecteur logique par le système.

RAID 0 offre les meilleures performances. Il est rapide car les données peuvent être
simultanément transférées vers/depuis tous les disques de la baie. En outre, les
opérations de lecture/écriture sur différents disques sont traitées simultanément.

FIGURE A-6 Configuration RAID 0
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RAID 1
RAID 1 met en oeuvre la mise en miroir des disques qui se concrétise par la copie des
mêmes données sur deux lecteurs. En conservant deux copies des données sur des
disques séparés, les données sont protégées d’une défaillance du disque. En cas de
défaillance à tout moment d’un disque de la baie RAID 1, le disque en bon état restant
(la copie) peut fournir toutes les données nécessaires en évitant un temps mort.

Avec la mise en miroir des disques, la capacité totale utilisable est équivalente à celle
d’un disque de la baie RAID 1. Ainsi, la combinaison de deux lecteurs de 1 Go, par
exemple, crée un lecteur logique unique doté d’une capacité utilisable de 1 Go. Cette
combinaison de lecteurs est interprétée comme un seul lecteur logique par le système.

Remarque – RAID 1 interdit toute expansion. Les niveaux RAID 3 et 5 permettent
l’agrandissement par ajout de lecteurs à une baie existante.

FIGURE A-7 Configuration RAID 1

En plus de la protection des données apportées par RAID 1, ce niveau RAID
améliore également les performances. Lorsque plusieurs E/S se produisent
simultanément, elles peuvent être réparties entre les copies du disque, réduisant
ainsi le temps réel d'accès aux données.
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RAID 1(0+1)

RAID 1(0+1) associe —la mise en miroir et l’entrelacement des disques de RAID 0 et
RAID 1. L’utilisation de RAID 1(0+1) est une fonction gain de temps qui vous
permet de configurer un grand nombre de disques en une seule étape. Il ne s’agit
pas d'une option RAID standard que vous pouvez sélectionner ; elle ne figure pas
dans la liste des options RAID supportées par le contrôleur. Selon le nombre de
disques sélectionnés, le contrôleur détermine automatiquement s’il faut utiliser le
niveau RAID 1 ou RAID 1(0+1). Si vous sélectionnez deux disques, un lecteur
logique RAID 1 est créé. La sélection d’un nombre pair de disques égal ou supérieur
à quatre crée un RAID 1(0+1).

FIGURE A-8 Configuration RAID 1(0+1)
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RAID 3
RAID 3 met en œuvre l’entrelacement de blocs avec parité dédiée. Ce niveau RAID
fractionne les données en blocs logiques de la taille d’un bloc de disque puis les
entrelace sur plusieurs lecteurs. Un lecteur est dédié à l'enregistrement de la parité.
En cas de défaillance d’un disque, les données d’origine peuvent être reconstruites à
l'aide des informations de parité et des informations sur les autres disques.

Au niveau RAID 3, la capacité totale est équivalente à la somme des capacités de
tous les lecteurs de la combinaison, excepté le lecteur de parité. Ainsi, la
combinaison de quatre lecteurs de 1 Go, par exemple, crée un lecteur logique unique
doté d’une capacité totale utilisable de 3 Go. Le système interprète cette combinaison
comme un seul lecteur logique.

RAID 3 offre une augmentation du débit des données lorsqu'elles sont lues par
petites portions ou séquentiellement. Toutefois, lors d'opérations d'écriture qui
n'utilisent pas tous les lecteurs, la performance est réduite car les informations
stockées sur le lecteur de parité doivent être recalculées et réécrites à chaque
nouvelle écriture de données, ce qui a pour effet de limiter les E/S simultanées.

FIGURE A-9 Configuration RAID 3
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RAID 5
RAID 5 met en oeuvre l’entrelacement de blocs avec parité distribuée. Ce niveau RAID
offre une redondance avec les informations de parité distribuées sur tous les disques
de la baie. Les données et leur parité ne sont jamais stockées sur le même disque.
En cas de défaillance d’un disque, les données d’origine peuvent être reconstruites à
l’aide des informations de parité et des informations sur les autres disques.

FIGURE A-10 Configuration RAID 5

RAID 5 offre une augmentation du débit des données lorsqu'elles sont accédées en
larges portions ou aléatoirement et réduit le temps d'accès en cas de nombreuses E/S
simultanées.
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Niveaux RAID avancés
Les niveaux RAID avancés qui suivent exigent l’utilisation du gestionnaire incorporé
de la baie de disques. Ces niveaux de RAID combinés offrent les avantages de la
protection des niveaux RAID 1, 3 ou 5 et les performances de RAID 1. Pour utiliser
les RAID avancés, créez au préalable deux baies RAID 1, 3 ou 5 au minimum et
unissez-les.

RAID 1+0 (10)

Lecteurs logiques RAID 1 reliés ensemble à l’aide du gestionnaire de volume
incorporé de la baie de disques.

RAID 3+0 (30)

Lecteurs logiques RAID 3 reliés ensemble à l’aide du gestionnaire de volume
incorporé de la baie de disques.

RAID 5+0 (50)

Lecteurs logiques RAID 5 reliés ensemble à l’aide du gestionnaire de volume
incorporé de la baie de disques.
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Lecteurs de réserve locaux et globaux
Les contrôleurs RAID externes offrent des fonctions de lecteur de réserve local et
global. Le lecteur de réserve local sert uniquement au lecteur spécifié ; le lecteur de
réserve global peut être utilisé pour n’importe quel lecteur logique de la baie.

Le lecteur de réserve local prend toujours le pas sur le lecteur de réserve global ; par
conséquent, en cas de défaillance d’un lecteur alors que les deux types de lecteur de
réserve sont disponibles simultanément ou si un espace plus important est
nécessaire pour replacer le lecteur défaillant, le lecteur de réserve local est utilisé.

S'il y a un lecteur défaillant dans le lecteur logique RAID 5, remplacez-le par un
nouveau lecteur pour préserver le fonctionnement du lecteur logique. Pour identifier
un lecteur défaillant, reportez-vous au Guide de l’utilisateur Sun StorEdge 3000 Family
RAID Firmware relatif à votre baie.

Précaution – Si, lorsque vous essayez de retirer un lecteur défaillant, vous retirez le
mauvais lecteur par inadvertance, vous ne serez plus en mesure d'accéder au lecteur
logique parce que vous avez rendu un autre lecteur défaillant.

Un lecteur de réserve local est un lecteur de secours affecté à un lecteur logique
donné. En cas de défaillance d'un lecteur membre de ce lecteur logique, le lecteur de
réserve local en devient membre et sa reconstruction commence immédiatement.

Un lecteur de réserve local prend toujours le pas sur un lecteur de réserve global ;
c'est-à-dire que, si un lecteur est défaillant alors que les deux types de lecteur de
réserve sont disponibles, le lecteur de réserve local est utilisé.

FIGURE A-11 Lecteur de réserve local (dédié)

Lecteur de réserve local
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Un lecteur de réserve global ne dessert par uniquement un seul lecteur logique
spécifié ; il est disponible pour tous les lecteurs logiques (voir FIGURE A-12). En cas de
défaillance d'un membre de n'importe quelle unité logique, le lecteur de réserve
global se joint à cette unité logique et la reconstruction des données commence
automatiquement.

Un lecteur de réserve local prend toujours le pas sur un lecteur de réserve global ;
c'est-à-dire que, si un lecteur est défaillant alors que les deux types de lecteur de
réserve sont disponibles, le lecteur de réserve local est utilisé.

FIGURE A-12 Lecteur de réserve global

Lecteur logique 0
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Lecteur logique 1 Lecteur logique 2
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Disposer de lecteurs de réserve local et global
Dans la FIGURE A-13, les lecteurs membres du lecteur logique 0 sont des lecteurs de
9 Go et ceux des lecteurs logiques 1 et 2 sont tous des lecteurs 4 Go.

FIGURE A-13 Mélange des disques réserve local et global

Un lecteur de réserve local prend toujours le pas sur un lecteur de réserve global ;
c'est-à-dire que, si un lecteur est défaillant alors que les deux types de lecteur de
réserve sont disponibles, le lecteur de réserve local est utilisé.

Dans la FIGURE A-13, il n’est pas possible pour le lecteur de réserve global de 4 Go de
s’unir au lecteur logique 0 en raison de sa capacité insuffisante. Le lecteur de réserve
de 9 Go assistera le lecteur logique 0 au moment d'une défaillance d'une unité au
sein du lecteur logique. Si le lecteur défaillant se trouve dans le lecteur logique 1 ou
2, le lecteur de réserve global de 4 Go assiste immédiatement le lecteur défaillant.

Lecteur de réserve local Lecteur de réserve global
(4 Go)(9 Go)

(9 Go)

(9 Go)

(4 Go)

(4 Go)

(4 Go)

Lecteur logique 0 Lecteur logique 1 Lecteur logique 2
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(4 Go)(4 Go)
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ANNEXE B

Surveillance des unités JBODs
(SCSI uniquement)

Cette annee explique comment surveiller une unité autonome JBOD et télécharger
une mise à jour de son firmware pour les baies Sun StorEdge 3310 SCSI uniquement.
Remarquez que les fonctions de la baie ne sont pas toutes prises en charge par les
unités JBOD. Les procédures suivantes sont couvertes dans cette annexe :

■ « Activation de la prise en charge d'une unité JBOD », page 205
■ « Affichage des caractéristiques des composants et des alarmes », page 207
■ « Mise à niveau du firmware sur disques durs », page 208
■ « Mise à niveau du firmware sur les périphériques SAF-TE », page 209
■ « Échange d'un lecteur défaillant », page 210

▼ Activation de la prise en charge d'une unité
JBOD
Pour surveiller la condition du périphérique et les événements d'une unité JBOD,
vous devez tout d'abord activer la prise en charge des unités JBOD.

1. Sélectionnez View → Agent Options Management.

La fenêtre Agent Options Management s'affiche.

2. Cochez la case Enable JBOD Support.

3. Pour afficher immédiatement l'unité JBOD dans la fenêtre principale de
Configuration Service, vous devez rechercher de nouveaux inventaires.
Sélectionnez View → View Server et cliquez sur Probe.

4. Cliquez sur OK.

L'unité JBOD s'affiche dans la fenêtre principale de Configuration Service.

Dans le cas d'une configuration simple bus, les deux ports de l'unité JBOD sont
connectés à un adaptateur de bus hôte sur le serveur (voir l'exemple ci-dessous).
205



Dans le cas d'une configuration double bus, chacun des ports est connecté à son
propre adaptateur de bus hôte (voir l'exemple ci-dessous).

Remarque – Dans le cas d'une configuration double bus, si chacun des ports est
connecté à un serveur différent, Configuration Service ne peut que surveiller l'unité
JBOD du serveur connecté au port B.
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▼ Affichage des caractéristiques des composants et
des alarmes
La fenêtre View Enclosure affiche les caractéristiques des composants et des alarmes
d'un JBOD.

1. Sélectionnez l'icône EMU icon .

2. Sélectionnez → View Enclosure.

Pour afficher l'ID de l'unité remplaçable par l'utilisateur, cliquez sur View FRU.
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Téléchargement du firmware pour
périphériques
Cette option permet de mettre à niveau le firmware sur disques durs et les
périphériques SAF-TE sur l'unité JBOD.

▼ Mise à niveau du firmware sur disques durs
1. Sélectionnez un composant JBOD.

2. Sélectionnez Array Administration → Download FW for Devices.

3. Cliquez sur l'onglet Download FW for Disks.

4. Sélectionnez les lecteurs sur lesquels vous voulez télécharger le nouveau firmware
dans la liste Available Disks et cliquez ensuite sur Add.

Si vous avez l'intention de supprimer des lecteurs logiques, sélectionnez-les dans la
liste Selected Disks et cliquez ensuite sur Remove.
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5. Cliquez sur Browse et recherchez le fichier du firmware à télécharger.
Sélectionnez-le, cliquez sur Open puis sur OK.

Le téléchargement du firmware s'effectue.

6. Lorsque l'indicateur de progrès a atteint 100 %, cliquez sur OK.

7. Pour actualiser Configuration Service, sélectionnez View → View Server.

8. Cliquez sur Probe, puis sur OK.

9. Pour vous assurer que le firmware a été téléchargé avec succès, sélectionnez
View → View Physical Drive, et veillez à ce que la version du firmware ait été
modifiée dans le champ Product Revision.

▼ Mise à niveau du firmware sur les périphériques
SAF-TE

1. Sélectionnez un composant JBOD.

2. Sélectionnez Array Administration → Download FW for Devices.

3. Cliquez sur l'onglet Download FW for SAF-TE Devices.

4. Pour ajouter un périphérique, sélectionnez-le dans la liste Available SAF-TE
Devices et cliquez ensuite sur Add.

Pour supprimer un périphérique, sélectionnez-le dans la liste Selected SAF-TE
Devices et cliquez ensuite sur Remove.
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5. Cliquez sur Browse et recherchez le fichier du firmware à télécharger.
Sélectionnez-le, cliquez sur Open puis sur OK.

Le téléchargement du firmware s'effectue.

La baie émet un signal sonore et les voyants DEL clignotent à environ 70 %.

6. Lorsque l'indicateur de progrès a atteint 100 %, cliquez sur OK.

7. Pour actualiser Configuration Service, sélectionnez View → View Server, et
cliquez sur Probe.

8. Cliquez sur OK.

9. Pour vous assurer que le firmware a été téléchargé avec succès, sélectionnez
View → View Enclosure, et veillez à ce que la version du firmware ait été modifiée
changé dans le champ Firmware Rev.

▼ Échange d'un lecteur défaillant
Une panne de lecteur est indiqué par le symbole rouge d'état de périphérique .
Après avoir remplacé un lecteur défaillant, procédez selon les étapes suivantes.

Environnement d'exploitation Solaris

1. Si le lecteur revient automatiquement en ligne (à savoir que le symbole rouge
d'état du périphérique disparaît), exécutez la commande

2. Exécutez la commande

3. Si le lecteur ne revient pas automatiquement en ligne (à savoir que le symbole
rouge d'état du périphérique ne disparaît pas), exécutez une réinitialisation de la
reconfiguration en exécutant la commande

# devfsadm

# format

# reboot -- -r
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Système d'exploitation Microsoft Windows NT/2000

1. Installez le nouveau lecteur selon les instructions stipulées dans le Manuel
d'installation, d'utilisation et d'entretien Sun StorEdge 3000 Family pour votre baie.

2. Sélectionnez View → View Server, et cliquez sur Rescan.

3. Pour garantir que Configuration Service reconnaît le nouveau lecteur,
sélectionnez-le dans la fenêtre principale Configuration Service.

4. Sélectionnez View → View Physical Drive, et vérifiez les informations.
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ANNEXE C

Utilisation de la configuration de
cluster

Si vous utilisez Microsoft Windows NT, Configuration Service peut surveiller le
stockage SCSI partagé. Cette section se compose des rubriques suivantes :

■ « Planification de la configuration de cluster », page 213
■ « Conditions relatives à la configuration de cluster », page 214
■ « Configuration de cluster », page 214

Une configuration de cluster doit d'abord être définie avec le matériel approprié.
Elle requiert également Microsoft Windows NT Server, Édition Entreprise, avec le
Service Pack 3 ou 4, et Microsoft Cluster Server (MSCS).

Si vous envisagez d'installer une configuration de cluster, vous devez lire ce chapitre.

Planification de la configuration de
cluster
Avant de définir une configuration de cluster, vous devez déterminer le type de
configuration souhaitée dans la mesure où il importe dans la configuration initiale
du stockage dans Configuration Service.

Il existe deux types principaux de configuration de cluster :

■ Un cluster de serveurs en attente à chaud où toutes les unités logiques appartiennent
à l'un des deux serveurs dans le cluster. Si le serveur possédant les unités logiques
tombe en panne, celles-ci sont transférées au second serveur, qui était inactif jusqu'à
présent. Deux unités logiques au minimum sont requises par cette configuration.

■ Un cluster équilibré en charge, où certaines unités logiques se trouvent sur un
serveur et certaines sur l'autre serveur. Les deux serveurs traitent les données en
même temps, mais les E/S sont traitées sur des unités logiques différentes.
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Vous devez définir au moins trois unités logiques. Cette configuration permet
d'établir une petite unité logique pour le disque quorum et une grande unité logique
à utiliser sur chacun des serveurs dans le cluster. Le disque quorum maintient les
données de configuration du cluster nécessaires au recouvrement du cluster en cas
de panne de serveur.

Conditions relatives à la configuration
de cluster
Lorsque vous installez le logiciel Microsoft Cluster Server, identifiez le disque à
utiliser comme disque quorum, qui contient les informations sur le cluster.

Dans une configuration de cluster, Configuration Service n'est exécuté que sur un
serveur à la fois, le serveur possédant le disque quorum. Si le serveur exécutant
Configuration Service fonctionne mal, Cluster Administrator passe
automatiquement la charge du disque du premier serveur au second serveur et lance
les services de Configuration Service sur ce serveur.

Dans une configuration de cluster à deux serveurs, le cluster lui-même, avec sa
propre adresse IP, devient le serveur géré sur la liste Managed Servers de
Configuration Service. Ajoutez le cluster à la liste Managed Servers pendant la
dernière étape de configuration du cluster pour Configuration Service.

▼ Configuration de cluster
Vous trouverez ci-dessous une synthèse des étapes requises à la configuration d'une
baie de disques dans une configuration de cluster avec deux serveurs hôtes.

1. Configurez les serveurs.

a. Configurez les deux serveurs, chacun d'eux avec un bus PCI et un disque de
démarrage qui ne fait pas partie du stockage SCSI partagé.

b. Installez une carte d'adaptateur d'hôte telle que Ultra-Wide, un adaptateur
d'hôte différentiel, dans chacun des serveurs et définissez un ID SI unique
pour chacun des adaptateurs d'hôte sur le bus SCSI partagé.

c. Installez deux cartes réseau sur chacun des serveurs.

d. Installez Microsoft Windows NT Server, Édition Entreprise et Windows NT
Service Pack 3 (ou version ultérieure) sur le disque de démarrage de chacun des
serveurs.
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2. Installez le sous-système de stockage actif-actif double et connectez-le aux deux
adaptateurs hôtes.

Voir les étapes d'installation dans la documentation fournie.

3. Installez l'agent Configuration Service sur chacun des serveurs.

a. Arrêtez les services de Configuration Service sur un serveur avant de les
installer sur l'autre serveur.

b. Assurez-vous que le service de Configuration Service est exécuté sur un serveur
ayant accès à l'unité logique d'hôte mappée sur le lecteur logique affecté au
contrôleur principal.

c. Voir les étapes d'installation de l'agent dans le chapitre d'installation approprié.

Après avoir installé l'agent, vous n'avez pas besoin de redémarrer le système.
Toutefois, une fois l'agent installé, arrêtez les services de Configuration Service
sur les serveurs.

Remarque – Dans les étapes suivantes, vous allez travailler avec un seul serveur à
titre d'exemple.

4. Installez le logiciel de la console de Configuration Service.

Vous pouvez installer la console de Configuration Service sur l'un des serveurs ou
sur n'importe quel ordinateur du réseau où se trouvent les serveurs. Configuration
Service permet de configurer et de surveiller à distance la baie de disques. Voir les
étapes détaillées dans le chapitre d'installation approprié.

5. Ajoutez le serveur qui a lancé les services de Configuration Service à la liste
Managed Servers de la console de Configuration Service (voir « Ajout de
serveurs », page 43).

Sélectionnez bien Auto Discovery et ajoutez le mot de passe ssmon.

6. Utilisez le logiciel de la console de Configuration Service pour vérifier et
configurer le stockage de Configuration Service sur le serveur actif et redémarrez
ensuite le serveur.

Votre baie de stockage peut avoir déjà été préconfigurée sur le sous-système de
stockage actif-actif double. Vous devez consulter la configuration dans l'arborescence
de Configuration Service afin de déterminer si c'est le cas.

Si le stockage n'est pas configuré ou si vous souhaitez modifier la configuration,
configurez toutes les unités logiques sur un serveur. Par la suite, après l'installation
de Microsoft Cluster Server, vous pouvez partager l'affectation du stockage entre les
serveurs avec Cluster Administrator.
Annexe C Utilisation de la configuration de cluster 215



7. Utilisez Disk Administrator de NT pour créer des partitions et formater les unités
logiques sur le serveur actif.

a. Si nécessaire, réaffectez les lettres de lecteur pour les disques.

Les partitions doivent toutefois toujours être formatées avec NTFS.

Microsoft Windows NT perçoit les unités logiques des contrôleurs actifs-actifs
doubles sur les deux serveurs dans le cluster. Vous pouvez créer des partitions et
des lecteurs logiques uniquement sur un seul serveur. Par la suite, après
l'installation de MSCS, vous pouvez utiliser Cluster Administrator pour répartir
le stockage entre les deux serveurs.

Les lettres de lecteur pour le stockage SCSI partagé entre les deux serveurs
doivent être les mêmes. S'il y a un lecteur CD additionnel ou un disque dur
externe sur un serveur et non sur l'autre, vous devez certainement réaffecter les
lettres du lecteur pour le stockage partagé. Après avoir exécuté cette étape,
assurez-vous qu'elles sont les mêmes sur l'autre serveur.

b. Prenez note des lettres de lecteur affectées au stockage partagé.

8. Accédez au second serveur.

a. Lancez Disk Administrator et assurez-vous que le deuxième serveur a les
mêmes lettres de lecteur que le premier.

Si ce n'est pas le cas, réaffectez les lettres de lecteur de sorte qu'elles soient les
mêmes sur les deux serveurs.

9. Arrêtez le second serveur.

10. Installez le logiciel Microsoft Cluster Server sur le premier serveur et redémarrez-le.

a. Après avoir installé MSCS, lancez Cluster Administrator et assurez-vous qu'il
peut reconnaître le cluster.

11. Accédez au second serveur, installez MSCS sur ce serveur en l'associant au
premier, puis redémarrez.

a. Après avoir installé MSCS sur le second serveur, redémarrez le second serveur
et vérifiez dans Cluster Administrator que les deux serveurs sont inclus dans le
cluster.
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12. Ajustez les groupes de disques dans Cluster Administrator.

Assurez-vous que le disque quorum et les autres disques, le cas échéant, figurent
ensemble dans un groupe de disques sous le premier serveur où vous avez
initialement configuré le stockage. Pour des renseignements supplémentaires sur
l'exécution de cette étape, voir la documentation sur Microsoft Cluster Service.

Remarque – Après avoir placé les deux unités logiques dans le même groupe de
disques, vous pouvez supprimer le groupe de disques vide.

13. Ajoutez les services de Configuration Service au groupe ayant un disque quorum
sur le premier serveur.

a. Sur les deux serveurs, arrêtez chacun des trois services de Configuration
Service, à savoir Configuration Service Startup, Configuration Service Monitor
et Configuration Service Server, puis configurez-les en mode manuel.

b. Utilisez Cluster Administrator pour installer chacun des services de
Configuration Service comme ressource au groupe ayant le disque quorum.

Saisissez chacun des services dans l'ordre répertorié ci-dessous en respectant le
format indiqué pour le nom (avec les deux mots liés). Après avoir installé chacun
des services, mettez le service en ligne pour le lancer sur le serveur actif.

Entrez les services comme services génériques. Une invite vous demande
d'indiquer les dépendances pour chacune des ressources. Les dépendances dans
le groupe sont les suivantes.

■ Disque associé au disque quorum
■ Autre disque, le cas échéant, à ajouter à ce groupe
■ Configuration ServiceStartup
■ Configuration ServiceMonitor
■ Configuration ServiceServer

Configuration ServiceStartup dépend des deux disques qui font déjà partie du
groupe. Configuration ServiceMonitor dépend de Configuration Service Startup,
et Configuration ServiceServer dépend de Configuration Service Monitor.

14. Pour que les deux serveurs du cluster s'affichent sous forme d'une seule icône
dans Configuration Service sous l'adresse IP du cluster, modifiez CLUSTER.TXT.

Le fichier se situe dans le même répertoire que les fichiers de la console Configuration
Service. Il se trouve sur le disque système de l'ordinateur où la console Configuration
Service a été installée. Si le lecteur C est le disque système, le chemin d'accès est le
suivant :

C:\Program Files\Sun\sscs
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Le texte suivant indique le contenu du fichier :

15. Modifiez la dernière ligne du fichier pour insérer l'adresse IP du cluster puis les
adresses IP des deux serveurs formant le cluster.

a. Enlevez le symbole dièse (#).

16. Lancez la console de Configuration Service et enlevez le premier serveur de la
liste Managed Servers et ajoutez à la liste le cluster en tant que serveur.

a. Accédez à la fonction Server List Setup. Voir « Ajout de serveurs », page 43.

Sélectionnez bien Auto Discovery et ajoutez le mot de passe ssmon. Si vous
saisissez le nom du cluster, Configuration Service fournit l'adresse IP si votre
réseau est muni d'un service DNS.

À ce stade, le cluster est configuré pour fonctionner correctement avec
Configuration Service. Si le serveur exécutant les services de Configuration
Service services tombe en panne, ses groupes de disques sont transférés au
second serveur et Cluster Administrator lance automatiquement les services de
Configuration Service sur ce serveur.

Remarque – Lorsqu'un serveur tombe en panne, il faut environ 15 minutes à l'icône
du cluster dans la console Configuration Service pour passer du violet au gris et
sans doute 10 autres minutes pour qu'elle redevienne violette.

Si vous souhaitez avoir une configuration équilibrée en charge avec certaines parties
du stockage exécutées sur l'autre serveur, vous devez utiliser Cluster Administrator
pour transférer un ou plusieurs groupes de disques sur l'autre serveur.

#Edit this file to map the NT cluster IP address
#servers constituting the cluster.
#The format of the entry is:
#<Cluster IP Address>=<server1 IP Address>:<server2 IP Address>
#The IP address must be in dot form.
#Example: If the cluster IP address is 151.239.130.70 and the
#IP addresses of individual servers are 151.239.130.71 and
#151.239.130.72,the entry would be:
# 151.239.130.70=151.239.130.71:151.239.130.72
#
#IMPORTANT NOTE:
#Use only the Cluster IP address to configure an NT cluster
#server on the Configuration Service console.
#
#151.239.130.70=151.239.130.71:151.239.130.72
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ANNEXE D

Détermination des noms d’hôtes
universels WWN

Cette annexe explique comment déterminer le nom d’hôte universel (WWN) dans
les systèmes fonctionnant sous les environnements d’exploitation Solaris et
Microsoft Windows NT.

▼ Pour déterminer le nom d’hôte universel WWN
Avant d’utiliser la fonction LUN Filter, vous devez déterminer quelle est la baie Sun
StorEdge 3510 Fibre Channel connectée à une carte HBA particulière et le nom
universel WWN associé à chaque carte.

Environnement d'exploitation Solaris
1. Si vous avez installé un nouveau périphérique HBA sur votre ordinateur,

redémarrez l’ordinateur.

2. Tapez la commande suivante :

3. Faites dérouler la liste pour voir les périphériques Fibre Channel et les noms
universels WWNs associés.

# luxadm probe
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Linux et Microsoft Windows NT/2000

1. Amorcez un hôte déterminé et notez la version du bios et les modèles de cartes
connectés à votre hôte.

2. Accédez au bios de la carte HBA avec la commande correcte (alt-q ou control-a sont
usuellement les plus utilisés).

Si l’hôte contient plusieurs cartes HBA, sélectionnez la carte connectée au stockage.

3. Analysez la carte pour trouver les périphériques qui y sont connectés
(usuellement avec Scan Fibre Devices ou Fibre Disk Utility).

Le nom du nœud (ou étiquette similaire) est le nom universel.

Exemple avec une carte Qlogic :

ID Fournisseur Produit Rév Nom du noeud Port ID

0 Qlogic QLA22xx Adapter B 210000E08B02DE2F 0000EF
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ANNEXE E

Messagerie électronique et
protocole SNMP

Configuration Service est doté de capacités de surveillance intégrale d'événements et
de notification par message électronique. La console de Configuration Service peut
envoyer des messages électroniques SMTP à une liste précise d'adresses
électroniques. Certains systèmes de messagerie, tels que Microsoft Exchange,
peuvent être configurés ou programmés avec des scripts permettant de notifier le
personnel d'administration en fonction des événements qui se sont produits.
Certains services de radiomessagerie permettent également d'envoyer ces messages
électroniques à un récepteur de radiomessagerie.

Les agents Configuration Service placent les événements dans les journaux des
erreurs de l'environnement d'exploitation. Ces agents peuvent également envoyer
les déroutements SNMP concernant les événements liés au stockage de masse à une
console de gestion d'entreprise, telle une console HP OpenView.

Cette annexe explique le processus de configuration des consoles Configuration
Service pour l'envoi de messages électroniques. Elle explique également comment
configurer les serveurs pour envoyer les déroutements des consoles de gestion
SNMP, décrit le format de déroutement et offre des informations supplémentaires
sur SNMP. Vous y trouverez également des explications sur une méthode
additionnelle d'envoi des déroutements SNMP ne requérant pas Configuration
Service. Les rubriques suivantes sont couvertes dans ce chapitre :

■ « Envoi de messages électroniques pour chaque serveur », page 222
■ « Configuration des serveurs pour l'envoi de déroutements », page 224
■ « Vérification de la chaîne de communauté », page 225
■ « Indication du destinataire de déroutement », page 226
■ « Configuration des serveurs dans l’environnement d’exploitation Solaris », page 227
■ « Détails sur le SNMP », page 229
221



▼ Envoi de messages électroniques pour chaque
serveur
Configurez la console pour envoyer des messages électroniques pour chacun des
serveurs gérés via la fonction Server List Setup.

1. Sélectionnez File → Server List Setup.

La fenêtre Server Setup s'affiche.

2. Cliquez sur Add.

Si le serveur a déjà été ajouté, vous devez le déplacer dans la liste Available Servers
et cliquez sur Edit.

La fenêtre Add Server ou Edit Server s’affiche. Les champs des deux fenêtres sont les
mêmes.
222  Guide de l’utilisateur Sun StorEdge 3000 Family Configuration Service 1.2 • avril 2003



3. Si vous n'avez pas encore ajouté le serveur, ajoutez les informations sur l'onglet
Properties.

Pour de plus amples informations, voir « Ajoutez un serveur : », page 44.

4. Pour envoyer des messages d'événement par le biais de la messagerie
électronique, sélectionnez l'onglet Mailing Lists.

La fenêtre Add Server s’affiche avec l’onglet Mailing Lists sélectionné.

a. Saisissez une adresse de courrier électronique par utilisateur dans le champ
Mail Address.

b. Dans la zone de liste Severity, parcourez les différents niveaux de gravité et
sélectionnez-en un.

c. Cliquez sur Add to List.

Pour supprimer un utilisateur de la liste, sélectionnez l'adresse de courrier
électronique et cliquez sur Delete from List.

d. Indiquez le serveur de messagerie. Cliquez sur Setup Mail Server.

La fenêtre Mail Server Setup s'affiche.
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Saisissez l'adresse IP ou le nom du serveur de messagerie Simple Mail Transport
Protocol (SMTP) qui transmet les messages de courrier électronique aux adresses
de destination indiquées précédemment.

e. Cliquez sur OK lorsque vous êtes satisfait des informations dans la fenêtre
Mail Server.

La fenêtre Add Server ou Edit Server s'affiche.

5. Cliquez sur OK lorsque vous êtes satisfait des informations dans la fenêtre Add
Server ou Edit Server.

La fenêtre Server Setup s'affiche.

6. Pour ajouter d'autres serveurs, répétez les étapes 2 à 5 pour chaque serveur.

7. Le cas échéant, déplacez le ou les serveurs que cette console doit contrôler vers la
liste Managed Servers.

Si vous modifiez un serveur, vous devez le redéplacer dans la liste Available Servers.

8. Cliquez sur OK pour revenir à la fenêtre principale de Configuration Service.

Configuration des serveurs pour l'envoi
de déroutements
Si le réseau comporte une console de gestion d'entreprise, par exemple une console
HP OpenView ou IBM NetView, vous pouvez configurer des serveurs Configuration
Service pour communiquer à la console les alarmes liées à certains événements.
Cette section décrit les étapes de configuration requises.

Remarque – Vous devez suivre les instructions de cette section uniquement si vous
voulez que Configuration Service envoie des déroutements SNMP aux autres
consoles de gestion d'entreprise.

Précaution – Si HP OpenView est installé sur le même serveur que vous êtes en
train de configurer pour envoyer des déroutements, évitez les erreurs d'initialisation
en reconfigurant les ressources système. Pour toute instruction sur la reconfiguration
des ressources système de reconfiguration, consultez la rubrique de dépannage
« Symptôme : Impossible d'installer HP OpenView ou de lancer le daemon de
déroutement. », page 240.
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Serveurs Microsoft Windows NT

Pour configurer un serveur Microsoft Windows NT afin qu'il envoie des déroutements
SNMP vers l'un ou plusieurs consoles de gestion d'entreprise, vous devez configurer
chaque service SNMP sur le serveur pour vous assurer des éléments suivants.

■ Le serveur répertorie la chaîne ou le nom de la communauté de la console de
gestion d'entreprise.

■ Le serveur affiche la console de gestion d'entreprise comme destination des
déroutements provenant du logiciel des agents Microsoft Windows NT.

▼ Vérification de la chaîne de communauté
Vous pouvez utiliser le nom de la communauté par défaut ou la chaîne de
communauté publique. Toutefois, la sélection d'un nom de communauté autre que
public offre plus de sécurité dans la mesure où il permet de limiter la communication
uniquement aux ordinateurs qui ont la chaîne de communauté spécifiée.

Configuration de la chaîne de communauté pour Microsoft Windows NT 4.0 :

1. Dans la fenêtre Control Panel, double-cliquez sur l'icône Network puis sur
l'onglet Services s'il n'est pas déjà sélectionné.

Dans la liste Network Services, effectuez un défilement jusqu'au service SNMP,
cliquez dessus pour le sélectionner puis sur Properties.

La fenêtre Microsoft SNMP Properties s'affiche.

Remarque – Si le service SNMP n'est pas installé, vous pouvez procéder à son
installation en cliquant sur Add dans la fenêtre Network. La fenêtre Select Network
Service s'affiche, vous permettant de sélectionner le service SNMP. Vous devez insérer le
CD de Microsoft Windows NT 4.0 pour copier les fichiers nécessaires au service SNMP.

2. Cliquez sur l'onglet Security dans la fenêtre Microsoft SNMP Properties pour
afficher les paramètres Security.

3. Assurez-vous que le nom ou la chaîne de communauté à utiliser pour le serveur
est indiqué dans la liste Accepted Community Names.

Si le nom ne figure pas dans la liste, cliquez sur Add pour afficher la fenêtre Service
Configuration. Tapez le nouveau nom dans le champ et cliquez sur Add dans cette
fenêtre. L’onglet Security s’affiche avec le nouveau nom dans la liste Accepted
Community Names.

Remarque – Les noms ou les chaînes de communauté réagissent à la taille des lettres.
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4. (Optionnel) Vous pouvez, le cas échéant, modifier le paramètre par défaut de
Accept SNMP Packets from Any Host à Only Accept SNMP Packets from These
Hosts et ajouter l'adresse du réseau de l'ordinateur de gestion d'entreprise
recevant les déroutements de l'agent de Configuration Service sur le serveur.

Ce paramètre fournit plus de sécurité dans la mesure où il vous permet de spécifier
l'ordinateur ou les ordinateurs dont les agents Microsoft Windows NT acceptent les
informations.

Pour ajouter l'adresse de réseau de l'ordinateur avec le logiciel de la console de
gestion Configuration Service à la zone de liste inférieure, cliquez sur Add pour
accéder à la fenêtre Security Configuration. Tapez l’adresse IP dans la case Entry et
cliquez sur Add dans cette fenêtre. L’onglet Security réapparaît avec l'adresse de
l'ordinateur de la console de gestion Configuration Service.

5. Cliquez sur OK.

▼ Indication du destinataire de déroutement
Au cours de cette procédure, vous spécifiez la console de gestion d'entreprise
comme destination des déroutements du serveur.

Remarque – Pour cette procédure, vous devez posséder l'adresse IP de la console
de gestion d'entreprise qui reçoit les déroutements. La procédure requiert également
le même nom de communauté tel qu'indiqué dans les sections précédentes.

Pour spécifier l'ordinateur de gestion d'entreprise comme destination des
déroutements d'agent, procédez comme suit.

1. Cliquez sur l’onglet Traps dans la fenêtre Microsoft SNMP Properties pour
afficher les paramètres Traps.

2. Assurez-vous que le nom de communauté indiqué est le même que le nom de
communauté spécifié dans l'onglet Security précédent.

Si vous devez rectifier le nom de communauté, saisissez le nom dans le champ
Community Name et cliquez sur Add. Si un autre nom figure déjà dans le champ de
saisie, il est conservé même si vous tapez par dessus. Pour supprimer un nom,
sélectionnez-le et cliquez sur Remove.

3. Ajoutez l'adresse IP de la console de gestion d'entreprise dans la liste Trap
Destinations.

a. Cliquez sur Add.

La fenêtre Service Configuration s’affiche.
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b. Saisissez l'adresse IP dans le champ Entry et cliquez sur Add.

L’onglet Traps s'affiche avec la nouvelle adresse du réseau dans la liste Trap
Destinations list.

c. Saisissez chacune des adresses IP dans le format suivant. AAA.BBB.CCC.DDD

Il n'est pas nécessaire de saisir les zéros de gauche. Exemple d'une adresse
appropriée :

192.168.100.1

4. Pour envoyer des déroutements optionnels de Configuration Service vers une
autre console de gestion d'entreprise, saisissez l'adresse du réseau de ce poste de
travail de gestion.

Si vous disposez de plusieurs consoles de gestion d'entreprise, chacune d'elles doit
avoir sa propre adresse indiquée ici.

5. Cliquez sur OK pour confirmer les paramètres.

6. Cliquez sur Close pour quitter la fenêtre Network.

7. Quittez Microsoft Windows NT et relancez le serveur.

Si vous avez l'intention d'installer Configuration Service, vous n'avez besoin de
redémarrer qu'après avoir installé le logiciel.

▼ Configuration des serveurs dans
l’environnement d’exploitation Solaris
Avec Configuration Service pour les systèmes avec l'environnement d'exploitation
Solaris, vous pouvez générer les déroutements SNMP version 1 via l'interface à un
daemon de déroutement SNMP appelé sstrapd. Par défaut, ce daemon ne démarre
pas automatiquement pendant le processus d'initialisation. Les étapes suivantes
décrivent le processus d'activation du traitement des déroutements.

1. Créez le fichier /var/opt/SUNWsscs/ssagent/sstrapd.conf à l'aide d'un
éditeur de texte standard.

Ce fichier contient le nom ou l'adresse IP de la ou des consoles de gestion SNMP.
Dans le cas de plusieurs consoles, énumérez-les sur des lignes distinctes.

2. Modifiez le fichier /etc/init.d/ssagent et enlevez les marques de
commentaire de la section de démarrage SNMP. Ces lignes sont marquées par
deux symboles dièse (##).
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3. Enregistrez le fichier après ces modifications.

Le daemon sstrapd est lancé à la prochaine initialisation ou immédiatement en
exécutant la commande suivante

Cette commande lance le daemon sstrapd ainsi que les deux autres daemons de
Configuration Service, s'ils ne sont pas en cours d'exécution. Une seule instance de
chacun des daemons est exécutée à ce niveau, indépendamment du fait que d'autres
daemons aient été précédemment exécutés.

▼ Configuration des serveurs dans
l’environnement d’exploitation Linux
Avec Configuration Service pour les systèmes avec l'environnement d'exploitation
Linux, vous pouvez générer les déroutements SNMP version 1 via l'interface à un
daemon de déroutement SNMP appelé sstrapd. Par défaut, ce daemon ne démarre
pas automatiquement pendant le processus d'initialisation. Les étapes suivantes
décrivent le processus d'activation du traitement des déroutements.

1. Créez le fichier /var/opt/SUNWsscs/ssagent/sstrapd.conf à l'aide d'un éditeur de
texte standard.

Ce fichier doit être créé avec une liste des noms de système ou d’adresses IP
(une par ligne) pour les consoles de gestion SNMP. Il peut contenir des lignes vides
et des lignes de commentaires.

2. Modifiez le fichier /etc/init.d/ssagent et enlevez les marques de commentaire de la
section de démarrage SNMP.

Ces lignes sont marquées par deux symboles dièse (##).

3. Enregistrez le fichier après ces modifications.

Le daemon sstrapd est lancé à la prochaine initialisation ou immédiatement en
exécutant la commande suivante

Cette commande lance le daemon sstrapd ainsi que les deux autres daemons de
Configuration Service, s'ils ne sont pas en cours d'exécution. Une seule instance de
chacun des daemons est exécutée à ce niveau, indépendamment du fait que d'autres
daemons aient été précédemment exécutés.

/etc/init.d/ssagent uptrap

/etc/init.d/ssagent uptrap
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Détails sur le SNMP
Le protocole Simple Network Management Protocol (SNMP) est l'un des protocoles
de gestion de réseau les plus utilisés. Il a pour fonction de gérer les périphériques de
réseau d'une façon relativement simple. Le protocole SNMP est simple, sans
connexion ni reconnaissance requises.

SNMP a initialement été développé pour fonctionner sous la suite de protocoles
Internet, essentiellement avec les protocoles TCP/IP (Transmission Control
Protocol/Internet Protocol). Depuis, SNMP a été implanté pour fonctionner avec
d'autres protocoles de transport communs, tels que IPX/SPX (Internet Packet
Exchange/Sequenced Packet Exchange) de Novell.

Messages de déroutement SNMP
Les agents Configuration Service se servent du protocole SNMP pour envoyer des
informations aux systèmes de gestion d'entreprise.

Une fois qu'un serveur a été configuré pour envoyer des déroutements, les
informations d'événement de Configuration Service sont transférées vers ce système.

Les messages de déroutement de Configuration Service contiennent les informations
suivantes :

■ OID (Identificateur d'objet) 1.3.6.1.4.1.2294.1.2

■ Event Date (MM, JJ, AA, par exemple 01,22,98)

■ Event Time (HH:MM:SS, par exemple 15:07:23)

■ Server Address and Name (Adresse IP et nom, par exemple 192.187.249.187
Administration)

■ Card Name

■ Event Severity (Informational, Warning, Critical)

■ Message texte

Les informations affichées et leurs formats dépendent de la console de gestion
SNMP utilisée.

La réception des déroutements ne peut avoir lieu que si le fichier RST_OID.MIB est
chargé dans la console de gestion d'entreprise. Sur les environnements d'exploitation
Solaris et Linux, ce fichier se trouve dans /opt/sun/SUNWsscs/ssagent. Sous
Microsoft Windows, ce fichier se trouve dans \Program Files\Sun\ssagent.
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Agents et gestionnaires
Le logiciel SNMP se compose d'agents et de gestionnaires. Un agent est le logiciel
autorisant la surveillance des variables dans le périphérique géré. Le logiciel agent
est soit intégré dans le périphérique géré, soit exécuté sur un ordinateur auquel le
périphérique est connecté.

La console de gestion ou le gestionnaire est le logiciel surveillant le réseau se servant
du protocole SNMP pour envoyer les demandes concernant les variables aux agents.
Le gestionnaire appelle les agents régulièrement dans la mesure où les valeurs de
variable changent. Les gestionnaires SNMP analysent les données reçues des agents
et les mettent à la disposition de l'utilisateur en format graphique. Les données
peuvent être stockées dans une base de données à des fins d'analyse d'historique et
de tendance.

En plus de la réponse aux demandes du gestionnaire SNMP, les agents peuvent
envoyer des notifications ou des déroutements non sollicités vers le poste de gestion.
Ceci équivaut aux interruptions dans un logiciel traditionnel.

Les consoles de gestion peuvent agir différemment en réponse à une alarme.
Normalement, les déroutements sont consignés dans un journal et l'information
qu'ils contiennent est envoyée à l'utilisateur intéressé par le biais d'une méthode de
notification. Les déroutements peuvent également provoquer des actions
supplémentaires de la part du gestionnaire SNMP, par exemple l'interrogation de
l'agent pour déterminer l'état actuel de l'entité en question ou le lancement d'une
application.

Management Information Base (MIB)
Sur un réseau, chacun des périphériques gouverné par des agents SNMP possède
une ou plusieurs variables ou objets qui lui sont associés. Un exemple type peut être
une variable qui suit le nom du périphérique. Ces variables ou objets sont décrits
dans un fichier texte appelé Management Information Base (MIB). Une base
MIB représente une définition textuelle précise des variables gérées. Les procédures
de définition d'une base MIB ont été établies par l'IETF (Internet Engineering Task
Force) de l'ISO (International Standards Organization).
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Objets SNMP
Certaines variables de gestion de réseau sont communes à tous les périphériques de
réseau LAN. La plupart de ces variables ont été normalisées et sont référencées en
tant que variables MIB-II et extensions MIB-II. L'IETF a également défini les
procédures des bases MIB qui ne font pas partie de la catégorie des MIB-II standard.
Ces variables sont énumérées dans des MIB d'entreprise privée.

Des variables Configuration Service sont énumérées dans la saisie Configuration
Service de MIB d'entreprise privée. À titre d'exemple, l'ID d'objet 1.3.6.1.4.1.2294.1.2
fait référence à un ID d'objet (ou OID) d'une variable pour suivre la version de
l'agent sous l'une des bases MIB de Configuration Service.

Le diagramme de la FIGURE E-1 illustre le processus de dérivation de l'OID. Les
nœuds dans l'OID sont cochés. Dans une base MIB, les données d'une variable ou
d'un objet spécifique résident sous son OID.

Le numéro de nœud d'arborescence de Sun est 2294. Toute entreprise privée désireuse
de développer des agents pour reconnaître ses propres périphériques peut faire une
demande au groupe IETF pour obtenir son propre numéro de nœud d'arborescence.

Types de demandes SNMP
Les opérations de SNMP prenant en charge l'accès aux données MIB sont Get,
GetNext et Set. Get extrait une valeur scalaire d'un champ d'une entrée de table à
partir de la valeur d'un index. GetNext permet de naviguer parmi les entrées du
tableau, chaque commande produisant la valeur suivante contenue dans la colonne (ou
le champ) en question. Set permet de créer ou de modifier la valeur d'une variable MIB.

Sécurité SNMP
Les valeurs des paramètres soulèvent des questions de sécurité. SNMP V1 (version
1) est doté d'un système de sécurité simple. Chacune des unités PDU (Protocole Data
Unit) contient une chaîne de communauté qui représente la combinaison d'un nom
utilisateur et d'un mot de passe. Vous pouvez configurer les agents pour une chaîne
de communauté particulière. Un agent ne répond pas à une demande qui lui est
envoyée sauf lorsque la chaîne de communauté dans le PDU de la demande coïncide
à la chaîne de communauté dans sa propre configuration.
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FIGURE E-1 Identificateur d'objet d'une variable MIB
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▼ Envoi de déroutements SNMP sans
Configuration Service
Des explications sur une méthode additionnelle d'envoi des déroutements SNMP ne
requérant pas Configuration Service figure ci-dessous.

La baie peut envoyer des déroutements SNMP concernant les événements liés au
stockage de masse à une console de gestion d'entreprise, telle une console HP
OpenView. La configuration suivante ne requiert pas que l'agent Configuration
Service soit installé pour envoyer des déroutements SNMP.

1. Ouvrez un éditeur de texte.

2. Saisissez les informations suivantes en remplaçant les variables par celles de
votre réseau :

[SNMP_TRAP]
ENABLED=1
RECEIVER1=123.123.123.123

[EMAIL]
ENABLED=1
SUBJECT=RAID Event
SENDER_MAIL_BOX=someone@somecompany.com
SMTP_SERVER=123.123.123.123
RECEIVER1=somebody@somecompany.com

3. Enregistrez le fichier sous le nom agent.ini.

4. Envoyez-le par FTP de votre poste de travail vers la baie.

5. Saisissez le nom de l'utilisateur racine, puis appuyez sur Entrée.

6. Lorsque l'invite du mot de passe s'affiche, appuyez sur Entrée.

Si vous avez indiqué un mot de passe pour le contrôleur, vous devez saisir ce mot de
passe à l'invite.

7. Après la connexion, passez au répertoire /cfg.

8. Placez le fichier de votre poste de travail dans le répertoire /cfg.

9. Quittez la session FTP.

10. Réinitialisez les contrôleurs avec la méthode utilisée pour la gestion de la baie
(par exemple, Configuration Service Console, Telnet ou session de terminal).
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ANNEXE F

Dépannage

Ce chapitre propose des suggestions de dépannage pour les symptômes suivants :

■ « Symptôme : lors de l'installation de Configuration Service, java -version
renvoie une version de l'environnement d'exécution Java antérieure à 1.2.2 alors
que la version installée sur la machine est 1.2.2, 1.3 ou 1.4. », page 236

■ « Symptôme : un serveur ne répond pas ou un serveur est arrêté. », page 236

■ « Symptôme : Aucun lecteur logique n’est affiché si vous essayez d’ajouter un
volume logique à partir de lecteurs logiques existants. », page 237

■ « Symptôme : une adresse IP d'un serveur dans un environnement DHCP a
changé. », page 238

■ « Symptôme : les déroutements ne sont pas reçus d'un serveur. », page 238

■ « Symptôme : Impossible d'installer HP OpenView ou de lancer le daemon de
déroutement. », page 240

■ « Symptôme : la console n'indique pas de changement en cas d'ajout ou d'échange
de matériel. », page 240

■ « Symptôme : LG est absent des systèmes fonctionnant sous l'environnement
d'exploitation Solaris. », page 241

■ « Symptôme : alarmes environnementales non rapportées », page 241

■ « Symptôme : la console Configuration Service semble fonctionner lentement »,
page 241

■ « Symptôme : Diagnostic Reporter ne fonctionne plus », page 242

■ « Symptôme : (Solaris/Linux) L’aide en ligne ne s’affiche pas », page 242
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Symptôme : lors de l'installation de Configuration Service,
java -version renvoie une version de l'environnement
d'exécution Java antérieure à 1.2.2 alors que la version installée sur la
machine est 1.2.2, 1.3 ou 1.4.

1. Vérifiez le répertoire /usr pour confirmer que le lien de Java renvoie à la dernière
version de Java et non à Java 1.1.

Pour vérifier la version de Java, tapez

(Environnement d'exploitation Solaris) Si le lien ne renvoie pas à la dernière version de
Java indiquée, tapez

pù xxx représente la dernière version de Java.

Symptôme : un serveur ne répond pas ou un serveur est arrêté.

Assurez-vous que les services de Configuration Service sont exécutés sur le serveur.

1. (Environnement d'exploitation Solaris) Exécutez la commande suivante

Les noms ssmon et ssserver doivent être présents sur l'affichage. Si ce n'est pas le
cas, passez à l'étape 2, mais s'ils ont démarré, passez à l'étape 4.

(Microsoft Windows NT) Sélectionnez Settings → Control Panel → Services et vérifiez
que les services de SUNWscsd Monitor, SUNWscsd Server et SUNWscsd Startup ont
démarré. Si ce n'est pas le cas, passez à l'étape 2, mais s'ils ont démarré, passez à
l'étape 4.

(Microsoft Windows 2000) Sélectionnez Start → Administrative Services → Computer
Management. Cliquez sur Services & Applications, puis vérifiez que les services
SUNWscsd Monitor, SUNWscsd Server et SUNWscsd Startup ont démarré. Si ce
n'est pas le cas, passez à l'étape 2, mais s'ils ont démarré, passez à l'étape 4.

# cd /usr
ls | grep java

rm java
ln -s /usr/xxx /usr/java

# ps -e | grep ss
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2. (Environnements d’exploitation Solaris/Linux) Arrêtez et démarrez les daemons
selon la procédure expliquée dans « Démarrage et arrêt de l'agent Configuration
Service », page 14.

(Microsoft Windows NT/2000) Arrêtez et démarrez les services en cliquant avec le
bouton droit de la souris sur le service à démarrer ou à arrêter.

3. Si les daemons/services ne s'arrêtent pas ou ne démarrent pas correctement,
réinitialisez la reconfiguration.

4. Assurez-vous que le logiciel du protocole TCP/IP est chargé, et que la carte de
réseau et la connexion au réseau fonctionnent correctement.

Pour tester la connectivité TCP/IP sur la ligne de commande, tapez

Si vous n'obtenez pas de réponse, il y a un problème avec les services du protocole
TCP/IP. Contactez le service informatique de votre entreprise pour toute assistance.

5. Assurez-vous que le nom du serveur et le mot de passe indiqués sont corrects.

Si le nom ou le mot de passe ne sont pas corrects, modifiez-les. Pour les
environnements d’exploitation Solaris, voir « Directives et niveaux de sécurité
administrative (Utilisateur) », page 15. Pour Windows Microsoft NT/2000, consultez
« Directives et niveaux de sécurité administrative (Utilisateur) », page 23. Pour les
environnements d’exploitation Linux, voir« Directives et niveaux de sécurité
administrative (Utilisateur) », page 32.

Le mot de passe doit être celui qui a été établi au cours de la procédure de
configuration des utilisateurs de Configuration Service.

■ Assurez-vous que les utilisateurs Configuration Service (ssmon, ssadmin,
ssconfig) ont été définis correctement. Assurez-vous que les utilisateurs sont
définis dans Microsoft Windows NT avec Permissions Act en tant que partie du
système d’exploitation et Log on en tant que batch job.

■ Si vous vous servez d'un service de noms (domaines Windows NT et NIS ou NIS+
dans un environnement d'exploitation Solaris), assurez-vous que les utilisateurs
ont été correctement ajoutés au service de noms.

■ Si vous avez saisi les noms d'utilisateur dans un domaine sous Microsoft Windows NT,
attendez quelques instants que les noms des utilisateurs se soient propagés.

Symptôme : Aucun lecteur logique n’est affiché si vous essayez d’ajouter
un volume logique à partir de lecteurs logiques existants.

Si vous ne voyez aucun lecteur logique affiché dans le champ Select a Logical Drive,
l’annulation du mappage des lecteurs logiques n’a pas été effectuée et il n’est par
conséquent pas possible de les sélectionner. Vous devez d’abord annuler le mappage
des lecteurs logiques.

# ping {Adresse IP du serveur ou nom du serveur}
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Symptôme : une adresse IP d'un serveur dans un environnement DHCP
a changé.

Dans un environnement DHCP, il est possible qu'une adresse IP du serveur ait
changé si le serveur est arrêté depuis plus de trois jours.

Dans ce cas, indiquez la nouvelle adresse IP du serveur à la console Configuration
Service dans la mesure où elle communique avec le serveur par son adresse IP.

Pour remédier à cette situation, la nouvelle adresse IP du serveur doit être saisie
dans la fenêtre Edit Server du logiciel de la console Configuration Service.

1. Sélectionnez File → Server List Setup.

2. Déplacez le nom du serveur de la liste Managed Serversà celle de Available Servers.

La fenêtre Edit Server s'affiche. Cette fenêtre affiche le nom du serveur ainsi que
l'adresse IP tels que configurés.

3. Sélectionnez le nom du serveur dans la liste Available Servers et cliquez ensuite
sur Edit.

La fenêtre Edit Server s'affiche. Cette fenêtre affiche le nom du serveur ainsi que
l'adresse IP tels que configurés.

4. Si l'adresse du réseau a changé, cliquez sur Get IP Addr by Name.

Configuration Service recherche l'adresse IP correcte et l'affiche si vous fournissez le
nom du serveur tel qu'il est enregistré par le service utilisé par votre réseau. Sinon,
vous devez saisir l'adresse IP manuellement.

Si le nom utilisé pour le serveur n'est pas le même que celui du réseau du serveur
ou si le service de noms n'a pas encore été actualisé, vous devez saisir l'adresse IP
manuellement.

5. Après avoir saisi l'adresse IP du serveur, cliquez sur OK pour indiquer l’adresse
modifiée et revenez à la fenêtre Server List Setup.

6. Redéplacez le nom du serveur vers la liste Managed Servers.

7. Cliquez sur OK pour quitter la fenêtre Server List Setup.

Symptôme : les déroutements ne sont pas reçus d'un serveur.
Pour déterminer pourquoi un déroutement d'un serveur de Configuration Service
n'est pas reçu sur un poste de travail de gestion SNMP, tel que HP OpenView,
procédez comme suit :

1. Assurez-vous que le service SNMP a été lancé sur le serveur.

Vérifiez que sstrapd fonctionne en exécutant la commande suivante
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Les informations affichées contiennent le nom sstrapd ; si ce n'est pas le cas,
voir « Démarrage et arrêt de l'agent Configuration Service », page 14 pour des
instructions sur l'activation d'un daemon.

Sous Microsoft Windows NT, sélectionnez Control Panel → Services et vérifiez si le
service SNMP est indiqué et affiché comme ayant démarré. Dans le cas contraire,
installez-le et lancez ensuite le service. Pour des renseignements supplémentaires,
consultez la documentation de Microsoft Windows NT.

2. Vérifiez que l'adresse cible correcte de la console de gestion de l'entreprise et la
chaîne de communauté sont correctement définies sur le serveur.

Les étapes détaillées de la configuration d'envoi des déroutements vers une console
de gestion d'entreprise sur un serveur Microsoft Windows NT sont indiqués dans
« Configuration des serveurs pour l'envoi de déroutements », page 224.

3. Assurez-vous que la base MIB de Configuration Service est compilée sous la
console de gestion SNMP.

Sous les environnements d'exploitation Solaris et Linux, le fichier RST_OID.MIB se
trouve dans /opt/SUNWsscs/ssagent. Sous Microsoft Windows, ce fichier se
trouve dans \Program Files\Sun\ssagent. Voir la documentation de votre
console de gestion SNMP (telle que HP OpenView) pour toute information sur la
compilation de la base MIB.

4. Sous Microsoft Windows NT, vérifiez les entrées du Registre NT pour
Configuration Service.

En cas d'absence d'entrées Configuration Service, réinstallez l'agent Configuration
Service sur le serveur.

a. Assurez-vous d'abord que

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SNMP\
Parameters\ExtensionAgents

contient une entrée pour SSAGENT.

b. Assurez-vous ensuite que

HKEY_LOCAL_MACHINE\SOFTWARE\Sun\Sun StorEdge Configuration
Service Agent\SNMP Extension Agent\Current Version

pointe vers le programme d'agent étendu avec le chemin d'accès complet :

C:\PROGRA~1\Sun\ssagent\SSAGENT.DLL

C:\PROGRA~1\Sun\ssagent\ est le répertoire d’installation par défaut. Si vous
avez installé Configuration Service dans un autre répertoire, veillez à ce qu’il
pointe à ce répertoire.

# ps -e | grep ss
Annexe F Dépannage 239



c. Finalement, assurez-vous que

SSAGENT.DLL

est dans le répertoire C:\PROGRA~1\Sun\ssagent.

Symptôme : Impossible d'installer HP OpenView ou de lancer le daemon
de déroutement.
Si vous installez HP OpenView sur le même serveur que vous avez configuré pour
envoyer des déroutements SNMP, les ressources du système sont insuffisantes pour
l'exécution du daemon de déroutement et HP OpenView. Reconfigurez les ressources
système en procédant comme suit.

1. Ajoutez les lignes suivantes après /etc/system.

2. Redémarrez le serveur.

Symptôme : la console n'indique pas de changement en cas d'ajout ou
d'échange de matériel.

Si vous ajoutez un nouvel équipement ou si vous remplacez un périphérique
défaillant, tel qu'un lecteur de disque, un lecteur de bande, un bloc d'alimentation
ou un ventilateur, la console Configuration Service n'affiche pas toujours des
informations actualisées. L'affichage en arborescence et les autres affichages associés
ne reflète pas toujours l'état actuel d'un périphérique.

En cas d'ajout d'un nouveau périphérique ou si vous souhaitez que ce périphérique
soit reconnu avant la prochaine analyse périodique, cliquez sur Rescan dans la
fenêtre Server View. Le serveur ré-analyse immédiatement l'inventaire et la console
actualise son inventaire de serveur. Elle affiche ensuite le résultat de tout
changement dans une vue arborescente. Pour garantir une exécution opportune de
l'inventaire, effectuez l'analyse manuellement.

Vous serez peut-être obligé de cliquer sur Rescan plusieurs fois. Lorsque le serveur est en
cours d'analyse et que la console envoie une demande pour l'inventaire, le serveur envoie
l'inventaire de la dernière actualisation puisqu'il n'a pas terminé l'analyse en cours.

set shmsys:shminfo_shmmax=x2000000
set shmsys:shminfo_shmmin=1
set shmsys:shminfo_shmmni=256
set shmsys:shminfo_shmseg=256

set semsys:seminfo_semmap=256
set semsys:seminfo_semmni-=512
set semsys:seminfo_semmns=512
set semsys:seminfo_semms1=32
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Symptôme : LG est absent des systèmes fonctionnant sous
l'environnement d'exploitation Solaris.

Si LG n'est pas affiché par Configuration Service, assurez-vous que LG est libellé et
non pas exclu par Configuration Service (si installé).

Symptôme : alarmes environnementales non rapportées

Des boîtiers de stockage avec des capacités de surveillance de boîtier SCSI (telles que
des cartes SAF-TE) envoient des alarmes environnementales à la console Configuration
Service. L'état d'alarme peut résulter d'une défaillance d'un lecteur, d'un ventilateur,
d'un bloc d'alimentation, d'une batterie ou d'une température anormale.

Si une alarme environnementale survient, vous devez cliquer sur Reset dans la
fenêtre View Enclosure pour effacer l’alarme. Toutefois, vous devez posséder les
privilèges de sécurité de configuration pour pouvoir cliquer sur Reset dans le logiciel.

La spécification de surveillance SAF-TE pour ces boîtiers de stockage requiert
qu'après une alarme, les alarmes environnementales suivantes ne soient pas
générées tant que l'alarme n'a pas été réenclenchée.

Après avoir réenclenché l'alarme, les événements environnementaux sont à nouveau
affichés dans Event Log.

Symptôme : la console Configuration Service semble fonctionner
lentement

La console Configuration Service sous Windows NT requiert au moins 10 Mo de
mémoire virtuelle (mémoire physique plus la taille du fichier d'échange) sur le poste
de travail de la console. Le programme de la console répond mieux avec une
mémoire physique plus grande ce qui réduit la pagination de la mémoire dans le
fichier d'échange.

Lorsque la mémoire utilisée approche la taille de la mémoire virtuelle totale
disponible (mémoire physique plus la taille du fichier d'échange), toute pagination
excessive risque de poser des problèmes ce qui affectera les performances de toutes
les applications de ce poste de travail.

Augmentez la mémoire physique et la taille du fichier d'échange pour accroître la
mémoire virtuelle. Pour changer la taille du fichier d’échange, sélectionnez Control
Panel → System, puis l'onglet Performance dans la fenêtre System Properties
affichée. Sous Windows NT, changez la taille du fichier d'échange dans la section
Virtual Memory, onglet Performance.
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Symptôme : Diagnostic Reporter ne fonctionne plus

Si vous ne recevez plus de messages électroniques de Diagnostic Reporter, il se peut
qu'il ne fonctionne plus et que vous deviez l'arrêter et le relancer.

(Système d'exploitation Solaris) Il y a trois conditions affectant Diagnostic Reporter
et empêchant le rapport de sa condition. La solution consiste à arrêter et relancer
Diagnostic Reporter.

■ Si l'agent de Configuration Service tombe en panne ou s'il est arrêté et relancé,
Diagnostic Reporter cesse de fonctionner.

■ Si Diagnostic Reporter Config Tool fonctionne et que le daemon de Diagnostic
Reporter est arrêté et relancé, une condition peut se produire empêchant la
communication de Diagnostic Reporter Config Tool avec le daemon.

■ Si l'agent de Configuration Service tombe en panne ou est arrêté, le daemon de
Diagnostic Reporter ne le détecte pas, cesse d'envoyer des messages électroniques et
continue à indiquer que Diagnostic Reporter est connecté en affichant un état vert.

Arrêtez et relancez Diagnostic Reporter en tapant

Symptôme : (Solaris/Linux) L’aide en ligne ne s’affiche pas

Vérifiez que le nom complet du chemin du navigateur Internet que vous voulez
utiliser pour afficher l’aide en ligne a été spécifié.

1. Passez à /opt/SUNWsscs/sscsconsole et tapez

2. Saisissez le nom complet du chemin du navigateur Internet.

# /etc/init.d/ssdgrptd stop
# /etc/init.d ssdgrptd start

./config_sscon
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ANNEXE G

Messages et codes d'erreur

Cette annexe présente une liste des codes d'erreur, des messages d'erreur et des
messages d'état.

Codes d'erreur
Indiqué et décrit dans le journal des événements, un code d'erreur est un code à
huit caractères divisé en quatre champs de deux caractères. Le tableau ci-dessous
présente les codes d'erreur utilisés dans chaque champ à deux caractères.
Le format des quatre champs à deux caractères est :

SSMMmmEE

où

SS = le champ Severity

MM = le champ Major

mm = le champ Minor

EE = le champ Error

TABLEAU G-1 Champ Severity

Champ Severity Description

01 Critical

01 Critique

02 Warning

02 Avertissement

03 Informational

03 Informatif
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Le champ Minor est défini dans le tableau ci-dessous. La définition du champ Error
varie en fonction de la définition du champ Minor et le tableau correct est référencé.

TABLEAU G-2 Champ Major

Champ Major Description

01 Not Used

01 Non utilisé

03 Legacy

03 Existant

04 RAIDCard Card message

04 Message de carte RAIDCard

05 JBOD (Just a bunch of disks) message

05 Message JBOD

06 SSMon monitor message

06 Message de surveillance SSMon

07 dll/shared library message

07 Message de bibliothèque partagée/dll

08 SSserver message

08 Message SSserver

09 HBA (Host Bus Adapter) message

09 Message HBA (adaptateur au bus hôte)

0A Server Communications message

0A Message de communications du serveur

0B Sun StorEdge controller message

0B Message du contrôleur

TABLEAU G-3 Champ Minor

Champ Minor Description

01 Unknown

01 Inconnue

02 Voir « Champ Error : état de lecteur du système », page 246.

03 Voir « Champ Error : état du disque », page 246.
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04 Voir « Champ Error : État SAF-TE », page 247.

05 Voir « Champ Error : État de bande », page 248.

06 Voir « Champ Error : État de redondance », page 250.

07 Voir « Champ Error : État interne », page 251.

08 Voir « Champ Error : État de périphérique », page 251.

09 Voir « Champ Error : État d'initialisation », page 252.

0A Voir « Champ Error : Paramètre client non valide », page 252.

0B Voir « Champ Error : Ouvrir le transport », page 253.

0C Voir « Champ Error : Fermer le transport », page 253.

0D Voir « Champ Error : Allocation de mémoire », page 254.

0E RaidCard fault detected.

0E Problème détecté avec RaidCard.

0F Voir « Champ Error : Transport », page 254.

10 Voir « Champ Error : Commande », page 255.

11 Voir « Champ Error : Commande », page 255.

12 Voir « Champ Error : Communications principales », page 255.

13 Voir « Champ Error : Communications asynchrones », page 256.

14 Voir « Champ Error : Sécurité des communications », page 256.

15 Voir « Champ Error : Temporisation », page 257.

16 Voir « Champ Error : Administration », page 257.

17 Voir « Champ Error : Firmware », page 258.

18 Voir « Champ Error : Arrêt du système », page 259.

19 Dynamic Growth fault detected.

19 Erreur de croissance dynamique détectée.

1C Voir « Champ Error : Réglage de la configuration », page 259.

1D Voir « Champ Error : Événement du contrôleur », page 260.

1E Voir « Champ Error : Événement du lecteur », page 261.

1F Voir « Champ Error : Host Side Event », page 262.

20 Voir « Champ Error : Événement du lecteur logique », page 263.

23 Voir « Erreur d'événement de surveillance et de gestion du serveur », page 263.

TABLEAU G-3 Champ Minor (suite)

Champ Minor Description
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Champ Error : état de lecteur du système

Champ Error : état du disque

TABLEAU G-4 Erreurs d'état de lecteur du système

Champ Error

01 Offline

01 Déconnecté

02 Degraded

02 Dégradé

03 Online

03 Connecté

04 Unknown

04 Inconnue

05 Parity Check

05 Contrôle de parité

06 Reconstruction

06 Reconstruction

07 Reconfiguration

07 Reconfiguration

08 Dynamic Growth

08 Croissance dynamique

09 Nonexistent

09 Inexistant

0A Initialization

0A Initialisation

TABLEAU G-5 Erreurs d'état du disque

Champ Error Description

01 Offline

01 Déconnecté

02 Degraded
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Champ Error : État SAF-TE

02 Dégradé

03 Online

03 Connecté

04 Unknown

04 Inconnue

05 SMART

05 SMART

06 Dead

06 Détruit

TABLEAU G-6 Erreurs d'état SAF-TE

Champ Error Description

01 Power

01 Alimentation

02 Fan

02 Ventilateur

03 Thermal

03 Thermique

04 Alarm

04 Alarme

05 Locked

05 Verrouillé

06 Slot

06 Slot

07 Unknown

07 Inconnue

08 Unable to get SAF-TE information

08 Impossible d'obtenir les informations sur SAF-TE

09 Battery

TABLEAU G-5 Erreurs d'état du disque (suite)

Champ Error Description
Annexe G Messages et codes d'erreur 247



Champ Error : État de bande

09 Batterie

0A Invalid Number of Slots

0A Nombre de logements non valide

0B Environmental Data Not Available

0B Données d'environnement non disponibles

TABLEAU G-7 Erreurs d'état de bande

Champ Error Description

01 Read

01 Lecture

02 Write

02 Écriture

03 Hard Error

03 Erreur codée

04 Media Error

04 Erreur de support

05 Read Failure

05 Lecture impossible

06 Write Failure

06 Écriture impossible

07 Media Life

07 Durée de support

08 Not Upgradable

08 Non évolutif

09 Write Protect

09 Protégé contre l'écriture

0A Nonremoval

TABLEAU G-6 Erreurs d'état SAF-TE (suite)

Champ Error Description
248  Guide de l’utilisateur Sun StorEdge 3000 Family Configuration Service 1.2 • avril 2003



0A Fixe

0B Cleaning Media

0B Nettoyage du support

0C Unsupported Format

0C Format incompatible

0D Snapped Tape

0D Bande cassée

14 Clean Now

14 Nettoyage immédiat

15 Clean Periodic

15 Nettoyage périodique

16 Expired Cleaning Media

16 Nettoyage de support expiré

1E Hardware A

1E Matériel A

1F Hardware B

1F Matériel B

20 Interface

20 Interface

21 Eject Media

21 Éjecter le support

22 Down Load Fail

22 Échec de téléchargement

28 Loader Hardware A

28 Matériel de chargeur A

29 Loader Tray Tape

29 Bande du bac de chargeur

2A Loader Hardware B

2A Matériel de chargeur B

2B Loader Door

2B Porte du chargeur

TABLEAU G-7 Erreurs d'état de bande (suite)

Champ Error Description
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Champ Error : État de redondance

C8 Query Log Failed

C8 Échec de requête d'état

C9 Inquire Tape Failed

C9 Échec de requête de bande

TABLEAU G-8 Erreurs d'état de redondance

Champ Error Description

01 Mode OK

01 Mode OK

02 No Memory for Negotiation

02 Mémoire insuffisante pour la négociation

03 Secondary Failure

03 Défaillance secondaire

04 Secondary Removed

04 Secondaire retiré

05 Detected Removal of Secondary

05 Retrait détecté du secondaire

06 Detected Insertion of Secondary

06 Insertion détectée du secondaire

07 Primary Failure

07 Défaillance du principal

08 Primary Removed

08 Principal retiré

09 Detected Removal of Primary

09 Retrait détecté du principal

0A Detected Insertion of Primary

0A Insertion détectée du principal

TABLEAU G-7 Erreurs d'état de bande (suite)

Champ Error Description
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Champ Error : État interne

Champ Error : État de périphérique

0B Unknown State

0B État inconnu

0C Partner Failed

0C Échec de partenaire

0D Partner Inserted

0D Partenaire inséré

0E Partner Removed

0E Partenaire supprimé

TABLEAU G-9 Erreurs d'état interne

Champ Error Description

01 No Memory

01 Mémoire insuffisante

02 Semaphore

02 Sémaphore

03 Thread

03 Thread

04 No Devices

04 Aucun périphérique

TABLEAU G-10 Erreurs d'état de périphérique

Champ Error Description

01 Inquiry

01 Requête

02 Unknown

02 Inconnue

TABLEAU G-8 Erreurs d'état de redondance (suite)

Champ Error Description
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Champ Error : État d'initialisation

Champ Error : Paramètre client non valide

TABLEAU G-11 Erreurs d'état d'initialisation

Champ Error Description

01 dll Initializing

01 Initialisation de dll

02 dll Initializing Failed

02 Échec lors de l'initialisation de dll

TABLEAU G-12 Erreurs de paramètre client

Champ Error Description

01 Set Configuration – Configuration Miscompare

01 Réglage de configuration – Comparaison erronée de la configuration

02 Set Configuration – Configuration Device Invalid

02 Réglage de la configuration – Périphérique de configuration non valide

03 Set Configuration – Enquire Miscompare

03 Réglage de la configuration – Comparaison erronée de l'interrogation

04 Set Configuration – Enquire2 Miscompare

04 Réglage de la configuration – Comparaison erronée de l'interrogation 2

05 Incorrect Application Length

05 Longueur d'application incorrecte

06 Command not Supported

06 Commande non prise en charge

07 Invalid Command

07 Commande non valide

08 Set Configuration – General Miscompare

08 Réglage de la configuration – Comparaison erronée générale

09 Invalid Length

09 Longueur non valide

0A Invalid Card Identifier
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Champ Error : Ouvrir le transport

Champ Error : Fermer le transport

0A Identificateur de carte non valide

0B Invalid Card Name

0B Nom de carte non valide

0C Invalid Parameter

0C Paramètre non valide

0D Invalid Command for Card Type

0D Commande non valide pour le type de carte

0E Set Configuration – Invalid Additional Parameter

0E Réglage de la configuration – Paramètre supplémentaire non valide

0F Set Configuration – Block Overlap

0F Réglage de la configuration – Superposition de bloc

10 Set Configuration – Device Information Invalid

10 Réglage de la configuration – Informations sur le périphérique non valides

TABLEAU G-13 Erreurs d'ouverture du transport

Champ Error Description

01 Open Transport

01 Ouvrir le transport

TABLEAU G-14 Erreurs de fermeture du transport

Champ Error Description

01 Close Transport

01 Fermer le transport

TABLEAU G-12 Erreurs de paramètre client (suite)

Champ Error Description
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Champ Error : Allocation de mémoire

Champ Error : Transport

TABLEAU G-15 Erreurs d'allocation de mémoire

Champ Error Description

01 Insufficient Memory

01 Mémoire insuffisante

02 Insufficient Memory for Administration Operation

02 Mémoire insuffisante pour l'opération d'administration

TABLEAU G-16 Erreurs du champ Transport

Champ Error Description

01 Lock Fault

01 Problème de verrou

02 Insufficient Memory

02 Mémoire insuffisante

03 Acquire Lock Fault

03 Obtenir une erreur de verrou

04 Release Lock Fault

04 Problème de désactivation du verrou

05 Invalid Command

05 Commande non valide

06 Invalid Length

06 Longueur non valide

07 Invalid Card Name

07 Nom de carte non valide

08 Invalid Card Identification

08 Identification de carte non valide

09 No Cards Found

09 Aucune carte détectée

0A No Devices Found
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Champ Error : Commande

Champ Error : Communications principales

0A Aucun périphérique détecté

0B Open Fault

0B Erreur d'ouverture

0C Card Name not Found

0C Nom de carte introuvable

TABLEAU G-17 Erreurs de code de commande

Champ Error Description

01 Lock Fault

01 Problème de verrou

TABLEAU G-18 Erreurs de communications principales

Champ Error Description

01 Socket Fault

01 Erreur de connecteur

02 Report Fault

02 Erreur de rapport

03 Thread Fault

03 Erreur de thread

04 Lock Fault

04 Problème de verrou

05 System Fault

05 Erreur système

TABLEAU G-16 Erreurs du champ Transport (suite)

Champ Error Description
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Champ Error : Liaison de communication

Champ Error : Communications asynchrones

Champ Error : Sécurité des communications

TABLEAU G-19 Liaison de communication

Champ Error Description

01 Socket Fault

01 Erreur de connecteur

TABLEAU G-20 Communications asynchrones

Champ Error Description

01 Socket Fault

01 Erreur de connecteur

02 Thread Fault

02 Erreur de thread

03 Cold Link Fault

03 Erreur de liaison à froid

04 Send Event Fault

04 Erreur lors de l'envoi de l'événement

TABLEAU G-21 Sécurité des communications

Champ Error Description

01 Security Violation

01 Violation de sécurité
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Champ Error : Temporisation

Champ Error : Administration

TABLEAU G-22 Erreurs de temporisation

Champ Error Description

01 Configuration Update

01 Mise à jour de la configuration

02 Lock Timeout

02 Temporisation de verrouillage écoulée

TABLEAU G-23 Erreurs d'administration

Champ Error Description

01 Set Customer Name Fault

01 Erreur de réglage du nom de client

02 Set Configuration Ended

02 Réglage de la configuration arrêté

03 Initialize

03 Initialisation

04 Initialize Ended

04 Initialisation arrêtée

05 Rebuild

05 Reconstruction

06 Rebuild Ended

06 Reconstruction arrêtée

07 Parity Check

07 Contrôle de parité

08 Parity Check Ended

08 Contrôle de parité arrêté

09 Set SAF-TE Slot State

09 Réglage de l'état du logement SAF-TE

0A Set SAF-TE Perform Slot
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Champ Error : Firmware

0A Réglage de logement de l'exécution SAF-TE

0B Set SAF-TE Send Global

0B Réglage de l'envoi global SAF-TE

0E Schedule Parity Check

0E Planification du contrôle de parité

0F Schedule Parity Check Ended

0F Planification du contrôle de parité arrêtée

10 Set Controller Parameters

10 Réglage des paramètres du contrôleur

11 Firmware Download

11 Téléchargement du firmware

12 Consistency Check for Rebuild Ended

12 Vérification de la cohérence ou reconstruction arrêtée

TABLEAU G-24 Erreurs de téléchargement du firmware

Champ Error Description

01 Not a SAF-TE Device

01 Pas un périphérique SAF-TE

02 Invalid Data Length

02 Longueur de données non valide

03 Download Failed

03 Échec de téléchargement

04 Check Sum Failed

04 Échec de la somme de contrôle

TABLEAU G-23 Erreurs d'administration (suite)

Champ Error Description
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Champ Error : Arrêt du système

Champ Error : Modification du chemin RDP

Champ Error : Réglage de la configuration

TABLEAU G-25 Erreurs d'arrêt du système

Champ Error Description

01 System Shutdown Failed

01 Échec de l'arrêt du système

TABLEAU G-26 Erreurs de modification du chemin RDP

Champ Error Description

01 RDP Path Failed

01 Échec du chemin RDP

02 RDP Path Restored

02 Chemin RDP restauré

TABLEAU G-27 Erreurs de réglage de la configuration

Champ Error Description

01 Set Configuration Thread creation Failed

01 Échec de réglage de la configuration de création d'une thread

02 Get Logical Drive List Command Failed

02 Échec d'obtention de la commande de liste des lecteurs logiques

03 Create Config Command Failed

03 Échec de la commande de création de la configuration

04 Init Completion Status Command Failed

04 Échec de la commande de l'état d'achèvement de l'initialisation

05 Get Configuration Command Failed

05 Échec de la commande d'obtention de la configuration
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Champ Error : Événement du contrôleur

06 Change Volume Config Command Failed

06 Échec de la commande de modification de la configuration de volume

07 Delete Logical Drive Command Failed

07 Échec de la commande de suppression d'un lecteur logique

TABLEAU G-28 Erreurs d’événement du contrôleur

Champ Error Description

01 Controller Reset

01 Réinitialisation du contrôleur

02 Controller DRAM Parity Error

02 Erreur de parité DRAM du contrôleur

03 Redundant Controller Failed

03 Échec du contrôleur redondant

04 Controller Power Supply Failed

04 Échec de l'alimentation électrique du contrôleur

05 Controller Fan Failed

05 Échec du ventilateur du contrôleur

06 Controller Temperature Alert

06 Alerte de température du contrôleur

07 Controller UPS AC Power Loss

07 Perte d'alimentation CA UPS du contrôleur

08 Controller Initialization Complete

08 Initialisation du contrôleur terminée

09 Controller Power Supply Back Online

09 Retour de l'alimentation électrique du contrôleur

0A Controller Fan Back Online

0A Reprise du ventilateur du contrôleur

0B Controller Temperature Normal

TABLEAU G-27 Erreurs de réglage de la configuration (suite)

Champ Error Description
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Champ Error : Événement du lecteur

0B Température normale du contrôleur

0C Controller UPS AC Power Back On

0C Retour de l'alimentation CA UPS du contrôleur

TABLEAU G-29 Erreurs d’événement du lecteur

Champ Error Description

01 Drive Channel Select Timeout

01 Temporisation écoulée de la sélection de canal de lecteur

02 Drive Channel SCSI Bus Error

02 Erreur de bus SCSI du canal de lecteur

03 Drive Channel Unexpected Disconnect

03 Canal de lecteur déconnecté de manière inattendue

04 Drive Channel Negotiation Error

04 Erreur de négociation du canal de lecteur

05 Drive Channel Target Timed Out

05 Temporisation écoulée de la cible du canal de lecteur

06 Drive Channel Parity Error

06 Erreur de parité du canal de lecteur

07 Drive Channel Data Under Or Overrun

07 Données du canal de lecteur sous-exécution ou débordement

08 Drive Channel Undefined Error

08 Erreur indéfinie du canal de lecteur

09 Drive Channel SCSI Bus Reset Issued

09 Réinitialisation envoyée du bus SCSI du canal de lecteur

0A Drive Channel Not Ready Error

0A Erreur du canal de lecteur pas prêt

0B Drive Channel Target HW Error

0B Erreur matérielle cible du canal de lecteur

TABLEAU G-28 Erreurs d’événement du contrôleur (suite)

Champ Error Description
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Champ Error : Host Side Event

0C Drive Channel Target Media Error

0C Erreur de support cible du canal de lecteur

0D Drive Channel Unexpected Unit Attention

0D Intervention d'unité inattendue du canal de lecteur

0E Drive Channel Unexpected Sense Data

0E Données de détection inattendue du canal de lecteur

0F Drive Channel Block Reassign Fail

0F Échec de la réattribution de bloc du canal de lecteur

10 Drive Channel Block Reassign Success

10 Réattribution de bloc du canal de lecteur réussie

11 Drive Channel SCSI Aborted Command

11 Commande d'annulation SCSI du canal de lecteur

12 Drive Channel SCSI Channel Fail

12 Échec du canal SCSI du canal de lecteur

TABLEAU G-30 Host Side Event Errors

Champ Error Description

01 Host Channel SCSI Bus Reset

01 Réinitialisation du bus SCSI de canal de l'hôte

02 Host Channel SCSI Bus Device Reset

02 Réinitialisation du périphérique de bus SCSI de canal de l'hôte

03 Host Channel Abort Tag Message

03 Message de balise d'annulation de canal de l'hôte

04 Host Channel Parity Error

04 Erreur de parité du canal de l'hôte

05 Host Channel Reselect Timeout

05 Temporisation de resélection du canal de l'hôte écoulée

TABLEAU G-29 Erreurs d’événement du lecteur (suite)

Champ Error Description
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Champ Error : Événement du lecteur logique

Erreur d'événement de surveillance et de gestion du serveur

TABLEAU G-31 Erreurs d’événement du lecteur logique

Champ Error Description

01 Logical Drive SCSI Drive Fail

01 Échec du lecteur SCSI du lecteur logique

02 Logical Drive Initialization Fail

02 Échec d'initialisation du lecteur logique

03 Logical Drive Rebuild Fail

03 Échec de reconstruction du lecteur logique

04 Logical Drive Initialization Commenced

04 Initialisation en cours du lecteur logique

05 Logical Drive Initialization Completed

05 Initialisation terminée du lecteur logique

06 Logical Drive Rebuild Commenced

06 Reconstruction en cours du lecteur logique

07 Logical Drive Rebuild Completed

07 Reconstruction terminée du lecteur logique

TABLEAU G-32 Erreur d'événement de surveillance et de gestion du serveur

Champ Error Description

01 Server to Manage/Monitor has Sun StorEdge changed.

01 Le serveur de gestion ou de surveillance a été modifié.
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Messages d'état et d'erreur
La plupart des messages d'erreur et d'état sont explicites. Le TABLEAU G-33 explique
plus en détail les termes utilisés dans les messages. Le TABLEAU G-34 répertorie les
messages d'erreur/d'état.

TABLEAU G-33 Valeurs substituées

Value Description

Channel Card channel number indicating a SCSI channel. A value of 1
indicates the first channel.

Canal Le numéro de canal de carte indiquant un canal SCSI. Une valeur 1
indique le premier canal.

Fan Fan number.

Ventilateur Numéro de ventilateur.

Enclosure Enclosure number.

Boîtier Numéro du boîtier.

LogicalArray Logical array number.

Baie logique Numéro de baie logique.

LogicalDrive Logical Drive number.

Lecteur logique Numéro de lecteur logique.

Lun LUN number.

Unité logique Numéro d'unité logique.

Name A text name.

Nom Un nom texte.

Power Power supply number.

Alimentation Numéro d'alimentation électrique.

Slot Slot number.

Slot Numéro de logement

State State of a logical array or a device or an enclosure in text. The
values are: Critical, Online, Offline, Critical Rebuild, Non Existent,
Low Battery, Normal

État Description textuelle de l'état d'une baie logique ou d'un
périphérique ou d'un boîtier. Les valeurs sont : Critical, Online,
Offline, Critical Rebuild, Non Existent, Low Battery, Normal
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Target A target or SCSI ID number.

Cible Un numéro cible ou d'identificateur SCSI.

Temperature The temperature in centigrade.

Température La température exprimée en degrés centigrades.

TABLEAU G-34 Messages d'erreur et d'état

Error and Status Messages

A tape has been left in the autoloader by a previous hardware fault. Insert an empty
magazine to clear the fault. If the fault does not clear, turn the autoloader off and then on
again. If the problem persists, call the tape drive supplier helpline.

Une bande a été laissée dans le chargeur automatique par une défaillance matérielle
précédente. Insérez un magasin vide pour éliminer l'erreur. Si l'erreur persiste, éteignez le
chargeur automatique puis rallumez-le. Si le problème persiste, contactez l'assistance du
fournisseur de lecteur de bande.

A user named ssconfig must be created for configuring SUNWsscs Diag Reporter.

Un utilisateur nommé ssconfig doit être créé pour configurer SUNWsscs Diag Reporter.

Abort/Clear-Queue/Abort-Tag Message (SCSI Channel %d, SCSI ID %d, Target Lun %d).
Possible failure of I/O module, cable, controller, or HBA.

Abandonner/Effacer file d'attente/Abandonner message balise (Canal SCSI %d, ID SCSI %d,
Numéro d'unité logique cible %d).
Défaillance possible du module E/S, câble, contrôleur ou adaptateur de bus hôte.

Access denied for one or more servers. Log in as an ssconfig user, and then try the operation
again.

Accès interdit à un ou plusieurs serveurs. Connectez-vous sous ssconfig et retentez l'opération.

Active trap events is empty.

Les événements de déroutement sont vides.

Add SCSI Drive into Logical Drive information.

Informations sur l'ajout du lecteur SCSI dans le lecteur logique.

Agent Name is empty.

Le nom de l'agent est vide.

An error occurred while getting data from the server.

Une erreur s'est produite lors de l'obtention de données du serveur.

TABLEAU G-33 Valeurs substituées (suite)

Value Description
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An existing configuration for this package is found. Do you want to restore it?

Une configuration existante de ce package a été trouvée. Voulez-vous la restaurer ?

An HBA card with this WWN already exists.

Une carte d'adaptateur de bus hôte avec ce nom WWN existe déjà.

Another instance of this program is already running!

Une autre instance de ce programme est déjà en cours d'exécution !

Are you sure you want to continue?

Voulez-vous toujours poursuivre ?

Are you sure you want to continue?

Voulez-vous toujours poursuivre ?

Are you sure you want to delete the log file?

Êtes-vous sûr de vouloir supprimer le ficher journal ?

Are you sure you want to delete the log file?

Êtes-vous sûr de vouloir supprimer le ficher journal ?

Are you sure you want to overwrite the file?

Êtes-vous sûr de vouloir remplacer le fichier ?

Are you sure you want to rebuild the drive?

Êtes-vous sûr de vouloir reconstruire le lecteur ?

Array Admin in Progress.

Administration de la baie en cours.

At least one email address needs to be configured.

Il faut configurer au moins une adresse électronique.

Attempted to load a cartridge type, not supported by this drive. The cartridge has been
automatically ejected. Attempted to load an unsupported tape format.

Tentative de charger un type de cartouche incompatible avec ce lecteur. La cartouche a été
automatiquement éjectée. Tentative de charger un format de bande incompatible.

Attempted to write to a write-protected cartridge. Remove the write-protection or use
another tape.

Tentative d'écriture sur une cartouche protégée contre l'écriture. Retirez le dispositif de
protection d'écriture ou utilisez une bande différente.

Audible alarm has an unknown status

L'alarme sonore est dans un état inconnu

TABLEAU G-34 Messages d'erreur et d'état (suite)

Error and Status Messages
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Audible alarm has been triggered.

L'alarme sonore a été déclenchée.

Audible alarm has been turned off.

L'alarme sonore a été arrêtée.

Background check or rebuild operation in progress.

Opération de reconstruction ou de vérification en arrière-plan en cours.

Background initialization in progress.

Initialisation en arrière-plan en cours.

Background parity check in progress.

Contrôle de parité en arrière-plan en cours.

Background rebuild operation in progress.

Opération de reconstruction en arrière-plan en cours.

Background rebuild/check has been successfully terminated by abort command.

La vérification/reconstruction en arrière-plan a été correctement arrêtée par la commande
d'annulation.

Background rebuild/check has failed. Cause unknown.
See additional messages.

La vérification/reconstruction en arrière-plan a échoué. Cause inconnue.
Voir messages supplémentaires.

Background rebuild/check has failed. Possible device failure.
See additional messages.

La vérification/reconstruction en arrière-plan a échoué. Défaillance possible de périphérique.
Voir messages supplémentaires.

Background rebuild/check has failed. Possible system drive failure.

La vérification/reconstruction en arrière-plan a échoué. Défaillance possible du lecteur
système.

Before starting to use SUNWsscsConsole, run /opt/SUNWsscs/sscsconsole/config_sscon to
input the pathanme of the default Web browser to access HTML help files.

Avant d'utiliser la console SUNWsscs, exécutez /opt/SUNWsscs/sscsconsole/config_sscon
pour saisir le nom du chemin du navigateur Internet par défaut permettant d'accéder aux
fichiers d'aide HTML.

Begin downloading firmware to devices. Do you want to continue?

Début du téléchargement du firmware vers les périphériques. Voulez-vous continuer ?

TABLEAU G-34 Messages d'erreur et d'état (suite)

Error and Status Messages
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Block Reassignment Failure (Ch:%d,Id:%d). Defective drive. Replace.

Échec de la réaffectation de bloc (Ch:%d,Id:%d). Lecteur défectueux. Remplacez-le.

Block Reassignment Succeeded( Ch:%d,Id:%d.) Informational message. Drive might be
failing.

Réussite de la réaffectation de bloc (Ch:%d,Id:%d). Message informatif. Le lecteur pourrait
être défectueux.

Cannot find the Java Runtime Environment $JRE_MAJOR.$JRE_MINOR or above!
SUNWsscs Console needs JRE 1.2 or above to run. The Console will try to find it in
/usr/java, /usr/jre, /usr/local/java, or /usr/local/jre. If you installed the JRE
in a directory other than one mentioned above, make a link.

Impossible de trouver Java Runtime Environment $JRE_MAJOR.$JRE_MINOR ou version
ultérieure ! La console SUNWsscs a besoin de la version JRE 1.2 ou ultérieure.
La console tentera de le trouver dans /usr/java, /usr/jre, /usr/local/java,
ou /usr/local/jre. Si vous installez JRE dans un répertoire autre que celui mentionné
ci-dessus, créez un lien.

Cannot get available LUN to assign this parition.

Impossible d'obtenir le numéro d'unité logique requis à l'affectation de cette partition.

Cannot get configuration from controller. The operation is canceled.

Impossible d'obtenir la configuration du contrôleur. Opération annulée.

Cannot get SAFTE device status!

Impossible d'obtenir l'état du périphérique SAF-TE.

Changes made to Optimization will NOT take effect until all the logical drives are deleted
and then the controller is RESET.

Des modifications effectuées à l'optimisation n'auront aucune incidence tant que tous les
lecteurs logiques ne sont pas supprimés et le contrôleur n'est pas ensuite réinitialisé.

Changes made to this setting will NOT take effect until the controller is RESET. Prior to
resetting the controller, the operation may not proceed normally. Do you want to RESET
controller?

Les modifications effectuées à ce réglage n'auront aucune incidence tant que le contrôleur
n'est pas réinitialisé. Avant la réinitialisation du contrôleur, le fonctionnement risque de ne
pas être normal. Voulez-vous réinitialiser le contrôleur ?

Click View to select one file.

Cliquez sur View pour sélectionner un fichier.

Collect mail canceled by user.

La réception du courrier a été annulée par l'utilisateur.

Completed Dynamic Growth.
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Croissance dynamique terminée.

Configuration information saved successfully!

Les informations de configuration ont été sauvegardées avec succès !

Connect and Login command error

Erreur de la commande de connexion et d'entrée en session

Contact Fax number format is wrong.

Le format du numéro de fax du contact est incorrect.

Contact Name is empty

Le nom du contact est vide

Contact Phone number format is wrong.

Le format du numéro de téléphone du contact est incorrect.

Continuing Dynamic Growth - Parity Check Phase Completed.

Croissance dynamique en cours – Phase du contrôle de parité terminée.

Continuing Dynamic Growth - Rebuild Phase Completed.

Croissance dynamique en cours – Phase de reconstruction terminée.

Controller Event, Controller Init Complete. Controller has been rebooted. Informational
message.

Événement de contrôleur, l'initialisation du contrôleur est terminée. Le contrôleur a été
réamorcé. Message informatif.

Controller Event, Controller Reset.

Événement de contrôleur, réinitialisation du contrôleur.

Controller Event, DRAM Parity Error. Likely controller error. If error persists, replace
defective controller.

Événement du contrôleur, erreur de parité DRAM. Probablement une erreur de contrôleur.
Si l'erreur persiste, remplacez le contrôleur défectueux.

Controller Event, Fan Back On-line. Informational message.

Événement du contrôleur, ventilateur remis en ligne Message informatif.

Controller Event, Fan Failure Detected. Fan is integrated with power supply. Replace power
supply. Check LED indicators to identify supply.

Événement du contrôleur, défaillance de ventilateur détectée. Le ventilateur est intégré à
l'unité d'alimentation électrique. Remplacez l'unité d'alimentation. Vérifiez les diodes pour
identifier l'alimentation.

Controller Event, Power Supply Back On-line. Informational message.
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Événement du contrôleur, alimentation remise en ligne Message informatif.

Controller Event, Power Supply Failure Detected. Replace power supply. Check LED
indicators to identify supply.

Événement du contrôleur, défaillance de l'alimentation électrique détectée. Remplacez l'unité
d'alimentation. Vérifiez les diodes pour identifier l'alimentation.

Controller Event, Redundant Controller Failure Detected. Likely controller error. If error
persists, replace defective controller.

Événement du contrôleur, défaillance du contrôleur redondant détectée. Probablement une
erreur de contrôleur. Si l'erreur persiste, remplacez le contrôleur défectueux.

Controller Event, SDRAM Error. Likely controller error. If error persists, replace defective
controller.

Événement du contrôleur, erreur SDRAM Probablement une erreur de contrôleur. Si l'erreur
persiste, remplacez le contrôleur défectueux.

Controller Event, Temperature Alert. Check room temperature, clogged or restricted airflow.
Correct as necessary.

Événement du contrôleur, alerte de température. Vérifiez la température de la pièce et la
circulation de l'air pour toute obstruction. Prenez les mesures nécessaires.

Controller Event, Temperature Back to Normal. Informational message.

Événement du contrôleur, température redevenue normale. Message informatif.

Controller Event, UPS AC Power Back On. Informational message.

Événement du contrôleur, retour de l'alimentation CA de l'onduleur. Message informatif.

Controller Event, UPS AC Power Loss Detected. Contact technical support.

Événement du contrôleur, coupure de l'alimentation CA de l'onduleur détectée Contactez
l'assistance technique.

Creating Host LUN filter Entry; please wait…

Création d'une entrée d'un filtre d'unité logique hôte. Veuillez patienter…

Creating standard Host LUN mapping; please wait…

Création d'un mappage d'unité logique d'hôte standard. Veuillez patienter…

Customer Fax number format is wrong.

Le format du numéro de fax du client est incorrect.

Customer name has been updated.

Le nom du client a été mis à jour.

Customer Name is empty.

Le nom du client est vide.
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Customer Phone number format is wrong.

Le format du numéro de téléphone du client est incorrect.

Data is at risk. Media performance of this tape is severely degraded. Copy any data you
require from this tape. Do not use this tape again. Restart the operation with a different tape.

Risque de perte de données. Les performances de cette bande se sont sévèrement dégradées.
Copiez toutes les données pertinentes se trouvant sur cette bande. N'utilisez plus cette
bande. Recommencez l'opération avec une autre bande.

Data Under/Overrun(Ch:%d,Id:%d). Likely poorly seated or defective drive. If random
drives, possible I/O module or cable failure on drive loop.

Données sous-exécution/débordement (Ch:%d,Id:%d). Sûrement un lecteur mal placé ou
défectueux. Si le lecteur change de manière aléatoire, il est possible que le module E/S ou le
câble soit défectueux sur la boucle de périphériques.

Decrypt mail canceled by user.

Le décryptage du courrier a été annulé par l'utilisateur.

Deleted disk successfully!

Disque supprimé avec succès !

Deleting disk; please wait…

Suppression du disque. Veuillez patienter…

Deleting Host LUN filter Entry; please wait…

Suppression de l'entrée du filtre de l'unité logique d'hôte. Veuillez patienter…

Deleting standard Host LUN mapping; please wait…

Suppression du mappage de l'unité logique d'hôte standard. Veuillez patienter…

Device at [Channel:Target] has been marked DEAD.

Le périphérique à [Canal:Cible] est libellé DEAD (en panne).

Device at [Channel:Target] has failed the self-reliability test. Replace the device.

Le périphérique à [Canal:Cible] n'a pas passé le test de fiabilité. Remplacez le périphérique.

Device information failed.

Échec d'informations sur le périphérique.

Device is being automatically replaced by device [Channel:Target].

Le périphérique est automatiquement remplacé par le périphérique [Canal:Cible].

Device will NOT be automatically replaced.

Le périphérique NE SERA PAS automatiquement remplacé.

Disk at [Channel:Target] has failed. Replace the device.
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Le disque à [Canal:Cible] a échoué. Remplacez le périphérique.

Disk at [Channel:Target] is back online.

Le disque à [Canal:Cible] est de nouveau en ligne.

Disk information is not available.

Les informations sur le disque ne sont pas disponibles.

Do you want to download firmware to the controller?

Voulez-vous télécharger le firmware vers le contrôleur ?

Do you want to download firmware with boot recrod to the controller?

Voulez-vous télécharger le firmware avec l'enregistrement d'amorçage vers le contrôleur ?

Do you want to save the current event log file?

Voulez-vous enregistrer le fichier du journal d'événements actuel ?

Do you want to set up the mail server?

Voulez-vous configurer le serveur du courrier ?

Door lock has an unknown status.

Le verrou de porte est dans un état inconnu.

Door locked.

Porte verrouillée.

Door unlocked.

Porte déverrouillée.

Download Firmware with Boot Record.

Téléchargez le firmware avec l'enregistrement de démarrage.

Downloading Firmware to the devices

Téléchargement du firmware vers les périphériques en cours

Downloading Firmware to the RAID Controller.

Téléchargement du firmware vers le contrôleur RAID en cours.

Drive SCSI Ch:%d Check drive seating, cables, and I/O module. Replace as required.
Redundant controllers failed to bind.

Canal SCSI du lecteur:%/d. Vérifiez le logement du lecteur, des câbles et du module d'E/S.
Remplacez ce matériel au besoin. Échec de liaison des contrôleurs redondants.

Drive SCSI Ch:%d; Id:%d Likely poorly seated or defective drive. If random drives, possible
I/O module or cable failure.
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Canal SCSI de lecteur:%d ; Id:%d. Lecteur certainement mal placé ou défectueux. Si le lecteur
change de manière aléatoire, il est possible que le module E/S ou le câble soit défectueux.

Dynamic Growth Add Capacity Failed.

Échec de la capacité d'ajout de la croissance dynamique.

Dynamic Growth Check Consistency Failed.

Échec de la consistance de vérification de la croissance dynamique.

Dynamic Growth Close Transport Failed.

Échec de la fermeture du transport de la croissance dynamique.

Dynamic Growth Disable Controller failed.

Échec de la désactivation du transport de la croissance dynamique.

Dynamic Growth has completed on logical drive LogicalDrive.

La croissance dynamique est terminée sur le lecteur logique LogicalDrive.

Dynamic Growth has started on logical drive LogicalDrive.

La croissance dynamique a commencé sur le lecteur logique LogicalDrive.

Dynamic Growth Kill Partner Failed.

Échec du partenaire de suppression de la croissance dynamique.

Dynamic Growth Partner Status Failed.

Échec de l'état d'un partenaire de la croissance dynamique.

Dynamic Growth Rebuild Failed.

Échec de la reconstruction de la croissance dynamique.

Email address format is wrong.

Format de l'adresse électronique incorrect.

Enclosure #Enclosure state change: Name

Modification de l'état du boîtier #Boîtier : Nom

Enclosure #Enclosure, Cache backup battery has changed from State state to State state.

Boîtier#Boîtier, la batterie de sauvegarde cache est passé de l'état État à l'état État.

Enclosure #Enclosure, Fan #Fan has changed from a State state to a State state.

Le boîtier #Boîtier, le ventilateur #Ventilateur sont passés de l’état État à l’état État.

Enclosure #Enclosure, Power supply #Power has changed from a State state to a State state.

Le boîtier #Boîtier, le bloc d’alimentation #Alimentation sont passés de l’état État à l’état État.

Enclosure #Enclosure, temperature threshold has changed from a State state to a State state.
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La température seuil du boîtier #Boîtier, est passée de l’état État à l’état État.

Engaging firmware; a controller reset is not necessary.

Activation du firmware ; une réinitialisation du contrôleur est inutile.

Enter a Contact Name.

Saisissez un nom de contact.

Enter a Customer Name.

Saisissez un nom de client.

Enter a Location.

Saisissez un emplacement.

Enter a mail address.

Saisissez une adresse électronique.

Enter a System ID.

Saisissez une ID système.

Enter a valid gateway address.

Saisissez une adresse de passerelle valide.

Enter a valid IP address.

Saisissez une adresse IP valide.

Enter a valid network mask.

Saisissez un masque de réseau valide.

Enter SMTP server information

Saisissez des informations sur le serveur SMTP.

Enter the login password.

Saisissez le mot de passe de connexion.

Enter the ssconfig user password to login

Saisissez le mot de passe utilisateur ssconfig pour la connexion

Error in writing file, please try later!

Erreur lors de l'écriture dans le fichier. Réessayez plus tard !

Error occurred. Reset the config file.

Une erreur s'est produite. Réinitialisez le fichier de configuration.

Error on RAIDFlex port inquiry.
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Erreur sur la requête de port RAIDFlex.

Expand Logical Drive information.

Informations sur l'expansion du lecteur logique.

Failed primary controller has been removed.

Le contrôleur principal défectueux a été enlevé.

Failed secondary controller has been removed.

Le contrôleur secondaire défectueux a été supprimé.

Fan #Fan has an unknown status.

Le ventilateur #Ventilateur est dans un état inconnu.

Fan #Fan is malfunctioning.

Le ventilateur #Ventilateur fonctionne mal.

Fan #Fan is not present in the system.

Le ventilateur #Ventilateur n'est pas dans le système.

Fan #Fan is operational.

Le ventilateur #Ventilateur fonctionne normalement.

File I/O error. Configuration could not be saved!

Erreur d'E/S de fichier. Impossible de sauvegarder la configuration.

Firmware downloaded to Safte device (Ch:%d,Id:%d) failed.

Échec du téléchargement du firmware vers le périphérique Safte (Ch:%d,Id:%d).

Firmware downloaded to Safte device (Ch:%d,Id:%d) successfully.

Réussite du téléchargement du firmware vers le périphérique Safte (Ch:%d,Id:%d).

Firmware downloaded to SCSI drive (Ch:%d,Id:%d) failed.

Échec du téléchargement du firmware vers le lecteur SCSI (Ch:%d,Id:%d).

Firmware downloaded to SCSI drive (Ch:%d,Id:%d) successfully.

Réussite du téléchargement du firmware vers le lecteur SCSI (Ch:%d,Id:%d).

First select one Logical Drive!

Sélectionnez tout d'abord un lecteur logique !

First select one physical device.

Sélectionnez tout d'abord un périphérique physique.

First select one RAID controller.
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Sélectionnez tout d'abord un contrôleur RAID.

For NRAID Logical Drive 'Expand'/'Add Drive'/'Copy and Replace' function is disabled.

Pour le lecteur logique RAID1, la fonction « Expand/Add Drive/Copy and Replace » est
désactivée.

For RAID1 Logical Drive 'Add Drive'/'Copy and Replace' function is disabled.

Pour le lecteur logique RAID1, la fonction « Add Drive/Copy and Replace » est désactivée.

Forward mail canceled bu user

L’envoi du courrier a été annulé par l'utilisateur.

Getting Agent Options failed!

Échec de l'obtention des options d'agent !

Getting Controller Parameters failed!

Échec de l'obtention des paramètres du contrôleur !

Getting Host LUN Assignments failed! Please try again

Échec de l'obtention des affectations des unités logiques d' hôte ! Réessayez.

Getting the configuration failed!

Échec de l'obtention de la configuration !

Gross Error on SCSI Bus Detected (Log drive LogicalDrive, Ch:Channel,Id:Target,Lun:Lun).

Erreur brute sur le bus SCSI détectée (lecteur logique :Lecteur logique, Ch : Canal,Id
:Cible,Unité logique :Unité logique).

Gross Phase/Signal Error Detected. Check drive seating, cables, and I/O module. Replace as
required. Redundant controllers failed to bind.

Erreur brute de phase/signal détectée. Vérifiez le logement du lecteur, les câbles et le module
d'E/S. Remplacez ce matériel au besoin. Échec de liaison des contrôleurs redondants.

Group Name cannot be empty

Le nom de groupe ne peut pas être vide

Host LUN filter Entry created successfully!

Entrée du filtre de l'unité logique d'hôte créée avec succès !

Host LUN filter Entry deleted successfully!

Entrée du filtre de l'unité logique d'hôte supprimée avec succès !

Host LUN filter map (StorEdge SN#%d LD %d Partition %d) is created.

Mappage du filtre de l'unité logique d'hôte (StorEdge SN#%d LD %d Partition %d) créé.

Host LUN filter map (StorEdge SN#%d LD %d Partition %d) is deleted.
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Mappage du filtre de l'unité logique hôte (StorEdge SN#%d LD %d Partition %d) supprimé.

If file access is not properly coordinated when assigned to multiple hosts, data corruption
and access contentions may occur.

Si l'accès au fichier n'est pas coordonné correctement lors de son affectation à plusieurs
hôtes, la corruption des données et des conflits d'accès risquent de se produire.

If Minimum interval is \“0\” or \“*\”, then Content must be \“Event\”

Si l'intervalle minimum est \“0\” ou \“*\”, le contenu doit être \“Event\”

If the firnware download progress is interrupted the controllers/devices may become
unusable.

Si le téléchargement du firmware est interrompu, le contrôleur/les périphériques risquent
d'être inutilisables.

Initialization operations have completed.

Opérations d'initialisation terminées.

Initializaton, rebuild, expand, or add SCSI drive activities are in progress. Try again later.

Des activités d'initialisation, de reconstruction, d'extension ou d'ajout du lecteur SCSI sont en
cours. Réessayez plus tard.

Inserted failed primary controller.

Contrôleur principal défectueux inséré.

Inserted failed secondary controller.

Contrôleur secondaire défectueux inséré.

Install JRE 1.2.2, 1.3, 04 1.4 before installing the console.

Installez les versions JRE 1.2.2, 1.3 ou 1.4 avant la console.

Invalid server IP address!

Adresse IP du serveur non valide !

IP Address format error (must be xxx.xxx.xxx.xxx and 0 &amp;lt; xxx &amp;lt;255) !

Erreur du format d'adresse IP (doit être xxx.xxx.xxx.xxx et 0 &amp;lt; xxx &amp;lt;255) !

IP Address is duplicated!

L'adresse IP est dupliquée !

IP Address is empty.

L'adresse IP est vide.

Issue Reset to the controller.

Réinitialisez le contrôleur.
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Location is empty.

L'emplacement est vide.

Log in as \"ssconfig\" user and try the operation again.

Connectez-vous sous \"ssconfig\" et retentez l'opération.

Logical array LogicalArray Dynamic Growth has completed.

La croissance dynamique de la baie logique LogicalArray est terminée.

Logical array LogicalArray Dynamic Growth has started.

La croissance dynamique de la baie logique LogicalArray a commencé.

Logical array LogicalArray has changed from a State state to a State state.

La baie logique Baie logique est passé d'un état État à un état État.

Logical array LogicalArray initialization has completed.

L'initialisation de la baie logique Baie logique est terminée.

Logical array LogicalArray initialization has started.

L'initialisation de la baie logique Baie logique a commencé.

Logical array LogicalArray parity check has completed.

Le contrôle de la parité de la baie logique Baie logique est terminé.

Logical array LogicalArray parity check has started.

Le contrôle de la baie logique Baie logique a commencé.

Logical array LogicalArray scheduled parity check has completed.

Le contrôle de parité planifié de la baie logique Baie logique est terminé.

Logical array LogicalArray scheduled parity check has started.

Le contrôle de parité planifié de la baie logique Baie logique a commencé.

Logical Drive %d, a SCSI Drive Failed. Replace defective drive

Lecteur logique %d, échec d'un lecteur SCSI. Remplacez le lecteur défectueux.

Logical Drive LogicalDrive, Parity Check Failed. Non-recoverable error. Likely drive failure or
a non-recoverable error on stripe. Run parity check on the logical drive. Contact technical
support.
Note: If you manually aborted Parity Check, there is no risk of data corruption. There is no need to
contact technical support.
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Lecteur logique Lecteur logique, échec du contrôle de parité. Erreur non récupérable.
Sûrement une erreur de lecteur ou une erreur non récupérable sur la piste. Exécutez le
contrôle de parité sur le lecteur logique. Contactez l'assistance technique.
Remarque : Si vous avez annullé manuellement le contrôle de parité, il n’y a aucun risque que les
données soient corrompues. Il n’est pas nécessaire de contater l’assistance technique.

Logical Drive ID %d, Rebuild Completed. Informational message. Replace defective drive
with new drive.

Identificateur de lecteur logique %d, reconstruction terminée. Message informatif.
Remplacez le lecteur défectueux par un nouveau lecteur.

Logical Drive ID LogicalDrive, Add drive paused. Informational message.

Identificateur de lecteur logique Lecteur logique, ajout de lecteur interrompu.
Message informatif.

Logical Drive ID LogicalDrive, Add SCSI Drv Completed. Informational message.

Identificateur de lecteur logique Lecteur logique, ajout de lecteur SCSI terminé.
Message informatif.

Logical Drive ID LogicalDrive, Starting Parity Check. Informational message.

Identificateur de lecteur logique Lecteur logique, contrôle de parité commencé.
Message informatif.

Logical Drive ID LogicalDrive, Starting Rebuild. Informational message.

Identificateur de lecteur logique LogicalDrive, reconstruction commencée.
Message informatif.

Logical Drive ID LogicalDrive, Add SCSI Drv Failed. Non-recoverable error. Likely drive
failure or a non-recoverable error on stripe. Run parity check on the logical drive. Contact
technical support.

Identificateur de lecteur logique Lecteur logique, échec de l'ajout du lecteur SCSI. Erreur non
récupérable. Sûrement une erreur de lecteur ou une erreur non récupérable sur la piste.
Exécutez le contrôle de parité sur le lecteur logique. Contactez l'assistance technique.

Logical Drive ID LogicalDrive, Clone Completed. Informational message.

Identificateur de lecteur logique Lecteur logique, clonage terminé. Message informatif.

Logical Drive ID LogicalDrive, Clone Failed. Non-recoverable error Likely drive failure or a
non-recoverable error on stripe. Run parity check on the logical drive. Contact technical
support.

Identificateur de lecteur logique Lecteur logique, échec de clonage. Erreur non récupérable,
sûrement une erreur de lecteur ou une erreur non récupérable sur la piste. Exécutez le
contrôle de parité sur le lecteur logique. Contactez l'assistance technique.

Logical Drive ID LogicalDrive, Expand Completed. Informational message.

Identificateur de lecteur logique Lecteur logique, extension terminée. Message informatif.
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Logical Drive ID LogicalDrive, Expand Failed. Non-recoverable error. Likely drive failure or a
non-recoverable error on stripe. Run parity check on the logical drive. Contact technical
support.

Identificateur de lecteur logique Lecteur logique, échec d'extension. Erreur non récupérable.
Sûrement une erreur de lecteur ou une erreur non récupérable sur la piste. Exécutez le
contrôle de parité sur le lecteur logique. Contactez l'assistance technique.

Logical Drive ID LogicalDrive, Initialization Completed. Informational message.

Identificateur de lecteur logique Lecteur logique, initialisation terminée. Message informatif.

Logical Drive ID LogicalDrive, Initialization Failed. Informational message. Possible defective
drive or slot. User might have aborted operation.

Identificateur de lecteur logique Lecteur logique, échec d'initialisation. Message informatif.
Sûrement un logement ou lecteur défectueux. L'utilisateur peut avoir annulé l'opération.

Logical Drive ID LogicalDrive, Parity Check Completed. Informational message.

Identificateur de lecteur logique Lecteur logique, contrôle de parité terminé.
Message informatif.

Logical Drive ID LogicalDrive, Rebuild Failed. Informational message. Possible defective
drive or slot. User might have aborted operation.

Identificateur de lecteur logique Lecteur logique, échec de reconstruction. Message informatif.
Sûrement un logement ou lecteur défectueux. L'utilisateur peut avoir annulé l'opération.

Logical Drive ID LogicalDrive, Starting Add SCSI Drive Operation. Informational message.

Identificateur de lecteur logique Lecteur logique, opération d'ajout de lecteur SCSI commencée.
Message informatif.

Logical Drive ID LogicalDrive, Starting Clone. Informational message.

Identificateur de lecteur logique Lecteur logique, clonage commencé. Message informatif.

Logical Drive ID LogicalDrive, Starting Expansion. Informational message.

Identificateur de lecteur logique Lecteur logique, expansion commencée. Message informatif.

Logical Drive ID LogicalDrive, Starting Initialization. Informational message.

Identificateur de lecteur logique Lecteur logique, initialisation commencée.
Message informatif.

Logical Drive ID LogicalDrive, Starting Parity Check. Informational message.

Identificateur de lecteur logique Lecteur logique, contrôle de parité commencé.
Message informatif.

Logical Drive LogicalDrive has changed from a State state to a State state.

Le lecteur logique Lecteur logique est passé d'un état État à un état État.

Logical Volume Components List. Total disks in this Logical Volume=
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Liste des composants de volume logique. Total disques dans ce volume logique=

Login successful

Connexion réussie

Login unsuccessful

Échec de connexion

Logout command error.

Erreur de commande de déconnexion.

Mail information is empty

Information courrier vide.

Memory Allocation Error.

Erreur d'allocation de mémoire.

Minimum interval between emails must be one of the following formats: \"*\" \"0\" \"nn\
" \"nn:mm\"

Le format de l'intervalle minimum entre les messages électroniques doit être l'un des suivants :
\"*\" \"0\" \"nn\" \"nn:mm\"

Minimum interval can’t meet Content value.

L'intervalle minimum ne peut satisfaire la valeur du contenu.

Minimum interval format error.

Erreur du format de l'intervalle minimum.

Minimum interval format is HH[:MM].

Le format de l'intervalle minimum est HH[:MM].

Minimum interval is empty.

L'intervalle minimum est vide.

Multiple IP assignment mechanisms are not supported. Select only one mechanism.

Les mécanismes d'affectation d'IP multiples ne sont pas pris en charge. Sélectionnez
uniquement un mécanisme.

Mute controller beeper failure.

Échec de la désactivation du signal sonore du contrôleur.

Mute controller beeper.

Désactivez le signal sonore du contrôleur.

Negotiating with the secondary controller.
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Négociation en cours avec le contrôleur secondaire.

Negotiation completed successfully, waiting for next ping.

La négociation s'est terminée correctement, attente de la prochaine commande ping.

Negotiation Error(Ch:%d,Id:%d). Check drive seating, cables, and I/O module. Replace as
required.

Erreur de la négociation (Ch:%d,Id:%d). Vérifiez le logement du lecteur, les câbles et le
module d'E/S. Remplacez ce matériel au besoin.

New parity check schedule has been created.

Une nouvelle planification du contrôle de parité a été créée.

No admin progress exists.

Pas de progrès d'administration.

No Admin progress was found. All activity should be complete!

Aucun progrès d'administration trouvé. Toutes les activités devraient être terminées !

No array administration activity in progress!

Aucune activité d'administration de baie en cours !

No more events to report.

Plus d'événements à rapporter.

Not Ready Error Reported by Target(Ch:%d,Id:%d). Likely poorly seated or defective drive.
Possible defective drive slot.

Erreur Pas prêt rapportée par cible (Ch:%d,Id:%d). Sûrement un lecteur mal placé ou
défectueux. Peut-être un logement de lecteur défectueux.

Only the last partition of a logical drive can be deleted.

Seule la dernière partition d'un lecteur logique peut être supprimée.

Operation completed successfully.

Opération terminée avec succès.

Operation failed.

L'opération a échoué.

Operation in progress.

Opération en cours.

Operation on one of the servers failed

L'opération sur l'un des serveurs a échoué.

Out of the scope!
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Hors de portée !

Parity check could not be started on logical drive LogicalDrive.

Le contrôle de parité n'a pas commencé sur le lecteur logique Lecteur logique.

Parity check has completed on logical drive LogicalDrive.

Le contrôle de parité est terminé sur le lecteur logique Lecteur logique.

Parity check has started on logical drive LogicalDrive.

Le contrôle de parité a commencé sur le lecteur logique Lecteur logique.

Parity check or Rebuild has completed on logical drive LogicalDrive.

Le contrôle de parité ou la reconstruction est terminée sur le lecteur logique Lecteur logique.

Parity check schedule has been removed.

La planification du contrôle de parité a été supprimée.

Parity check schedule has been updated.

La planification du contrôle de parité a été actualisée.

Parity Error(Ch:%d,Id:%d ). Likely poorly seated or defective drive. If random drives,
possible I/O module or cable failure.

Erreur de parité (Ch:%d,Id:%d). Sûrement un lecteur mal placé ou défectueux. Si le lecteur
change de manière aléatoire, il est possible que le module E/S ou le câble soit défectueux.

Parity Error(SCSI Channel %d, SCSI ID %d, Target Lun %d). Possible failure of I/O module,
cable, controller, or HBA

Erreur de parité (Canal SCSI %d, ID SCSI %d, Numéro d'unité logique cible %d). Défaillance
possible du module E/S, câble, contrôleur ou adaptateur de bus hôte.

Partition 0 cannot be deleted.

La partition 0 ne peut être supprimée.

Partition table is full, 'Expand Logical Drive'/'Add Drive' function is disabled.

Le tableau de partition est complet, la fonction « Expand Logical Drive »/« Add Drive » est
désactivée.

Password error!

Erreur de mot de passe !

Password is empty

Le mot de passe est vide

Physical drive Channel:Target rebuild has completed.

La reconstruction du lecteur physique Canal:Cible est terminée.

TABLEAU G-34 Messages d'erreur et d'état (suite)

Error and Status Messages
Annexe G Messages et codes d'erreur 283



Physical drive Channel:Target rebuild has started.

La reconstruction du lecteur physique Canal:Cible a commencé.

Poll interval limited to 600 seconds (10 minutes). Specify a lower value.

Intervalle d'interrogation limité à 600 secondes (10 minutes). Entrez une valeur inférieure.

Port is invalid (port must be between 0 and 65535)

Le port n'est pas valide (il doit être compris entre 0 et 65535)

Port is invalid (port must be between 1270 and 1273)

Le port n'est pas valide (il doit être compris entre 1270 et 1273)

Power supply #Power has an unknown status.

L'alimentation #Alimentation est dans un état inconnu.

Power supply #Power is malfunctioning and has been switched off.

L'alimentation #Alimentation fonctionne mal et a été mise hors tension.

Power supply #Power is malfunctioning or disabled.

L'alimentation #Alimentation est défectueuse ou désactivée.

Power supply #Power is not present in the system.

L'alimentation #Alimentation n'est pas dans le système.

Power supply #Power is operational but disabled.

L'alimentation #Alimentation est opérationnelle mais elle est désactivée.

Power supply #Power is operational.

L'alimentation #Alimentation est opérationnelle.

Power supply #Power is present in the system.

L'alimentation #Alimentation est dans le système.

Primary controller failed. Secondary controller is servicing I/O.

Échec du contrôleur principal. Le contrôleur secondaire gère les E/S.

Primary controller has stopped negotiation because of insufficient memory.

Le contrôleur principal a arrêté la négociation parce que la mémoire est insuffisante.

Probe Agent command error!

Erreur de commande d'agent de sonde !

Progress not available

Les progrès ne sont pas disponibles
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Raid Controller is back online.

Contrôleur Raid de retour en ligne.

Read config file error

Erreur de lecture du fichier de configuration

Rebuild or check operations have completed with error - Drive Failure.

Les opérations de vérification ou de reconstruction sont terminées avec erreur – Panne de lecteur.

Rebuild or check operations have completed with error - Job Terminated.

Les opérations de vérification ou de reconstruction sont terminées avec erreur – Travail terminé.

Rebuild or check operations have completed with error - System Drive Failure.

Les opérations de vérification ou de reconstruction sont terminées avec erreur – Panne de
lecteur système.

Rebuild or check operations have completed with error - Unknown causes.

Les opérations de vérification ou de reconstruction sont terminées avec erreur – Causes
inconnues.

Rebuild or check operations have completed.

Les opérations de vérification ou de reconstruction sont terminées.

Received command to establish redundancy with secondary controller.

Commande reçue pour établir la redondance avec le contrôleur secondaire.

Received command to return control to primary controller.

Commande reçue pour redonner la gestion au contrôleur principal.

Received first ping after successful negotiation.

Première commande ping reçue après la réussite d'une négociation.

Received the first ping from secondary controller.

Première commande ping reçue du contrôleur secondaire.

Redundant Array State Change: Controllers back in redundancy mode!

Modification de l'état de la baie redondante : Contrôleurs de retour en mode de redondance !

Redundant Array State Change: Primary controller failed! Replace the Primary Controller.

Modification de l'état de la baie redondante : Échec du contrôleur principal !
Remplacez le contrôleur principal.

Redundant Array State Change: Secondary controller failed! Replace the Secondary
Controller.
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Modification de l'état de la baie redondante : Échec du contrôleur secondaire.
Remplacez le contrôleur secondaire.

Remove the package @PKG_NAME@ and then try to install this package

Enlevez le package @PKG_NAME@ et essayez ensuite d'installer ce package.

Removed a failed primary controller.

Contrôleur principal défectueux retiré.

Removed a failed secondary controller.

Contrôleur secondaire défectueux retiré.

Reselect Timeout(SCSI Channel %d, SCSI ID %d, Target Lun %d). Possible failure of I/O
module, cable, controller, or HBA.

Temporisation de resélection (Canal SCSI %d, ID SCSI %d, Unité logique cible %d).
Défaillance possible du module E/S, câble, contrôleur ou adaptateur de bus hôte.

Restoring control to primary controller.

Restauration de la gestion au contrôleur principal.

Retry the configuration operation after the update is complete.

Essayez à nouveau la configuration après l'actualisation.

SAF-TE card Channel:Target firmware has been updated.

Le firmware de la carte SAF-TE Canal:Cible a été mis à jour.

SAF-TE card Channel:Target global status has been updated.

L'état global de la carte SAF-TE Canal:Cible a été mis à jour.

SAF-TE card Channel:Target slot perform status has been updated.

L'état de performance du logement de la carte SAF-TE Canal:Cible a été mis à jour.

SAF-TE card Channel:Target slot status has been updated.

L'état du logement de la carte SAF-TE Canal:Cible a été mis à jour.

Save a Copy in server.

Enregistrement d'une copie sur le serveur.

Saving configuration information; please wait…

Enregistrement des informations de la configuration. Veuillez patienter…

Scan SCSI Drive information.

Analyse des informations du lecteur SCSI.

Scan SCSI Drive Successful. Informational message.
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Analyse du lecteur SCSI réussie. Message informatif.

Scheduled parity check could not be started on logical drive LogicalDrive.

Le contrôle de parité planifié n'a pas commencé sur le lecteur logique Lecteur logique.

Scheduled parity check has completed on logical drive LogicalDrive.

Le contrôle de parité planifié est terminé sur le lecteur logique Lecteur logique.

Scheduled parity check has started on logical drive LogicalDrive.

Le contrôle de parité planifié a commencé sur le lecteur logique Lecteur logique.

Scheduled parity check on logical drive LogicalDrive completed with error - Drive Failure.

Le contrôle de parité planifié est terminé sur le lecteur logique Lecteur logique avec erreur –
Panne de lecteur.

Scheduled parity check on logical drive LogicalDrive completed with error - Job Terminated.

Le contrôle de parité planifié est terminé sur le lecteur logique Lecteur logique avec erreur –
Travail terminé.

Scheduled parity check on logical drive LogicalDrive completed with error - System Drive
Failure.

Le contrôle de parité planifiée est terminé sur le lecteur logique Lecteur logique avec erreur –
Panne du lecteur système.

Scheduled parity check on logical drive LogicalDrive completed with error - Unknown
causes.

Le contrôle de parité planifié est terminé sur le lecteur logique Lecteur logique avec erreur –
Cause inconnue.

Scheduled parity check skipped to next schedule due to incompletion of previous check.

Le contrôle de parité planifié sera exécuté à la prochaine planification parce que le contrôle
précédent est incomplet.

SCSI Aborted Command(Ch:%d,Id:%d). Informational message. Drive might be failing or
defective slot.

Commande SCSI annulée (Ch:%d,Id:%d). Message informatif. Le lecteur peut être
défectueux ou logement défectueux.

SCSI Bus Device Reset(SCSI Channel %d, SCSI ID %d, Target Lun %d). Possible failure of
I/O module, cable, or HBA.

Réinitialisation du périphérique du bus SCSI (Canal SCSI %d, ID SCSI %d, Uunité logique
cible %d). Défaillance possible du module E/S, câble ou adaptateur de bus hôte.

SCSI Bus Reset Issued(Ch:%d,Id:%d). Check drive seating, cables, and I/O module. Replace
as required.
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Réinitialisation du bus SCSI émise (Ch:%d,Id:%d). Vérifiez le logement du lecteur, les câbles
et le module d'E/S. Remplacez ce matériel au besoin.

SCSI Bus Reset(SCSI Channel %d, SCSI ID %d, Target LUN %d). Possible failure of I/O
module, cable, or HBA.

Réinitialisation du bus SCSI (Canal SCSI %d, ID SCSI %d, Unité logique cible %d).
Défaillance possible du module E/S, câble ou adaptateur de bus hôte.

SCSI Channel Failure - (Ch:%d,Id:%d) Replace defective I/O or drive module.

Canal SCSI défectueux - (Ch:%d,Id:%d) Remplacez le module E/S ou de lecteur défectueux.

SCSI Channel Failure - Fibre Loop Connection Failure Check drive path. Possible cable or
module failure.

Canal SCSI défectueux – Échec de connexion à la boucle de fibre. Vérifiez le chemin du
lecteur. Câble ou module défectueux.

SCSI Channel Failure - General. Check drive path.

Canal SCSI défectueux – Général. Vérifiez le chemin de lecteur.

SCSI Channel Failure - Redundant Loop/Path Failure. Check drive path. Possible cable or
module failure.

Canal SCSI défectueux – Échec boucle/chemin redondant. Vérifiez le chemin de lecteur.
Câble ou module défectueux.

SCSI Channel Failure(Log drive LogicalDrive, Ch:Channel,Id:Target,Lun:Lun).

Canal SCSI défectueux (Lecteur logique : Lecteur logique, Canal : Canal, Id : Cible, Unité
logique : Unité logique).

SCSI Channel Restored - Fibre Loop Connection Restored. Informational message.

Canal SCSI restauré – Connexion restaurée à la boucle de fibre. Message informatif.

SCSI Channel Restored - Redundant Path Restored. Informational message.

Canal SCSI restauré – Chemin redondant restauré. Message informatif.

SCSI Drive Failed. Replace defective drive.

Lecteur SCSI défectueux. Remplacez le lecteur défectueux.

Secondary controller has failed.

Échec du contrôleur secondaire.

Select a Product ID before downloading firmware.

Sélectionnez un ID produit avant le téléchargement du firmware.

Select either AM or PM.

Sélectionnez soit AM soit PM.
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Select only ONE logical drive!

Sélectionnez uniquement UN lecteur logique !

Select only one row to edit it.

Sélectionnez une seule rangée à modifier.

Select only one row to remove it.

Sélectionnez une seule rangée à supprimer.

Select the agent before clicking Remove.

Sélectionnez l'agent avant de cliquer sur Remove.

Select the agent item before clicking Edit.

Sélectionnez l'agent avant de cliquer sur Edit.

Select the Channel/ID of the drive you want to scan

Sélectionnez le canal/ID du lecteur à analyser.

Select the firmware file before downloading it

Sélectionnez un fichier de firmware avant le téléchargement.

Select the Logical Drive(s)

Sélectionnez le(s) lecteur(s) logique(s)

Select the server item before clicking Edit.

Sélectionnez le serveur avant de cliquer sur Edit.

Select the server item before clicking Remove.

Sélectionnez le serveur avant de cliquer sur Remove.

Select the Starting Day.

Sélectionnez le jour de démarrage.

Select Timeout(Ch:%d,Id:%d). Likely poorly seated or defective drive. If random drives,
possible I/O module or cable failure.

Temporisation de sélection (Ch:%d,Id:%d). Sûrement un lecteur mal placé ou défectueux.
Si le lecteur change de manière aléatoire, il est possible que le module E/S ou le câble soit
défectueux.

Server failed the operation due to insufficient memory.

Échec du serveur. Mémoire insuffisante.

Server Name is empty

Le nom du serveur est vide
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Server Not managed!

Serveur non géré !

Set configuration failed!

Échec du réglage de la configuration !

Slot #Slot has had a device Name.

Le logement Logement avait un Nom de périphérique.

SMART Predictable Failure Detected Ch:%d,Id:%d). Informational message. Drive might be
failing.

Détection d'échec prévisible SMART (Ch:%d,Id:%d). Message informatif. Le lecteur pourrait
être défectueux.

SMTP From address format is wrong or empty.

Format de l'adresse SMTP De est incorrect ou vide.

SMTP From address format is wrong.

Format de l'adresse SMTP De incorrect.

SMTP Server address is empty.

L'adresse du serveur SMTP est vide.

Specify how often you want the parity checked.

Spécifiez la fréquence du contrôle de parité.

Standard Configuration options provide a group of basic default RAID sets whereby the
drive size, quantity, and assignments are preconfigured.

Les options de configuration standard fournissent un groupe d'ensembles RAID par défaut
de base dans lesquels la taille du lecteur, la quantité et les affectations sont préconfigurées.

Standard Configuration will replace the existing configuration.

La configuration standard remplacera la configuration existante.

Standard Host LUN mapping created successfully!

Le mappage d'unités logiques d'hôte standard a été créé avec succès !

Standard Host LUN mapping deleted successfully!

Le mappage d'unités logiques d'hôte standard a été supprimé avec succès !

Standard maps are available to all connected hosts in certain configurations.

Dans certaines configurations, les mappages standard sont disponibles pour tous les hôtes
connectés.

Standby rebuild operation completed with an unknown error.
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L'opération de reconstruction en attente s'est terminée avec une erreur inconnue.

Standby rebuild operation in progress.

Opération de reconstruction en attente en cours.

Starting Dynamic Growth.

Démarrage de la croissance dynamique.

Startup state of the secondary controller.

État de démarrage du contrôleur secondaire.

Successful negotiation between both controllers.

Négociation réussie entre les deux contrôleurs.

Successful startup. Both controllers have entered redundancy modes.

Démarrage réussi. Les deux contrôleurs sont entrés en mode de redondance.

SUNWsscsConsole needs JRE 1.2.2, 1.3, or 1.4 to run.The Console will try to find it in
/usr/java, /usr/jre,/usr/local/java, or /usr/local/jre. If you installed the JRE
in a directory other than one mentioned above, make a link.

L’exécution de SUNWsscsConsole requiert l’environnement JRE 1.2.2, 1.3, ou 1.4.
La Console tentera de la trouver dans /usr/java, /usr/jre,/usr/local/java,
ou /usr/local/jre. Si vous installez JRE dans un répertoire autre que celui mentionné
ci-dessus, créez un lien.

System ID is empty.

ID système vide.

Tape operation has stopped because an error occurred while reading or writing data, which
the drive cannot correct.

L'opération de bande s'est arrêtée parce qu'une erreur est survenue pendant la lecture ou
l'écriture des données que le lecteur ne peut pas rectifier.

TapeAlert notification. Device [Channel:Target].

Notification d'alerte de bande. Périphérique [Canal:Cible].

Target HW Error Reported((Ch:%d,Id:%d). Likely poorly seated or defective drive. Possible
defective drive slot.

Erreur matériel cible rapportée (Ch:%d,Id:%d). Sûrement un lecteur mal placé ou défectueux.
Peut-être un logement de lecteur défectueux.

Target Media Error Reported(Ch:%d,Id:%d). Likely poorly seated or defective drive. Possible
defective drive slot.

Erreur support cible rapportée (Ch:%d,Id:%d). Sûrement un lecteur mal placé ou défectueux.
Peut-être un logement de lecteur défectueux.
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Target Timed-out(Ch:%d,Id:%d). Check drive seating, cables, and I/O module. Replace as
required.

Temporisation cible(Ch:%d,Id:%d). Vérifiez le logement du lecteur, les câbles et le module
d'E/S. Remplacez ce matériel au besoin.

Temperature Alert. Check room temperature, clogged or restricted airflow. Correct as
necessary.

Alerte de température. Vérifiez la température de la pièce et la circulation de l'air pour toute
obstruction. Prenez les mesures nécessaires.

Temperature Back to Normal. Informational message.

Température redevenue normale. Message informatif.

Temperature change from TemperatureC to TemperatureC.

Changement de température de TempératureC à TempératureC.

The changer mechanism is having difficulty communicating with the tape drive. Turn the
autoloader off then on and restart the operation. If problem persists, call the tape drive
supplier helpline.

Le mécanisme de l'échangeur éprouve des difficultés à communiquer avec le lecteur de
bande. Mettez le chargeur automatique hors tension puis sous tension et recommencez
l'opération. Si le problème persiste, contactez l'assistance du fournisseur de lecteur de bande.

The client receives events only when it is running. Are you sure you want to exit?

Le client reçoit des événements uniquement quand il fonctionne. Êtes-vous sûr de vouloir
quitter ?

The configuration has been updated.

La configuration a été mise à jour.

The configuration was successfully updated. If new logical drives were created, the server
may need to be rebooted.

La configuration a été mise à jour avec succès. Si de nouveaux lecteurs logiques ont été créés,
la réinitialisation du serveur peut s'avérer nécessaire.

The Content of Periodic Trap cannot be \"Event\". Please select another one.

Le contenu du déroutement périodique ne peut pas être \"Event\". Veuillez en sélectionner
un autre.

The Controller devices list changed.

La liste des périphériques du contrôleur a été modifiée.

The controller needs to be reset for the new firmware to take effect. Do you want to reset the
controller?
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Le contrôleur doit être réinitialisé pour que le nouveau firmware entre en vigueur.
Voulez-vous réinitialiser le contrôleur ?

The controller parameters have been updated.

Les paramètres du contrôleur ont été mis à jour.

The current user is ssconfig; you cannot log in again.

L'utilisateur actuel est ssconfig ; vous ne pouvez pas vous reconnecter.

The device does not belong to the same HBA card. The operations cannot continue.

Le périphérique n'appartient pas à la même carte de l'adaptateur de bus hôte.
L'opération ne peut pas se poursuivre.

The device resource cannot be locked for exclusive use. Check to see if some applications are
currently accessing the resource. If so, close those applications and try the operation again.

La ressource du périphérique ne peut pas être verrouillée à des fins d'utilisation exclusive.
Vérifiez si certaines applications accèdent actuellement aux ressources. Si c'est le cas,
fermez ces applications et retentez l'opération.

The drive can no longer write data to the tape.

Le lecteur ne peut plus écrire de données sur la bande.

The drive letter (mounted point) cannot be assigned.

La lettre du lecteur (point de montage) ne peut pas être affectée.

The encrypt key is empty.

La clé de cryptage est vide.

The encrypt key you entered includes extra space in the beginning or at the end, which can
cause encryption errors. Do you want to continue

La clé de cryptage saisie comprend un espace supplémentaire au début ou à la fin ce qui
peut entraîner des erreurs de cryptage. Voulez-vous continuer ?

The firmware does not support multiple IP assignment mechanisms.

Le firmware ne prend pas en charge les mécanismes d'affectation IP multiples.

The firmware download failed because you have tried to use the incorrect firmware for this
tape drive. Obtain the correct firmware and try again.

Le téléchargement du firmware a échoué car vous avez essayé d'utiliser un firmware
incorrect pour ce lecteur de bande. Obtenez le firmware correct et essayez à nouveau.

The IP Address cannot be empty.

L'adresse IP ne peut pas être vide.
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The last cleaning cartridge used in the tape drive has worn out. Discard the worn out
cleaning cartridge, wait for the current operation to finish, and then use a new cleaning
cartridge.

La dernière cartouche de nettoyage utilisée dans ce lecteur de bande est usée. Jetez cette
cartouche, attendez que l'opération en cours se termine puis utilisez une nouvelle cartouche
de nettoyage.

The LD# is moved up after you delete the LD, so it may not be consistent with the LD#
shown in the RS-232 terminal window.

Le numéro du lecteur logique est incrémenté après la suppression du lecteur logique.
Il risque de ne pas correspondre au numéro de lecteur logique affiché dans la fenêtre du
terminal RS-232.

The length of the encrypt key must be greater than 8 characters.

La longueur de la clé de cryptage doit être supérieure à 8 caractères.

The Mail Server field cannot be empty.

Le champ Mail Server ne peut pas être vide.

The media has exceeded its specified life. The tape cartridge has reached the end of its useful
life. Copy any data you need to another tape. Discard the old tape.

Le support a dépassé sa durée de vie spécifiée. La cartouche de bande a terminé sa durée de
vie utile. Copiez toutes les données pertinentes sur une autre bande. Jetez l'ancienne bande.

The memory allocation Failed.

Échec de l'allocation de mémoire.

The mount point (drive letter) cannot be written into file (registry).

Le point de montage (lettre du lecteur) ne peut pas être écrit dans le fichier (registre).

The operation failed because the autoloader door is open. Clear any obstructions from the
autoloader door, eject the magazine, and then insert it again. If the fault does not clear, turn
the autoloader off and then on again.

L'opération à échoué parce que la porte du chargeur automatique est ouverte. Éliminez toute
obstruction de la porte du chargeur automatique, éjectez le magasin puis insérez-le à
nouveau. Si l'erreur persiste, éteignez le chargeur automatique puis rallumez-le.

The operation failed because the tape in the drive has snapped. Discard the old tape. Restart
the operation with a different tape.

L'opération a échoué parce que la bande dans le lecteur s'est brisée. Jetez l'ancienne bande.
Recommencez l'opération avec une autre bande.

The Selected Device list is empty!

La liste Selected Device est vide !

The server already exists!
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Le serveur existe déjà !

The Server Name cannot be empty or only contain any extra spaces

Le champ Server Name ne peut être vide ou contenir uniquement des espaces.

The set configuration Failed.

Échec du réglage de la configuration.

The tape cartridge is not data grade. Any data you backup to the tape is at risk. The drive
has not been able to read the MRS stripes. Replace the cartridge with a data-grade tape.

La cartouche de bande n'est pas une bande de données. Toutes les données enregistrées
dessus risquent d'être perdues. Le lecteur ne sera pas capable de lire les pistes MRS.
Remplacez la cartouche par une cartouche de données.

The tape drive has a hardware fault, which is not read/write related. Turn the tape drive off
and then on again and restart the operation. If the problem persists, call the tape drive
supplier helpline.

Le lecteur de bande a un problème matériel qui n'est pas lié à l'écriture ou la lecture de
données. Mettez le lecteur de bande hors tension puis sous tension et recommencez
l'opération. Si le problème persiste, contactez l'assistance du fournisseur de lecteur de bande.

The tape drive has a hardware fault. Eject the tape or magazine, reset the drive (hold the
unload button down for 5 seconds), and restart the operation.

Le lecteur de bande a un problème matériel. Éjectez la bande ou le magasin, réinitialisez le
lecteur (appuyez sur le bouton de déchargement pendant cinq secondes), puis recommencez
l'opération.

The tape drive has a problem with the SCSI interface. Check the cables and cable connections
and restart the operation.

Le lecteur de bande a détecté un problème avec l'interface SCSI. Vérifiez les câbles et les
connexions puis recommencez l'opération.

The tape drive is due for routine cleaning. Wait for the current operation to finish and then
use a cleaning cartridge.

Le lecteur de bande doit être nettoyé. Attendez que l'opération en cours se termine puis
utilisez une cartouche de nettoyage.

The tape drive is having problems reading data.No data has been lost, but there has been a
reduction in the capacity of the tape.

Le lecteur de bande a détecté des problèmes à la lecture de données. Aucune donnée ne sera
perdue mais la capacité de la bande sera réduite.

The tape drive needs cleaning. If the operation has stopped, eject the tape and clean the
drive. If the operation has not stopped, wait for it to finish and then clean the drive.

Le lecteur de bande doit être nettoyé. Si l'opération s'est terminée, éjectez la bande et nettoyez
le lecteur. Si l'opération n'est pas terminée, attendez qu'elle finisse puis nettoyez le lecteur.

TABLEAU G-34 Messages d'erreur et d'état (suite)

Error and Status Messages
Annexe G Messages et codes d'erreur 295



The tape in the drive is a cleaning cartridge. If you want to backup or restore, insert a data-
grade tape.

La bande dans le lecteur est une cartouche de nettoyage. Si vous voulez sauvegarder ou
restaurer, insérez une bande de données.

The tape is damaged or the drive is faulty. The drive can no longer read data from the tape.
Call the tape supplier helpline.

La bande est endommagée ou le lecteur est défectueux. Le lecteur ne peut plus lire les
données de la bande. Contactez l'assistance du fournisseur de bande.

The tape is from a faulty batch or the tape drive is faulty. Use a good tape to test the drive. If
the problem persists, call the tape drive supplier helpline.

La qualité de la bande ou le lecteur de bande est défectueux. Utilisez une bande de meilleure
qualité pour tester le lecteur. Si le problème persiste, contactez l'assistance du fournisseur de
lecteur de bande.

The tape operation failed. Eject and then reinsert the tape or magazine.

L'opération de bande a échoué. Éjectez puis réinsérez la bande ou le magasin.

The WWN must be a Hex string that is less than 17 characters.

Le nom WWN doit être une chaîne hexadécimale inférieure à 17 caractères.

There are no available disks to configure.

Aucun disque disponible à la configuration.

There are no logical drives to manage.

Aucun lecteur logique disponible à la gestion.

There are not enough available disks to add a new LD.

Il n'y a pas assez de disques pour ajouter un nouveau lecteur logique.

There is a problem with the autoloader mechanism. Loader mechanism has detected a
hardware fault.

Il y a un problème avec le mécanisme du chargeur automatique. Le mécanisme a détecté un
problème matériel.

There is no spare or replacement drive. Rebuild cannot continue.

Aucun lecteur de réserve ou de remplacement n'existe. La reconstruction ne peut pas se
poursuivre.

This Configuration Will Overwrite the Existing Configuration. All Previous Configuration
Information and Data Will Be Lost.

Cette configuration remplacera la configuration existante. Toutes les informations de la
configuration précédente et les données seront perdues.

This operation will add to the existing configuration.
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Cette opération ajoutera à la configuration existante.

This operation will delete the fibre map.

Cette opération supprimera le mappage de fibre.

This operation will erase any existing configuration and data.

Cette opération effacera toutes les configurations ou données existantes.

This operation will result in the loss of current controller settings and data on ALL of the
logical drives. Are you sure you want to restore factory defaults?

Cette opération entraînera la perte des réglages et données actuels du contrôleur sur TOUS
les lecteurs logiques. Voulez-vous toujours restaurer les valeurs par défaut ?

This operation will result in the loss of data on ALL of the modified partitions. Do you want
to continue?

Cette opération entraînera la perte des données sur TOUTES les partitions modifiées.
Voulez-vous continuer ?

To find out the java version currently installed, type “java-version”

Pour déterminer la version Java actuellement installée, tapez « java-version »

Trap information has been modified. Do you want to save it?

Les informations de déroutement ont été modifiées. Voulez-vous les enregistrer ?

Unable to allocate memory for array inquiry. Unable to monitor this array.

Impossible d'allouer de la mémoire à la requête de la baie. Impossible de surveiller cette baie.

Unable to determine local host, terminating!

Impossible de déterminer l'hôte local. Fin.

Unable to eject cartridge because the tape drive is in use. Wait until the operation is complete
before ejecting the cartridge.

Impossible d'éjecter la cartouche parce que le lecteur de bande est en cours d'utilisation.
Attendez que l'opération se termine avant d'éjecter la cartouche.

Unable to inquire card. Array error.

Impossible d'interroger la carte. Erreur de baie.

Unable to inquire SAF-TE device. SAF-TE monitoring for this enclosure disabled.

Impossible d'interroger le périphérique SAF-TE. La surveillance SAF-TE pour ce boîtier est
désactivée.

Unable to inquire tape device. This device will be removed.

Impossible d'interroger le périphérique de bande. Ce périphérique sera supprimé.

Unable to inquire target devices. Device and SAF-TE monitoring disabled.
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Impossible d'interroger les périphériques cibles. La surveillance des périphériques et SAF-TE
est désactivée.

Unable to issue Self-Reliability Query on device at [Channel:Target].

Impossible de lancer une requête d'auto-fiabilité au périphérique sur [Canal:Cible].

Unable to open bindings file -or- no bindings present. Check Bindings file.

Impossible d'ouvrir le fichier de liaison ou aucune liaison n'est présente. Vérifiez le fichier de
liaison.

Unable to open I/O transport layer

Impossible d'ouvrir la couche de transport E/S.

Unable to query TapeAlert log data. TapeAlert monitoring disabled for this device.

Impossible d'interroger les données de journal d'alertes de bande. La surveillance d'alertes
de bande est désactivée pour ce périphérique.

Unable to read enclosure environmental status.

Impossible de lire l'état environnemental du boîtier.

Unable to send login info to the server.

Impossible d'envoyer les informations de connexion au serveur.

Undefined Error(Ch:%d,Id:%d). Contact technical support.

Erreur non définie (Ch:%d,Id:%d). Contactez l'assistance technique.

Unexpected Disconnect(Ch:%d,Id:%d). Check drive seating, cables, and I/O module.
Replace as required.

Déconnexion inattendue (Ch:%d,Id:%d). Vérifiez le logement du lecteur, les câbles et le
module d'E/S. Remplacez ce matériel au besoin.

Unexpected Sense Data Received from Target(Ch:%d,Id:%d). Likely poorly seated or
defective drive. Possible defective drive slot.

Données de détection inattendues reçues de la cible(Ch:%d,Id:%d). Sûrement un lecteur mal
placé ou défectueux. Peut-être un logement de lecteur défectueux.

Unexpected Unit Attention Received from Target(Ch:%d,Id:%d). Likely poorly seated or
defective drive. Possible defective drive slot.

Intervention d'unité inattendue reçues de la cible(Ch:%d,Id:%d). Sûrement un lecteur mal
placé ou défectueux. Peut-être un logement de lecteur défectueux.

Unknown redundancy state.

État de redondance inconnu.

UNMAPPED LUN, NOT AVAILABLE TO HOST

NUMÉRO D'UNITÉ LOGIQUE NON MAPPÉ, PAS DISPONIBLE À L'HÔTE
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Username is empty.

Nom d'utilisateur vide.

Waiting for debounce ping.

Attente du retour de ping.

Write config file error.

Erreur d'écriture du fichier de configuration.

Wrong Fax number format.

Format erroné du numéro de fax.

Wrong Phone number format.

Format erroné du numéro de téléphone.

You must first delete the host mapping for the partitions whose index number is greater
before you can change this partition.

Avant de modifier cette partition, vous devez d'abord supprimer le mappage hôte pour les
partitions dont le numéro d'index est supérieur.

You must first delete the host mapping for the partitions whose index number is greater or
equal before you can delete this partition.

Avant de supprimer cette partition, vous devez d'abord supprimer le mappage hôte pour les
partitions dont le numéro d'index est supérieur ou égal.

You must first delete the host mapping for this logical drive before you can delete it.

Vous devez d’abord annuler le mappage hôte de ce lecteur logique avant de pouvoir le
supprimer.

You must first delete the host mapping of the last partition before you can add a new
partition.

Avant d'ajouter une nouvelle partition, vous devez d'abord supprimer le mappage hôte de la
dernière partition.

You selected “Event” as the Trap Type, therefore, you must select at lease one Active trap
event.

Vous avez sélectionné Event comme type de déroutement et vous devez par conséquent
choisir au moins un événement de déroutement actif.

You selected “My SMTP server needs authorization,” therefore, you must enter a Password.

Vous avez sélectionné l'option « My SMTP server needs authorization » et devez par
conséquent saisir un mot de passe.

You selected “My SMTP server needs authorization,” therefore, you must enter a Username.
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Vous avez sélectionné l'option « My SMTP server needs authorization » et devez par
conséquent saisir un nom utilisateur.

You selected “use encrypt,” therefore, you must enter an encrypt key.

Vous avez sélectionné l'option « use encrypt » et devez par conséquent saisir une clé de
cryptage.
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Glossaire

Cette annexe énumère les acronymes et définit les termes RAID figurant dans la
documentation. Elle inclut également les définitions des états opérationnels des
lecteurs de disque, des lecteurs logiques et des contrôleurs redondants.

Acronymes
ANSI American National Standards Institute (organisme américain responsable de la

coordination de l'ensemble des normes de l'industrie en général)

CEI Commission électrotechnique internationale

CH Canal

CISPR International Special Committee on Radio Interference (comité international
spécial des perturbations radioélectriques)

EMU Event Monitoring Unit (unité de contrôle des événements)

FC-AL Fibre Channel-Arbitrated Loop (boucle arbitrée Fibre Channel) Une connexion
FC-AL est mise en œuvre soit sous forme d'une boucle, soit sous forme d'une
connexion fabrique. Une boucle peut contenir 126 nœuds accessibles par le
biais d'un seul serveur ou de deux serveurs.

FRU Field-Replaceable Unit (unité remplaçable par l'utilisateur)

GBIC Gigabit Interface Converter (module GBIC) Périphérique d'entrée/sortie
enfichable à chaud qui se branche dans un port Gigabit Ethernet ou Fibre Channel.

Go Giga-octet. 1.000.000.000 - Un milliard d'octets

HBA Host Bus Adapter (adaptateur de bus hôte)

ID Numéro identificateur

JBOD Just a Bunch of Disks (une unité de disque munie de lecteurs, mais non munie
de contrôleurs).

LAN Local Area Network (réseau local)
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LD Logical drive (lecteur logique)

LVD Système de signalisation à faible bruit, faible puissance et basse amplitude,
permettant la transmission de données entre les serveurs et périphériques de
stockage pris en charge. La technologie LVD utilise deux fils pour la
transmission d'un signal sur câble de cuivre et nécessite un câble dont la
longueur ne doit pas dépasser 25 m.

Mo Méga-octet. Un million d'octets ou de caractères de données.

NVRAM Non-Volatile Random Access Memory (mémoire vive non volatile). Unité de
mémoire dotée d'une batterie de manière à ce que les données restent intactes,
même après la mise hors tension de l'alimentation principale.

PID Numéro d'identification du contrôleur principal.

RAID Redundant Array of Independent Disks (ensemble redondant de disques
indépendants). Configuration dans laquelle plusieurs lecteurs sont combinés
en un seul lecteur virtuel pour améliorer les performances et la fiabilité.

SAN Storage Area Networking (réseau de stockage SAN). Réseau rapide, évolutif et
à norme ouverte de périphériques et de contrôleurs de stockage permettant
l'accélération de l'accès aux données.

SCSI Small Computer Systems Interface (interface SCSI). Norme utilisée dans toute
l'industrie pour la connexion de lecteurs de disque et de lecteurs de bande à un
poste de travail.

SES Pilote SCSI Enclosure Services. Interface vers les dispositifs gérés par les
services SCSI Enclosure Services. Ces dispositifs captent et surveillent les
conditions physiques à l'intérieur d'un boîtier et permettent d'accéder aux
fonctions de production de rapport et de configuration du boîtier (par exemple
des voyants DEL du boîtier).

SID Numéro d'identification du contrôleur secondaire.

S.M.A.R.T. Self Monitoring Analysis and Reporting Technology (technologie SMART).
Norme utilisée dans toute l'industrie pour l'indicateur de prédiction de fiabilité
pour les lecteurs de disque dur IDE/ATA et SCSI. Les lecteurs de disque dur
gérés conformément à la norme SMART fournissent des avertissements
préalables à certaines défaillances des disques durs et permettent la protection
des données critiques.

SMTP Simple Mail Transfer Protocol (protocole SMTP). Protocole pour l'envoi de
messages électroniques entre serveurs et entre clients et serveurs de
messagerie. Les messages peuvent être récupérés par un client de messagerie
utilisant les protocoles POP ou IMAP.

SNMP Simple Network Management Protocol (protocole SNMP). Ensemble de
protocoles permettant la gestion de réseaux complexes. SNMP repose sur
l'envoi de messages appelés Protocol Data Units (ou PDU) à différentes parties
d'un réseau. Les matériels conformes SNMP, appelés agents, stockent les
données les concernant dans des bases d'information de gestion Management
Information Bases (ou MIB) et envoient ces données aux demandeurs SNMP.
302  Guide de l’utilisateur Sun StorEdge 3000 Family Configuration Service 1.2 • avril 2003



unité logique Logical unit number (numéro d'unité logique). Les numéros de périphériques
majeurs et mineurs constituent la séquence numérique d'unités logiques pour
un périphérique raccordé à un ordinateur.

WWN World Wide Name (nom universel). Nombre utilisé pour identifier les volumes
d'une baie à la fois dans le système de baie et les systèmes se servant de Solaris.

Terminologie
baie physique Une baie physique est un groupe de lecteurs physiques gérés par Configuration

Service et qui fait partie d'un ou de plusieurs lecteurs logiques. Lorsqu'un
groupe de lecteurs physiques est configuré pour constituer un lecteur logique
sans que toute la capacité des lecteurs physiques soit utilisée, Configuration
Service exige que les membres de la même baie physique de lecteurs soit utilisés
ensemble dans tout lecteur logique créé à partir de la capacité restante.

Dans la fenêtre New Configuration, le bouton Add Disk devient Add Array
lorsque la capacité du lecteur restante se trouve sur plusieurs lecteurs
physiques qui ont déjà été utilisés pour créer un lecteur logique. Lorsque les
lecteurs physiques ont été partagés, ils doivent être sélectionnés en tant que
baie. Ils ne peuvent plus être sélectionnés séparément.

cache à écriture
différée Une stratégie d'écriture de la mémoire cache en vertu de laquelle le contrôleur

de la baie reçoit les données à écrire sur disque, les stocke dans sa mémoire
tampon et envoie immédiatement au système d'exploitation de l'hôte le signal
que l'opération d'écriture est terminée, sans attendre que les données soient
réellement écrites sur le lecteur de disque. Après un bref délai, lorsqu'il n'est
pas occupé, le contrôleur écrit les données sur le lecteur de disque.

L'écriture différée améliore les performances des opérations d'écriture et le débit
du contrôleur. Toutefois, parce qu'il existe un danger de perte de données en cas
de coupure de l'alimentation électrique, les systèmes de stockage fonctionnant en
écriture différée doivent être équipées d'une alimentation sans coupure ou d'une
mémoire cache protégée par batterie. Une alimentation sans coupure alimente le
système suffisamment longtemps pour permettre l'écriture sur le lecteur de
disque de toutes les données contenues dans la mémoire cache. Dans le cas d'une
mémoire cache protégée par batterie, la batterie fournit une alimentation
permettant de maintenir les données en mémoire pendant 48 heures.

cache à écriture
synchrone Stratégie d'écriture de la mémoire cache en vertu de laquelle le contrôleur de la

baie écrit les données sur le lecteur de disque avant de signaler au système
d'exploitation de l'hôte que l'opération est terminée. L'écriture synchrone produit
de moins bonnes performances pour les opérations d'écriture et le débit des
données, mais constitue une stratégie plus sûre présentant un risque minimal de
perte de données en cas en cas de coupure d'alimentation électrique.
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canal Tout chemin d'accès utilisé pour la transmission de données et d'informations
de contrôle entre des périphériques de stockage et un contrôleur de stockage
ou adaptateur d'E/S. Désigne également un bus SCSI sur un contrôleur de baie
de disques. Chaque contrôleur de baie de disques est doté d'au moins un canal.

contrôle de parité Opération de vérification de l'intégrité des données redondantes stockées dans
les baies à tolérance de pannes (RAID 1, 3, 5 et 6, cette dernière technique étant
également appelée RAID 1+0). Le contrôle de parité sur un lecteur logique
recalcule la parité des blocs de données dans chaque jeu de blocs de données
entrelacés RAID et la compare à la parité enregistrée. En cas de différence, une
erreur est indiquée et la nouvelle parité corrigée est substituée à la parité stockée.

contrôleurs actif-actif Deux composants, par exemple des contrôleurs de stockage dans un système
de stockage à tolérance de pannes, qui partagent une tâche ou un ensemble de
tâches lorsqu'ils fonctionnent normalement. Lorsqu'un des éléments tombe en
panne, l'autre assume toute la charge de travail. Les contrôleurs à double
activité sont branchés au même ensemble de périphériques pour offrir à la fois
de meilleures performances d'E/S et une meilleure tolérance de pannes qu'un
contrôleur unique.

enfichable à chaud Capacité d'une unité remplaçable par le client (FRU) d'être enlevée et
remplacée, le système restant sous tension et opérationnel.

entrelacement Mode de stockage des blocs de données arrivant séquentiellement sur les différents
lecteurs SCSI d'un lecteur logique. Par exemple, dans le cas d'un lecteur logique
comportant trois lecteurs SCSI, les données sont stockées de la manière suivante :

bloc 1 sur le lecteur SCSI 1

bloc 2 sur le lecteur SCSI 2

bloc 3 sur le lecteur SCSI 3

bloc 4 sur le lecteur SCSI 1

bloc 5 sur le lecteur SCSI 2, etc.

Cette méthode d'écriture des données augmente le débit des données du
système de disques, parce que plusieurs lecteurs travaillent simultanément à
l'extraction et au stockage des données. Les niveaux RAID 0, 3, 5 et 6 utilisent
tous les entrelacements.

état L'état opérationnel actuel d'un lecteur de disque, d'un lecteur logique ou de
contrôleurs redondants. Le système stocke les états des lecteurs, des lecteurs
logiques et des contrôleurs redondants dans sa mémoire non volatile. Cette
information est maintenue en cas d'interruption de l'alimentation électrique du
système.

fabrique Réseau de type Fibre Channel constitué autour d'un ou de plusieurs commutateurs.
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facteur
d'entrelacement Taille en kilo-octets des blocs de données entrelacés parmi les lecteurs

physiques d'un lecteur logique. La taille peut varier, par multiples de 8 kilo-
octets, entre 8 et 64 kilo-octets. D'une manière générale, plus les blocs sont
gros, plus les opérations sont efficaces pour les systèmes dont la lecture des
données s'effectue surtout de manière séquentielle.

Pour changer la taille des blocs sur un lecteur existant, vous devez sauvegarder
les données, redéfinir la taille de bloc, reconfigurer l'espace de stockage et
restaurer toutes les données.

Fibre Channel Liaison de télécommunication économique de un giga-octet/s reliant du
matériel très divers.

groupe de partenaires Paire d'unités de contrôle interconnectées. Les unités d'expansion connectées
aux unités de contrôle interconnectées peuvent également faire partie du
groupe de partenaires.

groupes Un groupe constitue un nouvel objet de données permettant à plusieurs serveurs
d'appartenir à une seule entité. Ce concept est semblable à celui de domaine et
permet l'organisation de serveurs par Configuration Service. Au lieu d'organiser
les serveurs gérés en une arborescence linéaire, l'opérateur Configuration Service
peut les grouper en ensembles ou groupes de serveurs semblables.

La définition de groupes n'est pas obligatoire. On peut configurer Configuration
Service pour zéro groupe et quinze serveurs, par exemple, ou pour un groupe
comprenant dix serveurs et cinq serveurs figurant à la racine de l'arborescence.
Configuration Service permet toutes les combinaisons possibles.

Le nombre de groupes et le nombre de serveurs par groupe ne sont limités que
par la mémoire du système disponible. Lorsqu'un utilisateur supprime un
groupe de la zone de liste des groupes, Configuration Service réaffecte les
serveurs appartenant à ce groupe à la catégorie « aucun groupe ». Configuration
Service actualise automatiquement l'arborescence dans la fenêtre principale.

hors bande Ce terme qualifie les connexions et périphériques se trouvant hors du
cheminement des données.

lecteur de réserve à
remplacement à chaud Lecteur en configuration RAID 1 ou RAID 5, ne contenant pas de données et

maintenu en réserve dans l'éventualité d'une défaillance d'un autre lecteur.

lecteur en attente Un lecteur marqué comme lecteur de réserve pour la reconstruction automatique
des données à la suite de la défaillance d'un lecteur physique associé à un lecteur
logique. Pour qu’un lecteur en attente puisse prendre laplace d’un autre lecteur,
il doit avoir au moins la même taille que le lecteur défaillant. De plus, le lecteur
défaillant même doit appartenir à un RAID de niveau 1, 3, 5, ou 1+0.

lecteur logique Une baie de lecteurs physiques indépendants que l'hôte détecte comme un seul
grand lecteur.

lecteur logique à
tolérance de pannes Lecteur logique protégeant les données en cas de défaillance d'un seul lecteur

grâce à l'architecture RAID 1, 3, 5 ou 6 (également appelée architecture RAID 1+0).
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mappage d'unité
logique Capacité de changer l'unité logique virtuelle présentée au serveur par le

dispositif de stockage. L'un de ses avantages est la possibilité d'amorcer un
serveur à partir du système de stockage en réseau, en l'absence d'un lecteur de
disque local. Chaque serveur exige l'unité logique 0 comme unité d'amorçage.

masquage d'unité
logique Caractéristique permettant à un administrateur de mapper dynamiquement un

adaptateur au bus de l'hôte à une unité logique donnée. Cela permet à un ou
plusieurs serveurs d'avoir accès à un ou plusieurs lecteurs, tout en interdisant
les accès non désirés entre un serveur et un lecteur.

mise en cache Permet aux données d'être stockées dans une zone de disque prédéterminée ou
dans la mémoire RAM (mémoire vive). La mise en mémoire cache permet
d'accélérer les opérations des systèmes RAID, des lecteurs de disque, des
ordinateurs et des serveurs, ainsi que d'autres périphériques.

mise en miroir
(RAID 1) Les données écrites sur un lecteur de disque sont simultanément écrites sur un

autre lecteur de disque. En cas de défaillance d'un des disques, l'autre disque
peut être utilisé pour permettre le fonctionnement continu du système et la
reconstruction des données du disque défaillant. L'avantage principal de la
mise en miroir des disques est la redondance des données à 100 %. Lorsque le
disque est mis en miroir, la panne d'un des disques n'a aucune incidence. Les
deux disques contiennent les mêmes données tout le temps et l'un ou l'autre
peuvent agir comme disque opérationnel.

La mise en miroir de disque fournit une redondance à 100 % mais elle est
relativement coûteuse dans la mesure où chacun des lecteurs du système est
dupliqué.

partition Section de l'espace de stockage du disque appelée également lecteur système
ou numéro d'unité logique qui est détectée par le système d'exploitation hôte
comme un seul lecteur physique. Un lecteur logique peut se trouver sur un ou
plusieurs lecteurs physiques.

politique d'écriture Stratégie d'écriture des données de la mémoire cache utilisée pour contrôler les
opérations d'écriture de système. Les options de politique d'écriture sont
écriture différée et cache à écriture synchrone.

politique de lecture Les descriptions des politiques de lecture sont les suivantes :

Lorsque vous indiquez la politique de lecture No Cache, le contrôleur ne
stocke pas de données dans la mémoire cache de lecture.

« Normal » indique que le contrôleur en cours d'utilisation n'utilise pas la
lecture anticipée en mémoire cache pour le lecteur en cours d'utilisation.

Sélectionnez la politique de lecture Read Ahead pour que le contrôleur lise
automatiquement plusieurs blocs de données adjacents. C'est la méthode la
plus efficace pour les applications lisant les données séquentiellement.
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port N Port Fibre Channel dans une connexion point à point ou de type Fabric

RAID Redundant Array of Independent Disks (ensemble redondant de disques
indépendants). Un agencement de deux ou plusieurs lecteurs de disque configurés
pour travailler ensemble et fournir plus d'espace de stockage, une meilleure
performance et/ou une sauvegarde redondante des données. Les diverses
combinaisons de ces fonctions sont décrites par les niveaux RAID définis. Pour la
description précise des niveaux RAID, voir « Introduction à RAID », page 189.

reconstruction La reconstruction d'un disque est l'opération consistant à reconstruire les données
telles qu'elles étaient sur un disque avant sa défaillance. La reconstruction peut se
faire uniquement dans les baies avec redondance des données.

Voir « reconstruction automatique », page 307 pour de plus amples
informations sur la reconstruction. Pour le taux de reconstruction, voir « taux
d'utilisation en arrière-plan », page 308.

reconstruction
automatique Opération par laquelle les données sont automatiquement reconstruites après

la défaillance d'un lecteur et écrites sur un lecteur de secours (lecteur de
réserve). Une reconstruction automatique se produit également lorsqu'un
nouveau lecteur est installé manuellement à la place d'un lecteur défaillant.
Si la reconstruction est interrompue par une réinitialisation, utilisez Array
Administration → Rebuild pour redémarrer l'opération de reconstruction.

répartition des données
sur plusieurs disques La répartition des données sur plusieurs disques fait intervenir la capacité du

microprogramme d'entrelacer des blocs de données sur deux lecteurs logiques
RAID par ailleurs indépendants. Les deux lecteurs logiques entrelacés sont
présentés à l'environnement d'exploitation sous la forme d'un seul lecteur
logique. Les avantages de l'entrelacement sont les suivants.

Prise en charge simultanée de deux défaillances de lecteurs parmi les lecteurs
logiques à tolérance de pannes combinés (dans la mesure où une défaillance
provient de chaque lecteur logique).

Amélioration des performances, grâce à l'augmentation du nombre d'axes de
rotation.

Le désavantage de la répartition des données sur plusieurs disques est
l'augmentation de la charge de travail du système en raison de la gestion de
niveaux RAID redondants, puisque la tolérance de pannes de chaque lecteur
logique est gérée séparément.

reprise de charge Mode d'opération des systèmes à tolérance de pannes dans lequel un composant
est tombé en panne et ses fonctions ont été assumées par un composant redondant.
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taux d'utilisation en
arrière-plan Le taux d'utilisation en arrière-plan est le pourcentage de temps processeur

affecté aux activités d'administration de la baie de disques, par exemple la
reconstruction des lecteurs défaillants, les vérifications de parité et
l'initialisation. Si l'on donne la valeur 100 % à ce taux, les activités
d'administration ont une priorité supérieure à celle des autres activités de
système. Lorsque l'on donne la valeur 0 %, les activités d'administration sont
uniquement effectuées s'il n'y a pas d'autre activité dans le contrôleur.

terminaison Pièce utilisée pour terminer un bus SCSI. Les terminaisons empêchent le retour
par réflexion de l'énergie dans un câble, grâce à l'absorption des signaux
radioélectriques.

tolérance de pannes Capacité de gérer les problèmes matériels internes sans interrompre la
disponibilité des données contenues dans la baie, souvent par utilisation de
systèmes de secours amenés en ligne en cas de détection de panne. De
nombreux systèmes de stockage fonctionnent avec tolérance de pannes en
utilisant l'architecture RAID comme protection contre la perte de données en
cas de défaillance d'un seul lecteur de disque. L'utilisation des techniques
RAID 1 (écriture miroir), RAID 3 ou 5 (entrelacement avec parité) ou RAID 6,
équivalent à RAID 1+0, (écriture miroir et entrelacement) permettent au
contrôleur de la baie de reconstruire les données d'un lecteur en panne et de
les écrire sur un lecteur en attente ou un lecteur de rechange.

volume Également appelé numéro d'unité logique ou LUN, un volume est constitué de
un ou plusieurs lecteurs pouvant être groupés pour former une seule unité de
stockage de données.
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